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คํานํา 
 เอกสารคําสอนวิชา การใชโปรแกรมคอมพิวเตอรทางสถิติในดานสังคมศาสตร (The 

Application of Statistical Package in Social Sciences) พัฒนาและใชสอนนิสิตภาควิชาสังคม

วิทยาท้ังสาขาวิชาการพัฒนาชุมชนและสาขาวิชาการจัดการบริการสังคมในรหัสวิชาท่ีแตกตางกันไป

ตามการปรับปรุงหลักสูตรจนถึงปจจุบัน คือ รหัสวิชา 26234160 ตามหลักสูตรศิลปศาสตรบัณฑิต 

สาขาวิชาการจัดการบริการสังคม หลักสูตรปรับปรุง พ.ศ. 2560 ท่ีใหนิสิตเรียนในภาคเรียนท่ี 1 ป

การศึกษา 2563 เปนตนไป 

 จุดมุงหมายของวิชานี้ คือ การปูพ้ืนฐานความรูเก่ียวกับการใชโปรแกรมคอมพิวเตอรทางสถิติ

ในการวิเคราะหขอมูลเชิงปริมาณดานสังคมศาสตร เนื้อหาจึงประกอบดวยความรูเก่ียวกับการวิจัย

ดานสังคมศาสตร การวิจัยเชิงปริมาณ สถิติสําหรับการวิจัย การเตรียมขอมูลเขาโปรแกรม การติดตั้ง

และใชโปรแกรมเบื้องตน การจัดการขอมูล การวิเคราะหเครื่องมือการวิจัย การตรวจสอบขอมูล การ

วิเคราะหขอมูลดวยสถิติเชิงพรรณนาและสถิติเชิงอางอิง (การทดสอบแบบอิงคาพารามิเตอรและไมอิง

คาพารามิเตอร) โดยเนนการวิเคราะหตัวแปรไมเกิน 2 ตัวแปร และในแตละบทยังมีแบบฝกหัดทาย

บทใหทบทวนและศึกษาเพ่ิมเติมดวย  

เนื้อหาในเอกสารคําสอนใชโปรแกรม PSPP ท่ีเปนโปรแกรมทางสถิติแบบรหัสเปด (Open 

Source Statistical Software: OSSS) ภายใตสัญญาอนุญาตใหใชซอฟตแวรแบบสาธารณะท่ัวไป 

(GNU General Public License: GNU-GPL) ท่ีสามารถหาดาวนโหลดไดจากอินเทอรเน็ตและติดตั้ง

ใชงานไดดวยตนเอง เปนเครื่องมือในการวิเคราะหและทดสอบขอมูล 

ผูเขียนหวังวาผูเรียนจะไดความรูเบื้องตนเก่ียวกับการวิเคราะหขอมูลเชิงปริมาณ นําเอา

ความรูท่ีไดจากการเรียนไปใชเปนเครื่องมือวิเคราะหขอมูลเพ่ือจัดทํารายงานระหวางเรียนอยูใน

มหาวิทยาลัยและนําไปใชประโยชนหลงัเรียนจบไปแลว  

ผูชวยศาสตราจารย ดร. เรวัต แสงสุริยงค 

กุมภาพันธ 2564 



ข | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

คํานํา 

(ปรับปรุงคร้ังที่ 1) 

 เอกสารคําสอนวิชา 26234160 การใชโปรแกรมคอมพิวเตอรทางสถิติในดานสังคมศาสตร 

(The Application of Statistical Package in Social Sciences) ฉบับนี้ทําการปรับปรุงเนื้อหาใหม

ในบางสวน และทําการแกไขขอบกพรองท่ีพบระหวางการเรียนการสอน เพ่ือใชสอนตั้งแตภาคเรียนท่ี 

2 ปการศึกษา 2565 เปนตนไป   

 นอกจากการปรับปรุงและแกไขตามท่ีกลาวมาแลว ยังไดทําเอาผลการวิจัยของผูสอนเรื่อง 

ความเสี่ยงของการเกิดความคลาดเคลื่อนในการวิจัยเชิงปริมาณดานสังคมวิทยา (Risks of Error in 

the Quantitative Sociology Research) มาเพ่ิมไวในเนื้อหาท่ีเก่ียวกับการวิเคราะหเครื่องมือการ

วิจัย เพ่ือใหผูเรียนตระหนักถึงความสําคัญของการตรวจสอบเครื่องมือการวิจัยกอนนําไปใชในการเก็บ

รวบรวมขอมูล 

ผูเขียนหวังวาผูเรียนจะไดใชเอกสารนี้ในการเรียนรูการวิเคราะหขอมูลเชิงปริมาณดานสังคม 

และนําเอาความรูท่ีไดจากการเรียนรูจากเอกสารคําสอนนี้ไปใชประโยชนในการหาความรูเชิงวิชาการ

และเชิงประยุกตตอไป 

ผูชวยศาสตราจารย ดร. เรวัต แสงสุริยงค 

พฤศจิกายน 2565 

  



 

 

ภาควิชาสังคมวิทยา คณะมนุษยศาสตรและสงัคมศาสตร 

มหาวิทยาลัยบูรพา 

แผนการสอน 

1. รหัสและช่ือรายวิชา 

26234160 การใชโปรแกรมคอมพิวเตอรทางสถิติในดานสังคมศาสตร 

2. จํานวนหนวยกิต 3 หนวยกิต (2-2-5) 

3. หลักสูตรและประเภทของรายวิชา ศิลปศาสตรบัณฑิต สาขาวิชาการจัดการบริการสังคม เปนวิชา

เลือก 

4. คําอธิบายรายวิชา 

หลักการและฝกปฏิบัติการใชคอมพิวเตอรในการประมวลผลสถิติทางสังคมศาสตร โดยนําตัว

แปรและขอมูลเก่ียวกับประชากร ชุมชนและสังคมมาจัดเตรียมขอมูล บันทึกขอมูลและวิเคราะห

ตลอดจนการแปลความหมายและนําเสนอรายงาน 

5. วัตถุประสงคของรายวิชา 

5.1 ผูเรียนเขาใจเก่ียวกับการหาความรูดานสังคมศาสตร รวมถึงสาขาวิชาสังคมวิทยา 

5.2 ผูเรียนเขาใจวิธีการวิจัยเชิงปริมาณท่ีเกิดจากความสัมพันธระหวางทฤษฎี สมมติฐาน 

และตัวแปร 

5.3 ผูเรียนเขาใจและเลือกใชสถิติแตละประเภทในการวเิคราะหและทดสอบขอมูลไดถูกตอง

และเหมาะสม 

5.4 ผูเรียนสามารถแปลงขอมูลจากแบบสอบถามไปเปนแฟมขอมูลได 

5.5 ผูเรียนรูจักโปรแกรมคอมพิวเตอรดานสถิติสําหรับวิเคราะหขอมูล สามารถติดตั้งและเริ่ม

ใชงานเบื้องตนได 



ง | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

5.6 ผูเรียนสามารถนําขอมูลจากแบบสอบถามกรอกเขาโปรแกรม และนําขอมูลท่ีเก็บอยูใน

รูปของแฟมขอมูลเขาโปรแกรม 

5.7 ผูเรียนสามารถเลือกใชขอมูลและเปลี่ยนรูปแบบขอมูลใหตรงกับวัตถุประสงคของการ

วิเคราะหขอมูล 

5.8 ผูเรียนสามารถวิเคราะหคุณภาพของเครื่องมือการวิจัยได 

5.9 ผูเรียนสามารถตรวจสอบความถูกตองและความสมบูรณของขอมูล รวมถึงตรวจสอบ

ลักษณะของขอมูลตามขอตกลงเบื้องตนของสถิติ 

5.10 ผูเรียนสามารถใชโปรแกรมประมวลผลการแจกแจงขอมูลของตัวแปร 1 ตัวแปร ดวย

สถิติเชิงพรรณนา และเขียนบรรยายผลการวิเคราะหได 

5.11 ผูเรียนสามารถใชโปรแกรมประมวลผลทดสอบขอมูลของตัวแปร 1 ตัวแปร และ 2 ตัว

แปร ดวยสถิติเชิงอางอิงและเขียนบรรยายผลการทดสอบได 

6. ผลการเรียนรู 

ดานคุณธรรมจรยิธรรม:- มีจรรยาบรรณทางวิชาการหรือวิชาชีพ (1.5)  

ดานความรู:- สามารถประยุกตความรูจากทฤษฎีสูการปฏิบัติ (2.2)  

ดานทักษะทางปญญา:- สามารถคิดวิเคราะหอยางเปนระบบ  (3.3) 

ดานทักษะความสัมพันธระหวางบุคคลและความรับผิดชอบ:- มีภาวะผูนํา และสามารถทํางาน

เปนทีม (4.2) 

ดานทักษะการวิเคราะหเชิงตัวเลข การสื่อสาร และการใชเทคโนโลยีสารสนเทศ:- สามารถ

เลือกหรือประยุกตเทคนิคทางคณิตศาสตร หรือสถิติท่ีเก่ียวของในการศึกษาคนควา เสนอแนะ

แนวทางในการแกปญหาอยางเหมาะสม  (5.3) 

ดานทักษะพิสัย:- มีทักษะในการศึกษาและวิเคราะหสถานการณชุมชน/ องคกรดวยเครื่องมือ

ทางการจัดการบริการสังคม (6.2) 

7. อาจารยผูรับผิดชอบรายวิชา ผูชวยศาสตราจารย ดร. เรวัต แสงสุริยงค    



แ ผ น ก า ร ส อ น | จ 

 

8. แผนการสอน 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

1 

แนะนําการเรียนการสอน 

การวิจัยทางสังคมศาสตร 

1. การหาความรูดานสังคมศาสตร 

- ศาสตร คือ อะไร 

- ความรูเบื้องตนเก่ียวกับสังคมศาสตร 

- วิธีการหาความรู 

2. ประเภทการวิจัยดานสังคมศาสตร 

- การจัดประเภทงานวิจัย 

- หลักเกณฑการจัดประเภทงานวิจัย 

3. กระบวนการวิจัยดานสังคมศาสตร 

- การออกแบบการวิจัย 

- การวิจัยเชิงปริมาณและเชิงคุณภาพ 

- การวิจัยเชิงผสมผสาน 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/llRnMG-zDec 

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง ทําแบบฝกหัด แลกเปลี่ยนความ

คิดเห็น สรุป และทบทวนจากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรมสอนออนไลน (สอน

แบบออนไลน) เครื่องฉาย (สอนในชั้นเรียน) 

หองเรียนเสมือนจริง และคลิปวีดีโอ 

5.1 - 5.2 2.2, 3.3, 6.2 

https://youtu.be/llRnMG-zDec


ฉ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 
การวิจัยเชิงปริมาณ 

1. ความรูเบื้องตนเก่ียวกับการวิจัยเชิงปริมาณ 

- ความเปนมาของการวิจัยเชิงปริมาณดานสังคมศาสตร 

- ประเภทของการวิจัยเชิงปริมาณ 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/r8iu2FvFQZ8 

 
2. ทฤษฎ ี

- ทฤษฎี คือ อะไร 

- ประเภทของทฤษฎี 

- การเลือกใชทฤษีในการวิจัย 

3. สมมุติฐาน 

https://youtu.be/r8iu2FvFQZ8


แ ผ น ก า ร ส อ น | ช 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

- สมมติฐาน คือ อะไร 

- ประเภทของสมมติฐาน 

4. ตัวแปร 

- ตัวแปร คือ อะไร 

- ประเภทตัวแปร 

- ระดับการวัดของตัวแปร 

5. ความสัมพันธระหวางสมมุติฐานกับตัวแปร 

- ความสัมพันธเชิงสาเหตุ 

- ความสัมพันธเชิงสาเหตุในทิศทางตรงกันขาม 

- ความสัมพันธเชิงหลายสาเหตุ 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/vqAFwuagnG4 

 

https://youtu.be/vqAFwuagnG4


ซ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

2 

สถิติสําหรับการวิจัย 

1. สถิติ 

- ความหมายของสถิติ 

- ประเภทของสถิติ 

2. ความสัมพันธระหวางขอมูลกับสถิติ 

- ขอมูลกับสถิติเชิงพรรณนา 

- ขอมูลกับสถิติเชิงอางอิง 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/eWah0ra_Ik4 

 
3. การทดสอบสมมติฐาน 

- ประเภทการทดสอบสมมติฐาน 

- กฎเชิงประจักษ 

- การยอมรับและปฏิเสธสมมติฐาน 

4. ความคลาดเคลื่อนของผลการวิจัย 

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง ทําแบบฝกหัด แลกเปลี่ยนความ

คิดเห็น สรุป และทบทวนจากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรมสอนออนไลน (สอน

แบบออนไลน) เครื่องฉาย (สอนในชั้นเรียน) 

หองเรียนเสมือนจริง และคลิปวีดีโอ 

5.3 - 5.4 
2.2, 3.3, 5.2, 

6.2 

https://youtu.be/eWah0ra_Ik4


แ ผ น ก า ร ส อ น | ฌ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

- ประเภทของความคลาดเคลื่อนของผลการวิจัย 

- ปจจัยท่ีมีผลตอความคลาดเคลื่อนของผลการวิจัย 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/ciRwt0p2fKQ 

 
แบบสอบถามและขอมูล 

1. ความสัมพันธระหวางแบบสอบถามกับแฟมขอมูล 

- คําถามแบบปลายปด 

- คําถามแบบปลายเปด 

- คําถามแบบเลือกตอบ 

- คําถามแบบประเมินคา 

- คําถามแบบหลายคําตอบ 

- คําถามแบบจัดอันดับ 

- คําถามแบบเปรียบเทียบ 

- คําถามแบบถูกผิด 

https://youtu.be/ciRwt0p2fKQ


ญ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

2. การสรางตัวแปร 

- ชื่อตัวแปร 

- ประเภทตัวแปร 

- จํานวนคาตัวแปร 

- คําอธิบายตัวแปร 

- คําอธิบายคาตัวแปร 

- คาขาดหาย 

- ความกวางของชองคาตัวแปรหรือสดมภ 

- การจัดตําแหนงคาตัวแปร 

- ระดับการวัด 

- บทบาทของตัวแปร 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/s5AygVwHwOE 

 

https://youtu.be/s5AygVwHwOE


แ ผ น ก า ร ส อ น | ฎ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

3-4 

ความรูเบ้ืองตนเกี่ยวกับโปรแกรมทางสถิติ 

1. โปรแกรมสําเร็จรูปทางสถิติ 

- โปรแกรมเชิงพาณิชย 

- โปรแกรมแบบสาธารณะท่ัวไป 

2. การติดตั้งโปรแกรม PSPP 

- การคนหาและดาวนโหลด 

- วิธีการติดตั้ง 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/LLjl4-HiWRY 

 
3. การใชโปรแกรม PSPP เบื้องตน 

- การเปดโปรแกรม 

- การเปดแฟมขอมูล 

- การปดโปรแกรม 

4. สวนประกอบของโปรแกรม PSPP 

8 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง แนะนําการติดตั้งและการใช

โปรแกรม ฝกปฏิบัติ ทําแบบฝกหัด 

แลกเปลี่ยนความคิดเห็น สรุป และทบทวน

จากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรม PSPP โปรแกรม

สอนออนไลน (สอนแบบออนไลน) เครื่อง

ฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง 

และคลิปวีดีโอ 

5.5 3.3, 5.2 

https://youtu.be/LLjl4-HiWRY


ฏ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

- ระบบจัดการขอมูล 

- ระบบแสดงผลลัพธ 

- ระบบคําสั่งแบบขอความ 

5. เมนูการใชโปรแกรม PSPP 

- เมนูแบบรายการคําสั่ง 

- เมนูแบบปุมภาพ 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/vEFc3h9HH-0 

 

5 

การนําขอมูลเขาโปรแกรม 

1. การนําขอมูลเขาจากแบบสอบถาม 

- การสรางแฟมขอมูล 

- การนําขอมูลเขาโปรแกรมแบบกรอกขอมูล 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/bys0Njk-xBY 

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง สํารวจขอมูลในชั้นเรียน ฝกปฏิบัติ 

ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป 

และทบทวนจากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรม PSPP โปรแกรม

5.6 - 5.7 
2.2, 3.3, 4.2, 

5.2, 6.2 

https://youtu.be/vEFc3h9HH-0
https://youtu.be/bys0Njk-xBY


แ ผ น ก า ร ส อ น | ฐ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 
2. การนําขอมูลเขาจากแฟมขอมูล 

- แฟมขอมูลแบบตัวอักษร 

- แฟมขอมูลจากโปรแกรมตารางคํานวณ 

เนื้อหา (คลิปวีดีโอ) 

การเตรียมขอมูลและนําขอมูลจาก Google Form  

เขาโปรแกรม PSPP ตอนท่ี 1 

https://youtu.be/niDBdH23018 

 
การเตรียมขอมูลและนําขอมูลจาก Google Form  

เขาโปรแกรม PSPP ตอนท่ี 2 

https://youtu.be/lHfz6YYqIME 

สอนออนไลน (สอนแบบออนไลน) เครื่อง

ฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง 

และคลิปวีดีโอ 

https://youtu.be/niDBdH23018
https://youtu.be/lHfz6YYqIME


ฑ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 
การแสดงผลขอมูล 

https://youtu.be/OGWUdani90s 

 
การจัดการขอมูล 

1. การปรับขอมูล 

- การจัดเรียงขอมูล  

- การไขวตัวแปร  

- การรวมขอมูล  

- การแบงขอมูล  

- การเลือกขอมูล  

- การกําหนดน้ําหนักขอมูล 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/OGWUdani90s


แ ผ น ก า ร ส อ น | ฒ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

https://youtu.be/72G1F3ktV1M 

 
2. การเปลี่ยนรูปแบบขอมูล 

- การเปลี่ยนคาของตัวแปร  

- การสรางตัวแปรใหม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/h6viojhHJMA 

 

6 

การวิเคราะหเครื่องมือการวิจัย 

1. การวิเคราะหความถูกตอง 

- การวิเคราะหความเท่ียงตรงดวยดัชนีความสอดคลอง 

  ระหวางขอคําถาม-วัตถุประสงคของการวิจัย 

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด 

แลกเปลี่ยนความคิดเห็น สรุป และทบทวน

จากคลิปวีดีโอ 

5.8 - 5.9 
2.2, 3.3, 5.2, 

6.2 

https://youtu.be/72G1F3ktV1M
https://youtu.be/h6viojhHJMA


ณ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

- การวิเคราะหความเท่ียงตรงดวยคาความเห็นสอดคลองกัน 

2. การวิเคราะหความนาเชื่อถือ 

- การวัดความสอดคลองภายใน 

- การวัดความสอดคลองภายนอก 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/jd4qg0wQWD8 

 
การวิเคราะหขอมูลเชิงสํารวจ 

1. การตรวจสอบความถูกตองและความสมบูรณของขอมูล 

- การตรวจสอบการออกแบบขอมูล 

- การตรวจสอบความถูกตองของขอมูล 

- การตรวจสอบคาสูญหาย 

- การตรวจสอบคาผิดปกติและคาตางสุด 

2. การตรวจสอบขอมูลตามขอตกลงเบื้องตน 

- การแจกแจงปกติ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรม PSPP โปรแกรม

สอนออนไลน (สอนแบบออนไลน) เครื่อง

ฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง 

และคลิปวีดีโอ 

https://youtu.be/jd4qg0wQWD8


แ ผ น ก า ร ส อ น | ด 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

- ความเทากันของความแปรปรวน 

- ความเปนเสนตรง 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/u_w42ZjBlWQ 

 

7-8 

การวิเคราะหขอมูลดวยสถิติเชิงพรรณนา 

การวิเคราะหขอมูลเชิงพรรณนา 1 ตัวแปร 

1. การวิเคราะหขอมูลแบบคาจัดประเภท 

- การวิเคราะหขอมูลดวยคารอยละ 

- การวิเคราะหขอมูลดวยคาฐานนิยม 

2. การวิเคราะหตัวแปรแบบคาตอเนื่อง 

- การวิเคราะหขอมูลดวยคาเฉลี่ย (รายตัวแปร) 

- การวิเคราะหขอมูลคาเฉลี่ย (ตัวแปรดัชนี) 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/PO54ND3j7yA 

8 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด 

แลกเปลี่ยนความคิดเห็น สรุป และทบทวน

จากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรม PSPP โปรแกรม

สอนออนไลน (สอนแบบออนไลน) เครื่อง

ฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง 

และคลิปวีดีโอ 

5.10 
2.2, 3.3, 5.2, 

6.2 

https://youtu.be/u_w42ZjBlWQ
https://youtu.be/PO54ND3j7yA


ต | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 
การวิเคราะหขอมูลเชิงพรรณนา 2 ตัวแปร 

1. การวิเคราะหขอมูลระหวางตัวแปรแบบคาแบงประเภท 

- การวิเคราะหการเปรียบเทียบขอมูลระหวางตัวแปรแบบ 

  คาจัดประเภท 2 ตัวแปร 

- การวิเคราะหเปรียบเทียบขอมูลระหวางตัวแปรแบบคา 

  แบงประเภท 2 ตัวแปร โดยมีตัวแปรคุม 

2. การวิเคราะหขอมูลระหวางตัวแปรแบบคาแบงประเภทกับตัวแปร

แบบคาตอเนื่อง 

- การวิเคราะหเปรียบเทียบคาเฉลี่ย 2 กลุม 

- การวิเคราะหเปรียบเทียบคาเฉลี่ยมากกวา 2 กลุม 

- การวิเคราะหเปรียบเทียบคาเฉลี่ยโดยมีตัวแปรคุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/V8EEhN5D6Qs 

https://youtu.be/V8EEhN5D6Qs


แ ผ น ก า ร ส อ น | ถ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 

9 สอบกลางภาค 3 สอบ 5.3 – 5.4 
1.5, 2.2, 3.3, 

5.2, 6.2 

10-12 

การวิเคราะหขอมูลดวยสถิติเชิงอางอิง 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/3FeU-W4JlO8 

 
การทดสอบขอมูลแบบอิงคาพารามิเตอร 

1. การทดสอบคาเฉลี่ย 1 กลุมตัวอยาง 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/jl_XMFYKzDE 

12 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด 

แลกเปลี่ยนความคิดเห็น สรุป และทบทวน

จากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรม PSPP โปรแกรม

สอนออนไลน (สอนแบบออนไลน) เครื่อง

ฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง 

และคลิปวีดีโอ 

5.11 
2.2, 3.3, 5.2, 

6.2 

https://youtu.be/3FeU-W4JlO8
https://youtu.be/jl_XMFYKzDE


ท | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 
2. การเปรียบคาเฉลี่ยของกลุมตัวอยางท่ีไมเปนอิสระจากกัน 2 กลุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/kIdzyXUZYC8 

 
3. การเปรียบเทียบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 

กลุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/jIdHUt7jKrc 

 

https://youtu.be/kIdzyXUZYC8
https://youtu.be/jIdHUt7jKrc


แ ผ น ก า ร ส อ น | ธ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

4. การเปรียบเทียบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกัน

มากกวา 2 กลุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/7gckCBMMDQ4 

 
5. การทดสอบความสัมพันธรายคูแบบเพียรสัน 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/BCzr6p2bpCY 

 
6. สรุป 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/zFL60KFXAwA 

https://youtu.be/7gckCBMMDQ4
https://youtu.be/BCzr6p2bpCY
https://youtu.be/zFL60KFXAwA


น | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 

13 

การทดสอบขอมูลแบบไมอิงคาพารามิเตอร 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/5jS6NAIfHKw 

 
การทดสอบขอมูลแบบไมอิงคาพารามิเตอร (1 ตัวแปร) 

1. การทดสอบการแจกแจงของขอมูล 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/2e7SUpLxRVU 

 

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด 

แลกเปลี่ยนความคิดเห็น สรุป และทบทวน

จากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรม PSPP โปรแกรม

สอนออนไลน (สอนแบบออนไลน) เครื่อง

ฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง 

และคลิปวีดีโอ 

5.11 
2.2, 3.3, 5.2, 

6.2 

https://youtu.be/5jS6NAIfHKw
https://youtu.be/2e7SUpLxRVU


แ ผ น ก า ร ส อ น | บ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

2. การทดสอบสัดสวนของกลุมตัวอยางแบบทวินาม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/yIl-xoDd7yc 

 

14-16 

การทดสอบขอมูลแบบไมอิงคาพารามิเตอร (2 ตัวแปร) 

1. การทดสอบความแนบสนิทแบบไค-สแควร 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/3wwhwc-gjCY 

 
2. การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/4bAgtu8EJEU 

12 

1. วิธีการสอน:- บรรยาย อธบิาย แสดง

ตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด 

แลกเปลี่ยนความคิดเห็น สรุป และทบทวน

จากคลิปวีดีโอ 

2. สื่อ:- เอกสารคําสอน ภาพเลื่อน 

คอมพิวเตอร โปรแกรม PSPP โปรแกรม

สอนออนไลน (สอนแบบออนไลน) เครื่อง

ฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง 

และคลิปวีดีโอ 

5.11 
2.2, 3.3, 5.2, 

6.2 

https://youtu.be/yIl-xoDd7yc
https://youtu.be/3wwhwc-gjCY
https://youtu.be/4bAgtu8EJEU


ป | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 
3. การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 

2 กลุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/bPiqc3QLWrM 

 
4. การทดสอบคากลางของกลุมตัวอยางท่ีมีความสัมพันธกัน 2 กลุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/rg2CWlxbtCE 

 

https://youtu.be/bPiqc3QLWrM
https://youtu.be/rg2CWlxbtCE


แ ผ น ก า ร ส อ น | ผ 

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

5. การทดสอบคากลางของกลุมตัวอยางท่ีมีความสัมพันธกัน 2 กลุม 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/nx9sq6MvdEY 

 
6. การทดสอบความสัมพันธรายคูแบบสเปยรแมน 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/gmN7YxcjyhQ 

 
7. สรุป 

เนื้อหา (คลิปวีดีโอ) 

https://youtu.be/ShlhxBNRpY0 

https://youtu.be/nx9sq6MvdEY
https://youtu.be/gmN7YxcjyhQ
https://youtu.be/ShlhxBNRpY0


ฝ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สัปดาหท่ี หัวขอ/รายละเอียด 
จํานวน 

(ช่ัวโมง) 
วิธีการสอน/สื่อ 

วัตถุประสงค

ของรายวิชา 
ผลการเรียนรู 

 

17 สอบปลายภาค 3 สอบ 5.10 - 5.11 
1.5, 2.2, 3.3, 

5.2, 6.2 

8. การวัดผลและการประเมินผล 

    8.1 การวัดผล 

ลําดับ 
ผลลัพธการเรียนรูของรายวิชา  

(Course Learning Outcomes: CLO) 
วัตถุประสงค วิธีการวัด สัดสวน ชวงเวลา 

1 มีจรรยาบรรณทางวิชาการหรือวิชาชีพ 

3. ผูเรียนเขาใจและเลือกใชสถิติแตละ

ประเภทในการวิเคราะหและทดสอบ

ขอมูลไดถูกตองและเหมาะสม 

- สังเกตความสนใจและการถาม

ปญหาจากการฝกปฏิบัติ  

- การฝกปฏิบัติ การทํา

แบบฝกหัด และสอบระหวางภาค 

รอยละ 

20 

สัปดาหท่ี  

2, 9 

2 สามารถประยุกตความรูจากทฤษฎีสูการปฏิบัติ 
1. ผูเรียนเขาใจเก่ียวกับการหาความรู

ดานสังคมศาสตร รวมถึงสาขาวิชา

สังคมวิทยา 

- สังเกตความสนใจและการถาม

ปญหาจากการฝกปฏิบัติ  

รอยละ 

30 

สัปดาหท่ี  

1, 2, 5 



แ ผ น ก า ร ส อ น | พ 

ลําดับ 
ผลลัพธการเรียนรูของรายวิชา  

(Course Learning Outcomes: CLO) 
วัตถุประสงค วิธีการวัด สัดสวน ชวงเวลา 

2. ผูเรียนเขาใจวิธีการวิจัยเชิงปริมาณ

ท่ีเกิดจากความสัมพันธระหวางทฤษฎี 

สมมติฐาน และตัวแปร 

4. ผูเรียนสามารถแปลงขอมูลจาก

แบบสอบถามไปเปนแฟมขอมูลได 

- การฝกปฏิบัติ และการทํา

แบบฝกหัด 

3 สามารถคิดวิเคราะหอยางเปนระบบ 

7. ผูเรียนสามารถเลือกใชขอมูลและ

เปลี่ยนรูปแบบขอมูลใหตรงกับ

วัตถุประสงคของการวิเคราะหขอมูล 

8. ผูเรียนสามารถวิเคราะหคุณภาพ

ของเครื่องมือการวิจัยได 

9. ผูเรียนสามารถตรวจสอบความ

ถูกตองและความสมบูรณของขอมูล 

รวมถึงตรวจสอบลักษณะของขอมูล

ตามขอตกลงเบื้องตนของสถิติ 

- สังเกตความสนใจและการถาม

ปญหาจากการฝกปฏิบัติ  

- การฝกปฏิบัติ และการทํา

แบบฝกหัด 

รอยละ 

30 

สัปดาหท่ี  

1-17 

4 มีภาวะผูนํา และสามารถทํางานเปนทีม 6. ผูเรียนสามารถนําขอมูลจาก

แบบสอบถามกรอกเขาโปรแกรม และ

- สังเกตความสนใจและการถาม

ปญหาจากการฝกปฏิบัติ  

รอยละ 

5 

สัปดาหท่ี  

5 



ฟ | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

ลําดับ 
ผลลัพธการเรียนรูของรายวิชา  

(Course Learning Outcomes: CLO) 
วัตถุประสงค วิธีการวัด สัดสวน ชวงเวลา 

นําขอมูลท่ีเก็บอยูในรูปของแฟมขอมูล

เขาโปรแกรม 

- การฝกปฏิบัติ การทํา

แบบฝกหัด และการแลกเปลี่ยน

ความคิดเห็น 

5 สามารถใชภาษาในการสื่อสารอยางมีประสิทธิภาพ 

10. ผูเรียนสามารถใชโปรแกรม

ประมวลผลการแจกแจงขอมูลของตัว

แปร 1 ตัวแปร และ 2 ตัวแปร ดวย

สถิตเิชิงพรรณนาและเขียนบรรยายผล

การวิเคราะหได 

11. ผูเรียนสามารถใชโปรแกรม

ประมวลผลทดสอบขอมูลของตัวแปร 

1 ตัวแปร และ 2 ตัวแปร ดวยสถิติเชิง

อางอิงและเขียนบรรยายผลการ

ทดสอบได 

- สังเกตความสนใจและการถาม

ปญหาจากการฝกปฏิบัติ  

- การฝกปฏิบัติ การทํา

แบบฝกหัด และสอบปลายภาค 

รอยละ 

10 

สัปดาหท่ี  

7, 8, 10-17 

6 

มีทักษะในการศึกษาและวิเคราะหสถานการณ

ชุมชน/ องคกรดวยเครื่องมือทางการจัดการบริการ

สังคม 

5. ผูเรียนรูจักโปรแกรมคอมพิวเตอร

ดานสถิติสําหรับวิเคราะหขอมูล 

สามารถติดตั้งและเริ่มใชงานเบื้องตน

ได 

- สังเกตความสนใจและการถาม

ปญหาจากการฝกปฏิบัติ  

- การฝกปฏิบัติ และการทํา

แบบฝกหัด 

รอยละ 

5 
สัปดาหท่ี 3-4 
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8.2 การประเมินผลการเรียนรู 

วิธีการประเมิน สัปดาหท่ีประเมิน   สัดสวนของการประเมิน 

จิตพิสัย (เวลาเรียน+ความสุภาพเรียบรอย) 1-16 15 

การฝกปฏิบัติและทําแบบฝกหัดทายบท           1-16 20 

สอบระหวางภาค 9 25 

สอบปลายภาค 17 40 

  8.2 ระดับคะแนน พิจารณาตามความเหมาะสม ดังนี้ 

       8.2.1 อิงเกณฑ ตามระดับคะแนนดังนี้ 

ระดับคะแนน ผลการเรียน 

80 – 100 A 

75 – 79 B+ 

70 – 74 B 

65 – 69 C+ 

60 – 64 C 

55 – 59 D+ 

50 – 54 D 

0 – 49 F 

       8.2.2 หรืออิงกลุม แบบ T-score หรือ MEAN-SD 



แ ผ น ก า ร ส อ น | ม 

 

   9. ทรัพยากรประกอบการเรียนการสอน 

   9.1 ตําราและเอกสารหลัก 

    เรวัต แสงสุริยงค. (2565). เอกสารคําสอน การใชโปรแกรมคอมพิวเตอรทางสถิติในดานสังคมศาสตร.  

ภาควิชาสังคมวิทยา คณะมนุษยศาสตรและสังคมศาสตร มหาวิทยาลัยบูรพา. 

http://socio.buu.ac.th/rewat 

Rewat Sangsuriyong. ASPSS [Video]. YouTube. 

https://youtube.com/playlist?list=PLvrcBRhaFrvOKMXwI0Yonle9WWJPd2lOE 

   9.2 ตําราและเอกสารแนะนํา 

วรภูริ มูลสิน (2555). หลักการวิจัยและวิเคราะหขอมูลทางสถิติดวย PSPP. เขาถึงไดจาก 

http://www.edu.ru.ac.th/coved/pdf/PSPP/คูมือ_pspp-book-2555.pdf 

GNU. (2019). PSPP Users’ Guide. Retrieved from  

https://www.gnu.org/software/pspp/manual/pspp.pdf 

GNU. (2020). PSPP. Retrieved from  

https://www.gnu.org/software/pspp/manual/pspp.html#Introduction 

Halter, C. P. (2017). The PSPP Guide: An Introduction to Statistical Analysis. 2nd ed.  

CreativeMinds Press Group.
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สวนท่ี 1 

ความรูเบื้องตนเก่ียวกับการวิจัยเชิงปริมาณ

ดานสังคมศาสตร 

  





 

 

บทที่ 1 

การวิจัยดานสังคมศาสตร 

ความมุงหมายของบทเรียน 

เพ่ือใหผูเรียนเขาใจเก่ียวกับการหาความรูดานสังคมศาสตร รวมถึงสาขาวิชาสังคมวิทยา 

เน้ือหา 

1. การหาความรูดานสังคมศาสตร 

2. ประเภทการวิจัยดานสังคมศาสตร 

3. ข้ันตอนการวิจัยดานสังคมศาสตร 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และทบทวนจาก

คลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรมสอนออนไลน (สอนแบบออนไลน) เครือ่งฉาย 

(สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และการทํา

แบบฝกหัดทายบท 
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เนื้อหา 

การตอบคําถามท่ีเกิดจากขอสงสัยของมนุษยมีการพัฒนาการควบคูไปกับวิวัฒนาการของสังคม

มนุษยอยางตอเนื่อง  กลาวคือ เริ่มจากการตอบขอสงสัยดวยความเชื่อ/ความศรัทธา  (fictitious stage) 

ตอมามีการพัฒนามาเปนการตอบขอสงสัยดวยหลักเหตุผล (metaphysical stage) และท่ีไดรับการ

ยอมรับอยางแพรหลายในปจจุบันก็คือ การตอบปญหาหรือขอสงสัยตาง ๆ ดวยหลักวิทยาศาสตร 

(positive stage) มีการต้ังสมมุติฐาน (hypothesis) เก็บรวบรวมขอมูลมาทําวิเคราะหวาจะยอมรับ 

(accept) หรือปฏิเสธ (reject) ขอสมมุติฐาน 

1. การหาความรูดานสงัคมศาสตร 

การคนหาความรูท่ีไมใชวิธีการท่ีเปนกระบวนการทางวิทยาศาสตร (nonscientific method) 

เชน การพยากรณโดยเทพ (oracles) การเขาฌาน (mysticism) การบอกเลาโดยผูวิเศษ (magic) การ

ทํานายดวยโหราศาสตร (astrology) คําผีบอก (spirit) มิใชไมมีอยู แตเปนวิธีการหาความรูท่ีอยูนอก

ขอบเขตการหาความรูท่ีเรียกวา “ศาสตร” และไดรับการยอมรับจากคนในสังคมสมัยใหมนอยมาก 

(Neuman, 2014, p. 8) 

1.1 ศาสตร คือ อะไร 

คําวา “science” หรือ “ศาสตร” หมายถึง แบบแผนทางสังคม (social institution) และ

กระบวนการหาความรู (produce knowledge) ประเภทหนึ่ง  อันเปนประดิษฐกรรม (invention)  ท่ี

เกิดมาจากการเปลี่ยนแปลงทางความคิดของมนุษย ในยุคเหตุผล (age of reason) หรือยุคแสงสวางทาง

ปญญา (enlightenment period) ของประวัติศาสตรยุโรปตะวันตกในชวงปลาย ค.ศ. 1600 ถึงกอน

ปลาย ค.ศ. 1800 ท่ี ใหความสํา คัญกับการคิดหาเหตุผลเชิงตรรกศาสตร  (logical reasoning) 

ประสบการณ (experience) ในโลกของวัตถุ (material world) ความเชื่อ (belief) ในความกาวหนาของ

มนุษย (human progress) และการทาทายดวยการตั้งคําถามเก่ียวกับอํานาจของศาสนาท่ีมีมาแตโบราณ 

(Neuman, 2014, p. 7-8) การหาความรูท่ีเปนศาสตร มีจุดเนนท่ีสําคัญ 2 สวน ดังนี้ (Punch, 2005, p. 

8-9) 
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1. ดานขอมูล ใหความสําคัญกับขอมูลจากโลกความจริง (real-world data) ขอมูลเชิงประจักษ 

(empirical data) และความคิดท่ีสามารถนําไปใชทดสอบไดดวยขอมูล 

2. ดานทฤษฎี ท่ีถือไดวาเปนหัวใจของศาสตร การใชทฤษีในการอธิบาย (explain) ขอมูลท่ี

รวบรวมมาแลวตองอธิบาย ไมใชรวบรวมขอมูลมาแลวแตไมใชขอมูลอธิบายสิ่งตางๆ 

ดังนั้น “ศาสตร” จึงเปนการรวบรวมขอมูลท่ีเก่ียวกับโลก เพ่ือสรางทฤษฎี (build theories) 

สําหรับใชอธิบายขอมูล และทดสอบทฤษฎดีวยขอมูล   

คนสวนใหญเม่ือไดยินคําวา “science” มักจะนึกถึงภาพและเขาใจวาเปนเรื่องของการทดลอง

ในหองปฏิบัติการคอมพิวเตอร  การสงกระสวยอวกาศไปในจักรวาล และคนท่ีใสเสื้อคลุมสีขาวทํางานอยู

ในหองทดลอง ซ่ึงในความเปนจริงแลวก็ไมใชเรื่องท่ีผิด เพียงแตวา ภาพและความเขาใจดังกลาวนั้นเปน

เพียงสวนหนึ่งของการคนหาความรูท่ีมีพ้ืนฐานมาจากวิทยาศาสตรธรรมชาติเทานั้นเอง (Neuman, 

2014, p. 7)  

ปจจุบันวิธีการหาความรูหรือท่ีเรียกวา ศาสตร (science) แบงออกไดเปน 2 ศาสตรใหญ ๆ คือ 

วิทยาศาสตรธรรมชาติ (natural sciences) และสังคมศาสตร (science: social) ความจริงแลวท้ัง 2 

ศาสตรเปนท้ังเพ่ือนรักและคูแขงกันมาอยางตอเนื่อง มีท้ังคนหาความรูท่ีคาบเก่ียวกัน หยิบยืมวิธีการหา

ความรู (methodology) มาใชงานรวมกัน และโตแยง/คัดคาน/ปฏิเสธความรูระหวางกันอยูเสมอ 

1.2 ความรูเบื้องตนเกี่ยวกับสังคมศาสตร 

สังคมศาสตร สามารถมองไดหลายมิติ กลาวคือ เปนสาขาวิชาท่ีมีขอบขายกวาง เนื่องจากเปน

การศึกษาเก่ียวกับสังคมของมนุษย (human society) ครอบคลุมตั้งแตการศึกษาปจเจกบุคคล 

( individual) เชน จิตวิทยาสังคม (social psychology) จนถึงการศึกษาธรรมชาติ (nature) เชน 

ชีววิทยาเชิงสังคม (social biology) และภูมิศาสตรทางสังคม (social geography) มีระเบียบวิธีการท่ีใช

ในการศึกษา (methodologically) หาความรูท้ังแบบการวิเคราะหจากมุมมองท่ีควรจะเปน (normative 

approaches) เชน กฎหมาย (law) ปรัชญาสังคมศาสตร  (social philosophy) ทฤษฎีการเมือง 

(political theory) และการศึกษาดวยหลักฐานทางประวัติศาสตร (historical approaches) เชน 

ประวัติศาสตรทางสังคม (social history) และประวัติศาสตรทางเศรษฐกิจ (economic history)  และก็

มีบอยครั้งท่ี สังคมศาสตร หมายถึง สังคมวิทยา (sociology) หรือ การวิเคราะหทฤษฎีสังคม (synthetic 
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social theory) เ ท า นั้ น  ( Kuper and Kuper, 2003) ซ่ึ ง ก็ ส อ ด ค ล อ ง กั บ พ จ น า นุ ก ร ม ฉ บั บ

ราชบัณฑิตยสถาน พ.ศ.  2525 (ราชบัณฑิตยสถาน,  2539, น . 817) ท่ี ได ใหความหมายของ 

“สังคมศาสตร” วา เปนศาสตรวาดวยความรูเก่ียวกับสังคม มีหมวดใหญ ๆ เชน ประวัติศาสตร (เก่ียวกับ

สังคม) มานุษยวิทยา สังคมวิทยา เศรษฐศาสตร รัฐศาสตร จิตวิทยาสังคม 

การศึกษาดานสังคมศาสตรมีมาตั้งแตโบราณ แตแนวคิดการศึกษาทางดานสังคมศาสตรสมัยใหม 

(modern social sciences) ท่ีใชวิธีการท่ีเปนวิทยาศาสตร (scientific method) ไดเริ่มข้ึนในยุครุงเรือง

ทางความคิด (enlightenment) ในศตวรรษท่ี 18 โดยเริ่มตนในสาขาวิชาเศรษฐศาสตร ตอมาในศตวรรษ

ท่ี 19 ไดแยกแนวคิดออกไปพัฒนาในสาขาวิชามานุษยวิทยา รัฐศาสตร จิตวิทยา และสังคมวิทยา ใน

ลักษณะของทฤษฎีระดับกวาง (wide-ranging theories) เชนงานของ ออกุสต กองต  (Auguste 

Comte)  คารล มารกซ (Karl Marx) และเฮอรเบิรต สเปนเซอร (Herbert Spencer) และในศตวรรษท่ี 

20 ได มีการพัฒนาไปสูการนําเอาวิธี เชิงปริมาณ (quantitative method) และเทคนิคเชิ งสถิ ติ  

(statistical techniques) และรวมถึงวิธีเชิงประจักษ (empirical method)1 มาใชมากข้ึน 

อยางไรก็ตามตั้งแตทศวรรษท่ี 1960 เปนตนมา วิธีการเชิงปริมาณท่ีเปนการวิจัยเชิงประจักษท่ี

ครอบงําอยูในการวิจัยดานสังคมศาสตรก็เริ่มถูกโจมตีถึงความไมเหมาะสมในการนําเอามาใชกับการวิจัย

ดานสังคมศาสตร และเริ่มมีนักสังคมศาสตรใหความสนใจในการนําเอาวิธีการเชิงคุณภาพ (qualitative 

methods) มาใชในการหาความรูดานสังคมศาสตรมากข้ึน เกิดการแบงสาขาการวิจัยดานสังคมศาสตร

เปน 2 กลุม คือ กลุมนักวิจัยเชิงปริมาณและกลุมนักวิจัยเชิงคุณภาพ แตการโตแยงระหวาง 2 กลุมอยาง

ยังคงมีอยางตอเนื่องหรือท่ีเรียกวา “สงครามแหงกระบวนทัศน (paradigm wars)” ในทฤษฎีการหา

ความรูอยางตอเนื่อง บางกลุมคิดวาวิธีเชิงคุณภาพและตองใชการรวมรูสึกหรือการเขาใจความรูสึกของ

ผูอ่ืน (emphatic) เทานั้นท่ีเหมาะกับการศึกษาพฤติกรรมมนุษย แตปจจุบันการโตงแยงมีแนวโนมลดลง

                                                           
1 วิธีการที่ทดสอบไดดวยหลักฐานอยางใดอยางหนึ่งที่ไดจากประสบการณมากกวาทฤษี เชน การทดลอง การสังเกต ปจจุบันนัก

สังคมศาสตรสวนใหญมักจะใชวิธีเชิงประจักษ 2 ประเภทดวยกันในการศึกษาหาความรู ดังนี้ 

1. การบรรยาย (descriptive studies) ข้ันแรกของการคนหาความรู ก็คือ การคนหาวาเหตุการณที่เกิดข้ึนนั้นเปนอยางไร เกิดกับ

ใคร ที่ไหน และเมื่อใด 

2. การอธิบาย (explanatory studies) เมื่อไดทําการบรรยายเหตุการณที่เกิดข้ึนแลว นักสังคมวิทยาก็จะอธิบายวาเหตุการณนั้น

เกิดข้ึนไดอยางไร และเกิดข้ึนเพราะอะไร 
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และใหความสนใจในการรวม (combination) ท้ัง 2 วิธีเขาดวยกัน (Punch, 2005, 2) หรือท่ีเรียกวา วิธี

เชิงผสมผสาน (mixed methods) 

โดยท่ัวไปแลว คําวา “สังคมศาสตร (social science)” หมายถึง การศึกษาพฤติกรรมของมนุษย

ดวยกระบวนการทางวิทยาศาสตร ท่ีเกิดมาจากคําวา สังคม (social) คือ ประชาชนและพฤติกรรมของ

ประชาชนท่ีเกิดจากบริบททางสังคม (social context) กับคําวา ศาสตร (science) คือ วิธีการใน

การศึกษาประชาชนและพฤติกรรมของประชาชน เม่ือเปาหมายของศาสตร คือ การสรางทฤษฎีท่ีอธิบาย

เก่ียวกับประชาชนและพฤติกรรมของประชาชน ดังนั้น ทฤษฎีดานสังคมศาสตรจึงวางอยูบนฐานของ

พฤติกรรมของมนุษย และการทดสอบดวยขอมูลจากโลกความจริง (Punch, 2005, p. 8-9) 

สังคมวิทยา (sociology) คือ วิชาท่ีวาดวยการศึกษาสังคมมนุษยและการกระทําระหวางกันทาง

สังคม (social interaction) อยางเปนระบบ (systematic) และเปนการศึกษาท่ีมีลักษณะเปนวัตถุวิสัย 

(objective) แบบวิทยาศาสตร (David Popenoe 1993 , p. 2) สาขาวิชาสังคมวิทยานอกจาเปนวิชาท่ีมี

ความใกลเคียงและสัมพันธกับวิทยาศาสตรธรรมชาติตลอดจนวิธีการท่ีใชในการศึกษาแลว สาขาวิชาสังคม

วิทยายังมีความสัมพันธกับสังคมศาสตรสาขาอ่ืน ๆ อีกดวย โดยในการศึกษาทางสังคมวิทยาจะมองวา

พฤติกรรมของมนุษย คือรูปแบบของพฤติกรรมท่ีถูกกําหนดโดยสังคม และสภาพแวดลอมทางสังคม 

(social circumstance) นักสังคมวิทยาสวนใหญจะอธิบายวา สิ่งท่ีมนุษยกระทําข้ึนในสังคมนั้นจะมี

ผลกระทบตอบุคคลตาง ๆ ดวย ดังนั้นปรากฏการณตาง ๆ ท่ีเกิดข้ึนในสังคมยอมจะมีผลกระทบซ่ึงกัน

และกันและมีผลกระทบตอกันอยางสลับซับซอนดวยกระบวนการกระทําระหวางกันทางสังคม (เรวัต แสง

สุริยงค, 2541)  

มีการกลาววา กลุมวิชาทางสังคมศาสตรใชระเบียบวิธีทางวิทยาศาสตรเพ่ือศึกษาโลกในเรื่องท่ี

เก่ียวของกับมนุษย วิชาในสังคมศาสตรแตกตางจากวิชาในกลุมมนุษยศาสตร เนื่องจากหลาย ๆ สาขาวิชา

ในสังคมศาสตรเนนการหาความรูดวยกระบวนการทางวิทยาศาสตร อยางไรก็ตามหลาย ๆ สาขาก็อาจจะ

เนนระเบียบวิธีเชิงคุณภาพมากกวาก็ได นั่นอาจเพราะมีสาเหตุมาจากท่ีท้ังสังคมศาสตรและวิทยาศาสตร

ธรรมชาติตางก็มีฐานะเปนสวนหนึ่งของปรัชญาวิทยาศาสตร (philosophy of science) ท่ีแยกตัวออกมา

จากปรัชญาความรู (epistemology)2 แตดวยเหตุท่ีความกาวหนาของวิทยาศาสตรธรรมชาติท่ีมีบทบาท

                                                           
2 เปนปรัชญาสาขาหนึ่งท่ีเนนศึกษาเกี่ยวกับลักษณะของความรูและขออางดานหลักการตลอดจนแนวคิดเกี่ยวกับความรูในแงมุมตาง ๆ 

โดยทั่วไป อาทิ ที่มา ฐานคติ สภาพ ขอบเขต และความถูกตอง (อนุสรณ ล่ิมมณี, 2542, p. 5) 

http://th.wikipedia.org/w/index.php?title=%E0%B8%A1%E0%B8%99%E0%B8%B8%E0%B8%A9%E0%B8%A2%E0%B8%A8%E0%B8%B2%E0%B8%AA%E0%B8%95%E0%B8%A3%E0%B9%8C&action=edit
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และครอบงําแนวคิดและวิธีการศึกษาทางวิทยาศาสตรอยางมากและรวมถึงวิธีการศึกษาทางสังคมศาสตร

ดวย จึงทําใหนักคิดทางสังคมศาสตรมีการตอตานวิธีการของวิทยาศาสตรธรรมชาติและพัฒนาวิธี

การศึกษาทางสังคมศาสตรมาใชศึกษาปรากฏการณทางสังคม คือ การวิเคราะหในเชิงตีความ 

(interpretive analysis) อันเปนแนวการศึกษาปรากฏการณทางสังคมท่ีมาจากปรัชญาการตีความ 

(hermeneutics or interpretative philosophy) (อนุสรณ ลิ่มมณี, 2542, น. 4-57) 

1.3 วิธีการหาความรู 

แมวาการหาความรูจะมีการสรางและพัฒนาวิธีการการศึกษาท่ีแตกตางกันไปตามธรรมชาติแต

ละสาขาวิชา แตวิธีการหาความรูท้ังหลายตกอยูภายใต 2 แนวทางดวยกัน ดังนี้ 

1. การใชวิธี เชิงประจักษ  (Empirical method) ซ่ึงเปนวิธี ท่ีนักวิทยาศาสตร  รวมท้ังนัก

สังคมศาสตรนิยมใชกันเปนสวนมาก การหาความรูดวยวิธีเชิงประจักษ เปนการใชการรับรูของมนุษย เชน 

การไดยิน และการไดเห็น หรือท่ีเราเรียกกันวา การสังเกต (observation) 

2. การใชวิธีไมใชเชิงประจักษ (Non-empirical method) มี 2 วิธี ดังนี้ 

      2.1 การใชหลักเหตุผล (Logic) เปนการหาความรูดวยวิธีการใชเหตุผลเพ่ือใหไดมาซ่ึงคําตอบ

นั้น มี 4 วิธี คือ 

2.1.1 หลักนิรนัย/อนุมาน (Deductive) คือ การหาความรูโดยใชขอสรุปท่ัวไปหรือทฤษฎี

อธิบายเรื่องเฉพาะเรื่องใดเรื่องหนึ่ง (ผล) อธิบายปรากฏการณท่ีเกิดข้ึน (เหตุ) โดยผลท่ีเกิดข้ึนนั้นมาจาก

เหตุเดียวเทานั้น 

2.1.2 หลักอุปนัย (Inductive) คือ การหาความรูโดยใชปรากฏการณท่ีเกิดข้ึน (เหตุ) 

อธิบายหรือสรางขอสรุปท่ัวไปหรือทฤษฎี (ผล) แตผลท่ีเกิดข้ึนนั้นไมจําเปนตองเกิดมาจากเหตุเดียว อาจ

เกิดมาจากหลายเหตุดวยกันก็ได 

2.1.3 หลักจารนัย (Abductive) คือ การหาความรูโดยใชหลักการอางถึงปรากฏการณท่ี

เกิดข้ึน (เหตุ) ท่ีเปนสิ่งท่ีใชอธิบายขอสรุปท่ัวไปหรือทฤษฎี (ผล) เปนการใชเหตุผลในทิศทางตรงขามกับ

หลักนิรนัย 

2.1.4 หลักกลนัย (Retroductive) คือ การหาความรูโดยใชหลักเหตุผลเหมือนกับการ

อุปนัย แตการอธิบาย/ทํานายขอสรุปท่ัวไปหรือทฤษฎี (ผล) มีความเก่ียวของกับหลายกฎ (rules) หรือ

หลายสิ่งท่ีไดจากการสังเกต (observations) หรืออาจกลาวไดวา ตัวอธิบาย/ทํานายมีหลายกฎ  
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      2.2 การใชญาณหรือการหยั่งรู (Intuition) คือ การหาความรูท่ีไดจากประสาทสัมผัส เชน 

การเห็น การไดยิน ความรูสึกจากสิ่งตาง ๆ 

อาจกลาวไดวาการหาความรูของมนุษยท่ีกลาวมาวางอยูบนฐานของ 2 ข้ัวระหวางการสังเกต 

(observation) กับการใชเหตุผล (reason) หรือท่ีบางครั้งเราอาจไดยินและไดเห็นในรูปของคําพูดท่ีวา 

ความรูเชิงประจักษ (empirical knowledge) คือ ความรูท่ีไดมาจากการสังเกตและไดฟงเก่ียวกับสิ่งตาง 

ๆ และความรูเชิงเหตุผล (logical/rational knowledge) คือ ความรูท่ีไดมาจากการใหเหตุผลโดยไมได

เห็นหรือไมไดยินมา  

การหาความรูอาจขาดความนาเชื่อถือและไมไดรับการยอมรับ หากเปนการหาความรูท่ีไมไดมา

จากการวิจัย (research) ดวยการคนควาเพ่ือหาขอมูลอยางถ่ีถวนตามหลักวิชา หรือเปนกระบวนการ

คนหาความรูอยางเปนระบบ (systematic process) จากเหตุการณ (events) พฤติกรรม (behaviours) 

ทฤษฎี (theories) และกฎ (laws) ตาง ๆ เพ่ือการคนพบ (discovering) การตีความ (interpreting) และ

แกไขขอเท็จจริง (revising facts) ดังนั้น นักสังคมศาสตร จึงตองใชวิธีการหาความรูดวย “การวิจัย” เพ่ือ

ตอบคําถามหรือขอสงสัยเก่ียวกับสังคมมนุษย และตองเปนคําตอบท่ีนาเชื่อถือและถูกตองแมนยํา (อารง 

สุทธาศาสน และวิภาส ทองสุทธิ์, 2563, น. 11) 

2. ประเภทการวิจัยดานสังคมศาสตร 

สังคมศาสตรมีขอบเขตของการหาความรู ท่ีกวางและมีบริบทท่ีเก่ียวของท่ีซับซอน คือ มี

การศึกษาท้ังเรื่องในอดีต ปจจุบัน อนาคต ธรรมชาติของมนุษย สิ่งท่ีสรางโดยมนุษย และสภาพแวดลอม

ของมนุษย ดังนั้นนักสังคมศาสตร (social scientist) จึงตองใชหลากหลายวิธีการในการอธิบาย 

(describe) คนหา (explore) และทําความเขาใจ (understand) ความเปนอยูของคนในสังคม (social 

life) และเหตุการณตาง ๆ ท่ีเกิดข้ึนในสังคมตามความเหมาะสม จึงทําใหงานวิจัยทางสังคมศาสตรถูก

สรางและพัฒนาข้ึนมาเปนจํานวนมาก แตหากพิจารณาใหดีจะพบวางานวิจัยเหลานั้นมีคุณลักษณะบาง

ประการรวมกันอยู เชน วิธีการใชเหตุผลในการหาความรู การใชองคความรูในการวิจัย ลักษณะของขอมูล

ท่ีเก็บรวบรวม วิธีการออกแบบการวิจัย เปนตน  
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2.1 การจัดประเภทงานวิจัย 

นักวิชาการนําเอาคุณลักษณะของงานวิจัยมาแบงประเภทของงานวิจัยใหเปนหมวดหมู แตก็ไมได

หมายความวานักวิชาการแตละคนจะมีมุมมองท่ีเหมือนกัน จึงเปนสาเหตุท่ีทําใหเราเห็นการจําแนก

หมวดหมูของงานวิจัยท่ีแตกตางกันหลายรูปแบบดังตอไปนี้ (Babbie, 2007, p. 25-26; Neuman, 

2014, p. 24; Punch, 2005, p. 39-41) 

1. การจําแนกตามการใชประโยชนของการวิจัย (Use of research) มี 2 ประเภท ดังนี้ 

   1.1 การวิจัยพ้ืนฐาน (Basic research) เปนการวิจัยเพ่ือพัฒนากรอบแนวคิด ทฤษฎี และองค

ความรูทางสังคมศาสตรเอง เนนการทดสอบทฤษฎีเพ่ือสนับสนุนหรือปฏิเสธทฤษฎี การวิจัยประเภทนี้

อาจเรียกไดวาเปนการวิจัยเชิงยืนยัน (confirmatory research) หรือนักวิชาการบางทานอาจเรียกวา 

การวิจัยทางทฤษฎี (theory research) หรือ การวิจัยบริสุทธ (pure research) คือ การวิจัยท่ีใชองค

ความรูท่ีมีอยูมาทําใหเกิดองคความรูใหมตามมา (knowledge for knowledge’s sake) 

   1.2 การวิจัยประยุกต  (Applied research) หรือการวิจัยทางปฏิบัติการ (practical 

research) เปนการวิจัยเพ่ือตอบปญหาและแกไขปญหาทางสังคม เนนการคนหาความสัมพันธระหวาง

เหตุและผลของปรากฎการณทางสังคมหรือเหตุการณตาง ๆ ท่ีเกิดข้ึนในสังคม การวิจัยประเภทนี้อาจ

เรียกไดวาเปนการวิจัยเชิงสํารวจ (exploratory research) เชน การวิจัยเพ่ือประเมินผลโครงการและ

การใชนโยบายของรัฐและเอกชน การทดลองใชโครงการตาง ๆ ของสังคมกอนท่ีจะนําไปใชจริง การ

คาดคะเนสถานการณทางสังคม การสํารวจความตองการของผูบริโภคเพ่ือประชาสัมพันธและโฆษณาขาย

สินคาตาง ๆ งานวิจัยประเภทนี้มีหลายลักษณะ แตในท่ีนี้จะจําแนกเพ่ือเปนตัวอยางดังนี้ 

1.2.1 การวิจัยประเมินผล (Evaluation research) เปนการวิจัยเก่ียวกับประสิทธิภาพ

และประสิทธิผลในการดําเนินโครงการ นโยบาย และการรณรงคตาง ๆ 

 1.2.2 การวิจัยปฏิบัติการ (Action research) เปนการวิจัยท่ีใหความสําคัญกับการมีสวน

รวมของหนวยวิเคราะห เพราะเชื่อวาการพัฒนาความรูตองมาจากประสบการณของสามัญชนและ

ประชาชนท่ัวไป และสามารถนําไปใชปรับปรุงและแกไขปญหาสถานการณไดเปนอยางดี 

 1.2.3 การวิจัยประเมินผลกระทบทางสังคม (Social impact assessment research) 

เปนการวิจัยท่ีตองการคาดการณผลท่ีอาจเกิดจากการเปลี่ยนแปลงในการดําเนินโครงการ และการเลือก

ดําเนินนโยบายใดนโยบายหนึ่ง 
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2. การจําแนกตามลักษณะการรวบรวมขอมูลและเทคนิคการวิเคราะห (Data collection and 

analysis techniques) สามารถแบงยอยไดเปน 2 ประเภทกวาง ๆ ดังนี้ 

      2.1 การวิจัยเชิงปริมาณ (Quantitative method) เปนวิธีการวิจัยท่ีพยายามจําแนกประเภท

ปรากฏการณทางสังคม แลวทําการรวบรวมและวิ เคราะห (analyze) ดวยขอมูลท่ีเปนตัวเลข 

(numerical data) โดยมุงเนนการหาความเชื่อมโยงท่ีเกิดข้ึนจํานวนเล็ก ๆ นอย ๆ (a smaller number) 

ในบรรดาคุณลักษณะ (attribute) ของสิ่งท่ีทําการศึกษาจากหลายๆ กรณี (many cases) ดังนั้น สิ่งตาง 

ๆ ท่ีทําการศึกษาจึงตองสามารถวัดหรือนับไดเปนตัวเลข มีการออกแบบการวิจัยในรูปแบบตาง ๆ ดังนี้ 

 2.1.1 การวิจัยแบบมีการปฏิสัมพันธกับหนวยวิเคราะห (Reactive research) เปน

วิธีการวิจัยท่ีมีการติดตอกันระหวางนักวิจัยและหนวยวิเคราะหในรูปแบบใดรูปแบบหนึ่ง มี 2 ประเภท 

ดังนี้ 

2.1.1.1 การวิจัยเชิงทดลอง (Experimental research) เปนการออกแบบการวิจัย

ดวยการจําลองหรือสรางสอดแทรก (Intervention) หรือเลือกหนวยวิเคราะหในหองปฏิบัติการหรือชีวิต

จริงท่ีมีสภาพแวดลอมท่ีแตกตางกันมาทําการศึกษาเปรียบเทียบความแตกตางท่ีเกิดข้ึนระหวางกลุมตาง 

ๆ 

  2.1.1.2 การวิจัยเชิงสํารวจ (Survey research) เปนการออกแบบการวิจัยโดยใช

แบบสอบถาม (questionnaires) หรือการสัมภาษณ ( interviews) ในการคนหาคําตอบจากหนวย

วิเคราะหจํานวนมาก ๆ ดวยวิธีการสุมตัวอยาง (sampling) 

2.1.2 การวิจัยแบบไมมีการปฏิสัมพันธกับหนวยวิเคราะห (Nonreactive research) เปน

วิธีการวิจัยท่ีมีการนําเอาขอมูลของผูท่ีมีสวนรวมหรือหนวยวิเคราะหมาใชโดยท่ีเขาไมรูวาขอมูลถูกนําไปใน

การวิจัย มี 2 ประเภท ดังนี้ 

    2.1.2.1 การวิเคราะหเนื้อหา (Content analysis) เปนการใชวิธีการวิเคราะหขอมูล

จากเนื้อหาหรือสารสนเทศท่ีมีการจัดเก็บไวแลว เชน หนังสือ บทเพลง วรรณกรรม ภาพยนตร ภาพถาย 

โฆษณา 

    2.1.2.2 การใชสถิติท่ีมีอยูแลว (Existing statistics) เปนการใชขอมูลท่ีมีการเก็บ

รวบรวมไวแลว ท้ังจากงานวิจัยท่ีทําไวแลวหรือขอมูลจากหนวยงานภาครัฐและเอกชน เชน รายได อายุ 

การศึกษา 
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     2.2 การวิจัยเชิงคุณภาพ (Qualitative method) เปนวิธีวิจัยท่ีใหความสําคัญกับประสบการณ

ของบุ คคล  (personal experiences) และการตี ค ว าม  ( interpretation) เ พ่ื อ ทํ าคว าม เข า ใ จ 

(understanding) ความหมาย (meaning) ของปรากฏการณทางสังคม มากกวาการจําแนกประเภท 

และมุงเนนไปท่ีการหาความเชื่อมโยงท่ีเกิดข้ึนเปนสวนใหญ (a larger number) ในบรรดาคุณลักษณะ 

(attribute) ของสิ่งท่ีทําการศึกษาจาก 2-3 กรณี (few case) ท่ีมีความเก่ียวของกัน โดยใชการพรรณนา 

(descriptive) หรือการอธิบาย (explanatory) ดวยคําพูดหรือภาษาบรรยายเปนหลัก มีการออกแบบ

การวิจัยในรูปแบบตาง ๆ ดังนี้ 

          2.2.1 การวิจัยภาคสนาม (Field research) เปนการวิจัยท่ีนักวิจัยทําการเก็บรวบรวม

ขอมูลโดยการเขาไปสังเกตดวยตนเองและจดบันทึกเก่ียวกับหนวยวิเคราะหและบริบทดานตาง ๆ ท่ี

เกิดข้ึนตามความเปนจริง โดยใชระยะเวลาท่ียาวนานจนกวาจะไดขอมูลครบถวนและสมบูรณ 

          2.2.2 การวิจัยเชิงประวัติศาสตรเปรียบเทียบ (Historical-comparative research) เปน

การวิจัยท่ีนักวิจัยทําการเก็บรวบรวมขอมูลเก่ียวกับเหตุการณตาง ๆ ในเชิงประวัติศาสตรท่ีเกิดข้ึนในอดีต

หรือเปรียบเทียบความแตกตางในเชิงวัฒนธรรมระหวางสังคม 

3. การจําแนกตามเปาหมายของการวิจัย (Purpose of research) มี 2 ประเภท ดังนี้ 

     3.1 การวิจัยเชิงสํารวจเบื้องตน (Exploratory research) เปนการวิจัยท่ีมีเปาหมายหลักอยูท่ี

การตรวจสอบหรือคนหาคําตอบสําหรับทําความเขาใจประเด็นปญหาหรือปรากฏการณเล็ก ๆ จากคําถาม

วา อะไร (what) เพ่ือพัฒนาความคิดและคําถามการวิจัยในระดับตอไป 

     3.2 การวิจัยเชิงพรรณนา (Descriptive research) เปนการวิจัยท่ีมีเปาหมายหลักอยูท่ีการ

บรรยายใหเห็นภาพสิ่งท่ีศึกษาดวยตัวเลขและตัวอักษร ตอบคําถามตามเคาโครงท่ีกําหนดไววาใคร (who) 

เม่ือไหร (when) ท่ีไหน (where) อยางไร (how) และนําเสนอการวิจัยในรูปของรายละเอียดและการ

จําแนกประเภท    

     3.3 การวิจัยเชิงอธิบาย (Explanatory research) เปนการวิจัยท่ีมีเปาหมายหลักอยูท่ีการ

อธิบายเหตุการณตาง ๆ วาเกิดข้ึนไดอยางไร (why) รวมถึงการสราง ตอเติม พัฒนา ขยาย และทดสอบ

ทฤษฎ ี

  4. การจําแนกตามประเภทของกรณีศึกษา (Within or across cases) 
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     4.1 การวิจัยแบบศึกษาเปนรายกรณี (Case-study research) เปนการศึกษาเชิงลึก (in-

depth) อยางละเอียดจากหนวยตาง ๆ (unites) หรือสิ่งท่ีศึกษา (cases) ประมาณ 2-3 กรณี ในชวงเวลา

หนึ่งหรือเปรียบเทียบหลาย ๆ ชวงเวลา   

     4.2 การวิจัยแบบศึกษาเปรียบเทียบกรณี (Across-case research) สวนใหญเปนการศึกษา

เชิงปริมาณ จากสิ่งท่ีศึกษาท่ีมีจํานวนมาก (30-3,000 กรณี) เพ่ือเปรียบเทียบขอมูลระหวางกรณีศึกษา

ประมาณ 2-3 คุณลักษณะหรือตัวแปร มากกวาท่ีจะสังเกตในรายละเอียดแตละกรณี  

  5. การจําแนกตามมิติของเวลาในการวิจัย (Time dimension in research) มี 3 ประเภท ดังนี้ 

     5.1 การวิจัยแบบตัดขวาง (Cross-sectional research) เปนการวิจัยท่ีตองการคนหาคําตอบ

โดยการรวบรวมขอมูลมาจากหนวยวิเคราะหในชวงเวลาใดเวลาหนึ่ง (at one time) แตการวิจัยแบบนี้มี

ขอดีท่ีประหยัดเวลาและงบประมาณ แตไมสามารถแสดงใหเห็นถึงกระบวนการหรือการเปลี่ยนแปลงทาง

สังคมได 

     5.2 การวิจัยแบบระยะยาว (Longitudinal research) เปนการวิจัยท่ีตองการคนหาคําตอบ

เชิงความสัมพันธโดยการรวบรวมขอมูลจากหนวยวิเคราะหท่ีอยูในชวงเวลาท่ีแตกตางกัน มี 3 รูปแบบ คือ 

          5.2.1 แบบชวงเวลาตอเนื่องกัน (Time-series) เปนการรวบรวมขอมูลจากหนวยวิเคราะห

ท่ีมีคุณลักษณะแตกตางกันกลุมหนึ่งหรือหลายกลุมในชวงเวลาหนึ่งแบบติดตอเปนลําดับ 

          5.2.2 แบบชวงเวลาท่ีตางกัน (Panel study) เปนการเก็บรวบรวมขอมูลจากหนวย

วิเคราะหท่ีมีคุณลักษณะเหมือนกันตั้งแต 2 ชวงเวลาข้ึนไป 

          5.2.3 แบบติดตามไปขางหนา (Cohort) ทําการเก็บรวบรวมขอมูลจากหนวยวเิคราะหท่ีมี

คุณลักษณะหรือประสบการณเหมือนกัน ต้ังแต 2 ชวงเวลาข้ึนไป ท้ังแบบใชขอมูลยอนหลังและไม

ยอนหลัง 

     5.3 แบบรายกรณี (Case study) เปนการวิจัยท่ีตองการคนหาขอมูลเชิงลึก (in-depth) จาก

หนวยวิเคราะหจํานวนไมมาก หรือหนึ่งกรณีในชวงเวลาหนึ่งหรือเปรียบเทียบในหลายชวงเวลา   

6. การจําแนกตามประเภทของคําถามการวิจัย (Research question) มี 2 ประเภท ดังนี้  

   6.1 แบบไมมีสมมติฐาน (without hypotheses) เปนการวิจัยท่ีออกแบบและวางแผนการ

วิจัยโดยเนนการรวบรวมขอมูลและวิเคราะหขอมูลเพ่ือนําไปใชตอบคําถามการวิจัยเทานั้น 
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   6.2 แบบมีสมมติฐาน (with hypotheses) เปนการวิจัยท่ีออกแบบและวางแผนท่ีเนนการ

รวบรวมขอมูลและวิเคราะหขอมูลเพ่ือนําไปตอบถามการวิจัยดวยวิธีการทดสอบสมมติฐานท่ีไดมาจาก

ทฤษฎ ี

2.2 หลักเกณฑการจัดประเภทงานวิจัย 

ภายใตความแตกตางของการจําแนกประเภทงานวิจัยมีรูปแบบของการนิยามประเภทการวิจัยท่ี

แตกตางกันพอสรุปได ดังนี้ 

  1. นิยามการแบงประเภทและแบงประเภทงานวิจัยเหมือนกัน เชน จําแนกตามวิธีการรวบรวม

ขอมูล แบงเปน การวิจัยเชิงปริมาณ และการวิจัยเชิงคุณภาพ 

2. นิยามการแบงประเภทเหมือนกันแตมีประเภทงานวิจัยไมเหมือนกัน เชน จําแนกตาม

จุดมุงหมาย แบงเปนการวิจัยพ้ืนฐาน การวิจัยเชิงทฤษฎี การวิจัยประยุกต การวิจัยแบบมีสมมติฐาน และ

การวิจัยแบบไมมีสมมติฐาน 

3. นิยามการแบงประเภทไมเหมือนกันแตแบงประเภทงานวิจัยเหมือนกันหรือคาบเก่ียวกัน เชน 

จําแนกตามวิธีการวิจัย แบงเปนการวิจัยเชิงสํารวจ การวิจัยเชิงพรรณนา การวิจัยเชิงอธิบาย การวิจัยเชิง

ทํานาย 

4. นิยามไมเหมือนกันและมีประเภทงานวิจัยท่ีไมเหมือนกัน เชน จําแนกตามสาขาการวิจัย 

แบงเปน การวิจัยทางสังคมวิทยา การวิจัยทางรัฐศาสตร การวิจัยทางการศึกษา 

กลาวโดยสรุป มีวิธีการแบงประเภทงานวิจัยท่ีหลากหลาย แตท่ีพบอยางแพรหลายและนิยมมาก

ท่ีสุด คือ แบงเปนการวิจัยเชิงปริมาณ และการวิจัยเชิงคุณภาพ โดยมีนิยามการแบงประเภทท่ีแตกตางกัน 

เชน แบงตามลักษณะขอมูล แบงตามวิธีการวิเคราะหขอมูล แบงตามระเบียบวิธี แบงตามการตอบคําถาม

การวิจัย เปนตน  

3. กระบวนการวิจัยดานสังคมศาสตร 

การวิจัยทุกสาขาวิชาและทุกประเภทมีข้ันตอนการทําวิจัยหรือระเบียบวิธีการวิจัยท่ีไมแตกตาง

กันมากนัก แตโดยท่ัวไปอาจแบงออกเปนข้ันตอนหลัก ๆ ไดดังนี้ (Scanlon cited in Wilkinson, 2000, 

p. 9) 
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1. ข้ันคัดเลือกความสนใจ (Choosing a focus) คือ การเลือกและกําหนดปญหาท่ีจะทําการวิจัย 

2. ข้ันออกแบบการวิจัย (Research design) คือ การเตรียมและตัดสินใจเก่ียวกับการใชวิธีการ

รวบรวมขอมูลและการวิเคราะหขอมูล 

3. ข้ันรวบรวมขอมูล (Data collection) คือ การเก็บขอมูลดวยการสัมภาษณดวยตนเองหรือสง

แบบสอบถามไปใหกลุมเปาหมายตอบเอง  

4. ข้ันวิเคราะหขอมูล (Data analysis) คือ การวิเคราะหและตีความขอมูลท่ีไดมาจากการเก็บ

รวบรวมขอมูล 

5. ข้ันเขียนผลการวิจัย (Writing up the results) คือ การนําเสนอผลการวิจัยดวยพรรณนาและ

อธิบายจากผลการวิเคราะหขอมูล 

3.1 การออกแบบการวิจัย 

การคนหาความรูดวยการวิจัยมีกระบวนการท่ีเปนระบบ (systematic) การเริ่มทําการวิจัยจึง

ตองมีการออกแบบการวิจัย (research design) อยางเปนข้ันตอน (step-by-step) ตามระเบียบวิธีของ

การทําวิจัย หรือท่ีเรียกวา ระเบียบวิธีการวิจัย (research methodology) การออกแบบการวิจัยตาม

กระบวนการวิจัยทางสังคมศาสตรสามารถแสดงใหเห็นเปนแผนผังดังนี้ 
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รูปท่ี 1.1 กระบวนการวจิัย (ปรับปรุงมาจาก Babbie, 2007, p. 108) 

 การเริ่มดําเนินโครงการวิจัยอาจมีจุดเริ่มตนมาจากความสนใจ หรือความคิด หรือทฤษฎี เปนไป

ไดท้ังสิ้น หรืออาจเริ่มมาจากความสนใจท่ีทําใหเกิดความคิดซ่ึงเหมาะกับทฤษฎีหนึ่ง หรือทฤษฎีอาจทําให

เกิดความคิดใหม ๆ และสรางความสนใจใหม ๆ ตามมาก็เปนไปไดเชนกัน (Babbie, 2007, p. 109) 
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3.2 การวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพ 

การทําวิจัยของนักสังคมศาสตรตองปฏิบัติการวิจัยตามลําดับข้ันของกระบวนการวิจัยใหถูกตอง 

แตเนื่องจากการวิจัยทางสังคมศาสตร 2 ประเภทใหญ คือ การวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพ 

ตางมีปรัชญาและแนวคิดในการคนหาความรูท่ีแตกตางกัน ดังนั้นการวิจัยท้ังสองประเภทจึงมีลําดับและ

ข้ันตอนของการทําวิจัยท่ีแตกตางกันอยูบาง ดังตารางดานลาง (Neuman, 2014, p. 14-15) 

ตารางท่ี 1.1 เปรียบเทียบข้ันตอนการวิจัยเชิงปริมาณและเชิงคุณภาพ 

ข้ันท่ี การวิจัยเชิงปริมาณ การวิจัยเชิงคุณภาพ 

1 เลือกหัวขอ (Select topic) ทําความเขาใจสังคม (Acknowledge social self) 

2 ตั้งคําถามใหชัดเจน (Focus question) เกิดมุมมองและความเขาใจ (Adopt perspective) 

3 ออกแบบการศึกษา (Design study) ออกแบบการศึกษา (Design study) 

4 รวบรวมขอมูล (Collect data) รวบรวมขอมูล (Collect data) 

5 วิเคราะหขอมูล (Analyze data) วิเคราะหขอมูล (Analyze data) 

6 ตีความขอมูล (Interpret data) ตีความขอมูล (Interpret data) 

7 นําเสนอผลการวิจัย (Inform others) นําเสนอการวิจัย (Inform others) 

นักวิจัยท่ีเนนวิธีการวิจัยเชิงคุณภาพ เริ่มตนการวิจัยดวยการใชตัวนักวิจัยเองทําการประเมินและ

ไตรตรอง (self-assessment and reflections) สถานการณจากบริบทของสังคมเชิงประวัติศาสตร 

(sociohistorical context) เพ่ือรับรูในเรื่องตัวตน (self-aware) ของสังคมหรือการวางตัวของนักวิจัยใน

สังคม ไมมุงเนนท่ีการตั้งคําถามเฉพาะเรื่องเหมือนกับการวิจัยเชิงปริมาณ แตใหความสําคัญกับกระบวน

ทัศนทางทฤษฎีและปรัชญา (theoretical-philosophical paradigm) ของการอยากรูอยากเห็น 

(inquisitive) และมุงเนนการสรางคําถามท่ีตองการคําตอบท่ีเปดกวาง (open-ended) อันจะนําไปสูการ

เกิดมุมมองและความเขาใจ สําหรับข้ันการออกแบบการศึกษา การรวบรวมขอมูล การวิเคราะหขอมูล 

และการตีความขอมูล  

การวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพมีข้ันตอนท่ีเหมือนกัน แตมีความแตกตางกันใน

รายละเอียดของแตละข้ันตอน กลาวคือ นักวิจัยเชิงคุณภาพจะเนนการกระบวนการวิจัยระหวางข้ันตอน

การรวบรวมขอมูล การวิเคราะหขอมูล และการตีความขอมูลไปท่ีการสรางทฤษฎีใหมและสรุปผลตาม
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ทฤษฎีท่ีมีอยูแลว ขณะท่ีนักวิจัยเชิงปริมาณสวนใหญจะเนนข้ันตอนการตีความไปท่ีการทดสอบสมมติฐาน 

(test hypothesis) ท่ีสรางไวอยูกอนแลว สวนนักวิจัยเชิงคุณภาพจะเนนข้ันตอนการตีความไปท่ีการ

ตีความเพ่ือการสรางแนวคิดใหมและการสรางทฤษฎี (constructing theoretical) สําหรับข้ันตอน

สุดทาย คือ การนําเสนอการวิจัย การวิจัยท้ังสองประเภทมีการนําเสนอการวิจัยเหมือนกัน แตอาจ

แตกตางกันในรูปแบบของรายงานตามแนวทางของการวิจัยแตละประเภท (Neuman, 2006, p. 14-15)  

การวิจัยแตละวิธีมีท้ังจุดออนและจุดแข็ง บางสถานการณอาจตองเลือกใชการวิจัยเชิงผสมผสาน 

(mixed methods research) ท้ังการวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพ ดังนี้ 

1. ตองการความเขาใจท่ีสมบูรณ (More complete understanding) เพราะการใชเครื่องมือ

วัดแนวคิดดวยวิธีการเชิงปริมาณ คาคะแนนท่ีไดจากการวัดอาจไมสามารถบอกเรื่องราวตาง ๆ ไดอยาง

สมบูรณ ดังนั้นจึงตองสอบถามหรือสนทนากับประชาชนท่ีเก่ียวของจํานวนหนึ่งอาจทําใหเกิดความเขาใจ

ไดดีข้ึน 

2. ตองการตรวจสอบบริบทตามความแตกตางของเครื่องมือ (Context specific instruments) 

การสรางเครื่องมือเพ่ือศึกษาแนวคิด นําไปใชกับกลุมตัวอยาง/ประชากรท่ีแตกตางกัน การทําความเขาใจ

กลุมตัวอยาง/ประชากรกอนการพัฒนาเครื่องมือ ทําใหการพัฒนาเครื่องมือเปนไปดวยดีและเหมาะสม

มากกวา 

3. ตองการอธิบายผล (Explain results) การใชเครื่องมือรวบรวมขอมูลเก่ียวกับตัวแปรปจจัย

เพ่ือการทํานายแนวคิดนั้น เปนการใหความสําคัญกับตัวทํานาย สามารถอธิบายวาอะไร (what) และ

ทําไม (why) เปนผลทําใหเกิดปรากฏการณ แตการวิจัยแบบผสมผสม สามารถบอกไดวา ปรากฏการณท่ี

ทําการศึกษามีกลไกในการเกิดอยางไร (how) 

4. ตองการตรวจสอบการกําหนดปจจัยแทรก (Determine if an intervention will work) 

การคนหาปจจัยแทรกท่ีนักวิจัยผูอ่ืนพัฒนาไว แตไมสามารถคนหาคําตอบไดจากตัวอยางท่ีทําการศึกษา 

ดังนั้นจึงตองใชวิธีการแบบผสมผสานในการตรวจสอบกอนท่ีจะกําหนดตัวแปรแทรก 

5. ตองการเชื่อมโยงข้ันตอนตาง ๆ ในกระบวนการประเมินผล (Tie together several steps 

in an evaluation process) เชน การประเมินประสิทธิภาพขององคกร เพ่ือทําความเขาใจผลลัพธของ

องคกร การใชเครื่องมือวัดประสิทธิภาพใหคําตอบเฉพาะผลลัพธ แตการวิจัยแบบผสมผสาน จะชวย

อธิบายวา ทําไม (why) ผลลัพธจึงเกิดข้ึน  
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3.3 การวิจัยเชิงผสมผสาน 

การวิจัยเชิงผสมผสาน (mixed method research) เปนท้ังวิธีการ (method) และระเบียบวิธี 

(methodology) เพ่ือดําเนินการวิจัย (conducting research) เก่ียวกับการรวบรวม (collecting) การ

วิเคราะห (analyzing) และการบูรณาการ (integrating) ดวยวิธีการวิจัยเชิงปริมาณ (quantitative 

research) และการวิจัยเชิงคุณภาพ (qualitative research) ในการคนหาคําตอบ (inquiry) อาจเปน

การศึกษาเรื่องเดียว (single study) หรือ โครงการตอเนื่องระยะยาว (longitudinal) โดยมีจุดมุงหมาย 

คือ ทําใหเกิดความเขาใจ (understanding) ปญหาหรือประเด็นการวิจัยท่ีดีกวาการใชวิธีการใดวิธีการ

หนึ่งข้ึนเพียงวิธีการเดียว แบงไดเปน 3 ประเภท ดังนี้ 

1. วิธีการเปรียบเทียบ (Triangulation mixed methods design) นําขอมูลและผลการวิจัยท่ี

ไดจากวิธีการวิจัยเชิงปริมาณและเชิงคุณภาพมาทําการเปรียบเทียบและตีความ (interpretation) 

การวิจัยเชิงปริมาณ 

 (ขอมูลและผลการวิจัย) 
-> ตีความ <- 

การวิจัยเชิงคุณภาพ 

(ขอมูลและผลการวิจัย) 

2. วิธีการอธิบาย (Explanatory mixed methods design) เริ่มทําการวิจัยดวยวิธีการเชิง

ปริมาณ และทําการติดตามหรือตรวจสอบ (follow up) เพ่ืออธิบายดวยวิธีการเชิงคุณภาพ 

การวิจัยเชิงปริมาณ 

 (ขอมูลและผลการวิจัย) 

-> 

ติดตาม/ตรวจสอบ 

การวิจัยเชิงคุณภาพ 

(ขอมูลและผลการวิจัย) 

3. วิธีการสํารวจเบื้องตน (Exploratory mixed methods design) ใชวิธีการเชิงคุณภาพสํารวจ

ขอมูลเบื้องตนกอนกอรางหรือสราง (building) การวิจัยดวยวิธีการเชิงปริมาณ 

การวิจัยเชิงคุณภาพ 

 (ขอมูลและผลการวิจัย) 

-> 

กอราง/สราง 

การวิจัยเชิงปริมาณ 

(ขอมูลและผลการวิจัย) 
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สรุป 

การวิจัยทางสังคมศาสตร เปนวิธีการหนึ่งในการหาความรูของมนุษยท่ีไดรับอิทธิพลมาจาก

วิทยาศาสตรธรรมชาติและตามแนวทางท่ีพัฒนาข้ึนมาเองจากนักคิดดานสังคมศาสตร โดยมีการออกแบบ

อยางเปนข้ันตอนและเปนระบบตามหลักวิชาการ (methodology) ใชวิธีเชิงประจักษท้ังทางตรงและ

ทางออมในการเก็บขอมูลและสารสนเทศ (information) ท้ังเชิงปริมาณ และ/หรือเชิงคุณภาพ นําไป

วิเคราะห อธิบาย ทํานาย สรางขอสรุป และสนับสนุนทฤษฎี รวมถึงตอบคําถามท่ีเกิดจากขอสงสัย

เก่ียวกับสังคมมนุษยในทุกดาน (social phenomena) และนําไปประยุกตใชในการแกไขปญหาท่ีเก่ียว

ของในสังคม  

แบบฝกหัดทายบท 
ใหผูเรียนคนหางานวิจัยดานสังคมศาสตรจากฐานขอมูลของหองสมุดท่ีสนใจแลวตอบคําถาม 

ดังนี้ 

1. งานวิจัยท่ีคนได เปนงานวิจัยเชิงปริมาณ เชิงคุณภาพ หรือเชิงผสมผสาน  

2. งานวิจัยดังกลาว มีข้ันตอนการวิจัยก่ีข้ันและอะไรบาง 

3. งานวิจัยดังกลาว มีและไมมีข้ันตอนการวิจัยตามท่ีบรรยายไวหรือไม 

  



 

 

 บทที่ 2 

การวิจัยเชิงปริมาณ 

ความมุงหมายของบทเรียน 

เพ่ือใหผูเรียนเขาใจวิธีการวิจัยเชิงปริมาณท่ีเกิดจากความสัมพันธระหวางทฤษฎี สมมติฐาน และ

ตัวแปร  

เน้ือหา 

1. ความรูเบื้องตนเก่ียวกับการวิจัยเชิงปริมาณ 

2. ทฤษฎี 

3. สมมุติฐาน 

4. ตัวแปร 

5. ความสัมพันธระหวางสมมติฐานและตัวแปร 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย แสดงตัวอยาง ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรมสอนออนไลน (สอนแบบออนไลน) เครื่องฉาย 

(สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และการ

ทําแบบฝกหัดทายบท 
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เนื้อหา 

การทําวิจัยแตละวิธีการ (approach) มีกระบวนการท่ีแตกตางกัน การทําวิจัยดวยวิธีการนิรนัย 

(deductive) มีการตั้งสมมติฐานจากทฤษฎีและเก็บรวบรวมขอมูล2

3มาทดสอบสมมติฐาน สวนการทําวิจัย

ดวยวิธีการอุปนัย (inductive) ใชการรวบรวมขอมูลเพ่ือคนหากฎเกณฑหรือรูปแบบ (pattern) แลวจึง

สรางเปนขอเสนอเชิงทฤษฎีชั่วคราว (tentative conclusion or proposition) สําหรับการคนหาขอมูล

มาสนับสนุน 

1. ความรูเบ้ืองตนเก่ียวกับการวิจัยเชิงปริมาณ 

การวิจัยดานสังคมศาสตรรวมถึงสาขาสังคมวิทยาจําแนกแบบกวาง ๆ หรือตามวิธีการ 

(techniques) การรวบรวมขอมูล (data collection) และการวิเคราะหขอมูล (data analysis) ไดเปน 

2 ประเภทใหญ คือ การวิจัยเชิงปริมาณ (quantitative research) และการวิจัยเชิงคุณภาพ (qualitative 

research) การวิจัยท้ังสองประเภทตางมีความเชื่อเก่ียวกับความจริงท่ีเรียกวา ภาววิทยา (ontology) 

และวิธีการคนหาความรูหรือการเขาถึงความจริงท่ีเรียกวา ญาณวิทยา (epistemology) จึงทําใหเกิด

มุมมองท่ีแตกตางกันในวิธีการรวบรวบขอมูลและการวิเคราะหขอมูล  (Blaikie, 2010, p. 204)  

ปจจุบัน แมวายังมีการแบงข้ัวกันอยางชัดเจนระหวางกลุมท่ีชอบวิธีเชิงปริมาณและกลุมท่ีชอบวิธี

เชิงคุณภาพ แตเริ่มเกิดกลุมท่ีชอบวิธีเชิงผสมผสานนําเอาท้ังสองวิธีมาใชในการวิจัยมากข้ึน อยางไรก็ตาม 

ไมวาจะมีความเชื่อท่ีแตกตางกันและชอบไมเหมือนกัน แตตางมีเปาหมายท่ีเหมือนกัน คือ การไดความรู

หรือขอสรุปผลการวิจัยท่ีมีความถูกตองและมีความนาเชื่อถือ 

1.1 ความเปนมาของการวิจัยเชิงปริมาณดานสังคมศาสตร 

การวิจัยเชิงปริมาณเปนกลยุทธหนึ่ง (a strategy) ในการหาความรู (inquiry) เก่ียวกับโลกและ

ธรรมชาติดวยวิธีการท่ีเปนวิทยาศาสตร (scientific method) ของกลุมนักวิจัยท่ีเชื่อ (belief) ในความ

                                                           
3 สวนใหญใชขอมูลเชิงปริมาณ แตก็สามารถใชขอมูลเชิงคุณภาพไดในกรณีที่การทดสอบสมมุติฐานนั้นตองการใหขอคิดเห็นหรือใหเหตุผลที่

ไดมาจากหลักฐาน  
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เปนจริ ง  ( true) หรือ ท่ี เรียกกันว า  นักปฏิฐานนิยม (positivist)4 และนักปฏิฐานนิยมยุคหลั ง 

(postpositivist)5 การทาทายแนวคิดนักปฏิฐานนิยมของนักปฏิฐานนิยมยุคหลังท่ีเปนนักสังคมวิทยายุค

บุกเบิก เชน ออกุสต กองต (Auguste Comte) อีมีล เดอรไคม (Emile Durkheim) ในศตวรรษท่ี 19 ท่ี

เห็นวา แนวคิดเก่ียวกับความจริงแทไมสามารถนํามาใชในการศึกษาพฤติกรรม (behavior) และการ

กระทํา (actions) ของมนุษยได ทําใหมีการนําเอาวิธีการหาความรูเชิงเหตุและผลบนฐานความคิดของ

นักปฏิฐานนิยมไปพัฒนาใหมโดยใชวิธีการกําหนดความสัมพันธเชิงสาเหตุ (deterministic) เพ่ือพิสูจน 

(identify) สาเหตุ (causes) ท่ีมีอิทธิพล (influence) ทําใหเกิดผลลัพธ (outcomes) เชน วิธีการทดลอง 

หรือใชวิธีการลดทอน (reductionistic) โดยการนําเอาสิ่งท่ีเปนความคิด (ideas) เชน ทฤษฎี สมมติฐาน 

และคําถามการวิจัย มาลดทอนใหมีขนาดเล็กเปนชุดความคิดหรือตัวแปรท่ีสามารถนําไปทดสอบได แต

ยังคงรักษาวิธีการเขา ถึงความรู ท่ี เปนจริงเชิ งวัตถุวิสัย (objective reality) ดวยวิธีการสัง เกตุ  

(observation) และการวัด (measurement) จากความจริงท่ีมีอยูภายนอก (out there) ท่ีดํารงอยู 

หลังจากนั้นเปนตนมาทําใหเกิดการพัฒนาการวัดเชิงตัวเลข (numeric measurement) ดวยวิธีการ

สังเกตและศึกษาพฤติกรรมของปจเจกบุคคลอยางแพรหลายในบรรดานักปฏิฐานนิยมยุคหลัง รวมถึง

นํามาใชทดสอบ (tested) และตรวจสอบ (verified) กฎหรือทฤษฎีใหเกิดความเขาใจเก่ียวกับโลกใหดีข้ึน 

ทําใหวิธีการวิจัยท่ีเริ่มจากทฤษฎีใดทฤษฎีหนึ่ง แลวทํารวบรวมขอมูลมาเพ่ือสนับสนุน (supports) หรือ

ปฏิเสธ (refutes) ตามวิธีการของนักปฏิฐานนิยมยุคหลังไดรับการยอมรับวาเปนวิธีการท่ีเปนวิทยาศาสตร 

(Creswell, 2009, p. 6-7) 

ตั้งแตชวงปลายศตวรรษท่ี 19 เปนตนมา การวิจัยเชิงทดลองดานจิตวิทยาเริ่มนําเอาวิธีการวิจัย

เชิงปริมาณท่ีวางอยูบนฐานความคิดแบบปฏิฐานนิยมมาใชเปนเครื่องมือคนหาความรูกันอยางแพรหลาย 

(Creswell, 2014, p. 12) ขอมูลในการวิจัยเชิงปริมาณดานสังคมสวนใหญเม่ือเก็บรวบรวมมาแลวนิยมทํา

ใหเปนรหัส (coding) ในรูปแบบของตัวเลข (numerical) สําหรับนําไปใชกับโปรแกรมคอมพิวเตอรเพ่ือ

วิเคราะหดวยวิธีการทางสถิติ (statistical analysis) ดวยการพรรณนา (describing) และการอธิบาย 

(explaining) กอนนําไปนําเสนอตามจุดมุงหมาย (Babbie, 2013, p. 413-414) 

                                                           
4 แนวคิดเกาที่เนนการหาความรูที่เปนความจริงแท (absolute truth) คือ เปนจริงตลอดเวลาและทุกสถานที่ และเปนจริงเสมอไมวา

สถานการณจะเปนอยางไร 
5 แนวคิดใหมที่ไมเชื่อวา ความจริงแทมีอยูจริง  
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1.2 ประเภทของการวิจัยเชิงปริมาณ 

การวิจัยเชิงปริมาณอาจแบงไดเปนหลายประเภท แตหากแบงตามวัตถุประสงคของการวิจัย

สามารถแบงไดเปน 2 วิธีการ (approaches) ดังนี้ 

1. การวิจัยพ้ืนฐาน (Basic research) คือ การวิจัยท่ีเนนการทดสอบทฤษฎีเพ่ือสนับสนุนหรือ

ปฏิเสธทฤษฎ ีการวิจัยประเภทนี้อาจเรียกไดวาเปนการวิจัยเชิงยืนยัน (confirmatory research) 

2. การวิจัยเชิงประยุกต (Applied research) คือ การวิจัยท่ีเนนการคนหาความสัมพันธระหวาง

เหตุและผลของปรากฎการณทางสังคมหรือเหตุการณตาง ๆ ท่ีเกิดข้ึนในสังคม การวิจัยประเภทนี้อาจ

เรียกไดวาเปนการวิจัยเชิงสํารวจ (exploratory research) 

การวิจัยเชิงปริมาณแมวาจะมีวัตถุประสงคท่ีแตกตางกัน แตเปาหมายท่ีสําคัญ คือ การทดสอบ

ทฤษฎี  ( theories) ท่ี เป นข อสรุ ป ท่ี เป นนามธรรมจากความ เป นจริ งมา ทํ า ให เป นรู ปธรรม 

(operationalization) ดวยการสรางเปนสมมติฐาน (hypothesis) ทําการนิยาม (identification) หรือ

พรรณนา (description) ตัวแปร (variable) สําหรับสรางเปนเครื่องมือ (instrument) วัดหรือรวบรวม

ขอมูลท่ีเปนตัวเลข (numbered data) จากกลุมตัวอยาง (sample) หรือประชากร (population) ท่ีมี

จํานวนมากหรือขนาดใหญ และนําไปวิเคราะหดวยวิธีการทางสถิติ (statistical procedures) เพ่ือการ

ทดสอบหานัยสําคัญเชิงสถิติ (statistical significance) ของขอมูล (Creswell, 2009, p. 4; Wagner & 

Okeke cited by Garner, M., Wagner, C., & Kawulich, B., 2009, p. 62; Williams, 2016, p. 88) 

2. ทฤษฎ ี

คําวา ทฤษฎี (theory) มาจากภาษากรีก คือ “theoria” ซ่ึงหมายถึง “looking at” เปนคํา

กวาง ๆ และเปนประโยคเชิงขอความ คลายกับสมมติฐาน แตทฤษฎีมีลักษณะท่ีแตกตางกันมาก บาง

ทฤษฎีอาจอยูในรูปของทฤษฎีชาวบาน (folk theory) ซ่ึงไมตางไปจากความเชื่อในชีวิตประจําวัน 

(everyday beliefs) บางทฤษฎีอาจเปนทฤษฎีระดับกวาง (grand theory) อธิบายเคาโครงหรือภาพรวม 

(explanatory schema) ของปรากฎการณทางสังคม (social phenomena) และบางทฤษฎีอาจเปน

ทฤษฎีระดับกลาง (middle range theory) ท่ีเปนประโยคหรือขอความ (statement) ท่ีสามารถทดสอบ

ได (testable) และมีขอบเขตการอธิบายเฉพาะปรากฎการณทางสังคมภายใตบริบท (context) เฉพาะ

ของสังคม-ประวัต/ิวัฒนธรรม (socio-historical/cultural) (Williams, 2016, p. 218-224) 
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2.1 ทฤษฎี คือ อะไร 

ทฤษฎี (theory) เปนความคิด (notion) หรือคํากลาว (statement) ท่ีสรุป (abstract) ใหเห็น

ถึงทิศทางของความสัมพันธระหวางแนวคิด (concept) เชน เหตุการณหนึ่งเกิดจากอะไร มีกระบวนการ

อยางไร อะไรเกิดข้ึนกอน อะไรเกิดข้ึนหลัง อะไรเปนสาเหตุท่ีทําใหเกิดและไมทําใหเกิด บางทฤษฎีไดรับ

การยอมรับอยางเปนทางการ (formal) แตบางทฤษฎีอาจยังไมไดรับการยอมรับอยางเปนทางการ 

(informal) บางทฤษฎีมีความละเอียด (elaborate) และความซับซอน (complex) แตลักษณะทฤษฎีท่ีดี

ตองมีความเรียบงาย (simplicity) และความชัดเจน (clarity)  (Bouma and Ling, 2004, p. 19) 

ทฤษฎีอาจเปนแนวคิด (a concept) ชื่อของปรากฎการณ (a naming of phenomena) 

ประเภทของความคิด (an ideal type) การพรรณนารายละเอียดของการกระทํา (a thick description 

of an action) การบรรยายในลักษณะของตัวแบบ (a narrative as well as a model) ทฤษฎีมีลักษณะ

การอธิบายขอเท็จจริงหรือจารนัย (abductive) กระบวนการ (process) มากกวาการชี้แนะ (suggested) 

และมีความสําคัญมากในการทําวิจัย เพราะเปนเครื่องมือหรือเลนส (lens) ท่ีชวยใหนักวิจัยมอง

ปรากฎการณ (phenomena) แมวาจะไมใหภาพท่ีสมบูรณแตชวยใหนักวิจัยตัดสินใจวาจะมองท่ีอะไร 

รวมถึงสรางคําถามการวิจัย ออกแบบการวิจัย สรางกรอบแนวคิด การวิจัยแบบนิรนัย (deduction 

approach) ทฤษฎีจะถูกใชเปนแนวทางในการสรางกรอบแนวคิด (conceptual framework) ของการ

วิจัย เพ่ือนําไปสูการสรางสมมติฐาน (hypothesis) และการทดสอบ (tested) นอกจากนั้นทฤษฎียังชวย

เปนกรอบของการอางอิงในการวิเคราะห ชวยใหนักวิจัยเขาใจวาเกิดอะไรข้ึน (what happened) และ

เกิดผลท่ีตามมาจากสิ่งท่ีเกิดข้ึน (consequences for what happened) อธิบายวาอะไรคือสาเหตุของ

สิ่งท่ีเกิดข้ึน กรอบแนวคิดเชิงทฤษฎี (theoretical frameworks) เปนสะพานเชื่อมระหวางความเชื่อ

เก่ียวกับญาณวิทยา (epistemology) และภาวะวิทยา (ontology) และการวิเคราะห (analysis) และ

การตีความของขอมูล (interpretation of data) (Hammond and Wellington, 2013, p.141-144)  

ทฤษฎีเปนการรวมความคิดหลาย ๆ ความคิดเขาดวยกัน (a collection of ideas) หรือคํา

บรรยายสรุปความเปนจริง (reality) ท่ีไดมาจากการสังเกตจากโลกเชิงประจักษ (empirical world) หรือ

เปนการอธิบายอยางเปนระบบ (systematic explanation) เก่ียวกับกฎเกณฑ (regularities) สําหรับ

นําไปใชในการสังเกต (observation) (Bryman, 2012, p. 21; Aneshensel, 2013, p. 20, 32 Babbie, 

2013, p. 8) 
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ทฤษฎีเปนขอเสนอหรือประพจน (propositions) หรือสมมติฐาน (hypotheses) ท่ีเปนชุดความ

เก่ียวพันระหวางกัน (interrelated) ของมโนทัศนหรือสิ่งท่ีเปนนามธรรม (constructs) หรือตัวแปร 

(variables) แสดงถึงความสัมพันธระหวางตัวแปรในรูปของขนาด (magnitude) หรือทิศทาง (direction) 

หรืออาจปรากฏอยูงานวิจัยในรูปของขอโตแยง (argument) การอภิปราย (discussion) เหตุผล 

(rationale) ท่ีใชในการอธิบาย (explain) หรือทํานาย (prediction) ปรากฎการณท่ีเกิดข้ึนในโลก 

(Creswell, 2009, p. 51) 

2.2 ประเภทของทฤษฎ ี

นักปรัชญาและนักวิชาการมีการสรางทฤษฎีสําหรับใชในการอธิบายและศึกษาสังคมไวจํานวน

มาก การนําเอาทฤษฎีมาใชในการคนหาความรูหรือทําวิจัยวิจัยข้ึนอยูกับความสนใจของนักวิจัยและ

ปรากฎการณทางสังคมท่ีศึกษา บางเรื่องอาจท่ีมีขอบเขตกวางและมีขนาดใหญระดับสังคม เชน การตอสู

ระหวางชนชั้นของสังคม ความสัมพันธระหวางประเทศ ความสัมพันธระหวางสถาบันหลักทางสังคม 

(รัฐบาล ศาสนา ครอบครัว)  บางเรื่องเปนวิถีชีวิตของคนหรือกลุมคนในสังคม เชน พฤติกรรมการหาคู 

การพิจารณาคดีของผูพิพากษา ความสัมพันธเพ่ือนรวมงาน แตบางเรื่องอาจเปนท้ังระดับมหภาคและ

จุลภาค เชน ความขัดแยง (conflict) โดยท่ัวไปมีการจําแนกทฤษฎีท่ีใชในการศึกษาสังคมออกเปน 3 

ระดับ ดังนี้ (Babbie, 2013, p. 33) 

1. ทฤษฎีระดับมหภาค (Macro theory) เปนทฤษฎีท่ีใชอธิบายลักษณะโดยรวมของสังคม 

(aggregate entities of society) หรือท้ังสังคม (whole societies) เชน ทฤษฎีโครงสราง-หนา ท่ี 

(structural-functional) ทฤษฎีเครือขายทางสังคม (social network) 

2. ทฤษฎีระดับกลาง (Meso theory) มีนักวิจัยบางกลุมนิยมเอาทฤษฎีระดับมหภาคมา

ประยุกตใชระหวางระดับมหภาคกับระดับจุลภาค เพ่ือใชศึกษาองคการ (organization) ชุมชน 

(community) และประเภทของสังคม (social category) 

3. ทฤษฎีระดับจุลภาค (Micro theory) เปนทฤษฎีท่ีใชอธิบายวิถีชีวิตของคนในสังคม (social 

life) ท่ีมีความใกลชิดและมีปฏิสัมพันธกันในระดับบุคคล (individual) หรือกลุมขนาดเล็ก (small group) 

เชน ทฤษฎีการกระทําระหวางกันเชิงสัญลักษณ (symbolic interactionism) 
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2.3 การเลือกใชทฤษฎีในการวิจัย 

การเลือกใชทฤษฎีในการอธิบายปรากฎการณทางสังคมในแตละสาขาวิชามีความเชื่อแตกตางกัน 

นักสังคมวิทยาสวนใหญเชื่อวา การศึกษาพฤติกรรม (behaviors) และการตัดสินใจ (decisions) ของ

บุคคล (individuals) ไมสามารถนําไปใชอธิบายปรากฎการณทางสังคมท่ีมีความซับซอนไดอยางสมบูรณ 

เพราะปรากฎการณทางสังคม (social phenomena) เกิดมาจากปฏิสัมพันธของประชาชน (social 

interaction) ในองคการ (organizations) สถาบัน (institutions) และสังคม (societies) ซ่ึงตรงขามกับ

นักจิตวิทยาและนักเศรษฐศาสตรสวนใหญท่ีมีแนวโนมจะยอมรับวาปรากฎการณทางสังคมนั้นสามารถ

ลดทอน (reducible) ไปสูการอธิบายการกระทํา (actions) ของบุคคล เพราะบุคคลมีทางเลือกท่ีเปน

อิสระ (independent choices) ดังนั้นจึงสามารถเอามารวมกันเพ่ืออธิบายกระบวนการทางสังคม 

(social processes) ท่ีซับซอนได (Sawyer, 2005)  

การนําเอาทฤษฎีไปใชเปนกรอบในการมองหรืออธิบายปรากฎการณทางสังคมตองเลือกใช

ทฤษฎีใหเหมาะกับประเด็นท่ีตองการศึกษา บางเรื่องอาจใชทฤษฎีระดับใดระดับหนึ่งเทานั้น แตบางเรื่อง

อาจนําเอาทฤษฎีในระดับท่ีแตกตางกันมาอธิบายรวมกัน (link) เพ่ือใหเห็นความเก่ียวของระหวางกัน 

แมวาแนวคิดการศึกษาและอธิบายปรากฎการณทางสังคมดวยการเชื่อมโยงระหวางแนวคิดท่ีมี

ระดับแตกตางกันของอีมีล เดอรไคม (Emile Durkheim) มีนักสังคมศาสตรจํานวนไมนอยท่ีไมเห็นดวย 

แตก็มีนักวิชาการจํานวนไมนอยท่ีนําเอาขอเสนอของเดอรไคมไปใชในการอธิบายขอเท็จจริงทางสังคม 

(social facts) อีกท้ังยังเปนตัวอยางหนึ่งท่ีสามารถนํามาอธิบายเพ่ือใหเขาใจวิธีใชทฤษฎีท่ีมีระดับแตกตาง

กันเชื่อมโยงความสัมพันธระหวางกลไกระดับจุลภาค (microlevel mechanism) กับกลไกระดับมหภาค 

(macrolevel mechanism) โดยเดอรไคมไดเสนอไววา ความแตกตางของอัตราการฆาตัวตาย (suicide) 

ของคนในสังคมเกิดมาจากระดับความเปนปกแผนทางสังคม (social solidarity) ในระดับท่ีสูงกวา พรอม

กับยกตัวอยางใหเห็นวา ประเทศท่ีประชาชนสวนใหญเปนคาทอลิกมีอัตราการฆาตัวตายนอยกวาประเทศ

ท่ีประชาชนสวนใหญเปนโปรเตสแตนต เพราะสังคมคาทอลิกมีความเปนปกแผนทางสังคมสูงจึงชวย

ปองกันไมใหประชาชนฆาตัวตายและทําใหมีอัตราการฆาตัวนอยกวา (Babones, 2014, p. 7-8) 

ปรากฏการณทางสังคมในโลกเสมือนจริง (virtual world) ท่ีอุบัติ/ผุดบังเกิด (emergence) อยาง

หลากหลายและรวดเร็ว อาจตองเชื่อมโยงท้ังทฤษฎี/แนวคิดในระดับจุลภาคกับมหภาค (micro-macro 
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link) เชน การปฏิสัมพันธทางสังคม กลุมสังคม เครือขายสังคม สื่อสังคมออนไลน ในการทําความเขาใจ

และอธิบายสิ่งท่ีเกิดข้ึน 

ทฤษฎีและสมมติฐานมีความสัมพันธกันอยางมาก เราสามารถนําเอาทฤษฎีท่ีเปนนามธรรมและ

เปนคํากลาวกวาง ๆ ไปทดสอบได (testable) โดยการลดทอน (deductive) ใหมีลักษณะเฉพาะหรือ

แคบลงใหเปนประโยคในเชิงสมมติฐาน (Williams, 2016, p. 88) 

3. สมมติฐาน 

มีการกลาวกันวา สมมติฐาน ไมมีความจําเปนหรือไมเหมาะกับการทําวิจัยดวยวิธีการอุปนัย 

(inductive) ท่ีเนนการสังเกตและทําความเขาใจปรากฏการณทางสังคมแลวสรางเปนทฤษฎี การวิจัย

แบบจารนัย (abductive) อาจใชสมมติฐานเปนแนวทางในการสรางทฤษฎี (generating theory) แต

แตกตางจากวิธีการนิรนัย (deductive) คือ เปนการสรางสมมติฐานท่ีเกิดข้ึนในระหวางทําการวิจัยและ

ถูกนํามาใชเปนข้ันตอนยอย (subsequent stage) ของการวิจัย สวนการวิจัยแบบกลนยั (retroductive) 

ไมมีการสรางสมมุติฐาน หนาท่ีของนักวิจัยคือ การออกแบบ (postulate) โครงสราง (structure) หรือ

กลไก (mechanism) ท่ีมีอยู และดําเนินการในรูปของการเสนอแนะ  (Blaikie, 2010, p. 10,147) 

สมมติฐานโดยท่ัวไปสรางมาจากทฤษฎีเพ่ือนําไปใชในการรวบรวมขอมูลและตรวจสอบ (verify) 

หรืออาจสรางมาจากผลการวิจัยในอดีต การทบทวนวรรณกรรมท่ีเก่ียวของ และรวมถึงอาจไดมาจากการ

คิดข้ึนเอง (thin air) (Flynn, Sakakibara, Schroeder, Bates & Fynn, 1990, p. p. 253) 

สมมติฐานท่ีไดมาจากทฤษฎีหรือแนวคิดตองนํามาประยุกตใชใหเหมาะสมกับสถานการณ อาจใช

เปนคําตอบ (answer) ท่ีเปนไปไดในการตอบคําถาม (question) ทําไม (why) และอยางไร (how)6 และ

อาจไมจําเปนตองมีความสัมพันธเชิงเหตุและผล (causal) แตตองมีความชัดเจน มีความเขาใจงาย ไมมี

ความคลุมเครือ และสามารถทําไปทดสอบไดอยางเปนข้ันเปนตอน (Black, 1999, p. 45, 53; Babbie, 

2008, p. 48) 

                                                           
6 คําถามการวิจยัประเภท อะไร (what) ไมตองต้ังสมมติฐาน 
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3.1 สมมติฐาน คือ อะไร 

สมมติฐาน (hypothesis) คือ ประโยคหรือขอความท่ีเปนการทํานายคําตอบลวงหนา (a 

predicted answer) ของปญหาวิจัย (a research question) ท่ีระบุถึงความสัมพันธระหวางตัวแปร

ตั้งแตสองตัวแปรข้ึนไปท่ีไดมาจากทฤษฎี การคาดคะเนจากความรู และประสบการณของนักวิจัย หรือท่ี

เรียกวา คําตอบท่ีเกิดมากอนประสบการณ (a priori) เพราะ เปนการทํานายคําตอบกอนท่ีจะใชวิธีการ

วิจัยในการคนหาคําตอบ (Punch, 2005, p. 37-38) เม่ือกําหนดเปนสมมติฐานเชิงวิจัยแลว ในการ

ทดสอบสมมติฐานดวยสถิติจะมีการแปลงสมมติฐานเชิงวิจัยไปเปนสมมติฐานเชิงสถิติกอน 

สมมติฐานไมเพียงแตจะเปนตัวกําหนดตัวแปร แตมีบทบาทสําคัญในการนําไปสูความเก่ียวของ

กันของสิ่งท่ีทําการศึกษา แมวาตัวแปรนั้นไมไดอยูในความสนใจท่ีตองกําหนดและนิยามความหมาย 

เพราะบางประโยคแสดงใหเห็นหรือหมายถึงความสัมพันธเชิงเหตุและผลอยางมีเหตุผลพรอมกับลําดับ

เวลาของเหตุการณ และสะทอนถึงความเปนไปไดของปรากฏการณท่ีเกิดข้ึนอันเปนผลมาจากหลาย

สาเหตุ หรือมีความตอเนื่องของสาเหตุของการเกิดเหตุการณ (Black, 1999, p. 34-35) 

สมมติฐานจะเขียนในลักษณะประโยคบอกเลาท่ัวไป (basic statement) เพ่ืออธิบายขอเท็จจริง

ท่ียังคลุมเครือและกําหนดทิศทางในการทําวิจัยใหเกิดความชัดเจน (Fisher, 1949, p. p. 13 cited by 

Cohen, 1977, p. 1) โดยแสดงการคาดคะเนของผลลัพธ (outcome) ท่ีเกิดจากความสัมพันธระหวางตัว

แปร 2 ตัวแปรหรือมากกวา (Babbie, 2008, p. 48) หรือเปนความสัมพันธระหวางสองแนวคิด 

(concept) ประโยคหนึ่งเปนเหตุ (cause) และอีกประโยคหนึ่งเปนผล (outcome) ท้ังเหตุและผล คือ 

ตัวแปร ท่ีใชเปนแนวทางในการรวบรวมขอมูลของนักวิจัยและนําไปใชในการทดสอบสมมติฐาน (Blaikie, 

2010, p. 10; Field, 2013, p. 7) 

3.2 ประเภทของสมมตฐิาน 

สมมติฐานมีลักษณะเหมือนกับทฤษฎีมาก แตถูกนํามาใชในการวิจัยดานสังคมใน 2 แนว คือ เปน

ประโยคเชิงขอความ (propositional statement) อาจเปนประโยคบอกเลาหรือประโยคปฏิเสธท่ีเปน

จริงหรือเปนเท็จอยางใดอยางหนึ่ง และเปนประโยคเชิงตรรกะ (logical form) เพ่ือใชในการทดสอบ

นัยสําคัญเชิงสถิติ (statistical significance) ของขอมูล (Williams, 2016, p. 88) ดังนั้นจึงมีการเขียน

สมมติฐานในงานวิจัยแตละเรื่องหรือสาขาวิชาใหเห็นใน 2 รูปแบบ ดังนี ้
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1. สมมติฐานเชิงวิจัย (Research hypothesis) คือ คําตอบท่ีผูวิจัยเขียนไวในตอนแรกเริ่มการ

วิจัย เปนการคาดเดาผลไวลวงหนาวาจะเปนไปตามนั้น เปนลักษณะของการใชคําบรรยายหรือพรรณนา

ลักษณะความสัมพันธของตัวแปร มักอยูในลักษณะการคาดคะเนผลวาไมแตกตางกัน แตกตางกัน 

มากกวา หรือนอยกวา และมีการกลาววา เปนสมมติฐานท่ีบรรยายหรือพรรณนาเก่ียวกับประชากร 

(population) (Christopher, 2017, p. 146)  เชน ชาวตางชาติท่ีทํางานอยูในนิคมอุตสาหกรรมแหลม

ฉบังและนิคมอุตสาหกรรมมาบตาพุดมีการดําเนินชีวิตประจําวันไมแตกตางกัน ประชาชนในเขตชนบทมี

ระดับการศึกษาแตกตางกับประชาชนในเขตเมือง ประชาชนในเขตชนบทมีรายไดนอยกวาประชาชนใน

เขตเมือง ครัวเรือนในเขตชนบทมีจํานวนสมาชิกมากกวาครัวเรือนในเขตเมือง  

2. สมมติฐานเชิงสถิติ (Statistical hypothesis) คือ สมมติฐานทางวิจัยท่ีถูกแทนท่ีดวยการใช

สัญลักษณในทางคณิตศาสตร หรือสถิติท่ีบงบอกความสัมพันธของตัวแปร ในรูปของเครื่องหมายแทน

คุณลักษณะของตัวแปรนั้น ๆ หรืออาจกลาวไดวา เปนสมมติฐานท่ีใชสถิติ (statistics) ในการทดสอบ 

(Christopher, 2017, p. 146) เชน µ = µ0  หรือ µ ≠ µ0 หรือ µ > µ0 หรือ µ < µ0 

ในการวิจัยเชิงปริมาณท่ีมีการทดสอบสมมติฐาน สมมติฐานทางวิจัยจะถูกแปลงใหเปนสมมติฐาน

ใน 2 ลักษณะ เพ่ือใชเลือกตัดสินใจปฏิเสธหรือยอมรับสมมติฐาน ดังนี้ 

1. สมมติฐานวางหรือสมมติฐานหลัก (Null hypothesis) หรืออาจมีชื่อเรียกเปนอยางอ่ืน เชน 

สมมติฐานกลาง สมมติฐานศูนย และสมมติฐานไรนัยสําคัญ นิยมเขียนเปน Ho หรือ H0 เปนสมมติฐานท่ี

มิไดบงชี้ความแตกตางหรือความสัมพันธ (no relationship) ของตัวแปร หรือเปนประโยคท่ีกลาวถึง 

ความไมแตกตางของประชากร (no difference) ของประชากร หรือเปนประโยคท่ีกลาวถึง ความเทากัน 

(equal) และอาจใชเครื่องหมาย = แทนก็ได เชน ชาวตางชาติท่ีทํางานอยูในนิคมอุตสาหกรรมแหลมฉบัง

และนิคมอุตสาหกรรมมาบตาพุดมีการดําเนินชีวิตประจําวันไมแตกตางกัน หรือ µ = µ0  

2. สมมติฐานทางเลือกหรือสมมติฐานรอง (Alternative hypothesis) หรืออาจมีชื่อเรียกเปน

อยางอ่ืน เชน สมมติฐานอ่ืน สมมติฐานแยง และสมมติฐานท่ีเหลือ นิยมเขียนเปน Ha หรือ H1 เปน

สมมติฐานท่ีระบุความสัมพันธ (a relationship) ของตัวแปร ท้ังในลักษณะมีทิศทางและไมมีทิศทาง  

หรือเปนประโยคท่ีกลาวถึง ความแตกตาง (difference) หรือ ความไมเทากัน (not equal) ของประชากร 

และอาจใชเครื่องหมาย ≠ แทนก็ได เชน ชาวตางชาติท่ีทํางานอยูในนิคมอุตสาหกรรมแหลมฉบังและนิคม

อุตสาหกรรมมาบตาพุดมีการดําเนินชีวิตประจําวันแตกตางกัน หรือ µ ≠ µ0 ชาวตางชาติท่ีเปน
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ชาวตะวันตกปฏิบัติตามวัฒนธรรมไทยนอยกวาชาวตะวันออก หรือ µ < µ0  ชาวตางชาติท่ีเปนชาว

ตะวันออกเดินทางกลับไปเยี่ยมครอบครัวมากกวาชาวตะวันตก หรือ µ > µ0  

บางตําราอธิบายวา สมมติฐานวางหรือสมมติฐานหลักเปนสมมติฐานเชิงสถิติ (statistical 

hypothesis) คือ เปนประโยคท่ีเก่ียวกับคา (value) ของพารามิเตอร (parameter) ของประชากรท่ีไม

ทราบลักษณะของประชากร (unknow population) และเปนสมมติฐานท่ีนักวิจัยกําหนดข้ึนเพ่ือ

พยายามท่ีจะปฏิเสธความชอบ (favor) สวนบุคคลในเชิงวิทยาศาสตร สวนสมมติฐานทางเลือกหรือสมมติ

ฐานรองเปนสมมติฐานเชิงวิจัย (research hypothesis) หรือเปนสมมติฐานเชิงวิทยาศาสตร (scientific 

hypothesis) ท่ีมาจากทฤษฎีหรืองานวิจัยท่ีมีอยูกอนแลว ดังนั้นนักวิจัยจึงพยายามปฏิเสธสมมติฐานวาง

หรือสมมติฐานหลักโดยการหาหลักฐานหรือขอมูลมาสนับสนุน (favor) สมมติฐานท่ีเปนวิทยาศาสตร 

(Hahs-Vaughn & Lomax, 2020, p. 173) 

4. ตัวแปร 

ตัวแปร (variables) เปนแนวคิดท่ีเปนนามธรรมสามารถสังเกต (observable) และวัด 

(measurable) ไดดวยการทําใหแนวคิดสามารถวัดไดดวยตัวแปร (Bouma and Ling, 2004, p. 41) 

ตัวแปรไดมาจากหลายแหลงท้ังแนวคิด ทฤษฎี ปญหาการวิจัย สมมติฐาน การทบทวน

วรรณกรรม งานวิจัยท่ีเก่ียวของ หนวยวิเคราะห (ใคร/อะไร) และการสรางของนักวิจัย (นิยามตัวแปร/

การวิเคราะห) มีตําราท้ังดานการวิจัยและการวิเคราะหขอมูลใหคํานิยามหรือความหมายเก่ียวกับตัวแปร

ไวหลากหลาย จึงนําเอามานําเสนอเปนตัวอยางพอสังเขปดังตอไปนี้  

4.1 ตัวแปร คือ อะไร 

 ตัวแปร คือ คุณลักษณะ (a characteristic) ของสิ่งตาง ๆ (objects) ในการวัด (measurement) 

คุณลักษณะของสิ่งตาง ๆ นั้นสามารถท่ีจะสมมติ (assume) ใหเปนสิ่งใดก็ได (any one) ตามท่ีกําหนดให

เปนผลลัพธ (outcomes) ไวตั้งแตตน เชน เพศ สวนสูง น้ําหนัก เชื้อชาติ สัญชาติ และรายไดของบุคคล 

ผลลัพธท่ีไดจากการวัดคุณลักษณะจากสิ่งประเภทเดียวกันหรือคนกลุมเดียวกันจะมีคาท่ีแตกตางกันในแต

ละสิ่งหรือแตละคน (Traub, 1994, p. 5)  
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 ตัวแปร คือ แนวคิดประเภทหนึ่ง (a type of concept) ซ่ึงมีความแตกตางกัน (vary) ในเรื่อง

ของจํานวน (amount) หรือคุณภาพ (quality) ซ่ึงอาจมากหรือนอย หรืออาจมีความแตกตางกันเปน

ประเภท (categories) ตัวแปรท่ีสนใจไมใชเรื่องของความแตกตางของจํานวนหรือประเภท แตเปนเรื่อง

ของความสามารถในการวัดได (measurable) (Bouma and Ling, 2004, p. 19) 

ตัวแปร คือ ทุกสิ่งท่ีสามารถทําการวัดได (measured) และมีลักษณะหรือคุณสมบัติท่ีแตกตาง

กัน (across entities) หรืออาจเปนสิ่งเดียวกันแตอยูในชวงเวลาท่ีแตกตางกัน (across time) (Field, 

2013) 

อาจกลาวไดวา ตัวแปร คือ สัญลักษณ (symbol) ท่ีนักวิจัยสรางมาจากแนวคิดหรือทฤษฎีเพ่ือ

แทนสรรพสิ่งท่ีตองการศึกษา (objects) และสามารถนําไปนับ คํานวณ และสรุปเปนปริมาณดวยตัวเลข 

กราฟ แผนภูมิ แผนภาพ และคําอธิบาย 

การวัดอาจทําไดโดยตรงจากประสาทสัมผัสของนักวิจัย เชน ตา หู จมูก หรือใชสิ่งประดิษฐเปน

เครื่องมือชวยวัดจากสิ่งท่ีอยูนอกความสามารถการเขาถึงดวยประสาทสัมผัสของมนุษย เชน ดาวเทียม 

กลองจุลทรรศน ยานสํารวจ และอาจตองสรางตัวแปรเทียมโดยอาศัยวัดหลาย ๆ ดัชนีท่ีสามารถสังเกตได 

เชน โครงสรางของสังคม สถาบันทางสังคม ความศรัทธา ความเชื่อ   

4.2 ประเภทตวัแปร 

ตัวแปรไมเพียงแตจําแนกสรรพสิ่ ง ท่ีวัดให มีแตกตางกันเทานั้น ในการทดสอบหรือหา

ความสัมพันธระหวางเหตุ (cause) และผล (outcome) ผูวิจัยยังตองกําหนดใหตัวแปรมีหนาท่ี 

(functions) แตกตางกันไปตามตรรกะและความสัมพันธตามทฤษฎีและสมมติฐาน บางตําราแบงเปน 3 

ประเภท เชน ตัวแปรอิสระ ตัวแปรตาม และตัวแปรคุม แตบางตําราแบงเปน 6 ประเภท เชน  ตัวแปร

อิสระ ตัวแปรตาม ตัวแปรคุม ตัวแปรแทรกแซง ตัวแปรกํากับ และตัวแปรเกินหรือตัวแปรแทรกซอน 

สําหรับในท่ีนี้ไดรวบรวมชื่อตัวแปรท่ีปรากฏในตําราตาง ๆ มาแบงตามลักษณะของการทําหนาท่ี 

ความสัมพันธกับตัวแปรอ่ืน ๆ และการสรางตัวแปร โดยมีรายละเอียดดังตอไปนี้ 

1. กลุมตัวแปรสาเหตุ (Cause Variables) คือ ตัวแปรท่ีผูวิจัยกําหนดใหเปนตนเหตุของ

ปรากฎการณ ซ่ึงมีหลายชื่อ แตชื่อท่ีนิยมใชมากท่ีสุด คือ ตัวแปรอิสระ โดยมีรายละเอียดดังตอไปนี้ 
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1.1 ตัวแปรอิสระ (Independent variable) คือ ตัวแปรท่ีเปนสาเหตุ (cause) ท่ีมีผลกระทบ 

(impact) หรือทําใหเกิดการเปลี่ยนแปลงตอตัวแปรอ่ืน ตัวแปรอิสระนอกจากจะมีชื่อเรียกวา ตัวแปรตน 

เพราะเปนตนเหตุทําใหตัวแปรอ่ืนมีเกิดการเปลี่ยนแปลง 

1.2 ตัวแปรอธิบาย (Explanatory/Explaining variable) หรืออาจรูจักในชื่อวา ตัวแปรตัว

ทํานาย (predictor variable) คือ ตัวแปรอิสระหรือตัวแปรเหตุประเภทหนึ่งท่ีใชอธิบายการเปลี่ยนแปลง

ในตัวแปรตอบสนอง (respond variables) มักใชในการศึกษาเชิงความสัมพันธ (correlational studies) 

การวิเคราะหเชิงทดถอย (regression) และการศึกษาแบบไมทดลอง (non-experimental study) เชน 

ระดับการศึกษาเปนตัวแปรอธิบายรายไดท่ีแตกตางกัน 

1.3 ตัวแปรทดลอง (Treatment variable) เพราะผูวิจัยสามารถกําหนดคาใหกลุมตัวอยางมี

ลกัษณะท่ีแตกตางกันเพ่ือทดลองเปรียบเทียบผลลัพธท่ีเกิดข้ึน เชน การทดสอบความเร็วในการใหบริการ

ดวยระบบอัตโนมัติกับระบบเจาหนาท่ี  

1.4 ตัวแปรถูกจัดการ (Manipulated variable) หากผูวิจัยจัดการหรือกําหนดใหมีคาเพ่ิมข้ึน

หรือลดลง หรือควบคุมใหมีคาคงท่ี (constant) เพ่ือทดลองการเกิดผลลัพธในกระบวนการวิเคราะหหรือ

ทดลอง 

 2. กลุมตัวแปรผล (Result Variables) คือ ตัวแปรท่ีผูวิจัยกําหนดใหแสดงผลของปรากฎการณ 

มีหลายชื่อเชนกัน แตชื่อท่ีนิยมใชมากท่ีสุด คือ ตัวแปรตาม โดยมีรายละเอียดดังตอไปนี้ 

2.1 ตัวแปรตาม (Dependent variable) คือ ตัวแปรท่ีมีคาหรือผลลัพธเปลี่ยนแปลงไปตามตัว

แปรอิสระหรือตัวแปรอ่ืน ๆ อาจมีชื่อเรียกอ่ืน เชน ตัวแปรท่ีถูกอธิบาย (explained variables) ตัวแปร

ถูกทํานาย (predicted variables) รวมถึงมีชื่อเรียกท่ีแตกตางกันไปอีกหลายชื่อดังตอไปนี้ 

2.2 ตัวแปรผลลัพธ (Outcome variable คือ ตัวแปรท่ีแสดงคาท่ีเปนผล (results) หรือ

ผลลัพธ (outcome) ท่ีไดมาจากการศึกษา สวนใหญใชในการศึกษาแบบไมทดลอง (non-experimental 

study) 

2.3 ตัวแปรเกณฑ (Criterion variable) สวนใหญนิยมเรียกในการวิเคราะหตัวแบบเชิงสถิติ 

(statistical modelling) เชน การวิเคราะหถดถอย (regression analysis) การวิเคราะหความแปรปรวน 

(analysis of variance) การวิ เคราะหจํ าแนกกลุ ม  (discriminant analysis) และการวิ เคราะห

สหสัมพันธคาโนนิคอล (canonical correlation) ท่ีกําหนดใหตัวแปรตามเปนตัวแปรท่ีถูกพยากรณ 

(being predicted) ผลลัพธท่ีได (outcome) จะข้ึนอยูกับ (depend on) หลายสาเหตุ 
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2.4 ตัวแปรตอบสนอง (Response variable) เปนชื่อท่ีนิยมเรียกกันในการวิจัยสาขาวิชา

จิตวิทยาท่ีเปนการทดลองเก่ียวกับการแสดงออกของพฤติกรรมเม่ือไดรับการกระตุนโดยสิ่งเรา 

2.5 ตัวแปรภายใน (Endogenous variable) คือ ตัวแปรเชิงสาเหตุท่ีกําหนดข้ึนในระบบหรือ

ตัวแบบเชิงสาเหตุ (a causal model) ท่ีทําการศึกษา เชน การวิเคราะหการถดถอยเชิงเสนตรง (linear 

regression) และมีคาท่ีถูกกําหนดโดยตัวแปรอ่ืน ๆ จึงมีความผันแปรไปตามสาเหตุจากตัวแปรท่ีเปน

ตนเหตุของการเกิดตัวแปร (คลายกับตัวแปรตาม แตไมเหมือนกันท้ังหมด) 

 3. กลุมตัวแปรบริบท (Context Variables) คือ ตัวแปรท่ีผูวิจัยกําหนดใหมีหรือไมมีอิทธิพล 

(influence) ตอความสัมพันธระหวางตัวแปรเหตุกับตัวแปรผล มีหลายชื่อเรียก โดยมีรายละเอียด

ดังตอไปนี้ 

3.1 ตัวแปรคุม (Control variable) คือ ตัวแปรท่ีผูวิจัยไมตองการใหอยูหรือตองกําจัดออกไป

ในการทดสอบความสัมพันธระหวางตัวแปรอิสระและตัวแปรตาม เพ่ือแสดงใหเห็นวาความสัมพันธ

ระหวางตัวแปรอิสระและตัวแปรตามไมไดเกิดจากตัวแปรอ่ืนหรือตัวแปรท่ีนํามาใชเปนตัวแปรคุม ดังนั้น

ตัวแปรคุมจึงมีชื่อเรียกในชื่อ อ่ืน เชน ตัวแปรเกินหรือตัวแปรแทรกซอนหรือตัวแปรภายนอก 

(extraneous variable) หรือตัวแปรรวม (covariate variable) 

3.2 ตัวแปรแทรกแซง (Intervening variable) คือ ตัวแปรท่ีไมสามารถสังเกตไดโดยตรง (not 

direct observable) แตมีความเก่ียวโยง (link) กับตัวแปรอิสระและตัวแปรตาม อาจมีการใชชื่อเรียกอ่ืน 

เชน  ตัวแปรสงผาน (mediating variable) หรือตัวแปรค่ันกลาง (intermediary variable) เชน มี

ความสัมพันธทางสถิติเชิงลบระหวางความเปนเมืองกับขนาดครอบครัว ความเปนเมืองไมใชปจจัยท่ีมีอิทธิ

พตอขนาดครอบครัวเพียงอยางเดียว แตความเปนเมืองมีแนวโนมทําใหคนมีการศึกษาและความรูในการ

วางแผนครอบครัวท่ีดี ทําใหมีบุตรจํานวนท่ีเหมาะสมกับสภาพเศรษฐกิจ ตัวแปรดานการศึกษาและ

เศรษฐกิจ คือ ตัวแปรแทรกท่ีค่ันกลางความสัมพันธระหวางความเปนเมืองกับขนาดครอบครัว หรือ

สถานภาพทางสังคมของพอแมมีผลตอทางตรงตอสถานภาพทางสังคมของลูก แตสถานภาพทางสังคมตัว

แปรท่ีมีผลทางออมตอสถานภาพทางสังคมของลูก คือ การศึกษาของลูก (Parent’s status -> child’s 

education -> child’s status) 

3.3 ตัวแปรค่ันกลาง (Mediator variable) คือ ตัวแปรท่ีมีอิทธิพล (influences) หรือค่ันกลาง

ความสัมพันธ (relation) ระหวาง 2 ตัวแปร และทําใหเกิดกระทบระหวางกัน (interaction effect)  
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3.4 ตัวแปรกํากับ (Moderator variable) หรืออาจมีชื่อเรียกเปนอยางอ่ืน เชน ตัวแปรปรับ 

ตัวแปรขยาย ตัวแปรกลาง คือ ตัวแปรท่ีมีปฏิสัมพันธ (interaction) กับตัวแปรอิสระ และมีผลทําใหเกิด

การเปลี่ยนทิศทางของความสัมพันธระหวางตัวแปรอิสระกับตัวแปรตาม เชน ทฤษฎีบูรณาการการ

ยอมรับและใชเทคโนโลยี (The Unified Theory of Acceptance and Use of Technology: UTAUT) 

เพศ อายุ และประสบการณ เปนตัวแปรค่ันกลางและมีอิทธิพลระหวางตัวแปรอิทธิพลทางสังคม (social 

influence) และความคาดหวัง (effort expectation) กับพฤติกรรมความตั้งใจ (behavioral intention) 

ตัวแปรกํากับอาจเปนตัวแปรแบบคาแบงกลุมหรือตัวแปรแบบคาตอเนื่องก็ได เชน สถานะภาพทาง

เศรษฐกิจและสังคมมีความสัมพันธกับความพรอมดานเทคโนโลยีดิจิทัล ตัวแปรกํากับท่ีเปนตัวแปรแบบ

คาแบงกลุม คือ ระดับการศึกษา หรือตัวแปรกํากับท่ีเปนตัวแปรแบบคาตอเนื่อง คือ รายได 

3.5 ตั วแปรเ กินหรือตัวแปรแทรกซอน (Extraneous variable)  คือ ตั วแปร ท่ีอยู ใน

สภาพแวดลอม (environment) ของการวิจัยแตไมไดทําการควบคุม หรืออาจกลาวไดวา ตัวแปรท้ังหมด

ท่ีไมใชตัวแปรอิสระ และเปนตัวแปรไมไดตั้งใจนํามาศึกษาหรือวิเคราะห แตอาจสงผลหรือไมมีผลตอตัว

แปรตามหรือผลลัพธ ตัวแปรอิสระกับตัวแปรตามอาจไมไดมีความสัมพันธเชิงสาเหตุระหวางกัน แต

ความสัมพันธเกิดจากตัวแปรเกิน เชน ศึกษาความสัมพันธระหวางสถานะภาพทางเศรษฐกิจและสังคมกับ

ความพรอมดานเทคโนโลยีดิจิทัล แตไมไดนําเอาประเภทของสังคมมาศึกษาดวย 

3.6 ตัวแปรพัวพัน/รบกวน (Confounding variable) คือ ตัวแปรภายนอกในแบบจําลองทาง

สถิติ ท่ีไมใชตัวแปรหลักท่ีศึกษา (ตัวแปรอิสระและตัวแปรตาม) และมีอิทธิพลตอตัวแปรอิสระและตัวแปร

ตาม ทําใหความสัมพันธระหวางตัวแปรหลักไมชัดเจน (อาจสูงกวาความเปนจริง) หรือเปนความสัมพันธ

ปลอม เชน คนในชนบทมีและใชเทคโนโลยีดิจิทัลนอยกวาคนในเมือง ปจจัยภายนอกท่ีมีซอนอยูและมี

อิทธิพลตอการมีและการใชเทคโนโลยีดิจิทัลของคนในเมืองและชนบท คือ ความพรอมดานโครงสราง

พ้ืนฐานดานเทคโนโลยีดิจิทัล 

3.7 ตัวแปรภายนอก (Exogenous variable) คือ ตัวแปรปจจัย (factor variables) ในระบบ

หรือตัวแบบเชิงสาเหตุ (a causal model) ท่ีทําการศึกษา คาของตัวแปรเปนอิสระจากตัวแปรท่ีอยู

ภายในระบบหรือตัวแบบ แตถูกกําหนด (determined) จากปจจัยหรือตัวแปรภายนอกระบบหรือตัว

แบบท่ีทําการศึกษา และเปนปจจัยท่ีไมนําเอามาศึกษา ในเชิงสถิติคือตัวแปรท่ีกําหนดไมใหมีความสัมพันธ

กัน (non-correlation) ระหวางตัวแปรภายนอกกับตัวแปรอิสระท่ีอยูภายในระบบหรือตัวแบบ เชน 
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สถานภาพทางเศรษฐกิจและสังคมมีหลายสาเหตุเปนตัวกําหนดสถานภาพทางเศรษฐกิจและสังคมแตไม

นําเอามาเปนปจจัยในการอธิบายดวย เชน ระดับความเปนเมือง ชาติตระกูล มรดก 

4. กลุมตัวแปรจําลอง (Pseudo Variables) คือ ตัวแปรท่ีผูวิจัยสรางหรือกําหนดใหมีคาจากดัชนี

ตาง ๆ เพ่ือทําหนาท่ีเปนตัวแปรเหตุ ตัวแปรผล หรือตัวแปรบริบท โดยมีรายละเอียดดังตอไปนี้ 

4.1 ตัวแปรเสริม (Auxiliary variable) คือ ตัวแปรท่ีชวยใหตัวแปรท่ีมีขอมูลท่ีไมสมบูรณ

สามารถวิเคราะหได เชน การวิเคราะหตัวแปรท่ีมีขอมูลสูญหายตองใชวิธีการรวมตัวแปรเสริมเขาชวย 

หรืออาจสรางตัวแปรพิเศษ (extra variables) เพ่ือใสคาเพ่ิมทําใหการวิเคราะหมีความแมนยําและ

ถูกตองมากข้ึน 

4.2 ตัวแปรเชิงโครงสราง (Construct variable) คือ ตัวแปรท่ีสรางจากแนวคิดหรือทฤษฎี มี

ลักษณะเปนตัวแปรนามธรรม (abstract variables) และไมสามารถสังเกตไดโดยตรง (latent 

variables) 

4.3 ตัวแปรหุน (Dummy variable) คือ ตัวแปรท่ีสรางจากการแปลงคา (recoding) ตัวแปร

แบบคาแบงกลุม (categorial variables) ท่ีมีคาแบงกลุมมากกวา 2 กลุม ใหมี 2 คา (binary data) เพ่ือ

ใชในการวิเคราะหการถดถอย (regression analysis) เชน ตัวแปรท่ีอยู (residence) มีคาตัวแปร 1 = 

เมือง (urban) 2 = ชานเมือง (suburb)  และ 3 = ชนบท (rural) สรางเปนตัวแปรหุนชื่อใหม คือ เขต

บานพักอาศัย (home_area) มีคาตัวแปร 2 คา คือ 1 = เมือง (urban) 0 = ไมใชเมือง (non-urban) 

หรือ 1 = ชนบท (rural) 0 = ไมใชชนบท (non-rural) เพ่ือใชในการวิเคราะหการถดถอย (regression 

analysis) 

4.4 ตัวแปรสังเกตได (Manifest variable) คือ ตัวแปร (variable) หรือปจจัย (factor) ท่ี

สามารถวัด (measured) หรือสังเกตได (observed) โดยตรง และเปนตัวแปรดัชนี (indicator variable) 

สําหรับสรางตัวแปรแฝง (latent variable) เพ่ือใหสามารถทดสอบหรือวัดไดวามีอยูหรือไม เชน สถาบัน

ครอบครัวไมสามารถวัดหรือสังเกตุไดโดยตรงตองวัดหรือสังเกตจากการแตงงาน อํานาจการตัดสนิใจของ

สมาชิกในครอบครัว ขนาดครอบครัว ประเภทครอบครัว สายเลือด 

4.5 ตัวแปรแฝง (Latent variable) คือ ตัวแปร (variable) หรือปจจัย (factor) ท่ีไมสามารถ

วัดหรือสังเกตไดโดยตรง ตองสรางหรืออางอิงจากตัวแปรหรือปจจัยท่ีสามารถสังเกตได เชน ความศรัทธา

ในศาสนาตองสรางหรือวัดจากตัวแปรท่ีสามารถสังเกตได เชน การถือศีล การฟงธรรม การทําบุญ 
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ความหลากหลายของประเภทตัวแปรท่ีจําแนกตามการทําหนาท่ีของตัวแปรท่ีกลาวมาเปนผลมา

จากการแบบการวิจัยและการวิเคราะหขอมูล หากนําตัวแปรดังกลาวมาจัดกลุมใหมสามารถแสดงใหเห็น

ไดดังรูปดานลาง 

 

 

 

 

 

 รูปท่ี 2.1 ความเก่ียวของระหวางตัวแปรเหตุ ตัวแปรผล และตัวแปรบริบท 

การวิเคราะหความสัมพันธระหวางตัวแปรเหตุและตัวแปรผล เปนความพยายามคนหาตนเหตุท่ี

แทจริง หากทราบพฤติกรรมหรือผลกระทบของตัวแปรบริบทแตละตัวแปร จะทําใหกําจัดปจจัยท่ีไม

เก่ียวของออกไดถูกตอง และไดคําตอบท่ีเปนจริง 

4.3 ระดับการวัดของตัวแปร 

ตัวแปรมีความแตกตาง กันอย าง ซับซอนท้ังด านรูปแบบ (forms) และระดับ  (levels) 

ความสัมพันธระหวางการวัดและจํานวนท่ีแสดงไดจากการวัดถูกเรียกวา ระดับการวัด (level of 

measurement) หรือมาตรการวัด (scale of measurement) 

ระดับการวัดตัวแปรมีความเก่ียวของกับเลือกใชประเภทของสถิติเพ่ือการพรรณนา (describe) 

หรือการอางอิง (inference) ไปสูประชากร โดยท่ัวไปนักวิจัยจะใชตัวอักษร (string) หรือเลข (numeric) 

เปนคาในการจัดกลุมหรือจัดประเภท (classify or categorize) จัดตําแหนงหรืออันดับ (rank or order) 

หรือกําหนดใหเปนคะแนนหรืออัตรา (score or rating)  

ใน ป ค.ศ. 1932 ผลของการประชุมของคณะกรรมการของสมาคมความกาวหนาทาง

วิทยาศาสตรแหง สหราชอาณาจักร (The British Association for the Advancement of Science) 

ท่ีประกอบไปดวยนักคณิตศาสตร นักฟสิกส และนักจิตวิทยา ไดเกิดประเด็นคําถามวา “มันเปนไปได

กลุมตัวแปรเหตุ 

กลุมตัวแปรจําลอง (เชิงสาเหตุ) 

กลุมตัวแปรผล 

กลุมตัวแปรจําลอง (เชิงผลลัพธ) 

กลุมตัวแปรบริบท 

ตัวแปรคุม 

ตัวแปรแทรกแซง 

ตัวแปรกํากับ 

ตัวแปรกวน 

ตัวแปรเกนิ/แทรกซอน 

ความสัมพันธ 
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หรือไมท่ีจะวัดความรูสึกของมนุษย?” ทําใหตองมีการประชุมเพ่ือถกเถียงกันอยางตอเนื่องยาวนานถึง 7 

ป จึงไดขอสรุปในป ค.ศ. 1940 วา การวัดสามารถแบงไดเปน 2 ประเภท คือ การวัดดวยวิธีการเชิง

ประจักษ (empirical operations) และการวัดท่ีเปนมาตราตามหลักคณิตศาสตร (mathematical) 

ตอมาในป ค.ศ. 1946 สแตนลี่ย สมิทธิ์ สตีเวนส (Stanley Smith Stevens) จึงเสนอแนวคิดในการ

แบงกลุมมาตราการวัดเปน 4 ประเภท โดยมาตราสวนการวัดแตละประเภทจะมีคุณลักษณะและประเภท

ท่ีแตกตางกันไปตามการนิยามจากขอมูลเชิงประจักษ ดังนี้ (Stevens, 1946; Osborn, 2008, p. 50-51) 

1. มาตราสวนแบบจัดกลุม (Nominal scale) คือ ตัวแปรท่ีกําหนดใหสิ่งท่ีศึกษา (objects) มี

ลักษณะเปนฉลากหรือชื่อ (label) ท่ีเปนคําท่ีสามารถนับจํานวนได (numeral) เชน เพศ อาชีพ ศาสนา 

ภูมิลําเนา เขตท่ีอยูอาศัย 

2. มาตราสวนแบบจัดอันดับ (Ordinal scale) คือ ตัวแปรท่ีกําหนดใหสิ่งท่ีศึกษา (objects) มี

ลักษณะเปนอันดับตําแหนง (rank order) ท่ีเปนคําท่ีสามารถนับจํานวนได (numeral) เชน ระดับ

การศึกษา (ประถม มัธยมศึกษา และอุดมศึกษา) ระดับรายได (นอย ปานกลาง และมาก) ชนชั้น (ต่ํา 

กลาง และสูง)  

3. มาตราสวนแบบชวง (Interval scale) คือ ตัวแปรท่ีไดจากการวัดวัตถุใหมีขนาดจํานวนท่ี

เทากัน (same amount) และกําหนดเปนตัวเลข (numerical) ท่ีแตกตางกัน เพ่ือแสดงใหเห็นสิ่งท่ีศึกษา

มีปริมาณท่ีแตกตางกัน เชน ข้ันเงินไดในการเสียภาษี 0-150,000 (0%), เกิน 150,000-300,000 (5%), 

เกิน 300,000-500,000 (10%), เกิน 500,000-750,000 (15%), เกิน 7500,000-1,000,000 (20%), เกิน 

1,000,000-2,000,000 (25%), เกิน 2,000,000-5,000,000 (30%) และเกิน 5,000,000 บาท ข้ึนไป 

(35%) 

4. มาตราสวนแบบอัตราสวน (Ratio scale) คือ ตัวแปรท่ีมีการวัดเหมือนกับชวงมาตรา แตมี

มาตราวัดท่ีเปนศูนยแท (absolute zero) เชน อายุ เงินเดือน น้ําหนัก สวนสูง คะแนนสอบ 

ปจจุบันมาตราสวนการวัดของ สตีเวนส ถูกนํามาใชอยางแพรหลายท้ังการวิจัยดานวิทยาศาสตร

และสังคมศาสตร แตในการวิจัยของแตละสาขามีธรรมชาติของการวัดและการใชมาตราสวนการวัดท่ี

แตกตางกัน เชน การสังเกตของนักวิทยาศาสตรกายภาพสวนใหญขอมูลเปนมาตราสวนแบบอัตราสวน 

(น้ําหนัก สวนสูง ความเร็ว) สวนการสังเกตของนักสังคมศาสตรสวนใหญขอมูลเปนมาตราสวนแบบจัด
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อันดับ (ทัศนคติ ความฉลาด สมรรถนะ) นอกจากท่ีกลาวมาในเอกสาร ตํารา และงานวิจัยตาง ๆ มีการ

แบงมาตราสวนการวัดของตัวแปรในมิติตาง ๆ ดังนี้ 

1. ตัวแปรแบบคาจัดประเภท (Categorical variable) เปนตัวแปรท่ีมีคาท่ีแบงออกจากกันอยาง

เด็ดขาดหรือแบงเปนกลุมประเภทอยางชัดเจน ไดแก ตัวแปรแบบจัดกลุม (nominal variable) และตัว

แปรแบบจัดอันดับ (ordinal variable) 

2 ตัวแปรแบบคาตอเนื่อง (Continuous variable) เปนตัวแปรท่ีมีคาท่ีมีความตอเนื่องกัน 

(continuous) ไดแก ตัวแปรแบบชวง (interval variable) และตัวแปรแบบอัตราสวน (ratio variable)  

3. ตัวแปรแบบคาไมตอเนื่อง (Discontinuous variable) เปนตัวแปรท่ีมีการแบงคาเปนกลุม 

ไดแก ตัวแปรแบบจัดกลุม ตัวแปรแบบจัดอันดับ ตัวแปรแบบทวิลักษณะ (binary variables) และตัว

แปรแบบคาวิมุต (discrete variable) 

4. ตัวแปรแบบคาสองประเภท (Dichotomous variable) เปนตัวแปรท่ีมีคาแบงกลุม 2 กลุม 

ไดแก ตัวแปรแบบสองประเภท/ทวิลักษณะ (binary variables) และตัวแปรแบบคาวิมุต/ไมตอเนื่อง 

(discrete variable) รวมถึงตัวแปรแบบจัดกลุมท่ีมีคาแบงกลุม 2 กลุม  

5. ตัวแปรแบบคาทวิลักษณะ (Binary variable) มีลักษณะเปนท้ังตัวแปรแบบจัดกลุม ตัวแปร

แบบจัดอันดับ และตัวแปรแบบคาไมตอเนื่อง คาของตัวแปรมีลักษณะเปนคําหรือขอความ (string) ท่ีมี

ลักษณะตรงขามหรือเปนสิ่งท่ีอยูคูกัน เชน ชาย/หญิง เมือง/ชนบท ไมใช/ใช ผิด/ถูก ไมสําเร็จ/สําเร็จ 

หรือเปนเลขท่ีมีคาไมตอเนื่องกันแตสามารถนับได (counting) เชน 0 กับ 1 

6. ตัวแปรแบบคาวิมุต (Discrete variable) มีลักษณะเปนท้ังตัวแปรแบบคาตอเนื่องและตัวแปร

แบบทวิลักษณะ คาของตัวแปรมีลักษณะเปนตัวเลข (numeric) แบบจํานวนเต็ม (integer) ท่ีสามารถ

คํานวณได (calculated) เชน 0 กับ/ถึง 1 หรือเปนตัวแปรสองประเภทท่ีแปลงคามาเปนคะแนน 0 กับ 1 

เชน 0 ไมใชชาย กับ 1 = ชาย หรือ 0 = ไมใชเมือง กับ 1 = เมือง 

7. ตัวแปรแบบคาหลายประเภท (Polychotomous variable) เปนตัวแปรแบบจัดประเภท 

(categorical variable) ท่ี มีคาของตัวแปรมากกวา 2 คา จึงเปนประเภทตัวแปรท่ีมีคุณลักษณะ

ครอบคลุมตัวแปรแบบแบงกลุมเกือบทุกประเภท ยกเวนตัวแปรแบบทวิลักษณะ (binary variables) 

การแบงประเภทตัวแปรตามระดับการวัดหรือมาตราการวัดตามท่ีกลาวมา ข้ึนอยู กับ

วัตถุประสงคหรือวิธีการของการจําแนก จึงทําใหเห็นลักษณะของตัวแปรในหลายมิติ แตในกระบวนการ
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ในการวิเคราะหขอมูลดวยโปรแกรมคอมพิวเตอรตองบอกใหโปรแกรมหรือคอมพิวเตอรรูวา แตละตัวแปร

เปนตัวแปรแบบตัวอักษร (string variables) หรือตัวแปรแบบตัวเลข (numeric variables) เพราะตัว

แปรแตละประเภทตองใชวิธีการประมวลผลในการคํานวณท่ีเหมาะสมตามหลักสถิติ คือ ตัวแปรแบบ

ตัวอักษรตองใชการนับ (counting) ไมสามารถนําไปคํานวณหาคาเฉลี่ย (mean) สวนตัวแปรแบบตัวเลข

อาจใชการนับหรือการหาคาเฉลี่ยก็ได ดังนั้นจึงควรทําความเขาใจและจัดตัวแปรในทุกระดับการวัดใหเปน 

2 กลุมตัวแปร ดังตารางดานลาง 

ตารางท่ี 2.1 ประเภทตัวแปรแบบตัวอักษรและตัวแปรแบบตัวเลข 

ตัวแปรแบบตัวอักษร (String Variables) ตัวแปรแบบตัวเลข (Numeric Variables) 

ตัวแปรเชิงคุณภาพ/คุณลักษณะ 

(qualitative variables) 

ตัวแปรเชิงปริมาณ 

(quantitative variables) 

ตัวแปรแบบคาจัดประเภท 

(categorical variables) 

ตัวแปรคาตอเนื่อง 

(continuous variables) 

ตัวแปรมาตราแบบจัดกลุมและจัดอันดับ 

(nominal scale and ordinal scale variables) 

ตัวแปรมาตราแบบชวงและอัตราสวน 

(interval scale and ratio scale variables) 

ตัวแปรแบบคาวิมุต 

(discrete variables) 

ตัวแปรแบบคาวิมุต  

(discrete variables) 

ตัวแปรแบบคาสองประเภทและตัวแปรแบบคาทวิลักษณะ 

(dichotomous and binary variables) 

 

ตัวแปรแบบคาหลายประเภท  

(polychotomous variables) 

 

 

การแบงประเภทการวัดของตัวแปรตามท่ีกลาวมามีความเก่ียวของกับการตัดสินใจเบื้องตนใน

การเลือกใชสถิติแตละประเภทในการวิเคราะหขอมูล การเขาใจและสามารถแบงประเภทการวัดของตัว

แปรไดถูกตองจะทําใหการเลือกใชสถิติถูกตองกอนทําตรวจสอบลักษณะของขอมูลตามขอตกลงเบื้องตน

ของสถิติแตละประเภทในข้ันตอไป 
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5. ความสัมพันธระหวางสมมติฐานและตัวแปร 

 ทฤษฎีมีความเปนนามธรรมมาและกลาวถึงความสัมพันธระหวางปรากฎการณแบบกวาง ๆ การ

ลดทอนทฤษฎีมาสรางเปนสมมติฐานในรูปแบบของความสัมพันธระหวางตัวแปรสามารถแบงรูปแบบของ

ความสัมพันธไดดังตอไปนี้ 

1. ความสัมพันธเชิงสาเหตุ (Causal relationship) เปนความสัมพันธท่ีตัวแปรเหตุและตัวแปร

ผลมีการเปลี่ยนแปลงไปในทิศทางเดียวกัน เม่ือตัวแปรเหตุมีคาเพ่ิมข้ึน ตัวแปรผลจะเปลี่ยนคาเพ่ิมข้ึนตาม

ไปดวย 

 
ความยากจนเปนสาเหตุของความเหลื่อมล้ําดานดิจิทัล 

H0 = ความยากจนไมใชสาเหตุของความเหลื่อมล้ําดานดิจิทัล 

H1 = ความยากจนเปนสาเหตุของความเหลื่อมล้ําดานดิจิทัล 

2. ความสัมพันธเชิงผกผัน (Inverse causal relationship) เปนความสัมพันธในรูปของตัวแปร

เหตุมีคาเพ่ิมข้ึนหรือลดลง ตัวแปรตามจะคาเปลี่ยนไปในทางตรงขาม คือ ตัวแปรเหตุมีคาเพ่ิมข้ึน ตัวแปร

ผลจะเปลี่ยนคาลดลง แตถาตัวแปรเหตุมีคาลดลง ตัวแปรผลจะเปลี่ยนคาเพ่ิมข้ึน 

 

ระดับการศึกษาเปนสาเหตุของความเหลื่อมล้ําดานดิจิทัล 

H0 = ระดับการศึกษาไมใชสาเหตุของความเหลื่อมล้ําดานดิจิทัล 

ความยากจน 

ความ 

เหลื่อมล้ําดาน

ดิจิทัล 

ความ 

เหลื่อมล้ําดาน

ดิจิทัล 

 

ระดับการศึกษา 
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H1 = ระดับการศึกษาเปนสาเหตุของความเหลื่อมล้ําดานดิจิทัล 

3. ความสัมพันธเชิงหลายสาเหตุ (Multiple-cause relationship) เปนความสัมพันธของตัว

แปรผลท่ีเกิดมาจากหลายสาเหตุและอาจมีทิศทางท่ีไมเหมือนกัน 

 

มีหลายสาเหตุรวมกันท่ีทําใหเกิดความเหลื่อมล้ําดานดิจิทัล 

H0 = ความยากจน การศึกษา และอายุ ไมใชสาเหตุรวมกันของการเกิดความเหลื่อมล้ําดานดิจิทัล 

H1 = ความยากจน การศึกษา และอายุ เปนสาเหตุรวมกันของการเกิดความเหลื่อมล้ําดานดิจิทัล 

สรุป 

 การวิจัยเชิงปริมาณเปนวิธีหาความรูท่ีเนนการวัดและการวิเคราะหขอมูลท่ีเก็บรวบรวมมาแลว

นิยมทําใหเปนรหัสในรูปแบบของตัวเลขสําหรับนําไปวิเคราะหดวยวิธีการทางสถิติ โดยการนําเอาทฤษฎี

มาลดทอนเปนสมมติฐานหรือชุดตัวแปรขนาดเล็กท่ีสามารถทําการทดสอบไดดวยขอมูลเชิงประจักษ ใช

ตัวแปรสรางเปนเครื่องมือวัด และรวบรวมขอมูลจากประชากรหรือกลุมตัวอยาง และทําการสรุปขอมูล

ดวยสถิติ เพ่ือพรรณนา อธิบาย หาความสัมพันธ ทํานายปรากฏการณทางสังคม และนําผลการวิจัยไป

กําหนดเปนนโยบายหรือตัดสินใจแกไขปญหาในสังคม หรืออาจเปนเพียงการทดสอบสมมติฐานเพ่ือ

สนับสนุนหรือปฏิเสธทฤษฎีเทานั้น 

ระดับ

การศึกษา 

อาย ุ

ความ 

เหลื่อมล้ํา

ดานดิจิทัล 

ความ

ยากจน 
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แบบฝกหัดทายบท 

ใหผูเรียนคนหางานวิจัยเชิงปริมาณดานสังคมศาสตรจากฐานขอมูลของหองสมุดท่ีสนใจ แลว

ตอบคําถาม ดังนี้ 

1. งานวิจัยท่ีคนได มีทฤษฎีอะไรบาง 

2. งานวิจัยท่ีคนได สมมติฐานประเภทใด 

3. งานวิจัยท่ีคนได เขียนสมมติฐานแตละประเภทไววาอยางไร 

4. ทดลองเขียนสมมติฐานเชิงสถิติท้ังสมมติฐานหลักและสมมติฐานรองจากงานวิจัยท่ีคนได 

5. ทดลองเขียนสมมติฐานเพ่ือทดสอบแบบหางเดียวและสองหางจากงานวิจัยท่ีคนได 

6. งานวิจัยท่ีคนได มีตัวแปรอะไรบาง และแตละตัวแปรมีระดับการวัดแบบใด 

  





 

 

บทที่ 3 

สถิติสําหรับการวิจัย 

ความมุงหมายของบทเรียน 

ผูเรียนเขาใจและเลือกใชสถิติแตละประเภทในการวิเคราะหและทดสอบขอมูลไดถูกตองและ

เหมาะสม 

เน้ือหา 

1. สถิติ 

2. ความสัมพันธระหวางขอมูลกับสถิติ 

3. การทดสอบสมมติฐาน 

4. ความคลาดเคลื่อนของผลการวิจัย 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย แสดงตัวอยาง ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรมสอนออนไลน (สอนแบบออนไลน) เครือ่งฉาย 

(สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และการ

ทําแบบฝกหัดทายบท 
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เนื้อหา 

ชวงปลายคริสตศตวรรษท่ี 17 เริ่มมีการใชคําวา ความนาจะเปน (probability) จนถึงตน

คริสตศตวรรษท่ี 19 คําวา โอกาส (chance) นาจะเริ่มครอบงําโลก นักวิทยาศาสตรสมัยใหมยุคแรก ๆ ไม

มีการใชสถิติและกอนทศษวรรษท่ี 1840 ก็ไมมีสิ่งท่ีบงบอกใหเห็นถึงเรื่องการวัด (measurement) จนถึง

ประมาณกลางศตวรรษท่ี 19 เปนตนมา สถิติ (statistics) ถูกนํามาใชโดยรัฐ (state) และเริ่มเขามามี

บทบาทในวิทยาศาสตรธรรมชาติ (natural science) รวมถึงสังคมศาสตรสมัยใหม (Williams, 2016, p. 

210-211) 

1. สถิต ิ

สถิติเปนเรื่องเก่ียวกับการรวบรวม (collection) การวิเคราะห (analysis) และแปลความหมาย 

(interpretation) ขอมูลท่ีเปนตัวเลข รวมถึงเปนเครื่องมือเชิงประจักษ (empirical tool) และเครื่องมือ

เชิงญาณวิทยา (epistemology tool) เพราะทําใหเราสามารถใชอธิบาย (explain) และทํานาย 

(predict) สิ่งตาง ๆ ในโลกนี้ได หากเราไมมีสถิติเราก็ไมสามารถท่ีจะอธิบายหรือทํานายได 

1.1 ความหมายของสถติ ิ

สถิติ (statistics) คือ การรวมกลุมของขอมูลเชิงตัวเลข (numerical data) ท่ีไดมาจากการ

สํารวจทางสังคม (social survey) หรือการสํามะโน (census) (Jary and Jary, 1995, p. 654)  

สถิติ คือ วิธีการหนึ่งทางคณิตศาสตร (a set of mathematical techniques) ท่ีใชในการ

จัดการ (organize) และเปลี่ยนแปลง (manipulate) ขอมูลเพ่ือนําไปใชตอบคําถามและทดสอบทฤษฎี 

(Healey, 1999, p. 1) 

สถิติ คือ วิธีการหนึ่งทางคณิตศาสตร (a set of mathematical procedure) ท่ีใชในการสรุป 

(summarizing) และตีความ (interpreting) ขอมูลท่ีไดมาจากการสังเกต (observation) (Pelham, 

2013, p. 5) 
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สถิติ คือ ศาสตร (science) ในการรวบรวม (collecting) การจัดการ (organizing) การวิเคราะห 

(analyzing) และการตีความ (interpreting) ขอมูลเพ่ือใชในการตัดสินใจ (making decisions) (Larson 

and Farber, 2015, p. 22) 

สถิติเปนคําท่ีมีสองความหมาย ความหมายแรก คือ การอธิบาย (describing) ขอมูลของ

ปรากฏการณใดปรากฎการณหนึ่ง และความหมายท่ีสอง คือ การรวบรวม (collecting) และการ

วิเคราะห (analyzing) ขอมูล (Greenfield and Greener, 2016, p. 289)  

นิยามในเชิงการวิจัย สวนใหญอธิบายวา สถิติ คือ คาสรุปรวมท่ีคํานวณมาจากลักษณะหรือตัว

แปรของตัวอยาง เพ่ือนําไปใชบรรยาย (describe) คุณลักษณะ (characteristic) ของตัวอยาง (sample) 

และอางอิง (inference) ไปยังประชากร (population) 

1.2 ประเภทของสถิต ิ

โดยท่ัวไปและตําราหลายเลมแบงประเภทสถิติตามเทคนิคทางสถิติเปน 3 ประเภท คือ สถิติเชิง

พรรณนา สถิติเชิงอางอิง และสถิติเชิงความสัมพันธและทํานาย (Healey, 1999, p. 259-260; Field, 

2009, p. 540; Yang, 2010, p. 7; Evans, 2014, p. 2-5) ดังนี้ 

1. สถิติเชิงพรรณนา (Descriptive statistic) คือ สถิติสาขาหนึ่งท่ีมีวัตถุประสงคในการใช

บรรยาย (describes) ลักษณะของขอมูลพ้ืนฐานของสิ่งท่ีใชในการศึกษา โดยใชวิธีสรุป (summary 

indictors) หรือลดจํานวนขอมูลขนาดใหญจากกลุมตัวอยางหรือการวัดใหอยูในรูปของดัชนีหรือคาสรุป

ขนาดเล็กท่ีมีความกระชับหรือสามารถเขาใจได ไมสามารถนําผลไปอางอิงหรือพยากรณคาของกลุมอ่ืน ๆ 

เชน จากการศึกษารายจายตอเดือนของประชาชนในชุมชนแหงหนึ่ง พบวา จากประชาชนท่ีสุมมาท้ังหมด 

100 คน มีรายจายรายเดือนเฉลี่ยคนละ 3,500 บาท โดยท่ัวไปมีการแบงเปน 5 ประเภท ดังนี้ 

    1.1 การวัดการแจกแจงความถ่ี (Frequency distribution) ไดแก คาความถ่ี (frequency) 

คาจํานวนนับ (count) และคารอยละ (percentage) 

    1.2 การวัดแนวโนมสูสวนกลาง (Central tendency) ไดแก คาฐานนิยม (mode) คามัธย

ฐาน (median) และคาเฉลี่ย (mean) 

    1.3 การวัดการกระจายหรือความผันแปร (Dispersion/Variation) ไดแก คาพิสัย (range) 

คาสวนเบี่ยงเบนมาตรฐาน (standard deviation) คาความแปรปรวน (variance) คาสัมประสิทธิ์ความ
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แปรปรวน (coefficient of variation) คาสวนเบี่ยงเบนควอไทล (quartile deviation) คาสวนเบี่ยงเบน

เฉลี่ย (mean or average deviation) และคาพิสัยระหวางควอไทล (interquartile range) 

    1.4 การวัดตําแหนง (Position/Location) ไดแก คาควอไทล (quartiles) คาเดไซล (decile) 

คาเปอรเซ็นไทล (percentiles) คา N-ไทล (N-tiles) และคะแนนมาตรฐาน (standardized scores: z-

scores) 

    1.5 การวัดรูปราง (Shape) ไดแก คาความเบ (skewness) และคาความโดง (kurtosis) 

 สถิติเชิงพรรณนานอกจากจะใชในการสรุป (summarize) หรือบรรยาย (describe) การแจก

แจงขอมูลของตัวแปรเดียวแลว ยังสามารถใชวัดความสัมพันธ (measures of association) ระหวาง 2 

ตัวแปรหรือมากกวา เพ่ือทดสอบนัยสําคัญทางสถิติ (statistical significance) ในการตอบคําถามเทานั้น 

แตไมสามารถบอกไดวาตัวแปรหนึ่งเปนสาเหตุ (causes) ของอีกตัวแปรหนึ่ง เชน การทดสอบดวยวิธีไค-

สแควร (Chi-square Test) แบบฟ (Phi) แบบแครมเมอร วี (Cramer’s V) แบบแลมดา (Lambda) แบบ

แกรมมา (Gamma) การทดสอบความสัมพันธแบบสเปยรแมน (Spearman) การทดสอบแบบถดถอย 

(Regression) และการทดสอบความสัมพันธแบบเพียรสัน (Pearson) (Healey, 2013, p. 6-8, 277-

364).  

2. สถิติเชิงอางอิง (Inferential statistic) คือ สถิติกลุมตัวแบบเชิงเสนท่ัวไป (general linear 

models) ท่ีคํานวณขอมูลจากกลุมตัวอยางหนึ่งกลุมตัวอยาง หรือมากกวาหนึ่งกลุมตัวอยาง แลวให

คาสถิติ (เชน คาเฉลี่ยของประชากรท้ังหมด) ท่ีสามารถใชอางอิงหรือทํานายลักษณะ (characteristics)  

ของประชากร เพ่ือตัดสินใจเชิงความนาจะเปน (probability) เชน จากประชาชนท่ีสุมมาท้ังหมด 100 

คน มีรายจายรายเดือนเฉลี่ยคนละ 3,500 บาท และโดยอาศัยทฤษฎีความนาจะเปน ทําการประมาณ

รายจายโดยเฉลี่ยรายเดือนของประชาชนท้ังหมดในชุมชนไดเปนระหวาง 3,300 และ 3,700 บาท 

โดยท่ัวไปมีการแบงเปน 2 ประเภท ดังนี้ 

   2.1 การทดสอบแบบอิงคาพารามิเตอร (Parametric test) คือ สถิติ ท่ีมีคาตัวเลขหรือ

พารามิเตอรของประชากรท่ีใชในการอางอิงไปสูคุณลักษณะของประชากร ขอตกลงเบื้องตนขอมูลท่ีใชใน

การวิเคราะหมีระดับการวัดเปนแบบคาตอเนื่อง ไดแก ชวงมาตรา (interval) และสัดสวนมาตรา (ratio) 

และขอมูลมีการแจกแจงปกติ (normal distribution) เชน การทดสอบคาเฉลี่ยของกลุมตัวอยาง 1 กลุม 

(One-sample t-test) การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีอิสระจากกัน 2 กลุม (Two-independent 

samples t-test) การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม (การทดสอบ
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ความแปรปรวนแบบทางเดียว: One-way ANOVA) การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีไมอิสระจาก

กัน 2 กลุม (Two-dependent sample t-test) การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีไมอิสระจากกัน

มากกวา 2 กลุม หรือท่ีเรียกวา การทดสอบความแปรปรวนแบบวัดซํ้า (Repeated Measures ANOVA) 

การทดสอบความแปรปรวนแบบสองทาง (Two-way ANOVA) การทดสอบความสัมพันธรายคูแบบเพียร

สันหรือการทดสอบสหสัมพันธแบบเพียรสัน (Pearson Correlation) การทดสอบการถดถอยเชิงเสนตรง 

(Linear Regression) การวิเคราะหองคประกอบ (Factor Analysis) และการวิเคราะหตัวแปรพหุ 

(Multivariate Analysis)7 

   2.2 การทดสอบแบบไมอิงคาพารามิเตอร (Non-parametric test) คือ สถิติท่ีไมมีคาตัวเลข

หรือพารามิเตอรของประชากรท่ีใชในการอางอิงไปสูคุณลักษณะของประชากร จึงทําใหบางตําราจัด

รวมอยูในกลุมของสถิติเชิงพรรณนา ขอมูลท่ีใชในการวิเคราะหมีระดับการวัดเปนแบบขอมูลแบงกลุม 

ไดแก มาตราแบบจัดกลุม (nominal scale) และจัดอันดับ (ordinal/rank-order scale) บางตําราอาจ

เรียกสถิติประเภทนี้วา การทดสอบท่ีมีการแจกแจงแบบอิสระ (distribution-free test)8 หรือ การ

ทดสอบท่ีเปนอิสระจากขอตกลง (assumption-free test) เพราะสถิติท่ีใชทดสอบขอมูลอาจมีขอตกลง

เพียงเล็กนอยหรือไมมีขอตกลงเลยเก่ียวกับลักษณะการแจกแจงของขอมูล (data distributions) เชน 

การทดสอบความสอดคลองของขอมูลดวยไค-สแควร (X2 goodness of fit) การทดสอบความเปนอิสระ

ของขอมูลดวยไค-สแควร (X2 Test for Independence) การทดสอบคากลางของขอมูล 1 กลุมตัวอยาง 

(One-sample Test) การทดสอบคากลางของกลุมตัวอยางท่ีมีความสัมพันธกัน (2 Related Samples 

Test) การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกัน (Independence Sample Test) การ

ทดสอบสหสัมพันธแบบสเปยรแมน (Spearman Correlation Test) การวิเคราะหการถดถอยแบบไมอิง

คาพารามิเตอร (Non-parametric Regression Analysis) และการวิเคราะหพหุแบบไมอิงคาพารามิเตอร 

(Non-parametric Multivariate Analysis)9 

                                                           
7 การวิเคราะหที่มีเง่ือนไขตองใชตัวอยางขนาดใหญและขอมูลมีการแจกแจงแบบปกติ เชน ตัวแบบสมการโครงสรางแบบใชคาความ

แปรปรวนรวม (Covariance Based Structural Equation Modeling: CB-SEM) ที่เนนการวิเคราะหเชิงยืนยัน (Awang, Afthanorhan, 

& Asri 2015) 
8 เปนการทดสอบที่ขอมูลมีลักษณะการแจกแจงแบบใดก็ได หรืออาจเรียกวา การทดสอบที่ไมมีขอตกลงหรือการทดสอบที่เปนอิสระจาก

ขอตกลง  (free assumption) 
9 การวิเคราะหที่สามารถใชตัวอยางขนาดเล็กและขอมูลมีการแจกแจงแบบอิสระ เชน การวิเคราะหตัวแบบสมการโครงสรางแบบใชคาความ

แปรปรวน (Variance Based Structural Equation Modeling: VB-SEM) ที่เนนการวิเคราะหเชิงสํารวจ (exploratory analysis) 

(Awang, Afthanorhan and Asri 2015)  
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3. สถิติเชิงความสัมพันธและการทํานาย (Correlational and predictive statistic) คือ สถิติท่ี

ใชในการบอก/พรรณนา (describing) ความสัมพันธระหวางเหตุการณตาง ๆ หรือทํานายจากเหตุการณ

หนึ่งไปสูอีกเหตุการณหนึ่ง โดยมีรายละเอียด ดังนี้ 

   3.1 สถิติเชิงความสัมพันธ เปนเครื่องมือท่ีใชในการวัดความเขมขน (strength) และทิศทาง 

(direction) ของความสัมพันธ (relationships) โดยรวมระหวาง 2 ชุดหรือกลุมขอมูลท่ีไดจากการสังเกต 

เชน ความสัมพันธระหวางความยากจนกับอาชญากรรม และนําไปใชในเชิงการอางอิงจากกลุมตัวอยาง

ไปสูกลุมประชากร ไดแก การวิเคราะหสหสัมพันธแบบเพียรสัน (Pearson Correlation) และการ

วิเคราะหสหสัมพันธแบบสเปยรแมน (Spearman Correlation) 

   3.2 สถิติเชิงการทํานาย เปนเครื่องมือท่ีใชในการทํานาย (prediction) ผลลัพธของเหตุการณ

หนึ่งจากอีกเหตุการณหนึ่ง เชน การทํานายความพรอมดานเทคโนโลยีสารสนเทศและการสื่อสารจาก

สถานะภาพทางเศรษฐกิจและสังคม การทํานายจะมีความถูกตองมากนอยเพียงใดข้ึนกับวาขอมูลท่ีไดมา

จากการสังเกตมีความสัมพันธกันมากนอยเพียงใด ไดแก การวิเคราะหการถดถอยเชิงเสนตรง (linear 

regression) และการวิเคราะหการถดถอยเชิงโลจิสติก (logistic regression) 

จากท่ีกลาวมาแสดงใหเห็นวา สถิติท่ีใชในการวิเคราะหขอมูลแตละประเภทมีความคาบเก่ียวกัน 

การจําแนกประเภทตองบอกหลักเกณฑใหชัดเจน เพราะสถิติเชิงความสัมพันธและเชิงการทํานายยัง

สามารถจําแนกไดเปน 2 ประเภท คือ สถิติแบบอิงคาพารามิเตอรและสถิติแบบไมอิงคาพารามิเตอร หรือ

สถิติเชิงพรรณนาสามารถจัดเปนสถิติแบบไมอิงคาพารามิเตอรไดเชนกัน เนื่องจากเปนสถิติท่ีใชพรรณนา

เฉพาะกลุมตัวอยางหรือประชากรเทานั้น โดยไมอางอิงจากกลุมตัวอยางไปสูประชากร 

2. ความสมัพันธระหวางขอมูลกับสถิต ิ

พยานหลักฐานท่ีใชในการวิจัยท่ีเรียกวา “ขอมูล” (อารง สุทธาศาสน และวิภาส ทองสุทธิ์, 2563, 

น. 12) มีหลายระดับการวัด หากเปนขอมูลแบบเมตริก (metric data) เปนคาตอเนื่อง (continuous 

data) เชน อายุ เงินเดือน น้ําหนัก สวนสูง สามารถนําไปคํานวณหาคาเฉลี่ยได แตการวิจัยดาน

สังคมศาสตรสวนใหญขอมูลเปนแบบไมใชเมตริก (nonmetric data) โดยเฉพาะขอมูลแบบคาจัด

ประเภท (categorical data) เชน เพศ วัย เขตท่ีอยูอาศัย ไมสามารถนําไปคํานวณหาคาเฉลี่ยได

เหมือนกับขอมูลแบบเมตริก ตองใชคาความถ่ีหรือคารอยละ  
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สถิติแตละประเภทมีขอตกลงเบื้องตน (basic assumptions) ในการวิเคราะหขอมูลแตละ

ประเภท หากฝนขอตกลง (violate assumptions) มีความเสี่ยงทําใหเกิดความคลาดเคลื่อนของผลการ

วิเคราะหและนําไปสูการตีความผิดตามมา 

2.1 ขอมูลกบัสถิติเชิงพรรณนา  

การบรรยายลักษณะทางประชากรของกลุมตัวอยางมีขอตกลงเก่ียวกับขอมูลเชนกัน การเลือกใช

สถิติวัดแนวโนมเขาสูสวนกลางและการกระจายมีแนวทางในการเลือกใชสถิติใหตรงกับขอตกลงดังตาราง

ดานลาง (Verma, & Abdel-Salam, 2019, p. 3-4) 

ตารางท่ี 3.1 ความสัมพันธระหวางประเภทขอมูลกับสถิติเชิงพรรณนา 

ประเภทของขอมูล ลักษณะของขอมูล แนวโนมสูสวนกลาง การกระจาย 

ไมใชเมตริก  

(จัดประเภท) 

จัดกลุม คาฐานนิยม คาความถ่ี/คารอยละ 

จัดอันดับ คามัธยฐาน คาพิสัย 

เมตริก  

(ตอเนื่อง) 

ชวง/อัตราสวน  

(ถามีการแจกแจงแบบปกติหรือ

ใกลเคียง) 

คาเฉลี่ย 
คาเบี่ยงเบน

มาตรฐาน 
ชวง/อัตราสวน  

(ถามีการแจกแจงแบบเบ) 
คามัธยฐาน 

2.2 ขอมูลกบัสถิติเชิงอางอิง  

ขอมูลท่ีไดมาจากประชากรหรือตัวอยางการวิจัยมีหลากหลายลักษณะหรือระดับการวัด หาก

ขอมูลเปนแบบเมตริก (metric data) หรือเปนขอมูลแบบคาตอเนื่อง (continuous data) เชน อายุ 

เงินเดือน น้ําหนัก สวนสูง หรือเปนมาตราแบบชวง (interval scale) หรือมาตราแบบอัตราสวน (ratio 

scale) สามารถเลือกใชสถิติแบบอิงคาพารามิเตอร (parametric statistical) ในการวิเคราะหขอมูลท่ี

รวบรวมมาได แตในการวิจัยดานสังคมศาสตรสวนใหญขอมูลเปนแบบไมใชเมตริก (nonmetric data) 

หรือเปนขอมูลแบบคาจัดประเภท (categorical data) เชน ทัศนคติ ความฉลาด สมรรถนะ หรือเปน

มาตราแบบจัดกลุม (nominal scale) หรือมาตราสวนแบบจัดอันดับ (ordinal scale) ไมเหมาะกับการ

วิเคราะหขอมูลดวยสถิติแบบอิงคาพารามิเตอร หากนักวิจัยฝนใชสถิติแบบอิงคาพารามิเตอร เชน ใช 
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ANOVA วิเคราะหหาอิทธิพลรวมดวยขอมูลมาตราแบบจัดอันดับจะไดผลการวิเคราะหท่ีเปนปฏิสัมพันธ

ลวง (spurious interactions) และไดคาการประมาณการของขนาดผลกระทบต่ํากวาท่ีควรจะเปน 

(underestimation of effect sizes) (Osborn, 2008, p. 50-51) 

การเลือกใชสถิติอางอิงหรือสถิติเชิงอนุมานทุกประเภท มีขอตกลงเบื้องตนรวมกัน คือ ตัวอยาง

ไดมาจากประชากรดวยวิธีการสุมแบบสุม (random sample) และแตละประเภทมีขอตกลงเก่ียวกับ

ระดับการวัดและลักษณะของขอมูลดังนี้ (Allison, 2002, p. V; Hair & Others, 2006, p. 49-50; Field, 

2009; Garson, 2012; Halter, 2017, p. 10-11; Verma, & Abdel-Salam, 2019, p. 65-188) 

1. การทดสอบแบบอิงคาพารามิเตอร (Parametric test) ขอมูลตองเปนขอมูลตัวเลขหรือเปน

คาตอเนื่องหรือมีการวัดต้ังแตระดับชวงมาตรา (interval scale) ข้ึนไป ขอมูลมีการแจกแจงปกติ 

(normal distribution) มีความเปนแบบเดียวกันของความแปรปรวน (homogeneity of variance) 

ความเปนอิสระของขอมูล (independence) และ/หรือขอมูลมีความเปนเสนตรงในการวิเคราะหการ

ถดถอยเชิงเสนตรง (linear regression analysis) 

2. การทดสอบแบบไมอิงคาพารามิเตอร (Non-parametric test) เปนสถิติท่ีมีขอตกลงเพียง

เล็กนอยหรือเปนการทดสอบท่ีเปนอิสระจากขอตกลง (assumption-free test) ขอมูลมีการวัดระดับใดก็

ได ขอมูลไมจําเปนตองมีการแจกแจงปกติ ขอมูลแตละกลุมไมจําเปนตองมีการกระจายเทากัน และ/

หรือไมมีความเปนเสนตรงในการวิเคราะหการถดถอยไมใชเชิงเสนตรง (nonlinear regression 

analysis) 

ตารางท่ี 3.2 เปรียบเทียบขอตกลงเบื้องตนของการทดสอบแบบอิงคาพารามิเตอรและไมอิง

คาพารามิเตอร 

ขอมูล อิงคาพารามิเตอร ไมอิงคาพารามิเตอร 

กลุมตัวอยางขนาดใหญ (large sample) / X 

ความเปนสุม (randomness) / / 

ความเปนอิสระ (independence) / / 

ระดับการวัด (level of measurement)   

- คาตอเนื่อง (อัตราสวน/ชวง) / X 

- คาจัดประเภท (จัดอันดับ/จัดกลุม) / / 
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ขอมูล อิงคาพารามิเตอร ไมอิงคาพารามิเตอร 

การแจกแจงแบบปกติ (normality) / X 

ความเทากันของความแปรปรวน (homogeneity) / X 

ความสัมพันธเชิงเสนตรง (linearity) / X 

การทดสอบสมมติฐานดวยสถิติเชิงอางอิงแบบเดิม (traditional test) คือ การทดสอบแบบอิง

คาพารามิเตอร (parameter test) โดยอิงอยู กับการแจกแจงแบบความนาจะเปน (probability 

distribution) เชน การแจกแจงปกติ (normal distribution) และนักวิจัยสวนใหญยอมรับกันอยาง

แพรหลายวาเปนสถิติท่ีมีอํานาจจําแนก (statistical power) ทําใหผลการทดสอบหรือขอสรุปมีความ

ถูกตองมาก อยางไรก็ตามหากขอมูลท่ีใชในการทดสอบไมตรงกับขอตกลงเบื้องตนของสถิติเชิงอางอิงแบบ

อิงคาพารามิเตอร สามารถใชการทดสอบแบบไมอิงคาพารามิเตอร (non-parametric test) ทดแทนได

แมวาจะมีประสิทธิภาพไมเทากับการทดสอบแบบอิงคาพารามิเตอร เพราะจะชวยลดความคลาดเคลื่อน

ของผลการวิเคราะหได 

กอนการวิเคราะหขอมูลดวยสถิติแบบอิงคาพารามิเตอรจึงตองทําการตรวจสอบคุณลักษณะของ

ขอมูล (exploratory data analysis) ใหตรงกับขอตกลง หากตรวจสอบแลวพบวาไมตรงกับขอตกลงให

เลือกใชสถิติแบบไมอิงคาพารามิเตอรแทนดังตารางดานลาง 

ตารางท่ี 3.3 เปรียบเทียบการทดสอบแบบอิงคาพารามิเตอรและไมอิงคาพารามิเตอร 

ประเภทการทดสอบ อิงคาพารามิเตอร ไมอิงคาพารามิเตอร 

กลุมตัวอยาง 1 กลุม 1-sample t test Sign test, Wilcoxon signed rank test 

กลุมตัวอยาง 2 กลุม 2-sample t test Mann-Whitney test 

กลุมตัวอยางมากกวา 2 กลุม One-Way ANOVA Kruskal-Wallis test 

ทดสอบซํ้า 2 เหตุการณ Paired sample t-test Wilcoxon Test 

ทดสอบซํ้ามากกวา 2 เหตุการณ 
One-Way repeated-

measures ANOVA 
Friedman test 

ความสัมพันธรายคู Pearson’ s correlation Spearman’ s correlation 
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3. การทดสอบสมมติฐาน 

มีตัวอยางของทฤษฎีจํานวนมากท่ีไดรับการยอมรับมาอยางยาวนาน แตตอมาขาดความ

นาเชื่อถือ เพราะความจริง (truths) ท่ีอยูบนฐานของความเปนจริงถูกปฏิเสธ ถาเราไมม่ันใจวา ทฤษฎี 

(theory) นั้น ถูกตอง (true) หรือไม วิธีท่ีดี คือ การหาขอมูลมาทําการสนับสนุน (support) หรือพิสูจน 

(proved) 

การทดสอบสมมติฐาน คือ วิธีการหนึ่งในกระบวนการสรุป (generates) การกระทํา (actions) 

ของประชากรท่ีไดรับอิทธิพลมาจากตัวแปรบางตัว อีกท้ังเปนกระบวนการท่ีเปนวิทยาศาสตรในการ

ทดสอบวา สมมติฐานนั้นเปนไปไดหรือนาเชื่อถือหรือไม 

การทดสอบสมมติฐานท่ีใชวิธีการอางอิงเชิงสถิติ (statistical inference) มี 2 สํานักความคิด 

และมีฐานความเชื่อท่ีแตกตางกัน ดังนี ้(Orloff & Bloom, 2014) 

1. สํานักความคิดแบบเบย (Bayesian) มีความเชื่อวา ความนาจะเปน (probability) ท่ี

สมมติฐานจะมีความเปนจริงกอน (priori) มีขอมูลมาสนับสนุน ความนาจะเปนท่ีสมมติฐานจะมีความเปน

จริงหลัง (posterior) มีขอมูลมาสนับสนุนแลว และการพิสูจนสมมติฐานตองอยูภายใตเง่ือนความควรจะ

เปน (likelihood) ท่ีไดจากขอมูล และความนาจะเปนรวม (total probability) ของขอมูลทําให

สมมติฐานมีความเปนไปไดท้ังหมด (all possible) 

2. สํานักความคิดแบบฟรีเควนทิสต (Frequentist) มีความเชื่อวา ความนาจะเปนของสมมติฐาน

ไมมีความเปนจริงท้ังกอนและหลัง แตความนาจะเปนของสมมติฐานข้ึนอยู กับความควรจะเปน 

(likelihood) ของขอมูลท่ีไดมาจากท้ังการสังเกตและไมไดทําการสังเกต (observed and unobserved 

data) ภายใตเง่ือนไขเฉพาะแตละสมมติฐาน สมมติฐานท่ีเปนจริงตองไดขอมูลมาจากการสุมตัวอยางท่ีมี

ลักษณะของการกระจายหรือแจกแจง (distributions)   

การทดสอบสมมติฐานแบบเบยมีอิทธิพลตอการวิเคราะหขอมูลในชวงกอนศตวรรษท่ี 20 แมวา

จะมีประโยชนในการคนหาความรูใหมในหลายเรื่องท่ีไมรูความนาจะเปนของสมติฐาน แตการมุงม่ันอยูกับ

การคนหาความรูกอนมีขอมูลท่ีไดจากการสังเกตแบบกระจาย (priori distributions) มาสนับสนุน เปน

ความรูท่ีใหความสําคัญกับความคิดเห็นสวนตัวหรือความรูกอนประสบการณเชิงจิตพิสัย (subjective 

priori) ท่ีเรียกสั้น ๆ วา ความเชื่อ (belief) การทดสอบสมมติฐานดวยความไมแนนอนของความนาจะ
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เปนจากกระจายของขอมูล และการอางอิงจากสิ่งหนึ่งดวยระดับความเชื่อม่ันจากสิ่งหนึ่งท่ีมีอยูกอน ทํา

ใหในชวงศตวรรษท่ี 20 การทดสอบแบบฟรีเควนทิสตเขามามีอิทธิพลแทน เนื่องจากไมใชความรูกอน

ประสบการณเชิงจิตพิสัย (subjective priori) ท่ีมีความไมแนนอนข้ึนอยูกับแตละบุคคล แตใชหลักความรู

จากประสบการณเชิงวัตถุ (objective posterior) ทดสอบความนาจะเปนของสมมติฐานจากขอมูลท่ี

ไดมาจากการสํารวจตรวจสอบเชิงวิทยาศาสตร (scientific investigations) กําหนดระดับนัยสําคัญทาง

สถิติ (significance level) และวิเคราะหหาคาความนาจะเปน (probability value: p-value) เพ่ือใช

ตัดสินใจท่ีจะปฏิเสธ (reject) สมมติฐานหลัก (null hypothesis) ผลการทดสอบอาจมีความแตกตางกัน

จากการกําหนดระดับนัยสําคัญทางสถิติท่ีแตกตางกัน และรวมถึงการเกิดความคลาดเคลื่อนแบบท่ี 1 หรือ 

2 (Orloff & Bloom, 2014) 

การวิจัยเชิงปริมาณท่ีมีการตั้งสมมติฐาน นักวิจัยจะใชผลทดสอบสมมติฐานในกระบวนการการ

ตัดสินใจ (determine) ประเมินขอมูลเชิงประจักษ (empirical value) ในการทดสอบ/ยืนยันทฤษฎี 

(theory)  

การทดสอบสมมติฐาน พัฒนามาจากวิธีการตรวจสอบ (proof) ความขัดแยงทางสถิติ  

(statistical contradiction) จากหลักฐาน (evidence) ท่ีรวบรวมมาจากขอสนับสนุนทางทฤษฎี 

(theory) โดยการอธิบายวา (demonstrating) ขอมูล (data) มีความแตกตาง (unlikely) จากการสังเกต 

(observed) ถาตัวแบบทางทฤษฎีท่ีสรางมาจากสมมติฐานเปนเท็จ (false) โดยมีข้ันตอนดังตาราง

ดานลาง 

ตารางท่ี 3.4 ข้ันตอนการทดสอบสมมติฐาน 

ข้ันท่ี 1 สรางสมมติฐาน H0 และ H1 สมมติฐานแบบหางเดียวหรือสองหาง 

ข้ันท่ี 2 กําหนดระดับนัยสําคัญทางสถิติ  .05 (5%) หรือ .025 (25%) หรือ .001 (.1%) 

ข้ันท่ี 3 รวบรวมขอมูล ขอมูลแบบคาแบงกลุมหรือคาตอเนื่อง 

ข้ันท่ี 4 วิเคราะหขอมูล อิงคาพารามิเตอรหรือไมอิงคาพารามิเตอร 

ข้ันท่ี 5 ทดสอบสมมติฐาน ปฏิเสธหรือยอมรับสมมติฐาน H0 หรือ H1 

ข้ันท่ี 6 สรุปและตีความ ตัดสินใจถูกตองหรือเกิดความคาดเคลื่อนแบบท่ี 1 หรือ 2 
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3.1 ประเภทการทดสอบสมมติฐาน 

การตัดสินใจเก่ียวกับสมมติฐานโดยอาศัยเกณฑบางอยางเขาชวย โดยท่ัวไปจะใชวิธีการทางสถิติ

กับขอมูลท่ีไดมาจากตัวอยาง แลวพิจารณาความนาจะเปนของเหตุการณท่ีเกิดข้ึน 2 แบบ ดังนี้ 

1. การทดสอบแบบ 2 หาง (Two tailed Test) คือ การทดสอบวาคาพารามิเตอรมีคาเทากับ

คาท่ีกําหนดหรือไม (สังเกตจากใน H1 หรือ Ha จะมีเครื่องหมาย =) เขียนเปนสัญลักษณทางคณิตศาสตร

ดังนี้ 

H0  µ = µ0 (ประชาชนในเขตชนบทมีระดับการศึกษาไมแตกตาง (เทากับ) กับประชาชนในเขตเมือง) 

H1  µ ≠ µ0 (ประชาชนในเขตชนบทมีระดับการศึกษาแตกตาง (ไมเทากับ) กับประชาชนในเขตเมือง) 

2. การทดสอบแบบหางเดียว (One tailed Test) คือ การทดสอบวาคาพารามิเตอรมีคามากกวา

หรือนอยกวาคาท่ีกําหนด (สังเกตไดจากใน H1 หรือ Ha จะมีเครื่องหมาย > หรือ <) มี 2 แบบ คือ  

    2.1 ทดสอบแบบหางเดียวดานขวา (right tailed) เขียนเปนสัญลักษณทางคณิตศาสตรดังนี้ 

       H0: µ = µ0 (ครัวเรือนในเขตชนบทมีจํานวนสมาชิกเทากับครัวเรือนในเขตเมือง) 

       H1: µ > µ0 (ครัวเรือนในเขตชนบทมีจํานวนสมาชิกมากกวาครัวเรือนในเขตเมือง) 

     2.2 ทดสอบแบบหางเดียวดานซาย (left tailed) เขียนเปนสัญลักษณทางคณิตศาสตรดังนี้  

H0 µ = µ0 (ประชาชนในเขตชนบทมีรายไดเทากับประชาชนในเขตเมือง) 

H1 µ < µ0 (ประชาชนในเขตชนบทมีรายไดนอยกวาประชาชนในเขตเมือง) 

การเลือกกําหนดสมมติฐานแบบมีทิศทางหรือแบบไมมีทิศทางข้ึนอยูกับคาคาดหมาย 

(expectation) ท่ีนักวิจัยเชื่อ (believes) วาเปนจริง (truth) เก่ียวกับประชากรท่ีเลือกมาเปน

ตัวอยาง หากม่ันใจเก่ียวกับทิศทางสมมติฐานหรือคาเฉลี่ยของประชากร (population mean) 

จะเขียนสมมติฐานเปนแบบมีทิศทาง อาจเปนการทดสอบแบบหางเดียวดานขวา (มากกวา >) 

หรือการทดสอบแบบหางเดียวดานซาย (นอยกวา <) แตหากไมม่ันใจเก่ียวกับคาเฉลี่ยของ

ประชากรจะเขียนสมมติฐานเปนแบบไมมีทิศทางหรือท่ีเรียกกวา การทดสอบแบบ 2 หาง 

(Healey, 2013, p. 172-173) 
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3.2 กฎเชิงประจักษ  

 การวิจัยเชิงปริมาณดานสังคมศาสตรและสาขาสังคมวิทยาวางอยูบนฐานของปรัชญา

วิทยาศาสตรธรรมชาติสํานักประจักษนิยม (empiricism) ท่ียอมรับเฉพาะความรูเชิงประสบการณท่ีมี

หลักฐานเชิงประจักษสนับสนุน จึงสรางกฎเชิงประจักษ (empirical rule) สําหรับใชทดสอบสมมติฐาน

หลัก (null hypothesis) ดวยขอมูลท่ีสรางมาจากตัวแปรเชิงสุม (random variable) บนฐานความเชื่อ

ท่ีวา ปรากฎการณท่ีเกิดข้ึนตามธรรมชาติมีลักษณะสุม 

ขอมูลจากตัวแปรเชิงสุมตามกฎเชิงประจักษมีลักษณะการกระจายหรือแจกแจงแบบปกติ 

(normal distribution) โดยกําหนดใหขอมูลท้ังหมดท่ีอยูภายใตโคงปกติ (normal curve) เทากับ 

100% หรือ 1 แบงขอมูลดวยกฎสามซิกมา (three sigma rule) เปน 3 สวนจากจุดกลางท่ีเปนคาเฉลี่ย

ดวยคาเบี่ยงเบนมาตรฐาน (three standard deviations of the mean) หรือเปนกฎ 68-95-99.7 (68-

95-99.7 rule) ขอมูลภายใตระฆังคว่ํา (bell curve) ถูกแบงขอมูลออกเปน 3 สวน ดังตอไปนี้ 

 
รูปท่ี 3.1 ขอมูลภายใตระฆังคว่ํา 

68% ตกอยูภายในพ้ืนท่ีท่ี 1 ของความเบี่ยงเบนมาตรฐาน (+/-1σ) ของคาเฉลี่ย  

95% ตกอยูภายในพ้ืนท่ีท่ี 2 ของความเบี่ยงเบนมาตรฐาน (+/-2σ) ของคาเฉลี่ย 

99.7% ตกอยูภายในพ้ืนท่ีท่ี 3 ของความเบี่ยงเบนมาตรฐาน (+/-3σ) ของคาเฉลี่ย 

 การนําเอากฎเชิงประจักษมาประยุกตใชทดสอบความนาจะเปนของสมมติฐานหลักโดยใชขอมูล

ท่ีไดมาจากประสบการณหรือการสํารวจ หากขอมูลตกอยูในพ้ืนท่ีท่ี 1 ถึง 3 หรือชวงรอยละ 68 ถึง 99.7 

แสดงวา ขอมูลมีลักษณะของการกระจายหรือแจกแจงใกลเคียงกับปรากฎการณหรือขอมูลท่ีเกิดข้ึนตาม

ธรรมชาติ จึงยอมรับสมมติฐานหลัก  
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การอางอิงขอมูลจากตัวอยางในการทดสอบความนาจะเปนของสมมติฐานในแตละศาสตรมี

ขอตกลงหรือการยอมรับแตกตางกัน ดานวิทยาศาสตรขอมูลสวนใหญไดมาจากหองปฏิบัติการท่ีมีการ

ควบคุมและจัดสภาพแวดลอมของตัวแปรใหมีความใกลเคียงกับธรรมชาติไดมากท่ีสุด จึงใชคารอยละ 

99.7 หรือกําหนดคานัยสําคัญทางสถิติ (significance level) หรือคาแอลฟา (alpha level: α) = .01 

ในการทดสอบสมมติฐานหลัก สวนดานสังคมศาสตรขอมูลสวนใหญไดมาจากสังคมท่ีมีความไมแนนอนอีก

ท้ังไมสามารถควบคุมบริบทใหปราศจากการรบกวนจากปจจัยตาง ๆ ได จึงใชคารอยละ 95 หรือ

กําหนดคานัยสําคัญทางสถิติ (significance level: α) หรือคาแอลฟา (alpha level: α) = .05 ในการ

ทดสอบสมมติฐานหลัก (Stark & Robert, 1996, p. 71; Williams, 2016, p. 214; Christopher, 2017, 

p. 148) 

3.3 การยอมรับและปฏิเสธสมมติฐาน 

 การตัดสินใจท่ีจะปฏิเสธหรือยอมรับสมมติฐานหลัก (H0) ข้ึนอยูกับคาสถิติท่ีเราคํานวณไดจาก

ขอมูลท่ีสังเกตุไดจากตัวอยาง (เชน คาของ X2, Z, t) โดยนําคาสถิติท่ีคํานวณไดไปเทียบกับ คาวิกฤต 

(critical value)10 เพ่ือดูวาคาสถิตินั้นตกอยูในพ้ืนท่ีปฏิเสธสมมติฐานหลัก (region of null hypothesis 

rejection) หรือท่ีเรียกวา เขตวิกฤต (critical region) หรือไม (คาวิกฤตในอดีตหาไดจากการเปดตาราง

สถิติ แตปจจุบันผลการวิเคราะหท่ีไดจากโปรแกรมคอมพิวเตอรจะใหคาสถิติสําหรับใชตัดสินใจในการ

ปฏิเสธหรือยอมรับสมมติฐานไดเลย) 

 

รูปท่ี 3.2 เขตวิกฤต 

                                                           
10

 คาวิกฤต คือ คาท่ีแบงพื้นท่ีใตโคงความนาจะเปนออกเปน 2 สวน คือ สวนแรกเรียกวา เขตวิกฤต (critical/rejection region) และสวนท่ี

สองเรียกวา เขตการยอมรับ (acceptance region) ซึ่งเปนบริเวณท่ีทําใหยอมรับ H0 ถาคาสถิติท่ีคํานวณจากขอมูลของตวัอยางมีคาตกอยูใน

เขตวิกฤต (critical region) เราจะปฏิเสธ H0 และยอมรับ H1 แตถามีคาตกอยูในเขตการยอมรับ (acceptance region) เราจะยอมรับ H0 

Critical Value 

Critical/Rejection Region Critical/Rejection Region 

Acceptance Region 

Critical Value 
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คาสถิติท่ีคํานวณและนําไปเปรียบเทียบกับคาวิกฤตวาตกอยูในเขตวิกฤติหรือไม คือ คาความ

นาจะเปน (probability value: p-value) ของขอมูลท่ีอยูนอกพ้ืนท่ีของขอมูลท่ีไดจากการสังเกต 

(observed) หรือ Acceptance Region ตามท่ีคาดคะเนไววาจะยอมรับสมมติฐานหลัก (H0) โดยคา

ความนาจะเปนมีคาอยูระหวาง 0 ถึง 1 กอนการทดสอบสมมติฐานผูวิจัยตองกําหนดคาวิกฤติหรือคา

นัยสําคัญทางสถิติ (significance: Sig.)11 หรือคา α ท่ีจะปฏิเสธสมมติฐานหลักกอน เชน α = .01 (1%) 

หรือ α = .05 (5%) ถาคํานวณไดคาความนาจะเปนอยูนอกเขตวิกฤติหรือมากกวาคา α เราจะยอมรับ

สมมติฐานหลัก (H0) แตถาคํานวณไดคาความนาจะเปนตกอยูในเขตวิกฤติหรือไดคาความนาจะเปน

เทากับหรือนอยกวาคา α เราจะปฏิเสธสมมติฐานหลัก (H0) และยอมรับสมมติฐานทางเลือก (H1) ดังนี้ 

 1. การทดสอบแบบหางเดียวทางขวา -> ยอมรับ (H0 เพราะ P-value > α) 

 
รูปท่ี 3.3 คาวิกฤติการทดสอบแบบหางเดียวทางขวา 

2. การทดสอบแบบหางเดียวทางซาย -> ยอมรับH0 เพราะ P-value > α  

 
รูปท่ี 3.4 คาวิกฤติการทดสอบแบบหางเดียวทางซาย 

                                                           
11 นักสังคมศาสตรสวนใหญยอมรับหรือนยิมใชคานัยสําคัญทางสถิติที่ระดับ .05 (Halter, 2017, p. 14) และเนื่องจากเปนคารอยละไม

สามารถเกิน 100% จึงไมใสเลข 0 กอนจุดทศนิยม (Christopher, 2017, p. 148) 

p-value = .1314 

α = .05 1-α = .95 

α = .05 

p-value = .1314 

1-α = .95 
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3. การทดสอบแบบ 2 หาง -> ยอมรับ H0 เพราะ P-value > α  

 

รูปท่ี 3.5 คาวิกฤติการทดสอบแบบ 2 หาง 

การใชโปรแกรมคอมพิวเตอรทดสอบสมมติฐานดวยสถิติ ผลการวิเคราะหสําหรับใชตัดสินใจ

ยอมรับหรือปฏิเสธสมมติฐานหลักมีการแสดงผลลัพธหลายรูปแบบ เชน แสดงดวยคําวา p-value หรือ

บางโปรแกรมแสดงดวยคําวา Sig. เพ่ือใหนักวิจัยนําไปเทียบกับคานัยสําคัญทางสถิติ (α) ท่ีกําหนด 

(.05, .25, .00) และเปนจุดแบงระหวางพ้ืนท่ียอมรับ (acceptance region) กับพ้ืนท่ีวิกฤติ/ปฏิเสธ 

(critical/rejection region) ท่ีเขียนเปนเกณฑไวกอนการวิเคราะหขอมูล 2 รูปแบบดังตอไปนี้   

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบสัดสวนของขอมูลดวยวิธี………………ไดคา

ความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐานหลัก (H0) แต

หากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธ

สมมติฐานหลัก (H0) และยอมรับสมมติฐานทางเลือก (H1) 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบสัดสวนของขอมูลดวยวิธี………………ไดคา

ความนาจะเปน (p-value > .05) ตกอยูในพ้ืนท่ีการยอมรับ จะยอมรับสมมติฐานหลัก (H0) แตหากไดคา

ความนาจะเปน (p-value =< .05) ตกอยูในพ้ืนท่ีการปฏิเสธ จะปฏิเสธสมมติฐานหลัก (H0) และยอมรับ

สมมติฐานทางเลือก (H1) 

การแปลความหมายคาความนาจะเปน (p-value) ตองระมัดระวังการตีความผิดพลาด ระดับ

นัยสําคัญทางสถิติ (significance level) = .05 หรือ .01 หมายถึง ความนาจะเปนท่ีจะเกิดความ

คลาดเคลื่อนแบบท่ี 1 (type I error) รอยละ 5 หรือรอยละ 1 หรือตีความไดวา ถายอมรับสมมติฐาน

p-value/2 = .0655 p-value/2 = .0655 

α/2 = .025 α/2 = .025 
1-α = .95 
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หลักหรือสมมติฐานหลักเปนจริง มีโอกาสแบบสุม (randomness) ท่ีจะเกิดการปฏิเสธสมมติฐานหลัก 5 

หรือ 1 ครั้ง (Orloff & Bloom, 2014) 

การทดสอบนัยสําคัญทางสถิติมีวัตถุประสงคและขอจํากัดท่ีแตกตางกันดังตอไปนี้ (Healey, 

2013, p. 277-279)  

1. การทดสอบเพ่ือการอางอิงไปสูประชากร เปนการทดสอบท่ีเนนการพิสูจน (proof) สมมติฐาน

หลัก (null hypothesis) และอางอิงจากตัวอยางไปสูประชากร ขอมูลท่ีใชในการทดสอบตองมาจากกลุม

ตัวอยางแบบสุม (random samples) จากประชากร (populations) และเนื่องจากการทดสอบนัยสําคัญ

ทางสถิติมีความเก่ียวของขนาดตัวอยาง จึงตองใชกลุมตัวอยางขนาดใหญเพ่ือการปฏิเสธสมมติฐานหลัก 

2. การทดสอบเพ่ือการตอบคําถามการวิจัย เปนการวัดความเก่ียวของ (measures of 

association) ระหวางตัวแปร เพ่ือใหขอมูลท่ีเก่ียวกับความเขม (strength) และทิศทาง (direction) 

รวมถึงการทดสอบอํานาจ (power) และความถูกตอง (validity) ของทฤษฎี ขอมูลอาจมาจากประชากร

ท่ีมีท้ังขนาดเล็กและขนาดใหญ หรือมาจากกลุมตัวอยางแบบไมสุม (nonrandom samples) ผลการ

ทดสอบแมวาจะมีความสัมพันธอยางมีนัยสําคัญทางสถิติเปนอยางมาก แตสามารถใชเปนเพียงหลักฐาน 

(evidence) หรือเปนเหตุผล (case) เพ่ือสนับสนุน (supported) ความเก่ียวของกันเชิงสถิติ (statistical 

association) ระหวางตัวแปรเทานั้น ไมสามารถยืนยัน (proof) ไดวามีความสัมพันธเชิงสาเหตุ (causal 

relationship) 

4. ความคลาดเคลือ่นของผลการวิจัย 

ผูวิจัยท่ีเลือกใชวิธีการวิจัยเชิงปริมาณนอกจากมีความรูในระเบียบวิธีการวิจัยและการสราง

เครื่องมือในการรวบรวมขอมูลเปนอยางดีแลว ยังตองมีความรูและความเขาใจในการใชสถิติเปนอยางดี 

รวมถึงตองนําเอาขอมูลมาใชใหถูกตองตามขอตกลงเบื้องตน (basic assumptions) ของแตละสถิติดวย 

เพ่ือปองกันไมใหเกิดความคลาดเคลื่อนในการอางอิง (inferential errors) ไปสูแนวคิดหรือทฤษฎีท่ี

ตองการพิสูจนหรือตรวจสอบ 



62 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

4.1 ประเภทของความคลาดเคลื่อนของผลการวิจัย 

ความคลาดเคลื่อนในการวิจัยเชิงปริมาณเปนหวงโซตอเนื่องกันและเกิดมาจากหลายสาเหตุแต

แบงไดเปน 2 กลุม ดังนี้ (Lash, Fox, & Fink, 2009: 13) 

1. ความคลาดเคลื่อนเชิงสถิติ (Statistical error) หรือท่ีเรียกวา ความคลาดเคลื่อนจากการเลือก

ตัวอยาง (sampling error) มีสาเหตุเกิดมาจากตัวอยางท่ีไดมาจากประชากรท้ังดานขนาดตัวอยาง 

(sample size) และการเลือกตัวอยาง (sampling) 

2. ความคลาดเคลื่อนเชิงระบบ (Systematic error) หรือท่ีเรียกวา ความคลาดเคลื่อนจาก

เครื่องมือ (instrument error) มีสาเหตุเกิดมาจากคุณภาพของเครื่องมือวัดท้ังดานความเท่ียงตรง 

(validity) และความนาเชื่อถือ (reliability) 

4.2 ปจจัยที่มีผลตอความคลาดเคลื่อนของผลการวิจัย 

ความคลาดเคลื่อนท่ีเกิดข้ึนอาจไมสามารถกําจัดออกไปไดจากการวิจัย แตสามารถลดความเสี่ยง

ของการเกิดความคลาดเคลื่อนไดโดยการเพ่ิมอํานาจของสถิติ (statistical power: 1-β) หรือท่ีเรียกวา 

อํานาจในการทดสอบสมมติฐาน (power of a hypothesis test) ท่ีเปนความนาจะเปน (probability) 

ของความถูกตองท่ีจะปฏิเสธสมมติฐานหลักท่ีเปนเท็จ (H0=false) หรือปฏิเสธสมมติฐานหลักเม่ือ

สมมติฐานทางเลือกเปนจริง (H1=true) หรือเปนดัชนีความนาจะเปนท่ีจะไมเกิดความคลาดเคลื่อนแบบท่ี 

2 หากอํานาจของสถิติเพ่ิมข้ึนหรือเขาใกล 1 โอกาสท่ีจะเกิดความคลาดเคลื่อนแบบท่ี 2 จะลดลง ซ่ึง

อํานาจของสถิติมีความเก่ียวของกับปจจัยตาง ๆ ดังนี้ (Cohen, 1977: 1-17; Christopher, 2017: 176-

177; Hahs-Vaughn and Lomax, 2020: 193-195) 

1. ระดับนัยสําคัญทางสถิติ (Statistical significance) คือ คาความนาจะเปน (p-value) ท่ีใช

กําหนดเกณฑในการปฏิเสธสมมติฐานหลัก (H0) เชน .05 หรือ .01 หรือ .001 หากใชระดับนัยสําคัญทาง

สถิติท่ีสูงกวาจะมีอํานาจของสถิติมากกวา (more power) การใชระบบนัยสําคัญทางสถิติท่ีต่ํากวา เพราะ

การกําหนดระดับนัยสําคัญทางสถิติท่ีตํ่ากวา (เชน .01 ต่ํากวา .05) จะทําใหการปฏิเสธสมมติฐานหลัก

ยากกวาระดับนัยสําคัญทางสถิติท่ีสูงกวาจึงทําใหมีอํานาจทางสถิตินอยกวา (less power) 

2. ขนาดของอิทธิพล (Effect size) คือ ขนาด (magnitude) ของคาทางสถิติท่ีไดจากทดสอบ

เปรียบเทียบหรือทดสอบความสัมพันธ (relationship) ระหวาง 2 ตัวแปร เชน คาเฉลี่ย คาสัมประสิทธิ์
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สหสัมพันธ คาสัมประสิทธิ์การถดถอย หากขนาดอิทธิพลมีมากแสดงวาปรากฎการณท่ีศึกษามี

ความสัมพันธกันมากกวาขนาดอิทธิท่ีนอยกวา หรืออาจกลาวไดวา มีโอกาสมากท่ีจะไมเกิดการทับกัน 

(nonoverlap) ของคะแนนระหวางกลุมท่ีทดสอบ 

3. ขนาดตัวอยาง (Sample size) การเลือกตัวอยางมีวัตถุประสงคเ พ่ือใชในการอางอิง 

(inference) จากตัวอยางไปสูประชากรท่ีทราบจํานวน (finite population) ดวยวิธีการประมาณคา 

(estimate) จากคาพารามิเตอรของประชากร (population parameters) เชน จํานวนรวม (total) 

คาเฉลี่ย (mean) และสัดสวน (proportion) ขนาดตัวอยางจึงเปนองคประกอบท่ีสําคัญในการออกแบบ

การวิจัย จึงตองมีจํานวนท่ีเพียงพอและมีผลทําใหเกิดผลกระทบ (effect) ตออํานาจของสถิตหรือระดับ

ของนัยสําคัญทางสถิติ 

4. การทดสอบสมมติฐาน (Hypothesis test) การเลือกทดสอบสมมติฐานแบบมีทิศทาง 

(directional) หรือแบบหางเดียว (one-tailed) ทําใหอํานาจของสถิติเพ่ิมมากข้ึนกวาการทดสอบแบบไม

มีทิศทาง (non-directional) หรือแบบสองหาง (two-tailed) เพราะการทดสอบแบบสองหางมีคาวิกฤติ 

(critical value) มากกวาการทดสอบแบบหางเดียว (พ้ืนท่ีปฏิเสธสมมติฐานวางหรือสมมติฐานหลัก 

(region of null hypothesis rejection) นอยกวา หรือมีคานัยสําคัญทางสถิติต่ํากวา ทําใหโอกาสท่ีคาท่ี

ไดจากการทดสอบทางสถิติ (test statistic) ท่ีใชทดสอบสมมติฐานหลักจะตกอยูในพ้ืนท่ีปฏิเสธสมมติฐาน

หลักนอยลง) จึงทําใหการทดสอบสมมติฐานแบบสองหางปฏิเสธสมมติฐานหลักยากกวาการทดสอบ

สมมติฐานแบบหางเดียว   

5. ความแปรปรวนของประชากร (Population variance) หรือความเบี่ยงเบนมาตรฐานของ

ประชากร (Population standard deviation) แมวาจะไมอยูภายใตการควบคุมของนักวิจัย แตถา

ประชากรมีความแปรปรวนเพ่ิมมากข้ึนจะทําใหอํานาจของสถิติลดลง เพราะความแปรปรวนของ

ประชากรคือสาเหตุของการเกิดความคลาดเคลื่อนมาตรฐาน (standard error) ของคาเฉลี่ยและมีผลทํา

ใหเกิดความคลาดเคลื่อนในการสุมตัวอยาง (sampling error) ตามมา เม่ือประชากรมีความแปรปรวน

ลดลงจะทําใหเกิดความคลาดเคลื่อนในการสุมตัวอยางลดลงและทําใหอํานาจของสถิติเพ่ิมข้ึนตามมา 

6. ผลตางของคาเฉลี่ย (Difference mean) แมวาจะไมอยูภายใตการควบคุมของนักวิจัย ยกเวน

การทดลองในหองปฏิบัติการท่ีสามารถควบคุมได หากคาเฉลี่ยของประชากรท่ีเปนจริง (true 

population mean) และคาเฉลี่ยของสมมติฐาน (hypothesized mean) เพ่ิมข้ึนจะทําใหอํานาจของ
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สถิติเพ่ิมข้ึน กลาวคือ หากผลตางระหวางคาเฉลี่ยของประชากรท่ีเปนจริงและคาเฉลี่ยของสมมติฐานมี

มากจะทําใหการปฏิเสธสมมติฐานหลักงายกวาผลตางระหวางคาเฉลี่ยท่ีนอยกวา 

ความคลาดเคลื่อนในการสรุปผลการทดสอบสมมติฐานหรือผลการวิจัยมีความเปนไปไดสอง

ผลลัพธ (two possible outcomes) คือ สมมติฐานหลักอาจไดรับการยอมรับหรือปฏิเสธ ดังนี้  

1. ความคลาดเคลื่อนแบบท่ี 1 (Type I error) คือ ปฏิเสธสมมติฐานหลักท่ีเปนจริง (H0 = true)  

2. ความคลาดเคลื่อนแบบท่ี 2 (Type II error) คือ ยอมรับสมมติฐานหลักท่ีเปนเท็จ (H0 = 

false) 

ตารางท่ี 3.5 การสรุปสมมติฐาน 

 ยอมรับ (Accept) H0 ปฏิเสธ (Reject) H0 

H0 = จริง (True) สรุปถูกตอง ความคลาดเคลื่อนแบบท่ี 1 (Type II Error) 

H0 = เท็จ (False) ความคลาดเคลื่อนแบบท่ี 2 (Type II Error) สรุปถูกตอง 

สรุป 

 สถิติท่ีใชในการวิเคราะหขอมูลการวิจัยประกอบดวยสถิติเชิงพรรณนาและสถิติเชิงอางอิง 

ขอตกลงเบื้องตนท่ีสําคัญของการเลือกใชสถิติแตละประเภท คือ ประเภทของขอมูล แมวาสถิติเชิง

พรรณนาจะไมสามารถนําผลไปอางอิงหรือพยากรณคาของกลุมอ่ืน ๆ แตหากเลือกใชไมตรงกับประเภท

ของขอมูลก็ทําใหไดผลการวิเคราะหท่ีผิดได สวนการทดสอบแบบอิงคาพารามิเตอรแมวาจะมีอํานาจ

จําแนกเชิงสถิติ (statistical power) ท่ีทําใหม่ันใจไดวา ผลการทดสอบหรือขอสรุปมีความถูกตองมาก 

แตถาฝนใชการทดสอบแบบอิงคาพารามิเตอรโดยละเมิดขอตกลง (violate assumptions) จะมีผลทําให

การคนพบหรือขอสรุปท่ีไดมีความไมถูกตอง หากขอมูลไมตรงกับขอตกลงของการทดสอบแบบอิง

คาพารามิเตอรควรเลือกใชการทดสอบแบบไมอิงคาพารามิเตอรแทน 

แบบฝกหัดทายบท 

ใหผูเรียนคนหางานวิจัยเชิงปริมาณดานสังคมศาสตรจากฐานขอมูลของหองสมุดท่ีสนใจ แลว

ตอบคําถาม ดังนี้ 

1. งานวิจัยท่ีคนไดวิเคราะหขอมูลดวยสถิติอะไรบาง  

2. สถิติแตละตัวในงานวิจัยท่ีคนไดจัดเปนสถิติประเภทใด  



 

 

สวนท่ี 2 

ความรูเบื้องตนเก่ียวกับการใชโปรแกรมทาง

สถิติ 

  





 

 

บทที่ 4 

แบบสอบถามและขอมูล 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถแปลงขอมูลจากแบบสอบถามไปเปนแฟมขอมูลได  

เน้ือหา 

1. ความสัมพันธระหวางแบบสอบถามกับแฟมขอมูล 

2. การสรางตัวแปร 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย แสดงตัวอยาง ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรมสอนออนไลน (สอนแบบออนไลน) เครื่องฉาย 

(สอนในชั้นเรียน) หองเรียนเสมือจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และการ

ทําแบบฝกหัดทายบท  
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เนื้อหา 

การนําขอมูลท่ีเก็บรวบรวมดวยแบบสอบถามหรือแบบฟอรมมาประมวลผลดวยคอมพิวเตอร 

ตองแปลงรูปขอมูลท่ีเก็บรวบรวมมาใหอยูในรูปขอมูลท่ีคอมพิวเตอรสามารถอานได (machine-

readable data)  ขอมูลท่ีสามารถใชในกระบวนการประมวลผลดวยโปรแกรมคอมพิวเตอร ตองเปน

ขอมูลดิจิทัลหรือขอมูลเชิงเลข (digital)  ดังนั้นการนําขอมูลท่ีไดจากแบบสอบถามไปประมวลผลหรือ

วิเคราะหขอมูล ตองทําการเปลี่ยนรูปขอมูลในแบบสอบถามใหเปนขอมูลในรูปแบบท่ีโปรแกรมสามารถ

นําไปประมวลผลได 

1. ความสมัพันธระหวางแบบสอบถามกับแฟมขอมลู 

คอมพิวเตอรมีกระบวนการประมวลผล คือ นําขอมูลเขา (input) จากแฟมขอมูล -> ประมวลผล 

(processing) ตามเง่ือนไข -> แสดงผล (display) ตามคําสั่ง ดังนี้ 

 

 

 

 

รูปท่ี 4.1 กระบวนการประมวลผลของคอมพิวเตอร 

การวิเคราะหขอมูลจากแบบสอบถาม (questionnaire) ตองแปลงขอมูลจากแบบสอบถามไป

เก็บไวในรูปของแฟมขอมูล (file) ท่ีเครื่องจักร (คอมพิวเตอร) สามารถอาน (machine readable) และ

นําไปประมวลผลได โดยแฟมขอมูลตองมีสวนประกอบท่ีสําคัญ คือ กรณีศึกษา/ตัวอยาง (case) ตัวแปร 

(variable) และคาตัวแปร (value)  

 

นําขอมูลเขา

• ขอมูล
• ตัวเลข
• ตัวอักษร

ประมวลผล

• คําสั่งทางสถิติ
• สถิติเชิงพรรณนา
• สถิติเชิงอางอิง

แสดงผล

• สารสนเทศ
• ตาราง
• กราฟ
• สถิติ
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รูปท่ี 4.2 สวนประกอบของชุดขอมูล (data set)  

 กอนออกแบบแฟมขอมูลตองทําความเขาใจความสัมพันธระหวางสวนประกอบของ

แบบสอบถามกับสวนประกอบของแฟมขอมูล ดังนี ้

1. ขอมูลของแบบสอบถามแตละชุด คือ กรณีศึกษา/ตัวอยาง (case)  

2. ขอคําถามแตละคําถาม คือ ตัวแปร (variable)  

3. คําตอบของแตละขอคําถาม คือ คาตัวแปร (value) 

เพ่ือใหเห็นภาพการเปลี่ยนรูปจากแบบสอบถามไปเปนแฟมขอมูล ในรูปของตาราง (table) โดย

มีแถว (row) เปนชุดขอมูลของแบบสอบถามแตละฉบับ มีหัวของแตละสดมภ (column) เปนชื่อตัวแปร 

และมีชอง (cell) เปนขอมูลของแตละตัวแปร จึงเขียนเปนภาพไดดังนี้ 

 

รูปท่ี 4.3 การเปลี่ยนรูปแบบสอบถามเปนแฟมขอมูล 

แฟมขอมูลท่ีคอมพิวเตอรสามารถอานและนําเขาโปรแกรมอาจไมอยูในรูปของตารางก็ได เพราะ

งานวิจัยบางเรื่องไดขอมูลจากฐานขอมูล (database) หรือรวบรวมดวยเครื่องจักร (machine) แตตอง

id gender age ICT1 ICT2 ICT3 

1 2 20 1 0 0 

2 1 25 1 1 0 

3 2 22 1 1 1 

4 1 18 0 1 1 

 

กรณศีกึษา/ตวัอยา่ง 

ตัวแปร 

คา่ตวัแปร 
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จัดเก็บขอมูลเปนแถว ๆ และมีตัวค่ัน (delimiter) เชน , (comma) ; (semicolon) " " (quotation 

marks) (tab) เพ่ือแบงขอมูลออกเปนสวน ๆ เชน แฟมขอมูล *.csv (comma-separated value) หรือ 

*.txt (text) ดังนั้นจึงตองเปดดูรูปแบบของขอมูลกอนดวยโปรแกรมแกไขขอความ (Text Editor) เชน 

Notepad ดังตัวอยางในภาพ 

 

รูปท่ี 4.4 ขอมูลในแฟมขอมูลนามสกุล CSV แบบมีตัวค่ันดวยเครื่องหมายจุลภาค 

การรวบรวมขอมูลในการวิจัยเชิงสํารวจสวนใหญนิยมออกแบบขอคําถามเปนแบบปลายปด 

(close end) มากกวาคําถามแบบปลายเปด (open end) เพราะคําถามแบบปลายปดแปลงขอมูลไป

วิเคราะหงายกวาคําถามแบบปลายเปด เพราะมีคําตอบหรือคาตัวแปร (value) ท่ีกําหนดไวแลว แต

เนื่องจากคําถามมีหลายรูปแบบ ดังนั้นการสรางตัวแปรจากแบบสอบถามจึงมีวิธีการท่ีไมเหมือนกัน ดังนี้ 

ตารางท่ี 4.1 การสรางตัวแปรจากแบบสอบถาม 

เครื่องมือรวบรวมขอมูล  โปรแกรมวิเคราะหขอมูล/แฟมขอมูล 

แบบสอบถามแบบปลายปด (คําตอบเดียว) 

แบบสอบถาม -> กรณีศึกษา/ตัวอยาง (case) 

ขอคําถาม -> ชื่อตัวแปร (variable name) และคําอธิบายตัวแปร (variable label) 

คําตอบ -> คาตัวแปร (value) 

แบบสอบถามแบบปลายปด (หลายคําตอบ) 

แบบสอบถาม -> กรณีศึกษา/ตัวอยาง (case) 

ขอคําถาม -> - 

คําตอบ -> ชื่อตัวแปร (variable name) หรือ คาตัวแปร (value) 

แบบสอบถามแบบปลายเปด 

แบบสอบถาม -> กรณีศึกษา/ตัวอยาง (case) 

ขอคําถาม -> - 

คําตอบ -> ชื่อตัวแปร (variable name) หรือ คาตัวแปร (value) 
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   การบันทึกขอมูลลงในแฟมขอมูล ถาเปนขอคําถามท่ีมีคําตอบเดียว ก็นําเอาคําตอบมาสรางเปน

ตัวแปรไดเลย แตหากเปนขอคําถามท่ีมีหลายคําตอบ ตองใชคําตอบมาสรางเปนตัวแปร ดังนี้ 

1. คําถามแบบคําตอบเดียว  

ตัวอยาง เพศ สรางเปนตัวแปรได 1 ตัวแปร คือ gender  

    ตัวอยาง อายุ….ป สรางเปนตัวแปรได 1 ตัว คือ age 

2. คําถามแบบหลายคําตอบ  

ตัวอยาง เทคโนโลยีท่ีมีใช [1] คอมพิวเตอร [2] โทรศัพท [3] อินเทอรเน็ต ตองสรางเปนตัว 

           แปรหลายตัวแปร คือ ICT1 ICT2 และ ICT3  

ตัวอยาง เชื่อชาติ …..สัญชาติ…… สรางเปนตัวแปรได 2 ตัว คือ Nation และ Race 

แมวาแบบสอบถามจะมีขอคําถามแบบปลายปดและปลายเปด มีคําตอบเดียวและหลายคําตอบ 

ตามท่ีกลาวมาแลว แตแบบสอบถามยังมีขอคําถามท่ีหลากหลายรูปแบบ จึงรวบรวมขอคําถามท่ีนิยมใช

กันมาออกแบบเปนแฟมขอมูลตัวอยาง ดังตอไปนี้ 

1.1 คําถามแบบเลือกตอบ 
คําถาม ชื่อตัวแปร คําอธิบายตัวแปร คาตัวแปรและคําอธิบาย 

1. เพศ 

[1] ชาย    [2] หญิง 

Gender 

 

Gender 1 = Male 

2 = Female 

2. ท่ีอยู 

[1] เมือง               [2] ชานเมือง   [3] ชนบท 

Residence Residence 1 = Urban 

2 = Suburb 

3 = Rural 

ตัวอยางแฟมขอมูลคําถามแบบเลือกตอบ 

ID Gender Residence 

1 1 2 

2 2 1 
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1.2 คําถามแบบปลายเปด 

คําถาม 
ชื่อ 

ตัวแปร 

คําอธิบาย 

ตัวแปร 

คาตัวแปร 

และคําอธิบาย 

1. สัญชาติ ……และเช้ือชาติ………ของทาน (โปรดระบุ) 

 

2. ระยะเวลาท่ีอาศัยอยูในประเทศไทย….…ป…....เดือน  

Nation 

Race 

Time 

Nation of Responder 

Race of Responder 

Stay in Thai (month) 

- 

- 

1-999 

ตัวอยางแฟมขอมูลคําถามแบบปลายเปด 

Nation Race Time 

British Chinese 6 

Japan Japan 10 

Indian Hindo 36 

1.3 คําถามแบบประเมินคา 

คําถาม 
ชื่อ 

ตัวแปร 

คําอธิบาย 

ตัวแปร 

คาตัวแปร 

และคําอธิบาย 

ความพึงพอใจท่ีมีตอการใชบริการผานเว็บไซต 

ขอ การใชบริการ 
ระดับคะแนน 

5 4 3 2 1 0 

1 มีบริการผานเว็บไซตตรงกับท่ี

คาดหวังไว 

      

2 มีความสะดวกเขาไปใชงานใน

สวนตาง ๆ ของเว็บไซต 

      

3 มีความไววางใจเมื่อทําธุรกรรม

ผานเว็บไซต 

      

 

eService1 

 

eService2 

 

eService3 

 

Expect of 

Services 

Convenience 

of Services 

Trust of 

Services 

0 = No 

1 = Least 

2 = Little 

3 = Nature 

4 = More 

5 = Most 

ตัวอยางแฟมขอมูลคําถามแบบประเมินคา 

eService1 eService2 eService3 

5 2 4 

2 1 3 
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1.4 คําถามแบบหลายคําตอบ 

คําถาม 
ชื่อ 

ตัวแปร 

คําอธิบาย 

ตัวแปร 

คาตัวแปร 

และคําอธิบาย 

เทคโนโลยีสารสนเทศและการสื่อสารท่ีทานมีใชในบาน (ตอบไดมากกวา 1 ขอ) 

ขอ คําถาม มี ไมม ี

1 คอมพิวเตอรแบบเคลื่อนท่ี   

2 คอมพิวเตอรแบบแท็บเล็ต   

3 คอมพิวเตอรแบบสวมใส   

4 โทรศัพทแบบอัจฉริยะ   
 

 

 

ICT1 

ICT2 

ICT3 

ICT4 

 

 

Laptop PC 

Tablet PC 

Wearable PC 

Smartphone 

 

 

 

0 = No 

1 = Yes 

ตัวอยางแฟมขอมูลคําถามแบบหลายคําตอบ 

ICT1 ICT2 ICT3 ICT4 ICT5 

0 1 1 0 1 

1 1 1 1 1 

1.5 คําถามแบบจัดอันดับ 

คําถาม 
ชื่อ 

ตัวแปร 

คําอธิบาย 

ตัวแปร 

คาตัวแปร 

และคําอธิบาย 

 ทานใชอินเทอรเน็ตท่ีใดมากท่ีสุด 3 อันดับ  

ขอ คําถาม 
อันดับ 

มากท่ีสุด นอย นอยท่ีสุด 

1 บานตนเอง    

2 บานญาต/ิเพ่ือน    

3 ท่ีทํางาน    

4 โรงเรียน/มหาวิทยาลยั    
 

Place1 

Place2 

Place3 

Place4 

Home 

Relation 

Office 

School 

1 = Least 

2 = More 

3 = Most 

หรือ 

Use1 

Use2 

Use3 

Last Use 

More Use 

Most Use 

1 = Home 

2 = Relation 

3 = Office 

4 = School 

ตัวอยางแฟมขอมูลคําถามแบบจัดอันดับ 

Place1 Place 2 Place 3 Place 4  USE1 USE2 USE3 

3  2 1  2 3 1 

2  3  หรือ 2 1 3 

0 1  3  3 1 4 
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1.6 คําถามแบบเปรียบเทยีบ 

ขอคําถาม 
ชื่อ 

ตัวแปร 

คําอธิบาย 

ตัวแปร 

คาตัวแปร

และคําอธิบาย 

สํานักงาน 

คําถาม 

ออนไลน 

 ระดับคะแนน ระดับคะแนน 

5 4 3 2 1 0 5 4 3 2 1 0 

      1. ความงายในการ

ดําเนนิการ 

      

      2. ความประหยัด

ในการใชบริการ 

      

 

  

0 = No 

1 = Least 

2 = Little 

3 = Nature 

4 = More 

5 = Most 

ServOff1 

ServOn1 

Ease of Office 

Ease of Web 

ServOff2 

ServOn2 

Saving to Office 

Saving to Web 

ตัวอยางแฟมขอมูลคําถามแบบเปรียบเทียบ 

ServOff1 ServOn1 ServOff2 ServOn2 

3 5 2 4 

2 3 3 5 

 



แ บ บ ส อ บ ถ า ม แ ล ะ ข อ มู ล | 75 

1.7 คําถามแบบถูกผิด 

ขอคําถาม 
ชื่อ 

ตัวแปร 

คําอธิบาย 

ตัวแปร 

คาตัวแปร 

และคําอธิบาย 

1. ความรูเกี่ยวกับกฎและระเบียบที่เกีย่วกับการใชเทคโนโลยีสารสนเทศ 

ขอ คําถาม ถูก ไมแนใจ ผิด 

1 ขอมูลอิเล็กทรอนิกสไมสามารถใช

เปนพยานหลักฐานในการพจิารณา

คดีทางกฎหมายได 

   

2 การยอมรับในความเปนเจาของ

ขอมูลอิเล็กทรอนิกสตองมีลายมือ

ชื่ออิเล็กทรอนิกสดวย 

   

3 หนวยงานของรัฐสามารถปฏิเสธ

ความรับผิดชอบทางกฎหมายจาก

ขอความในขอมูลอิเล็กทรอนิกสได 

   

 

 

 

Know1 

 

 

Know2 

 

 

Know3 

 

 

Evident in Law 

 

 

eSignature of 

Owner 

 

Disclaimer of 

Government 

 

 

 

 

0 = 0 คะแนน 

1 = 1 คะแนน 

ตัวอยางแฟมขอมูลคําถามแบบถูกผิด 

Know1 Know2 Know3 

1 1 0 

0 0 0 

1 1 1 

เฉลยคําตอบ 

ขอ 1 ถูก = 1 ไมแนใจ = 0 และผดิ = 0 

ขอ 2 ถูก = 1 ไมแนใจ = 0 และผดิ = 0 

ขอ 3 ถูก = 0 ไมแนใจ = 0 และผดิ = 1 
 

แบบสอบถาม 1 ชุด อาจมีขอคําถามเปนแบบคําตอบเดียว หรือเปนแบบสอบถามท่ีมีท้ังขอ

คําถามแบบคําตอบเดียวและหลายคําตอบรวมกัน การออกแบบแบบสอบถามตองคํานึงถึงการนําเอาขอ

คําถามและคําตอบไปใชในการสรางตัวแปรและคาตัวแปรในแตละแฟมขอมูล รวมถึงระดับการวัดตัวของ

ตัวแปร (variable scale) สําหรับใชสถิติในการวิเคราะหดวย  

จากตัวอยางแบบสอบถาม ขอคําถามแบบประเมินคา (rating scale) สวนใหญกําหนดการ

ประเมินคาเปน มากท่ีสุด มาก ปานกลาง นอย นอยท่ีสุด แมวาจะมีการกําหนดตัวเลขควบคูไปกับระดับ
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การประเมิน เชน 5 4 3 2 1 ดวย และในการวิเคราะหขอมูลก็มีการอนุโลมใหคําตอบท่ีไดจากการ

ประเมินคาแบบนี้ เปนระดับการวัดแบบมาตราวัด (scale measurement) หรือเปนคาตอเนื่อง 

(continuous data) เพ่ือไมใหละเมิดขอตกลง (violate assumptions) และสามารถวิเคราะหดวยสถิติ

สหสัมพันธ (correlation) ได แตหากการออกแบบคําตอบใหเปนคะแนน (score) ตั้งแต 0-5 นาจะทําให

ระดับการวัดของตัวแปรเปนไปตามขอตกลง (meet assumptions) จะดีกวาการอนุโลมเพ่ือใหเปนไป

ตามเง่ือนไขทางสถิต ิ

2. การสรางตัวแปร 

การสรางตัวแปร  (variable definition) คือ กําหนดคุณลักษณะของตัวแปร (variable 

attribute) ใหคอมพิวเตอรรูรายละเอียดเก่ียวกับตัวแปรและสามารถนําขอมูลไปใชวิเคราะหไดดวย

โปรแกรมคอมพิวเตอร โดยมีรายละเอียดและเง่ือนไขดังตอไปนี้ 

1. ชื่อตัวแปร (Variable Name) คือ สัญลักษณ (symbol) ท่ีกําหนดข้ึนเพ่ืออธิบายขอมูล (data) 

ใหโปรแกรมคอมพิวเตอรรูจักและนําไปใชในฟงกชั่น (function) ในกระบวนการประมวลผล โดยท่ัวไปมี

เง่ือนไขหรือกฎท่ีคลายกัน ดังนี้ 

   1.1 ชื่อตัวแปรตองเริ่มตนดวยตัวอักษรเทานั้น (โดยท่ัวไปใชภาษาอังกฤษ) หลังจากนั้นอาจ

เปนตัวอักษร (letter) ตัวเลข (number) อักขระพิเศษ (special character) เชน @, #, _ หรือ $ ก็ได 

   1.2 ชื่อตัวแปรหามปดทายดวย จุด หรือ เสนใตอักขระ (underscore) 

   1.3 ชื่อตัวแปรหามเวนวรรค (blank) และหามใชอักษรพิเศษ เชน !, ?, ‘ และ * 

   1.4 ชื่อตัวแปรในแฟมขอมูลเดียวกันตองไมเหมือนกันหรือซํ้ากัน 

   1.5 ชื่อตัวแปรโดยท่ัวไปควรมีความยาวไมเกิน 64 ตัวอักษร หรือ ไบต (bye) ภาษาท่ีใชไบต

เดียว เชน อังกฤษ เยอรมัน ฝรั่งเศส และสเปน เปนตน บางโปรแกรมสามารถกําหนดชื่อตัวแปรไดยาว

มากกวา 64 ตัวอักษร  

   1.6 ชื่อตัวแปรหามใชคําสงวน (reserved keyword) เชน ALL, AND, BY, EQ, GE, GT, LE, 

LT, NE, NOT, OR, TO และ WITH) 

   1.7 ชื่อตัวแปรอาจเปนอักษรใหญเล็กหรือตัวเล็ก (upper or lower case) เชน GENDER 

หรือ Gender หรือ gender ก็ได แตการใชอักษรตัวเลขจะสะดวกในการนําไปใชกับโปรแกรมอ่ืน ๆ 
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   1.8 ชื่อตัวแปรท่ีมีความยาวมาก จะมีผลกระทบตอการแสดงผล เชน แสดงผลไมครบ หรือ

แสดงผลหลายบรรทัด ดังนั้นไมควรกําหนดชื่อตัวแปรยาวมากเกิน ควรใชคําสั้น ๆ ท่ีมีความหมายในตัว

หรือใชคํายอท่ีนิยมใชกันอยางแพรหลายและเขาใจไดงายแทนขอคําถามจากแบบสอบถามท่ีเปนประโยค

ยาว ๆ เชน เทคโนโลยีสารสนเทศและการสื่อสารท่ีทานมีใชในบาน ใชชื่อตัวแปรวา ICT หากเปนเรื่อง

เดียวกันและมีความเก่ียวของกัน อาจใชตัวเลขตอทายตามลําดับ เชน ICT1 ICT2 ก็ได  

2. ประเภทตัวแปร (Variable Type) คือ ประเภทของขอมูลหรือคาตัวแปร (value) ท่ีใชในการ

ประมวลผล เนื่องจากขอมูลท่ีไดจากกระบวนการรวบรวมขอมูล (data collection) มีหลายรูปแบบ แต

ในกระบวนการประมวลผล ขอมูลท่ีเปนตัวอักษร (character/text/string/alphanumeric) ตองทําการ

นับ (count) เปนตัวเลข (numeric) แลวจึงนําไปประมวลผลดวยตัวดําเนินการทางคณิตศาสตร 

(arithmetic operator) เชน + - x ÷ สวนขอมูลท่ีเปนตัวเลข (numeric) สามารถคํานวณ (calculate) 

ดวยตัวดําเนินการทางคณิตศาสตรไดเลย อีกท้ังบางโปรแกรมมีระบบแบงประเภทตัวแปรตามประเภท

ของขอมูลท่ีกําหนดไวตั้งแตข้ันตอนนําขอมูลเขา (data input) ใหเลือกใชใหตรงกับขอตกลงเก่ียวกับ

ประเภทของขอมูลของแตละคําสั่งทางสถิติอีกดวย ดังนั้นในท่ีนี้จึงตองทําความเขาใจเก่ียวกับขอมูลของ

ตัวแปร 2 ประเภทดังตอไปนี้ 

ตารางท่ี 4.2 คําอธิบายประเภทขอมูล 

ประเภทขอมูล คําอธิบาย 

Numeric ขอมูลท่ีเปนตัวเลข มีคาเปนตัวเลข มีคาเปน + หรือ – ก็ได  

String ขอมูลท่ีไมใชตัวเลข เปนไดท้ัง ตัวอักษร ขอความ และตัวอักษรเลข เปนตัวแปร

ท่ีมีคาเปนตัวอักษรหรือตัวเลขหรือเครื่องหมายตาง ๆ แมวาคาตัวแปรจะเปน

ตัวเลข ก็ไมสามารถนําไปคํานวณได เพราะเปนตัวอักษรเลข (alphanumeric) 

3. จํานวนคาตัวแปรและทศนิยม (Width and Decimals) ตัวแปรแตละตัวจากแบบสอบถามมี

คาตัวแปรมาจากคําตอบท่ีแตกตางกัน แตโปรแกรมกําหนดคาเริ่มตน (default) ไวใหแลว ดังตอไปนี้ 

ตารางท่ี 4.3 คาเริ่มตนคาตัวแปรของตัวแปรแตละประเภท 

ประเภทตัวแปร จํานวนคาตัวแปร ทศนิยม 

Numeric 8 2 



78 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

ประเภทตัวแปร จํานวนคาตัวแปร ทศนิยม 

Comma 8 2 

Dot 8 2 

Scientific notation 8 2 

Date 11 0 

Dollar 8 2 

Custom currency 8 2 

String 8 0 

4. คําอธิบายตัวแปร (Variable Label) คือ คําอธิบายหรือขอความขยายชื่อตัวแปร เพ่ือใหเขาใจ

ความหมายของชื่อตัวแปร เพราะโดยท่ัวไปมักสรางชื่อตัวแปรดวยคํายอหรือคําท่ีมีความหมายสั้น ๆ แต

ชื่อตัวแปรบางตัวอาจไมตองใหความหมายก็ได เพราะชื่อตัวแปรสามารถสื่อความหมายหรือเขาใจไดใน

ตัวเองวา ตัวแปรนั้นหมายถึงอะไร เชน age แตชื่อตัวแปรท่ีสรางข้ึนเองบางครั้งอาจไมสื่อความหมายจึง

ตองใหคําอธิบายตัวแปรไว เพ่ือใหผูใชแฟมขอมูลท่ีไมไดเปนผูสรางแฟมขอมูลหรือการอานผลลัพธ 

(output) สามารถเขาใจไดวา ตัวแปรนั้นหมายถึงอะไร ดังตัวอยางตอไปนี้ 

ตารางท่ี 4.4 การสรางคําอธิบายตัวแปร 

ชื่อตัวแปร (Variable Name) คําอธิบายตัวแปร (Variable Label) 

Id Questionnaire Identification 

Gender กําหนดหรือไมกําหนดก็ได 

ICT1 Have the Desktop PC in Home 

ICT2 Have the Laptop PC in Home 

Place Place for Surf Internet 

Cost Amount spent on communication per month 

5. คําอธิบายคาตัวแปร (Value Label) การบันทึกขอมูลลงในแฟมขอมูลท่ีงายและสะดวกท่ีสุด 

คือ การใชตัวเลขหรือตัวอักษรเปนรหัสแทนคําตอบจากแบบสอบถาม แตการใชรหัสท่ีเปนตัวเลขเปนสิ่งท่ี

นิยมมากกวาการใชตัวอักษร เพราะขณะทําการบันทึกขอมูลแปนพิมพตัวเลขท่ีอยูกันเปนกลุมบริเวณ

เดียวกันสามารถทําการบันทึกขอมูลไดงายกวาการใชแปนพิมพตัวอักษร เชน Gender หรือ เพศ 
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กําหนดใหเลข 1 เปนรหัสแทน Male หรือ เพศชาย และ 2 เปนรหัสแทน Female หรือ เพศหญิง ดังนั้น

รหัสท่ีเปนตัวเลขหรือตัวอักษรจึงตองใหคําอธิบาย เพ่ือความเขาใจการในการแปลผลลัพธ  

การใหคํานิยมคาตัวแปร ไมจําเปนตองใหคําอธิบายทุกคาตัวแปร คาตัวแปรท่ีควรใหนิยาม คือ 

คาของตัวแปรแบบคาแบงประเภท (ระดับการวัดแบบจัดกลุมและจัดอันดับ) สวนคาตัวแปรแบบคา

ตอเนื่อง (ระดับการวัดแบบชวงและสัดสวน) เปนคาตัวแปรท่ีมีความหมายอยูในตัวอยูแลว ไมจําเปนตอง

ใหคําอธิบาย เชน คาใชจาย มีคาตัวแปรท่ีบันทึกไวเปน 10,000 เปนตน การใหคําอธิบายคาตัวแปร

สามารถแสดงใหเห็นไดเปนตัวอยาง ดังตอไปนี้   

ตารางท่ี 4.5 การสรางคําอธิบายคาตัวแปร 

ชื่อตัวแปร (Variable Name) คําอธิบายคาตัวแปร (Value Label) 

Id ไมตองใหความหมายเพราะลําดับท่ีแบบสอบถามมีความหมายอยูแลว 

Gender 1 = Male, 2 = Female 

ICT1 0 = No, 1 = Yes 

ICT2 0 = No, 1 = Yes 

Place 1 = Home, 2 = Relation, 3 = Office, 4 = School 

5 = Telecenter, 6 = Internet Café 

Cost ไมตองใหความหมายเพราะจํานวนคาใชจายมีความหมายอยูในตัวแลว 

คาตัวแปรท่ีไดจากคําตอบเรื่องเดียวกัน อาจมีคาตัวแปรท่ีแตกตางกัน ข้ึนอยูกับวัตถุประสงคใน

การเก็บขอมูล เชน อายุ คาใชจาย สามารถเก็บขอมูลได 2 แบบ ดังนี้ 

ตารางท่ี 4.6 ประเภทของคาตัวแปร 

ชื่อตัวแปร 
คาตัวแปร 

คาแบงกลุม คาตอเนื่อง 

อายุ (1) ต่ํากวา 15 ป 

(2) 15 – 60 ป 

(3) มากกวา 60 ป 

……………..ป 
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ชื่อตัวแปร 
คาตัวแปร 

คาแบงกลุม คาตอเนื่อง 

คาใชจายดานการสื่อสารราย

เดือน 

(1) นอยกวา 1,000 บาท 

(2) 1,001 – 5,000 บาท 

(3) มากกวา 5,000 บาท 

……………..บาท 

คาตัวแปรอายุและคาใชจาย เปนคาแบงกลุมตองใหคําอธิบาย สวนคาตัวแปรท่ีเปนคาตอเนื่อง 

ไมจําเปนตองใหคําอธิบาย เพราะมีความหมายอยูในตัวเองแลว  

6. คาขาดหาย (Missing Value) หรือ คาวาง หรือ คาสูญหาย อาจอยูในรูปของไมคาตัวแปรใน

ชองใสคาตัวแปร (cell) หรือ มีคาตัวแปรแตมีการกําหนดใหไมนํามาใชในการคํานวณ  

คาขาดหาย เกิดข้ึนไดในทุก ๆ งานวิจัย แมวามีการวางแผนการออกแบบแบบสอบถามใหรองรับ

คําตอบท่ีจะทําใหเกิดคาขาดหายไวแลวก็ตาม เชน ไมทราบ ไมตอบ ไมมีความคิดเห็น เปนตน คําตอบ

เหลานี้สวนใหญจะไมนําเขาไปรวมอยูในการประมวลผลขอมูล เพราะมีผลทําใหผลลัพธท่ีไดจากการ

คํานวณผิดไป การสรางคาขาดหายในแฟมขอมูลสามารถทําได 2 แบบ คือ  

  6.1 ไมใสคาใด ๆ ลงไปในชองใสคาตัวแปร (blank) แตโปรแกรมจะใหคาเปนจุด (.) วิธีนี้

โปรแกรมจะกําหนดใหเปนคาขาดหายของระบบ (system missing value) และไมนําเอาเขามารวมใน

การคํานวณโดยอัตโนมัติ 

  6.2 ใสรหัสท่ีกําหนดใหเปนคาขาดหาย (user missing value) รหัสตัวเลขท่ีนิยมนํามาใชเปน

คาขาดหาย คือ เลข 9 วิธีการนี้ผูใชโปรแกรมจะตองกําหนดใหโปรแกรมรูวาเลข 9 คือ คาขาดหาย ไม

ตองนํามารวมในการคํานวณ 

การกําหนดรหัสคาขาดหายตองสัมพันธกับประเภทของขอมูล หากประเภทขอมูลเปนตัวเลข 

รหัสคาขาดหายก็ตองเปนตัวเลขเชนกัน     

7. ความกวางของชองคาตัวแปรหรือสดมภ (Columns) คาเริ่มตน (default) ความกวางของ

สดมภท่ีโปรแกรมกําหนดไว คือ 8 ตําแหนง หากชื่อตัวแปรมีความยาวไมเกินท่ีโปรแกรมกําหนดไว การ

แสดงผลตัวแปรในหนาตางแสดงขอมูล (data view) จะแสดงผลอยูในบรรทัดเดียว แตหากชื่อตัวแปรมี

ความยาวมาก โปรแกรมจะแสดงผลในบรรทัดใหมในลักษณะซอนตอกัน ดังนั้นผูใชงานสามารถกําหนดให

การแสดงผลตัวแปรอยูในบรรทัดเดียวกันไดโดยกําหนดความกวางของสดมภใหมากข้ึน แตการสรางชื่อ
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ตัวแปรยาว ๆ เปนสิ่งท่ีควรหลีกเลี่ยง เพราะไมเพียงแตจะทําใหการแสดงผลไมสวยงามแลว การเพ่ิมความ

กวางของสดมภ จะมีผลทําใหการแสดงผลตัวแปรในหนาตางทําไดนอย การดูตัวแปรและคาตัวแปรใน

แนวนอนทําไดไมสะดวก เพราะตองใชแถบเลื่อนหนาจอ (scroll bar) เลื่อนดูขอมูลไปมา 

8. การจัดตําแหนงคาตัวแปร (Align) โปรแกรมมีการออกแบบการแสดงคาตัวแปรใหเห็นถึง

ความแตกตางของประเภทตัวแปรท่ีสรางไวเปนคาปริยาย ดังตอไปนี้ 

   8.1 ตัวแปรท่ีมีคาเปนตัวเลข การแสดงผลคาตัวแปรในหนาตางแสดงขอมูล คาตัวแปรจะ

แสดงผลชิดดานซายในชองใสคาตัวแปร  

   8.2 ตัวแปรท่ีมีคาเปนตัวอักษร คาตัวแปรจะแสดงผลชิดดานขวาในชองใสคาตัวแปร  

การเปลี่ยนแปลงการแสดงผลตําแหนงคาตัวแปรใหม สามารถทําได 3 แบบ จากรายการเมนู คือ 

แสดงผลชิดดานซาย (left) แสดงผลชิดดานขวา (right) และแสดงผลก่ึงกลาง (center) ตามท่ีตองการ 

แตการคงคาปริยายไวนาจะชวยใหการจําแนกประเภทตัวแปรทําไดงายกวาการจัดตําแหนงใหม 

9. ระดับการวัด (Measure) โดยท่ัวไปตัวแปรในการวิจัยแบงระดับการวัดเปน 4 ระดับ คือ 

มาตราแบบจัดกลุม มาตราแบบจัดอันดับ มาตราแบบชวง และมาตราแบบสัดสวน นําเอาท้ัง 4 ระดับมา

จําแนกเปนตัวแปรเชิงคุณภาพและเชิงปริมาณ หรือตัวแปรแบงกลุมและตัวแปรตอเนื่อง เปนตน แตการ

ใชโปรแกรม PSPP สรางตัวแปร แบงระดับการวัดตัวแปรเปน 3 แบบ ดังตอไปนี้ 

  9.1 ระดับการวัดแบบสเกล (Scale) 

  9.2 ระดับการวัดแบบจัดกลุม (Nominal) 

  9.3 ระดับการวัดแบบจัดอันดับ (Ordinal) 

การสรางตัวแปรท่ีมีคาเปนตัวเลขและตัวอักษรตามท่ีกลาวมาแลวเปนการกําหนดประเภทตัว

แปรตามคุณลักษณะของตัวแปร แตไมสามารถจําแนกไดวา ตัวแปรใดมีระดับการวัดท่ีเหมาะสมกับการ

นําเอาไปวิเคราะหดวยสถิติใด และโปรแกรมไดกําหนดคาปริยายระดับการวัดของตัวแปรแตละประเภท

ไวดังตอไปนี้ 

 

 

 

 



82 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

ตารางท่ี 4.7 ประเภทตัวแปรและระดับการวัด 

ประเภทตัวแปร ระดับการวัด 

Numeric Scale 

Comma Scale 

Dot Scale 

Scientific notation Scale 

Date Scale 

Dollar Scale 

Custom currency Scale 

String Nominal 

 การกําหนดระดับการวัดตัวแปรไมเพียงแตจะชวยใหโปรแกรมทําการคัดกรองตัวแปรแตละตัว

เขาไปในกระบวนการเลือกคําสั่งประมวลผลท่ีเหมาะสมเทานั้น แตยังชวยแสดงสัญลักษณระดับการวัดให

ผูวิเคราะหตัดสินใจเลือกใชตัวแปรในการเลือกใชคําสั่งในการคํานวณไดอยางเหมาะสมอีกดวย 

 10. บทบาทของตัวแปร (Role) คือ การกําหนดคุณสมบัติของตัวแปรท่ีเตรียมไวใชกับบางคําสั่งท่ี

ตองมีการเตรียมขอมูล (data preparation) การแทนคาแบบพหุ (multiple imputation) และการ

วิเคราะหแบบจําลอง (model techniques) เพ่ือนําไปใชในระบบสนทนา (dialog box) ในการติดตอกับ

ระบบผูใชงานแบบกราฟก (graphical user interfaces) ในการวิเคราะหขอมูล ดังนี้  

ตารางท่ี 4.8 ความหมายของบทบาทของตัวแปร 

บทบาทของตัวแปร ความหมาย 

Input ตัวแปรขอมูลเขาหรือตัวแปรอิสระ 

Output ตัวแปรผลลัพธหรือตัวแปรตาม 

None ไมกําหนดบทบาท (เปนคาเริ่มตน) 

Partition ตัวแปรท่ีมีการแบงขอมูลเปนกลุม ๆ สําหรับการสอน (training) หรือ การ

ทดสอบ (testing) หรือการตรวจสอบ (validation) 

Split ตัวแปรท่ีเตรียมไวสําหรับโปรแกรมอ่ืน ๆ หรือ third party software 
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สรุป 

ขอมูลท่ีเก็บรวบรวมดวยแบบสอบถามและตองการนํามาประมวลผลดวยโปรแกรมคอมพิวเตอร

ทางดานสถิติ ตองแปลงรูปใหเปนขอมูลท่ีคอมพิวเตอรสามารถอานไดในรูปของแฟมขอมูลท่ีมี

สวนประกอบท่ีสําคัญ คือ กรณีศึกษาหรือตัวอยาง ตัวแปร และคาตัวแปร 

 โดยท่ัวไปแฟมขอมูลท่ีนําขอมูลเขาโปรแกรมอาจจัดเก็บขอมูลเปนตารางท่ีประกอบดวยแถวท่ี

เปนชุดขอมูลของแบบสอบถามแตละฉบับ มีหัวแบงเปนสดมภเพ่ือใชเปนชื่อตัวแปร และมีชองใหใสขอมูล

หรือคาของแตละตัวแปร นอกจากแฟมขอมูลแบบตารางแลวยังมีแฟมขอมูลอีกประเภทหนึ่ ง ท่ี

คอมพิวเตอรสามารถนําไปประมวลผลได คือ แฟมขอมูลแบบตัวอักษรท่ีเก็บขอมูลเปนเปนแถว ๆ และมี

ตัวค่ันเปนเครื่องหมายลูกน้ํา (,) เครื่องหมายอัญประกาศ (" ") เวนระยะ (tab) เชน แฟมขอมูล *.csv 

หรือ *.txt  

แบบฝกหัดทายบท 

 ใหผูเรียนฝกแปลงแบบสอบถามเปนตัวแปรและขอมูลดังตอไปนี้ 

1. ใหผูเรียนสรางแบบสอบถามมีท้ังขอคําถามเลือกตอบแบบจัดกลุมและจัดอันดับ และขอ

คําถามแบบกรอกขอมูลเปนตัวเลขและตัวอักษร 

2. ใหผูเรียนแปลงแบบสอบถามใหเปนตัวแปรและคาตัวแปร 

  





 

 

บทที่ 5 

ความรูเบื้องตนเก่ียวกับโปรแกรมทางสถิติ 

ความมุงหมายของบทเรียน 

ผูเรียนรูจักโปรแกรมคอมพิวเตอรดานสถิติสําหรับวิเคราะหขอมูล สามารถติดตั้งและเริ่มใชงาน

เบื้องตนได  

เน้ือหา 

1. โปรแกรมสําเร็จรูปทางสถิติ 

2. การติดตั้งโปรแกรม PSPP 

3. การใชโปรแกรม PSPP เบื้องตน 

4. สวนประกอบของโปรแกรม PSPP 

5. เมนูการใชโปรแกรม PSPP 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง แนะนําการติดตั้งและการใชโปรแกรม ฝกปฏิบัติ ทําแบบฝกหัด 

แลกเปลี่ยนความคิดเห็น สรุป และทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ติดตั้งโปรแกรมวิเคราะหขอมูลใหเสร็จสมบูรณ และทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย ประเมิน

จากการติดตั้งโปรแกรม การใชโปรแกรม และการทําแบบฝกหัดทายบท   
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เนื้อหา 

การวิจัยเชิงปริมาณ สวนใหญมีการเก็บรวบรวมขอมูลจํานวนมากระดับหนึ่งตามขนาดของ

ประชากร ขอมูลท่ีเก็บรวบรวมมาแลว หากไมสามารถคํานวณและวิเคราะหอยางรวดเร็ว ขอมูลท่ีเก็บมา

อาจลาสมัยและไมมีประโยชนตอการวิจัย เพราะคําตอบและผลการทดสอบสมมติฐานการวิจัยไมใกลเคียง

สถานการณจริงท่ีเปลี่ยนไปตามการเปลี่ยนแปลงของสังคม ดังนั้นนักวิจัยจึงตองมีเครื่องมือท่ีสามารถ

ประมวลผลไดรวดเร็วและวิเคราะหขอมูลไดอยางซับซอน นั่นก็คือ โปรแกรมคอมพิวเตอรสําหรับการ

คํานวณและวิเคราะหขอมูล 

1. โปรแกรมสําเร็จรูปทางสถิต ิ

ปจจุบันโปรแกรมสําเร็จรูปสําหรับใชวิเคราะหขอมูลมีใหเลือกใชจํานวนมาก มีท้ังโปรแกรมแบบ

ใหใชฟรีและมีคาใชจาย และมีการจัดกลุมเปนโปรแกรมรหัสเปดหรือโอเพนซอรซ (open source) 

โปรแกรมสาธารณะ (public domain) โปรแกรมแจกฟรี  (freeware) และโปรแกรมมีลิขสิทธิ์ 

(proprietary) (Wikipedia, 2020) สําหรับในท่ีนี้แบงเปน 2 กลุม และมีตัวอยางโปรแกรมท่ีนิยมใชงาน

กันอยางแพรหลาย ดังตอไปนี้ 

1. โปรแกรมเชิงพาณิชย (Commercial Application) เชน IBM SPSS (Statistical Package 

for the Social Sciences) หรือ PASW (Predictive Analytics SoftWare), SAS (Statistical Analysis 

System) 

2. โปรแกรมแบบสาธารณะท่ัวไป (Non-commercial Application หรือ GNU (General 

Public License: GNU-GPL)12 เชน PSPP, R, JASP, JAMOVI 

โปรแกรมสําเร็จรูปทางสถิติมีการพัฒนาและออกแบบผานมาหลายยุค ในอดีตโปรแกรมสวนใหญ

ท่ีติดต้ังอยูบนเครื่องคอมพิวเตอรขนาดใหญ (main frame) และคอมพิวเตอรเครื่องแมขาย (server 

computer) ผูใชงานตองสงขอมูลและคําสั่งไปทําการประมวลผลผานเครื่องคอมพิวเตอรลูกขาย (client 

computer) แบบขอความ (command line) จนถึงในระยะแรกของยุคคอมพิวเตอรสวนบุคคล (PCs 

                                                           
12 ไมมีลิขสิทธิ์ (copyleft) เปดเผยและแพรรายละเอียดของโปรแกรม (open-source) ที่เรียกวา รหัสตนฉบบั (source code) เพื่ออนุญาต

ใหบุคคลทั่วไปสามารถไปทําซํ้า เผยแพร และดัดแปลงซอฟตแวรนั้นไดอยางถูกตองตามกฎหมาย และโดยเสรี 
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Era) ตอมาไดมีการพัฒนาระบบติดตอกับผูใชงานแบบกราฟก (graphic user interface: GUI) มีไอคอน 

(icon) และเมนู (menu) ทําใหสามารถใชงานไดงาย (user friendly) และในยุคหลังคอมพิวเตอรสวน

บุคคล (Post-PCs Era) มีหลายโปรแกรมท่ีสามารถใชงานจากระบบประมวลผลแบบกลุมเมฆ (cloud 

computing) ดวยโปรแกรมเรียกดูขอมูลบนอินเทอรเน็ต (browser) แบบออนไลน (online)  

สําหรับเอกสารคําสอนนี้จะแนะนําการใชเฉพาะโปรแกรม PSPP ท่ีติดตั้งบนคอมพิวเตอรสวน

บุคคลในระบบปฏิบัติการ Windows เทานั้น เพ่ือใหเรียนรูและฝกใชงานเบื้องตน โดยมีรายละเอียด

ดังตอไปนี้ 

2. การติดตั้งโปรแกรมทางสถิต ิ

 โปรแกรม PSPP เปน 1 ในโปรแกรมทางสถิติแบบรหัสเปด (Open Source Statistical 

Software: OSSS) ภายใตสัญญาอนุญาตใหใชซอฟตแวรแบบสาธารณะท่ัวไปท่ีเรียกกวา GNU General 

Public License (GNU-GPL) มี ให เลื อกใช ง านบนเครื่ องคอมพิว เตอร ส วนบุคคล (PC) หลาย

ระบบปฏิบัติการ (OS)13 โดยพัฒนาข้ึนมาเพ่ือเลียนแบบ (clone) ใหเปนตัวเลือกใชงานแทนโปรแกรม 

SPSS มีท้ังระบบการติดตอกับผูใชงานแบบกราฟก (GUI) และระบบคําสั่งแบบขอความ (command 

line) ท่ีคลายกัน แตมีคําสั่งและสถิติใหเลือกใชวิเคราะหขอมูลนอยกวา บางคําสั่งไมมีเมนูคําสั่งแบบ

กราฟกตองใชระบบคําสั่งแบบขอความแทน เชน การทดสอบกลุมตัวอยางมากกวา 2 กลุมท่ีเปนอิสระ

จากกัน (K Independent Samples Tests) 

ผูใชงานสามารถคนหาโปรแกรม PSPP จากอินเทอรเน็ต13

14 และทําการติดตั้งโปรแกรมกอนการ

ใชงานตามข้ันตอนดังตอไปนี้  

ข้ันท่ี 1 การคนหาและดาวนโหลดโปรแกรม 

1. เปดโปรแกรมคนหาขอมูลบนอินเทอรเน็ต (browser) เชน Google Chrome, Microsoft 

Edge  

                                                           
13 วินโดว (Windows) แมคโอเอสเท็น (Max OS X) และยูนกิซ/ลินุกซ (Unix/Linux)  
14 ควรดาวนโหลด (download) จากเว็บไซต GNU Project หรือ SOURCEFORGE เพราะเปนแหลงเผยแพรโปรแกรมที่มีความปลอดภัย

มากกวาแหลงอื่น และไมมีการดัดแปลงเพื่อติดต้ังโปรแกรมเสริมใหติดต้ังโปรแกรมอื่นเพิ่มเติมลงในเคร่ืองของผูใชงานซ่ึงอาจเปนทําให

คอมพิวเตอรเสียหายหรือสรางความรําคาญระหวางการใชงาน 
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2. พิมพคําวา pspp download 

3. เพ่ือความงายและลดข้ันตอนการเขาถึงไฟลติดตั้งใหเลือกลิงค pspp4windows download 

| SourceForge.net (https://sourceforge.net/projects/pspp4windows/)14

15 

4. คลิกเมาสท่ี Download 

 

4. Save เก็บไวใน Drive หรือ Folder ในเครื่องคอมพิวเตอรท่ีตองการติดตั้งโปรแกรม 

 

ข้ันท่ี 2 วิธีการติดตั้งโปรแกรม 

กอนการติดตั้งโปรแกรม ควรปดหรือหยุดการทํางานของโปรแกรมปองกันไวรัส การติดตั้ง

โปรแกรมสามารถเลือกทําได 2 วิธี ดังนี้ 

                                                           
15 ระบบใหบริการดาวโหลดจะพาไปที่เว็บไซต SOURCEFORGE และเลือกไฟลติดต้ังเวอรลาสุดและระบบปฏิบัติการ (OS) ที่กําลังใชงานให

อัตโนมัติ 



ค ว า ม รู เ บื้ อ ง ต น เ ก่ี ย ว กั บ โ ป ร แ ก ร ม ท า ง ส ถิ ติ | 89 

 

1. การติดตั้งแบบท่ัวไป (default) เปนวิธีการใหโปรแกรมกําหนดคุณสมบัติของโปรแกรมให

เหมาะกับระบบปฏิบัติการเอง มีข้ันตอนดังตอไปนี้  

๏ ดับเบิลคลิกเมาสท่ีไฟลติดตั้ง                                                   (ชื่อไฟลจะแตกตาง

ไปตามเวอรชั่นลาสุด) 

๏ หากโปรแกรม Windows แสดงหนาตาง User Account Control -> กดปุม Yes 

 

2. การติดตั้งแบบปรับแตงโดยผูใชงาน (customization) เปนวิธีท่ีผูใชงานสามารถกําหนด

คุณสมบัติในการติดตั้งโปรแกรมใหเหมาะสมกับระบบปฏิบัติการท่ีใชงาน โดยมีข้ันตอนดังนี้ 

๏ คลิกขวาท่ีไฟลติดต้ัง (ชื่อไฟลจะแตกตางไปตามเวอรชั่นลาสุดท่ีปรับปรุง) -> เลือกเมนู

คําสั่ง Properties  

๏ เลือกแถบ Compatibility ในหนาตาง Properties  

๏ เลือกคลิก / ท่ีคาท่ีตองการกําหนดคา 

๏ กดปุม Apply และกดปุม OK 

การติดตั้งโปรแกรม
(Installation)

การติดตั้งแบบท่ัวไป
(Defualt)

การติดตั้งแบบปรับแตงโดยผูใชงาน
(Customization)
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๏ ดับเบิลคลิกเมาสท่ีไฟลติดตั้ง                                                             

๏ หากโปรแกรม Windows แสดงหนาตาง User Account Control -> กดปุม Yes 

 

3. โปรแกรมแสดงหนาตาง Readme -> กดปุม Next 

 

4. โปรแกรมแสดงหนาตางใหเลือกพ้ืนท่ีในการติดตั้ง 
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๏ หากตองการติดตั้งในพ้ืนท่ีท่ีโปรแกรมกําหนด -> กดปุม Install 

๏ หากไมตองการติดตั้งในพ้ืนท่ีท่ีโปรแกรมกําหนด -> กดปุม Browse เลือกพ้ืนท่ีติดตั้งใหม 

 

 5. ระหวางการติดตั้ง โปรแกรมจะแสดงขอความวา Installing 

 

 6. เม่ือติดตั้งเสร็จเรียบรอยแลว โปรแกรมจะแสดงขอความวา Installation Complete หรือ 
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 7. เม่ือติดตั้งโปรแกรมเสร็จเรียบรอยแลว บนพ้ืนจอของคอมพิวเตอร (desktop) จะแสดง

ไอคอนหรือสัญรูป (icon) 2 ไอคอน คือ แฟมขอมูลคูมือการใชงาน (PSPP Manual) และปุมเปด

โปรแกรม (PSPP) 

  

หากตองการจัดเก็บไอคอนไวใหเปนระเบียบ ไมปนกับไอคอนอ่ืน ๆ ทําใหหางายเม่ือตองการใช

งาน ใหสรางโฟลเดอรบนพ้ืนจอของคอมพิวเตอรแลวยาย 2 ไอคอน ไปเก็บไวในโฟลเดอรดังกลาว โดย

คลิกขวาบนพ้ืนจอคอมพิวเตอร -> New -> Folder -> พิมพชื่อ PSPP -> ใชเมาสลากไอคอนไปใสไวใน

โฟลเดอร 

 

 

 

3. การใชโปรแกรมทางสถิติเบ้ืองตน 

 การใชโปรแกรมเบื้องตน เปนการแนะนําวิธีการเปดและปดโปรแกรม และใหรูจักสวนประกอบท่ี

สําคัญ ๆ ของโปรแกรม เชน เมนู คําสั่ง ระบบนําเขาขอมูล และระบบแสดงผล 

3.1 การเปดโปรแกรม มี 3 วิธี ดังนี้ 

 

๏ Start (เมนู)         -> PSPP (กลุมโปรแกรม) -> PSPP (โปรแกรม) 

การเปดโปรแกรม
(Open)

เมนู
(Menu)

คนหา
(Search)

ไอคอนหรือสัญรูป 
(Icon) 
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๏ คลิกท่ีเครื่องมือคนหา (search) ดานลางซายของจอภาพ         -> พิมพ

คําวา pspp 

 

๏ คลิกท่ีคําวา Open 

 

๏ คลิกท่ีไอคอนหรือสัญรูป (icon) PSPP บนพ้ืนจอของคอมพิวเตอร (desktop) 
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3.2 การเปดแฟมขอมูล (ทดลองเปดแฟมขอมูลตัวอยาง hotel.sav)  

๏ File -> New -> Data (ไปท่ี C:\Program Files\PSPP\share\pspp\examples) 

๏ เลือกไฟล hotel.sav  

๏ กดปุม Open 

 
 

 

3.3 การปดโปรแกรม มี 3 วิธี ดังนี้ 

 

๏ เมนู File -> Quit (Ctrl+Q) หรือ  

๏ กดปุม Ctrl+Q บนแปนพิมพ 

๏ คลิกเครื่องหมาย X มุมบนดานซายของโปรแกรม 

การปดโปรแกรม
(Quit)

เมนูคําสั่ง
(Menu Bar)

แปนพิมพ
(Keyboard)

ปุมปด
(Icon)
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๏ กดปุม Close without saving (ปดโดยไมทําการบันทึกแฟมขอมูล) 
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4. สวนประกอบของโปรแกรม PSPP 

โปรแกรม PSPP มี 3 ระบบท่ีสําคัญ คือ ระบบจัดการขอมูล (Data Editor) ระบบแสดงผลลัพธ 

(Output Viewer) และระบบคําสั่งแบบขอความ (Syntax Editor) โดยมีรายละเอียดดังตอไปนี้ 

4.1 ระบบจัดการขอมูล  

ระบบจัดการขอมูลประกอบดวยระบบแสดงรายการตัวแปร (Variable View) และระบบแสดง

รายการขอมูล (Data View) โดยมีรายละเอียดตามภาพดานลาง 

 

ระบบแสดงรายการตัวแปร (Variable View) 

 
ระบบแสดงรายการขอมูล (Data View) 

Menu Bar (แถบเมนูชุดคําส่ัง) 

Toolbar (แถบปุมคําส่ัง) 

Variable View (แถบเปล่ียนการแสดงรายการตัวแปร) 

Data View (แถบเปล่ียนการแสดงรายการขอมูล) 

Title Bar (แถบชื่อแฟมขอมูลและระบบโปรแกรม)

 

Variable Attributes (สดมภหรือคอลัมนแสดงคุณลักษณะของตัวแปร) 

Variables (รายการตัวแปร) 

Case (ชุดขอมูล) 

Cell Editor (ชองแสดงคาตัวแปร) 

Cell (ชองใสคาตัวแปร) 

Variable Name (ชื่อตัวแปร) 

Status Bar (แถบสถานภาพการทํางานของโปรแกรม) 
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4.2 ระบบแสดงผลลัพธ  

ระบบแสดงผลลัพธจะปรากฎใหเห็นเม่ือมีการใชคําสั่งใดคําสั่งหนึ่งในกระบวนการวิเคราะห

ขอมูล  

๏ ทดลองวิเคราะหขอมูลจากแฟมขอมูล hotel.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies…  

o Variables(s): เลือกตัวแปรท้ังหมด (v1 v2 v3 v4 v5) ใสในชอง Variables 

(ดับเบิลคลิกเมาสเมาสท่ีชื่อตัวแปรหรือใชเมาสชี้ท่ีชื่อตัวแปรและกดปุม 

o กดปุม OK 

 

 

Title Bar (แถบชื่อแฟมผลลัพธและระบบโปรแกรม) 
Menu Bar (แถบเมนูชุดคําส่ัง) 

Tree Diagram of Result (เมนูรายการผลลัพธ) 

Syntax Output (ผลลัพธของคําส่ังแบบขอความ) 

Table Output (ตารางผลลัพธ) 
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4.3 ระบบคําสั่งแบบขอความ  

๏ เปดจากเมนูคําสั่ง File -> New -> Syntax ในระบบจัดการขอมูล  

๏ ทดลองพิมพคําสั่งแบบขอความใน Syntax Editor ตามตัวอยางดานลาง 

frequencie 

/variable = v1 v2 v3 v4 v5 

/format = avalue table. 

 

๏ เลือกเมนู Run -> All 

4.4 การใชผลลัพธ 

 ผลลัพธท่ีไดจากการประมวลผลโปรแกรมจะเปดเปนหนาตางระบบแสดงผลลัพธ (Output 

Viewer) การใชผลลัพธมี 3 วิธี ดังนี้ 

 

๏ การดูผลลัพธจากหนาจอภาพ  

o นําผลลัพธไปกรอกใสตารางท่ีเตรียมไว ผลลัพธจากหนาจอภาพไมสามารถ Copy ไปใสใน

เอกสารอ่ืนได  

๏ การพิมพออกเครื่องพิมพ 

o เมนู File -> Print  

ผลลัพธ
(Ouput)

จอภาพ
(Screen)

เครื่องพิมพ
(Printer)

แฟมขอมูล
(Files)

Title Bar (แถบชื่อระบบโปรแกรม) 
Menu Bar (แถบเมนูชุดคําส่ัง) 

Syntax (คําส่ังแบบขอความ) 
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o เลือกเครื่องพิมพ 

๏ ก า ร ส ง อ อ ก  ( export) เ ป น แ ฟ ม ข อ มู ล น า ม ส กุ ล  PDF (*.pdf) HTML (*.html) 

OpenDocument (*.odt) Text (*.txt) และ Text [plain] (*.txt) PostScript (*.ps) และ 

Comma-Separated Value (*.csv) 

o เมนู File -> Export  

o พิมพชื่อไฟล ในชอง Name ดานบนของหนาตาง Export Output  

o เลือกประเภทไฟลจาก Infer file type from extension 

o เลือก Drive และ Folder ท่ีตองการเก็บขอมูล 

o กดปุม Save 
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5. เมนูการใชโปรแกรม PSPP 

 โปรแกรม PSPP ออกแบบเมนูสําหรับใหใชงานเปน 2 สวน คือ เมนูแบบรายการคําสั่ง (menu 

bar) และเมนูแบบปุมภาพ (toolbar) โดยมีรายละเอียดดังตอไปนี้ 

5.1 หนาตางระบบ Data Editor 

 Data Editor เปนระบบท่ีใชงานมากท่ีสุดระบบหนึ่งในการใชโปรแกรมแบบกราฟก (GUI) มีเมนู 

2 แบบดังตอไปนี้  

5.1.1 เมนูแบบรายการคําส่ัง (Menu Bar) 

 เมนูแบบรายการคําสั่งเปนเมนูแบบผังหรือตนไม (tree menu) แบงเปนกลุมคําสั่ง เม่ือใชคลิก

เมาสชี้และคลิกขวาจะมีรายการคําสั่งยอยใหเลือกใชดังตอไปนี้ 

5.1.1.1 เมนู File 

 เมนู File เปนเมนูรวมคําสั่งท่ีเก่ียวกับการจัดการแฟมขอมูล (file management) ไดแก New 

(สรางแฟมขอมูลใหม) Open (เปดแฟมขอมูลท่ีมีอยูแลว) Import Data (นําขอมูลเขาจากแฟมขอมูล

โปรแกรมอ่ืน) Save (จัดเก็บขอมูล) Save As (จัดเก็บขอมูลเปนแฟมขอมูลชื่อใหม) Rename Dataset 

(เปลี่ยนชื่อชุดขอมูล) Display Data File Information (แสดงรายละเอียดของขอมูลในแฟมขอมูล) 

Recently Used Data และ Recently Used Files (เลือกใชแฟมขอมูลท่ีเปดใชงาน) และ Quit (ปด

หรือออกจากโปรแกรม PSPP) 
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5.1.1.2 เมนู Edit 

 เมนู Edit เปนเมนูรวมคําสั่งเก่ียวกับจัดการตัวแปร (variable management) เพ่ือเพ่ิมหรือ

แกไขตัวแปร ไดแก Insert Variable (เพ่ิมตัวแปร) Go To Variable (เลื่อนหรือวิ่งไปยังตัวแปรท่ีเลือก) 

Cut (ตัดขอมูล) Copy (สําเนาขอมูล) Paste (วางหรือแปะขอมูลท่ีไดจากการตัดหรือสําเนาขอมูล) Clear 

Variables (ลบตัวแปร) และ Options (กําหนดรูปแบบการแสดงผลรายการตัวแปร) 

 

5.1.1.3 เมนู View 

เมนู View เปนเมนูรวมคําสั่งเก่ียวกับการจัดการการแสดงผล (display management) เพ่ือให

แสดงผลหรือหรือไมแสดงผล และเปลี่ยนแปลงการแสดงผล ไดแก Status Bar (ปด/เปดแถบสถานภาพ

การทํางานของโปรแกรม) Font (เปลี่ยนประเภทและขนาดตัวอักษร) Grid Line (แสดง/ไมแสดงเสนแบง

ในตารางขอมูล) Value Labels (แสดง/ไมแสดงคําอธิบายคาตัวแปร)  Data (แสดงขอมูล) และ 

Variables (แสดงรายการตัวแปร) 

 

 

 



102 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

5.1.1.4 เมนู Data 

 เมนู Data เปนเมนูรวมคําสั่งเก่ียวกับปรับขอมูล (data manipulation) ไดแก Sort Cases (การ

จัดเรียงขอมูล) Transpose (การไขวตัวแปร) Aggregate (การรวมขอมูล) Split File (การแบงขอมูล)  

Select Cases (การเลือกขอมูล) และ Weight Cases (การกําหนดน้ําหนักขอมูล) 

 

5.1.1.5 เมนู Transform 

เมนู Transform เปนเมนูรวมคําสั่งเก่ียวกับการแปลงรูปแบบขอมูล (variable 

transformation) ไดแก Compute (การสรางตัวแปรแบบคาตอเนื่อง) Count (การนับจํานวนขอมูล) 

(Rank Cases (การจัดลําดับตัวอยาง) Automatic Recode (การสรางตัวแปรแบบอัตโนมัติ) Recode 

into Same Variables (การเปลี่ยนคาตัวแปรในตัวแปรเดิม) Recode into Different Variables (การ

สรางตัวแปรแบบคาแบงกลุม) และ Run Pending Transforms (การสั่งประมวลผลตอ) 

 

5.1.1.6 เมนู Analyze 

 เมนู Analyze เปนเมนูรวมคําสั่งเก่ียวกับการวิเคราะหขอมูล (data analysis) ดวยสถิติประเภท

ตาง ๆ ไดแก Descriptive Statistics (การวิเคราะหดวยสถิติเชิงพรรณนา) Compare Means (การ
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วิเคราะหเปรียบเทียบคาเฉลี่ย) Univariate Analysis (การวิเคราะหตัวแปรเดี่ยว) Bivariate Correlation 

(การวิเคราะหความสัมพันธรายคู) Factor Analysis (การวิเคราะหองคประกอบ) Reliability (การ

วิเคราะหความนาเชื่อถือ) Linear Regression (การวิเคราะหถดถอยเชิงเสนตรง) Non-Parametric 

Statistics (การวิเคราะหดวยสถิติไมอิงคาพารามิเตอร) และ ROC Curve (การวิเคราะหพ้ืนท่ีใตโคง)   

 

5.1.17 เมนู Graphs 

เมนู Graphs เปนเมนูรวมคําสั่งเก่ียวกับการวิเคราะหขอมูลดวยวิทัศนหรือกราฟ ไดแก 

Scatterplot (กราฟการกระจาย) Histogram (กราฟแจกแจงความถ่ี) และ Barchart (กราฟแทง) 

 

5.1.1.8 เมนู Utilities 

เมนู Utilities เปนเมนูรวมคําสั่งเก่ียวกับการจัดการตัวแปรและแฟมขอมูล ไดแก Variables 

(แสดงรายละเอียดหรือขอมูลเก่ียวกับตัวแปร เลื่อนหรือวิ่งไปยังตัวแปร และแปะขอมูลเก่ียวกับตัวแปร ) 

และ Data File Comments (บันทึกหรือเขียนคําแนะนําเก่ียวกับแฟมขอมูล) 
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5.1.1.9 เมนู Windows 

เมนู Windows เปนเมนูรวมคําสั่งเ ก่ียวกับการจัดการหนาตางท่ีกําลังใชงาน (windows 

management) ไดแก Minimize all Windows (ยุบ/ปดหนาตางท้ังหมด) Split (แบงตารางรายการตัว

แปรหรือขอมูลเปน 4 สวน) และ DataSet (เลือกชุดขอมูลท่ีกําลังเปดใชงาน) 

 

5.1.1.10 เมนู Help 

 เมนู Help เปนเมนูรวมคําสั่งเก่ียวกับความชวยเหลือ ไดแก Reference Manual (คูมืออางอิง/

การใชงาน) และ About (ขอมูลโดยยอเก่ียวกับโปรแกรม) 

 

5.1.2 เมนูแบบปุมภาพ (Toolbar) 

 เมนูแบบปุมภาพเปนเมนูคําสั่งประเภทหนึ่งท่ีทีมพัฒนาเลือกคําสั่งท่ีใชงานกันบอยมาออกแบบ

เปนปุมกดและมีภาพสัญลักษณประกอบ ๆ เพ่ือใหใชงานไดสะดวกและรวดเร็วตามแนวคิด GUI  โดยมี

คําสั่งดังตอไปนี้ 

 

 

 

 

 

เปดแฟมขอมูล 

บันทึกแฟมขอมลู 

ไปยังตัวแปรที่เลือก 

สรางตัวแปรใหม 

แบงกลุมตวัอยาง 

กําหนดน้ําหนกั 

แสดง/ซอนคําอธิบายคาของตัว

แปร 
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5.2 หนาตางระบบ Syntax Editor 

 การใชโปรแกรม PSPP แบบ GUI บางครั้งอาจตองใชคําสั่งแบบขอความ (command line) โดย

เปดระบบ Syntax Editor จากเมนู File -> New -> Syntax และเม่ือหนาตางระบบ Syntax Editor 

ปรากฎข้ึนจะมีเมนูใหใชงานดังตอไปนี้ 

5.2.1 เมนู File 

 เมนู File เปนเมนูรวมคําสั่งท่ีเก่ียวกับการจัดการแฟมขอมูล (file management) เหมือนกับ

ระบบ Data Editor ไดแก New (สรางแฟมขอมูลใหม) Open (เปดแฟมขอมูลท่ีมีอยูแลว) Save (จัดเก็บ

ขอมูล) Save As (จัดเก็บขอมูลเปนแฟมขอมูลในชื่อใหม) Print (พิมพ Syntax ออกเครื่องพิมพ) และ 

Quit (ปดระบบ Syntax Editor) 

 

5.2.2 เมนู Edit 

เมนู Edit เปนเมนูรวมคําสั่งท่ีเก่ียวกับการจัดการคําสั่งหรือขอความใน Syntax ไดแก Cut (ตัด) 

Copy (สําเนา) Paste (แปะ) Delete (ลบ) Undo (ทํากลับ/ยกเลิก) Redo (ทําใหม) และ Find (คนหา) 
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5.2.3 เมนู Run 

เมนู Run เปนเมนูรวมคําสั่งท่ีเก่ียวกับการประมวลผล Syntax ไดแก All (ประมวลผลท้ังหมด) 

Selection (ประมวลผลเฉพาะท่ีเลือก) Current Line (ประมวลผลเฉพาะบรรทัดท่ีตัวชี้ตําแหนงวางอยู) 

และ To End (ประมวลผลจากตําแหนงท่ีตัวชี้ตําแหนงวางอยูจนสุด Syntax) 

 

5.2.4 เมนู Windows 

เมนู Windows เปนเมนูรวมคําสั่งท่ีเก่ียวกับการจัดการหนาตางระบบ Syntax Editor ไดแก 

Minimize all Windows (ยุบ/ปดหนาตางท้ังหมด) Output (เลือกเปดหนาตางผลลัพธ) และ Syntax 

Editor (เลือกเปดหนาตาง Syntax Editor) 

 

5.2.5 เมนู Help 

เมนู Help เปนเมนูรวมคําสั่งเก่ียวกับความชวยเหลือ ไดแก Reference Manual (คูมืออางอิง/

การใชงาน) และ About (ขอมูลโดยยอเก่ียวกับโปรแกรม) 
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5.3 หนาตางระบบ Output Viewer 

 หนาตางระบบ Output Viewer จะแสดงผลทุกครั้งท่ีมีการใชคําสั่งของโปรแกรม เชน เปด

แฟมขอมูล ประมวลผลขอมูล แกไขขอมูล ฯลฯ และเม่ือหนาตางระบบ Output Viewer ปรากฎข้ึนจะมี

เมนูใหใชงานดังตอไปนี้ 

5.3.1 เมนู File 

เมนู File เปนเมนูรวมคําสั่งเก่ียวกับการพิมพและสงออกผลลัพธ ไดแก Print (พิมพผลลัพธออก

ทางเครื่องพิมพ) Export (สงผลลัพธออกเปนไฟล *.spv, *.pdf, *.html, *.odt, *.txt, *.ps และ *.csv) 

และ Quit (ปดระบบ  Output Viewer) 

 

5.3.2 เมนู Edit 

เมนู Edit เปนเมนูรวมคําสั่งเก่ียวกับการจัดสําเนาผลลัพธ ไดแก Select All (เลือกผลลัพธ

ท้ังหมด) Copy (สําเนาผลลัพธท่ีเลือก) 

 

5.3.3 เมนู Windows 

เมนู Windows เปนเมนูรวมคําสั่งท่ีเก่ียวกับการจัดการหนาตางระบบ Output Viewer ไดแก 

Minimize all Windows (ยุบ/ปดหนาต าง ท้ังหมด) Output ( เลือกเปดหนาต างผลลัพธ )  และ 

D:\Data\PSPP\ASPSS_Data.sav [DataSet1] (เลือกเปดหนาตางขอมูล) 
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5.3.4 เมนู Help 

เมนู Help เปนเมนูรวมคําสั่งเก่ียวกับความชวยเหลือ ไดแก Reference Manual (คูมืออางอิง/

การใชงาน) และ About (ขอมูลโดยยอเก่ียวกับโปรแกรม) 

 

สรุป 

 โปรแกรม PSPP เปนโปรแกรมแบบสาธารณะท่ัวไป สามารถดาวนโหลดจากอินเทอรเน็ตมา

ติดตั้งและใชงานไดฟรี มีระบบติดตอกับผูใชงานท้ังแบบใชคําสั่งท่ีเปนขอความ (command line) และ

แบบกราฟก (GUI) เหมาะสําหรับผูเรียนท่ีเริ่มเรียนรูการวิเคราะหขอมูลและเริ่มทําวิจัยเบื้องตน และยัง

เปนโปรแกรมเริ่มตนสําหรับเรียนรูการวิเคราะหขอมูลดวยสถิติกอนกาวไปใชโปรแกรมอ่ืนตอไป 

แบบฝกหัดทายบท 

 ใหผูเรียนทบทวนการใชโปรแกรมดังตอไปนี้ 

1. ใหผูเรียนทดลองเปดโปรแกรมและปดโปรแกรม  

2. ศึกษาเมนู คําสั่ง และสวนประกอบของโปรแกรมวามีอะไรบาง 

  



 

 

บทที่ 6 

การนําขอมูลเขาโปรแกรม 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถนําขอมูลจากแบบสอบถามกรอกเขาโปรแกรม และนําขอมูลท่ีเก็บอยูในรูปของ

แฟมขอมูลเขาโปรแกรม  

เน้ือหา 

1. การนําขอมูลเขาจากแบบสอบถาม 

2. การนําขอมูลเขาจากแฟมขอมูล 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง สํารวจขอมูลในชั้นเรียน ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยน

ความคิดเห็น สรุป และทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และการ

ทําแบบฝกหัดทายบท  
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เนื้อหา 

ขอมูลท่ีใชในการวิจัยเชิงปริมาณอาจเปนขอมูลปฐมภูมิ (primary data) ท่ีไดจากการใช

แบบสอบถามในการรวบรวมขอมูล มีท้ังการสํารวจดวยแบบสอบท่ีสรางดวยกระดาษ (non-digital 

questionnaire) และแบบสอบถามท่ีสรางดวยโปรแกรมคอมพิวเตอร (digital questionnaire) และ

ขอมูลทุติยภูมิ (secondary data) ท่ีจัดเก็บไวแลว มีท้ังขอมูลแบบเกาท่ีเก็บไวเปนเอกสาร (non-digital 

data) เชน หนังสือ รายงานประจําป และขอมูลแบบใหมท่ีเปนดิจิทัล (digital data) เชน แฟมขอมูล

คอมพิวเตอร และโปรแกรมฐานขอมูล  

การนําขอมูลเขาไปวิเคราะหดวยโปรแกรมคอมพิวเตอรจึงตองมีการเตรียมขอมูลตามลักษณะ

ของขอมูลท่ีไดมา ซ่ึงอาจตองเริ่มจากการสรางแฟมขอมูล นําขอมูลเขาแบบกรอกขอมูล หรือดึงเขาจาก

แฟมขอมูล   

1. การนําขอมลูเขาจากแบบสอบถาม 

 แบบสอบถามหรือแบบสํารวจเปนเครื่องมือวัดท่ีนิยมใชในการรวบรวมขอมูลอยางแพรหลาย 

ปจจุบันนักวิจัยอาจตองสรางแบบสอบถามท้ังแบบเกาโดยใชการพิมพดวยกระดาษหรือท่ีเรียกวา 

แบบสอบถามแบบออฟไลน และอาจตองใชแบบสอบถามออนไลนควบคูกันไป เพราะผูตอบแบบสอบถาม

อาจถนัดหรือมีความพรอมใชแบบใดแบบหนึ่ง จึงตองเตรียมสรางแบบสอบถามท้ังสองแบบไวให

เลือกตอบ ดังนั้นหากมีการเก็บรวบรวมขอมูลดวยแบบสอบถามแบบออฟไลนจึงตองทําการสราง

แฟมขอมูลและกรอกขอมูลเขาโปรแกรมโดยมีวิธีการดังตอไปนี้ 

1.1 การสรางแฟมขอมูล 

การสรางแฟมขอมูล คือ การสรางแบบฟอรมรับขอมูจากแบบสอบถาม หรือเปนการแปลง

แบบสอบถามใหเปนขอมูลท่ีโปรแกรมสามารถนําไปประมวลผลได เม่ือเขาใจถึงความสัมพันธระหวาง

แบบสอบถามกับแฟมขอมูลแลว เราสามารถสรางแฟมขอมูลจากโปรแกรมไดดังนี้ 
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 1. เปดโปรแกรม PSPP โปรแกรมจะแสดงหนาตางระบบจัดการขอมูล (Data Editor) 

 2. คลิกเมาสท่ีแถบ Variable View ดานลางซายของหนาตาง Data Editor 

 

 3. ตัวอยางแฟมขอมูล 

 

4. การสรางตัวแปร 

 การสรางตัวแปร คือ การแปลงขอคําถามใหเปนตัวแปร บางขอคําถามอาจตองแปลงจากคําตอบ 

รวมถึงการกําหนดคุณลักษณะของตัวแปร เชน ชื่อตัวแปร ประเภทตัวแปร ลักษณะของขอมูล คําอธิบาย

ชื่อตัวแปร และคําอธิบายคาตัวแปร   

โดยท่ัวไปการเลื่อนตัวชี้ตําแหนงหรือเคอรเซอร (cursor) ไปยังชองตาง ๆ (cells) ในโปรแกรม 

PSPP สามารถใชเมาส (mouse) หรือ ทัชแพด (touchpad) หรือ แทร็คแพด (trackpad) เลื่อนได

เหมือนกับโปรแกรมท่ัวไป และสามารถใชคียบอรด (keyboard) ปุมลูกศรซายหรือขวา และปุมลูกศรข้ึน

หรือลง เลื่อนตัวชี้ตําแหนงหรือเคอรเซอรไปยังชองท่ีอยูใกลเคียงไดเชนกัน  

เนื่องจากมีบางคอลัมนท่ีมีระบบเมนูใหเลือกกําหนดคาซอนอยู เชน Type, Width Decimal, 

Value Labels, Missing Values, Align, Measure และ Role ทําใหไมสามารถใชคียบอรดปุมลูกศรซาย

หรือขวาเลื่อนไปทางซายหรือขวาได ตองใชคียบอรดปุมแท็บ (tab) เลื่อนจากซายไปขวา และใชปุมชิฟท 

(shift) + แท็บ (tab) เลื่อนจากขวาไปซาย 
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๏ การกําหนดชื่อตัวแปร (Variable Name)  

o พิมพช่ือตัวแปรในชองใตคอลัมน Name  
 

๏ การกําหนดประเภทและรูปแบบตัวแปร (Variable Type)  

o คลิกเมาสในชองใตคอลัมน Type โปรแกรมจะแสดงหนาตางใหกําหนดรูปแบบและ

ประเภทของตัวแปร (ถาใชตัวเลขเปนขอมูลของตัวแปรใหเลือก Numeric หรือถาใช

ตัวอักษรเปนขอมูลของตัวแปรใหเลือก String) 

o กําหนดจํานวนคาตัวแปร ในชอง Width: โดยพิมพตัวเลขทับตัวเลขคาเริ่มตน หรือกด

ปุม - หรือ + 

o กําหนดจํานวนทศนิยมตัวแปร ในชอง Decimal Places: โดยพิมพตัวเลขทับตัวเลขคา

เริ่มตน หรือกดปุม - หรือ + 

o กดปุม OK 

 

ขอมูลของตัวแปรดานสังคมศาสตรสวนใหญเปนตัวเลข (numeric) และตัวอักษร (string) หาก

ขอมูลเปนตัวอักษรควรแทนคาใหเปนตัวเลข และกําหนดใหเปนตัวแปรประเภท Numeric เพราะบาง

คําสั่งไมแสดงตัวแปรท่ีเปนตัวอักษร เชน Means หากกําหนดคาตัวแปร ชาย = M และ หญิง = F ตัว

แปรจะไมปรากฏในรายการตัวแปรใหเลือกเพ่ือทําการวิเคราะหเปรียบเทียบ ตองแปลงคาของตัวแปรให

เปนตัวเลขกอน) 

๏ การกําหนดจํานวนคาตัวแปร (Variable Width)  

o พิมพตัวเลขจํานวนคาตัวแปรใตคอลัมน Width 

หรือกดปุม - หรือ +   

 คาเริ่มตน (default) จํานวนคาตัวแปรของตัวแปรแบบตัวเลขและตัวอักษรกําหนดไวเปน 8 

ตําแหนง หากไมตองการบังคับจํานวนคาตัวแปรท่ีใหกรอกขอมูล ใหใชคาเริ่มตน 
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๏ การกําหนดจํานวนทศนิยมของคาตัวแปร (Variable Decimal)  

o พิมพตัวเลขจํานวนทศนิยมใตคอลัมน Decimal หรือกด

ปุม - หรือ +   

คาเริ่มตน (default) จํานวนทศนิยมของตัวแปรประเภทตัวเลขกําหนดไวเปน 2 ตําแหนง และ

ตัวแปรประเภทตัวอักษรกําหนดไว 0 ตําแหนง หากตองการใหการแสดงขอมูลในหนาตางแสดงขอมูล 

(data view) เขาใจงาย ดูแลวสามารถจําแนกประเภทตัวแปรไดวาตัวแปรใดเปนตัวแปรแบบคาแบงกลุม

และตัวแปรแบบคาตอเนื่อง ใหกําหนดจํานวนทศนิยมของตัวแปรแบบคาแบงกลุม คือ Nominal และ 

Ordinal เปน 0 ตําแหนง และกําหนดจํานวนทศนิยมของตัวแปรแบบคาตอเนื่อง คือ Scale เปน 2 

ตําแหนง (ตัวแปรคาตอเนื่องควรใชแบบ F8.2 หรือ Width = 8 และ Decimal = 2 เพ่ือใหผลลัพธ

จากคําส่ัง Compare Means แสดงทศนิยม 2 ตําแหนง) 

๏ การกําหนดคําอธิบายชื่อตัวแปร (Variable Label)  

o พิมพคําอธิบายช่ือตัวแปรใตคอลัมน Label   

หากชื่อตัวแปรสื่อความหมาย อาจไมตองมีคําอธิบายชื่อตัวแปร เชน Gender หากใชชื่อยอและ

ไมสื่อความหมาย เชน V1 หรือ QoS ควรกําหนดชื่อตัวแปรพอใหเขาใจได ไมยาวมาก เพราะหากสราง

ชื่อตัวแปรยาวมากจะมีผลในตารางการแสดงผลการวิเคราะห 

๏ กําหนดคําอธิบายคาของตัวแปร (Values)  

o คลิกเมาสในชองวางใตคอลัมน Value 

Labels (โปรแกรมจะแสดงหนางตางให

กําหนดคาและคําอธิบายคาของตัวแปร) 

o พิมพคาของตัวแปรในชอง Value: 

o พิมพความหมายของคาของตัวแปรในชอง 

Value Label: 

o กดปุม Add 

 

การแกไขคาและความหมายของคาของตัวแปร ใหคลิกเมาสท่ีคานั้นและทําการแกไข เม่ือทําการ

แกไขแลวใหกดปุม Apply เพ่ือเปลี่ยนแปลงคาและความหมาย และหากตองการลบความหมายของคา

ของตัวแปร ใหคลิกเมาสท่ีคานั้นและกดปุม Remove 

โปรแกรม PSPP ไมสามารถ Copy คาในชอง Value Labels ได หากตัวแปรมี Value Label 

เหมือนกัน ใหใชวิธีการดังนี้ 
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1. สรางตัวแปรใหครบ โดยยังไมตองกําหนด Value Labels 

2. เลือกเมนู File -> New -> Syntax 

ตัวอยาง 

ตัวแปร V1 V2 V3 V4 ใหพิมพคําสั่งในหนาตาง 

Syntax Editor ดังนี้ 

add value label V1 V2 V3 V4 0 'No' 1 

'Least' 2 'Less' 3 'Nature' 4 'More' 5 'Most'.  

3. เมนู Run -> Current Line หรือกด Cltr+R ท่ีทายบรรทัดของคําสั่ง 

๏ การกําหนดคาขาดหาย (Missing 

Values)  

o คลิกเมาสในชองวางใตคอลัมน 

Missing Values 

o เลือกกําหนดคาขาดหายแบบคาไม

ตอเนื่อง (discrete) เชน 0 (ไมมี

คําตอบ) 9 (ไมตอบ) 8 (ไมทราบ) 

หรือ เปนชวง (range) เชน Low: 0 

High: 14 Discrete value: 99 

(วิเคราะหเฉพาะคาตั้งแต 15 ข้ึนไป 

และไมรวม 99) 

o กดปุม OK 

 

๏ การกําหนดความกวางของชองคาตัวแปร

หรือสดมภ (Columns) 

o พิมพตัวเลขจํานวนความกวางของ

ชองคาตัวแปรใตคอลัมน Columns 

หรือกดปุม - หรือ +  
 

 

คาเริ่มตน (default) ความกวางของชองคาตัวแปรกําหนดไวเปน 8 ตําแหนง หากมีจํานวนตัว

แปรมากและตองการลดความกวางของหนาจอในการแสดงขอมูลใหลดตัวเลขจํานวนความกวางลง หรือ

ใชเมาสดึงลดขนาดความกวางในหนาตางแสดงขอมูล (data view) 
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๏ การจัดตําแหนงคาตัวแปร (Align) 

o คลิกเมาสในชองใตคอลัมน Align (โปรแกรมจะแสดง

เมนูรายการตําแหนงคาตัวแปร)  

o เลือกตําแหนงคาตัวแปร  

๏ การกําหนดระดับการวัด (Measure) 

o คลิกเมาสในชองใตคอลัมน Measure (โปรแกรมจะ

แสดงเมนูรายการระดับการวัด) 

o เลือกระดับการวัด  

๏ การกําหนดบทบาทของตัวแปร (Variable Role) 

o คลิกเมาสในชองใตคอลัมน Role (โปรแกรมจะแสดง

เมนูรายการจุดมุงหมายของตัวแปร) 

o เลือกประเภทท่ีมาของขอมูลหรือตัวแปร 

 

 ผูใชโปรแกรมอาจสรางตัวแปรโดยใชคาเริ่มตนท้ังหมด แตท่ีสําคัญในการวิเคราะหขอมูลตอง

ทราบวา ตัวแปรใดเปนตัวแปรแบบคาแบงกลุมหรือตัวแปรแบบคาตอเนื่อง เพราะในการเลือกวิเคราะห

ดวยสถิติแตละประเภทตองเลือกใชตัวแปรใหถูกตองและตรงกับขอตกลงเบื้องตน (basic assumptions) 

 5. การบันทึกแฟมขอมูล (Save) 

 แฟมขอมูล (data files) ท่ีสรางดวยโปรแกรม PSPP ใชโครงสรางระบบแฟมขอมูล (system 

file) แบบเดียวกับแฟมขอมูลของโปรแกรม SPSS วิธีการบันทึกแฟมขอมูลมีข้ันตอนดังตอไปนี้ 

๏ เลือกเมนู File -> Save… (Ctrl + S) 

หรือ Save As… (Shift + Ctrl + S) หรือ 

คลิกเมาสท่ีไอคอน  

o เลือกพ้ืนท่ี (folder) เก็บแฟมขอมูล 

o พิมพชื่อแฟมขอมูลในชอง Name 

(ทดลองพิมพ ASPSS_Data โดยไม

ตองใสนามสกุลของแฟมขอมูล) 

o กดปุม Save  
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รูปแบบ (format) ของแฟมขอมูล หากไมเลือกรูปแบบใดโปรแกรมจะบันทึกใหเปน System 

File เปนแฟมขอมูลแบบเกาท่ีไมมีการบีบอัดขอมูล ไดแฟมขอมูลท่ีมีนามสกุลเปน sav หากตองการ

บันทึกเปนแฟมขอมูลแบบใหมท่ีมีการบีบอัดขอมูลใหเลือกเปน Compressed System File จะได

แฟมขอมูลท่ีมีนามสกุล zsav และถาตองการบันทึกเปนแฟมขอมูลแบบใชไดหลายระบบ สําหรับใช

แลกเปลี่ยนขอมูล ใหเปดอานไดอยางเดียว ไมสามารถแกไขได ใหเลือก Portable File จะไดแฟมขอมูล

ท่ีมีนามสกุล por   

1.2 การนําขอมูลเขาโปรแกรมแบบกรอกขอมูล 

ขอมูลท่ีนํามาใชในการวิจัยมีท่ีมาจากหลายแหลงขอมูลและมีหลายรูปแบบ แตขอมูลท้ังหลาย

ตองผานกระบวนการแปลงขอมูลใหเปนขอมูลดิจิทัล (digital data) และมีโครงสรางขอมูล (data 

structure) เปนตารางขอมูลท่ีโปรแกรมสามารถนําไปประมวลผลได  

การวิจัยท่ีใชการสํารวจขอมูลดวยแบบสอบถามแบบเกาท่ีเปนกระดาษ หรือท่ีปจจุบันนิยม

เรียกวา แบบสอบถามแบบออฟไลน (offline questionnaire) กอนการกรอกขอมูลตองทําการสราง

แฟมขอมูลกอนตามท่ีวิธีการท่ีกลาวมาแลว จากนั้นจึงทําการกรอกขอมูลเขา (entering data) ดังตอไปนี้ 

๏ เปดแฟมขอมูล (แฟมขอมูลท่ีสรางไวและยังไมมีขอมูล) 

๏ คลิกเมาสท่ีแถบ Data View ดานลางซาย 

๏ พิมพคาตัวแปร (Value) ใตชองชื่อตัวแปร (Variable Name) 

๏ คลิกเมาสท่ีชองวางของตัวแปรถัดไป หรือใชคียบอรดปุมลูกศรซาย เพ่ือเลื่อน Cursor ไป

ยังชองขอมูลของตัวแปรถัดไป 

 

 ระหวางกรอกขอมูล ควรบันทึกขอมูลเปนระยะ โดยไปท่ีเมนู File -> Save… (Ctrl + S) หรือ 

Save As… (Shift + Ctrl + S) หรือคลิกเมาสท่ี ไอคอน  
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2. การนําเขาขอมลูจากแฟมขอมูล  

ขอมูลท่ีนํามาใชในการวิเคราะหดวยโปรแกรมคอมพิวเตอรอาจไดมาจากหลายแหลงขอมูล เชน 

การบันทึกขอมูลดวยโปรแกรมตารางคํานวณ (spreadsheet software) การรวบรวมขอมูลดวย

แบบสอบถามแบบออนไลน (online questionnaire) ขอมูลท่ีสงออก (export) ออกมาจากฐานขอมูล 

(database) และขอมูลเปด (open data) ของหนวยงานตาง ๆ ท่ีเผยแพรไวในอินเทอรเน็ต โดยท่ัวไป

ขอมูลท่ีเผยแพรขอมูลสูสาธารณะและการใหบริการแลกเปลี่ยนขอมูล นิยมทําเปนแฟมขอมู 2 รูปแบบ 

ดังนี้ 

1. แฟมขอมูลแบบตัวอักษร (Text Files) แฟมขอมูลมีนามสกุลเปน csv หรือ txt หรือ dat แบง

ขอ มูลดวยตัว ค่ัน (delimiter-separated formats)  เชน  เครื่ องหมายจุลภาค (comma) หรือ 

เครื่องหมายคําพูด (quote) เครื่องหมายเวนระยะ (tab)  

2. แฟมขอมูลจากโปรแกรมตารางคํานวณ (Spreadsheet Files) ท่ีเปนโปรแกรมเปดรหัส 

(open-source) เชน Gnumeric Spreadsheet (*.gnumeric) และ Open Document Spreadsheet 

(*.ods)  

โปรแกรม PSPP เปนโปรแกรมทางสถิติแบบรหัสเปดหรือโอเพนซอรซ (Open Source 

Statistical Software: OSSS) ท่ีออกแบบมาเพ่ือเปนตัวเลือกใชงานแทนโปรแกรม SPSS นอกจาก

สามารถเปดแฟมขอมูลของโปรแกรม SPSS ไดแลว ยังสามารถใชขอมูลจากแฟมขอมูลของโปรแกรม

ตารางคํานวณไดดวย เพราะมีโครงสรางรูปแบบการเก็บขอมูลเปนตาราง (table) มีสดมภ (column) 

และแถว (row) เหมือนกัน  

อยางไรก็ตามหากเปนแฟมขอมูลท่ีสรางดวยโปรแกรมตารางคํานวณแบบรหัสเปด เชน 

Gnumeric, LibreOffice or Openoffice แฟมขอมูลมีนามสกุล *.gnumeric หรือ *.ods สามารถนํา

ขอมูลเขาโปรแกรม (importing data) ไดทันทีโดยไมตองแปลงแฟมขอมูล  

สวนแฟมขอมูลจากโปรแกรมตารางคํานวณเชิงพาณิชยท่ีนิยมใชอยางแพรหลาย เชน Microsoft 

Excel (*.xls หรือ *.xlsx) และ Google Sheet (*.gsheet) ไมสามารถนําขอมูลเขาโปรแกรมทันที ตอง

ทําการแปลงแฟมขอมูลท่ีโปรแกรม PSPP สามารถอานเขาโปรแกรมได โดยตองแปลงใหเปนแฟมขอมูลท่ี

มีเฉพาะขอมูลตัวอักษรเทานั้น (plain text file) เชน แฟมขอมูลท่ีมีตัวค่ันเปนเครื่องหมายจุลภาค 

(Comma Separated Values) มีนามสกุล CSV (*.csv) หรือแฟมขอมูลท่ีมีเครื่องหมายเวนระยะ (Tab 

Separated Values) มีนามสกุล TXT (*.txt) 
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Import Data 

     

Text Files 

*.csv, *.txt และ *.prn 
 

Spreadsheet Files  

(Commercial Software) 

*.xls, *.xlsx และ *.gsheet 

 
Spreadsheet Files 

(Open Source Software) 

*.gnumeric และ *.ods 

2.1 การนําขอมูลเขาจากโปรแกรมตารางคํานวณ 

โปรแกรมตารางคํานวณเชิงพาณิชยท่ีนิยมใชกันอยางแพรหลายมี 2 โปรแกรม คือ Microsoft 

Excel และ Google Sheet การทดลองแปลงแฟมขอมูลท้ัง 2 โปรแกรมเปนแฟมขอมูลแบบตัวอักษร

นามสกุล CSV และนําขอมูลเขาโปรแกรมไมพบปญหาใด ๆ สวนการแปลงแฟมขอมูลนามสกุล xls , xlsx 

และ gsheet เปนแฟมขอมูลนามสกุล ODS พบปญหาการเขากันไมได (incompatibility) ของขอมูลท่ีได

จากแฟมขอมูลนามสกุล xls และ xlsx ดังนั้น เพ่ือใหผูเรียนไดประสบการณการนําขอมูลแบบตาราง

คํานวณเขาโปรแกรมจึงแบงเปน 2 วิธี  โดยมีข้ันตอนดังนี้ 

ดาวโหลดแฟมขอมูล “รายงานดานสังคม” จากศูนยกลางขอมูลเปดภาครัฐ (Open 

Government Data) ท่ี https://data.go.th มา 1 ป (ตัวอยางป พ.ศ. 2558) และบันทึก (Save) เปน

แฟมขอมูลชื่อ ASPSS_Data_Excel.xls 

 

๏ เปดแฟมขอมูล ASPSS_Data_Excel.xls ดวยโปรแกรม Microsoft Excel  
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คลิกเมาส ท่ีแถบขอมูล ชุมชน ตัดขอ มูลแถว ท่ี  1 (จํ านวนชุมชนประเภทตาง  ๆ ใน

กรุงเทพมหานคร ณ เดือนมิถุนายน 2558) และขอมูลแถวท่ี 53 (แหลงขอมูล : กองการพัฒนาชุมชน 

สํานักพัฒนาสังคม กรุงเทพมหานคร) 

๏ เลือกเมนู File 

๏ โปรแกรมแสดงหนาตาง Home 

๏ คลิกเมาสท่ีคําสั่ง Export -> Change File Type -> Save as Another File Type 

(หรือเลือกใชคําสั่ง Save As แทน Export)  

๏ กดปุม Save As  

 

๏ เลือกพ้ืนท่ีเก็บขอมูล ->พิมพชื่อแฟมขอมูลในชอง File name: ->  

๏ เลือกประเภทแฟมขอมูลใน Save as type: เปน CSV UTF-8 (Comma delimited) 

(*.csv) 

๏ กดปุม Save 
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การเลือกบันทึกแฟมขอมูลเปนแบบ UTF-8 (Universal Coded Character Set – 8 Bit) หาก

แฟมขอมูลมีหลายภาษา เชน ตัวเลข ตัวอักษรภาษาอังกฤษ ภาษาไทย และภาษาอ่ืน ๆ จะทําใหการ

แสดงผลรวมกันไดหรือแสดงภาษาผสมกัน ไมเปนขอมูลท่ีอานไมออก 

๏ โปรแกรมแสดงขอความเตือนวา “ประเภทแฟมขอมูลท่ีเลือกไมสนับสนุนสมุดงาน 

(workbooks) ท่ีมีอยูดวยกันหลายแผนงาน (sheets) ” หากตองการบันทึกเฉพาะแผน

งานท่ีกําลังเปดใชงาน (active) ใหเลือกคลิก OK  

๏ กดปุม OK 

 

๏ ทดลองเปดแฟมขอมูล ASPSS_Data_Excel.csv ดวยโปรแกรม Notepad (ดูวามีตัว

ค่ันหรือแบงขอมูลแบบใดบาง เพราะบางแฟมขอมูลอาจมีเครื่องหมายแบงขอมูลมากกวา 

1 แบบ) 

 
 

๏ เปดโปรแกรม PSPP 

๏ เลือกเมนู File -> Import Data … 
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๏ เลือกแฟมขอมูล ASPSS_Data_Excel.csv 

๏ เมนูดานซายแสดงข้ันตอนการนําแฟมขอมูลเขา 5 ข้ันตอน 

๏ กดปุม Next  

 

๏ กําหนดจํานวนขอมูลท่ีตองการนําขอมูลเขา 

o All cases (ท้ังหมด) 

o Only the first … cases (จํานวน) 

o Only the first … % of file (approximately) (รอยละ) 

๏ กดปุม Next 

 

๏ คลิกเมาสหรือใชคียบอรดลูกศรลง -> เลื่อนแถบสีไป Line ท่ี 2 

๏ Line above selected line contains variable names (บรรทัดบนท่ี เลือกเปน

บรรทัดของชื่อตัวแปร) เลือก /   

๏ กดปุม Next 
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๏ Separators (กอนนําแฟมขอมูลเขาตองตรวจดูวามีตัวค่ันอ่ืนหรือไม หากมีเครื่องหมาย

ค่ันแบบอ่ืน ใหเลือกดวย) คลิกเมาส / ท่ี Comma (,)  

๏ กดปุม Next    

 

๏ กําหนดคุณสมบัติตัวแปร (ไมกําหนดก็ได ไปกําหนดภายหลังใน Data Editor ก็ได) 

๏ คลิกเมาสปุมขวาท่ีตัวแปรรวมและเลือกคําสั่ง Clear Variables 

๏ กดปุม Apply 

 

๏ โปรแกรมแสดงหนาตาง Data Editor พรอม Output Viewer 
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๏ คลิกเมาสท่ีแถบ Data View ดานลางซายของโปรแกรมเพ่ือดูขอมูลท่ีนําเขามา 

 

บันทึกแฟมขอมูลเปนแฟมขอมูลนามสกุลเปน sav เพ่ือความสะดวกเปดใชในครั้งตอไป 

๏ เลือกเมนู File -> Save As… (Shift + Ctrl + S) 

หากขอมูลท่ีเปนภาษาไทยแสดงผลเปนภาษาตางดาว ใหแกไข Regional format ใน Settings 

ของระบบปฏบิัติการ Windows เปน Thai (Thailand) 

2.2 การนําขอมูลเขาจากแบบสอบถามออนไลน 

ปจจุบันนักวิ จั ยนิ ยม ใช  Google Form สร า งแบบสอบถามออนไลน  (online/digital 

questionnaire) มากข้ึน เพราะสามารถสงแบบสอบถามผานอินเทอรเน็ตไปถึงผูตอบไดสะดวดและ

รวดเร็ว ผลลัพธท่ีไดจากการสํารวจสามารถดูไดจากระบบ View Response ไดทันที แตหากตองการ

นํามาวิเคราะหดวยโปรแกรม PSPP ตองบันทึกขอมูลเขาโปรแกรม Google Sheet เปนแฟมขอมูล

นามสกุล *.gsheet และแปลงแฟมขอมูลใหเปนแฟมขอมูลแบบตัวอักษรหรือเปนแฟมขอมูลของ

โปรแกรมตารางคํานวณแบบรหัสเปด สําหรับในท่ีนี้จะแปลงเปน *.ods เพ่ือใหผูเรียนไดทดลองนําเขา

ขอมูลจากแฟมขอมูลแบบตารางคํานวณ  
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เปดแฟมขอมูล “Example Spreadsheet” ของ Google Sheet จากอินเทอร เน็ต (เปด 

https://www.google.com และคนหาคําวา “example spreadsheet google sheet”) ท่ีลิงค 

https://docs.google.com/spreadsheets/d/1BxiMVs0XRA5nFMdKvBdBZjgmUUqptlbs74Ogv

E2upms/edit 

 

๏  เลือกเมนู File -> Download -> OpenDocument format (.ods) 

 

๏ บันทึกแฟมขอมูลเปนชื่อ ASPSS_Data_Google.ods 
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๏ เปดโปรแกรม PSPP 

๏ เมนู File -> Import Data … 

๏ เลือกแฟมขอมูล ASPSS_Data_Google.ods 

๏ เมนูดานซายแสดงข้ันตอนการนําแฟมขอมูลเขา 3 ข้ันตอน 

๏ กดปุม Next 

 

๏ ในชอง Cells: กําหนดชวงขอมูล (ตรวจสอบจากแฟมขอมูลใหตรงกับท่ีโปรแกรม

กําหนด) 

๏ ใน Sheet Index: เลือกตารางขอมูล (หากมีหลายตารางขอมูลจะแสดงชื่อใหเลือก) 

๏ Use first row as variable names (กําหนดใหแถวแรกเปนชื่อตัวแปร) เลือก / 

๏ กดปุม Next   
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๏ กําหนดคุณสมบัติตัวแปร (ไมกําหนดก็ได ไปกําหนดภายหลังใน Data Editor ก็ได) 

๏ กดปุม Apply 

 

๏ โปรแกรมแสดงหนาตาง Data Editor พรอม Output Viewer 

 

๏ คลิกเมาสท่ีแถบ Data View ดานลางซายของโปรแกรมเพ่ือดูขอมูลท่ีนําเขามา 

 

๏ บันทึกแฟมขอมูลเปนแฟมขอมูลนามสกุลเปน sav เพ่ือความสะดวกเปดใชในครั้งตอไป 

๏ เลือกเมนู File -> Save As… (Shift + Ctrl + S) 
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สรุป 

 การนําขอมูลเขาโปรแกรม คือ การเตรียมขอมูลเพ่ือนําขอมูลจากแบบสอบถามหรือจากเอกสาร

ท่ีบันทึกขอมูลเขาโปรแกรมวิเคราะหขอมูลและบันทึกไวเปนแฟมขอมูล วิธีการนําขอมูลเขาโปรแกรมมีท้ัง

วิธีการกรอกขอมูลดวยตนเอง และดึงขอมูลจากแฟมขอมูลท่ีมีอยูแลว เชน แฟมขอมูลจากโปรแกรม

ตารางคํานวณ และแฟมขอมูลแบบตัวอักษร 

แบบฝกหัดทายบท 

 ใหผูเรียนฝกสรางแฟมขอมูลจากแบบสอบถาม และนําขอมูลจากโปรแกรมตารางคํานวณเขา

โปรแกรมดังตอไปนี้ 

1. ใหผูเรียนใชแบบสอบถามท่ีสรางไวสํารวจขอมูลภายในชั้นเรียนคนละ 5 ชุด และกรอกขอมูล

เขาโปรแกรม 

2. ใหผูเรียนสรางแบบสอบถามออนไลนดวย Google Form และสํารวจขอมูลภายในชั้นเรียน

คนละ 5 ชุด 

3. ใหผูเรียนแปลงแฟมขอมูลท่ีไดจากแบบสอบถามออนไลนและนําขอมูลเขาโปรแกรม 

4. ใหผูเรียนคนหาแฟมขอมูลแบบตารางคํานวณ (*.xls และ *.xlsx) และแฟมขอมูลแบบ

ตัวอักษร (*.csv) และทดลองนําขอมูลเขาจากแฟมขอมูล 

  





 

 

บทที่ 7 

การจัดการขอมูล 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถเลือกใชขอมูลและเปลี่ยนรูปแบบขอมูลใหตรงกับวัตถุประสงคของการวิเคราะห

ขอมูล 

เน้ือหา 

1. การปรับขอมูล 

2. การเปลี่ยนรูปแบบขอมูล 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และการ

ทําแบบฝกหัดทายบท  
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เนื้อหา 

 การจัดการขอมูล (Data Management) คือ การปรับขอมูล (data manipulation) ท่ีเปนตัว

แปรหรือคาของตัวแปรในแฟมขอมูล เชน เลือกขอมูล (selecting data) บางสวนมาวิเคราะห หรือ

เปลี่ยนรูปแบบขอมูล (data transformation) ใหเปนตัวแปรใหมหรือมีคาของตัวแปรเปนคาใหม  

 คําสั่งท่ีใชในการจัดการขอมูลมี 2 กลุมคําสั่ง คือ Data และ Transform ท้ัง 2 คําสั่งจะมีผลทํา

ใหแฟมขอมูลมีการเปลี่ยนแปลงแบบชั่วคราว (temporarily) แตจะมีผลทําใหแฟมขอมูลมีการ

เปลี่ยนแปลงแบบถาวร (permanently) เม่ือทําการบันทึกแฟมขอมูล (save) บางคําสั่งโปรแกรมจะ

แสดงสถานะของแตละคําสั่งเปน off หรือ by ในแถบสถานะภาพการทํางานดานลาง โดยมีรายละเอียด

ดังตอไปนี้ 

Data Transform 

- Sort Cases… (การจัดเรียงตัวอยาง) 

- Transpose… (การไขวตัวแปรและตัวอยาง) 

- Aggregate… (การรวมคาของกลุมตัวอยาง) 

- Split File… (การแบงกลุมตัวอยาง)* 

- Select Cases… (การเลือกตัวอยาง)* 

- Weight Cases… (กา ร กํ าหนดน้ํ า ห นั ก

ตัวอยาง) * 

- Compute… (การสรางตัวแปรแบบคาตัวเลข) 

- Count… (การนับจํานวนตัวอยาง) 

- Rank Cases… (การจัดลําดับตัวอยาง) 

- Automatic Recode…(การเปลี่ยนคาตัวแปรเปนตัว

แปรใหมแบบอัตโนมัติ) 

- Recode into Same Variables… (การเปลี่ยนคาตัว

แปรในตัวแปรเดิม) 

- Recode into Different Variables… (การเปลี่ยน

คาตัวแปรเปนตัวแปรใหม) 

- Run Pending Transforms (การสั่งประมวลผลตอ) 

 

*คําสั่งแบบชั่วคราวจนกวาจะมีการยกเลิกใชคําสั่ง (turn off) หรือกําหนดใหเปนคาปกติ (default 

value) 

บทนี้จะใชแฟมขอมูล ASPSS_Data.sav ท่ีเคยสรางไวในบทท่ี 6 การนําขอมูลเขาโปรแกรม และ 

hotel.sav ในโฟลเดอร examples (C:\Program Files\PSPP\share\pspp\examples) โดยสามารถ

เปดใชงานพรอมกัน และสลับเลือกใชงานจากเมนู Windows ดังนี้ 
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 การเลือกตัวแปรในรายการตัวแปรดานซายในหนาตางของแตละคําสั่ง มี 2 วิธี คือ ใชเมาสชี้ท่ีชื่อ

ตัวแปรท่ีตองการเลือกแลวกดปุมแบบดับเบิลคลิกท่ีปุมซายของเมาส หรือใชเมาสชี้ท่ีชื่อตัวแปรท่ีตองการ

เลือก แลวกดปุมลูกศร  

1. การปรับขอมลู 

การปรับขอมูล คือ การเปลี่ยนแปลงรูปแบบของขอมูลท้ังหมด (global changes) ในชุดขอมูล 

เชน การจัดเรียงขอมูล การไขวตัวแปร การรวมขอมูล การแบงขอมูล การเลือกขอมูล และการกําหนด

น้ําหนักขอมูล โดยมีรายละเอียดดังตอไปนี้  

1.1 การจัดเรียงตัวอยาง  

การจัดเรียงตัวอยาง (Sort Cases) คือ การเรียงตัวอยางตามคาของตัวแปร 1 ตัวแปร หรือหลาย

ตัวแปร และสามารถเลือกเรียงลําดับจากคานอยไปมาก (ascending order: 1-9 or A-Z) หรือจากคา

มากไปนอย (ascending order: 9-1 or Z-A) โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Data -> Sort Cases… 

๏ Sort by: เลือกตัวแปรคาจัดประเภท/คาตอเนื่อง 1 ตัวแปรหรือมากกวา จากรายการตัวแปร

ดานซาย  

๏ ในกลุมคําสั่ง Sort Order เลือกวิธีการจัดเรียง 

o Ascending (เรียงจากคานอยไปมาก เชน 1->9 หรือ A->Z) 

o Descending (เรียงจากคามากไปนอย เชน 9->1 หรือ Z->A) 

๏ กดปุม OK 
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ตัวอยาง: การจัดเรียงตัวอยางดวยตัวแปร Gender และ Age จากคานอยไปมาก 

 
 

 

1.2 การไขวตัวแปรและตวัอยาง  

 การไขวตัวแปรและตัวอยาง (Transpose) คือ การสลับตัวแปร (variables) ท่ีอยูในรูปของ

สดมภ (columns) ไปเปนตัวอยาง (cases) อยูในรูปของแถว (rows) และสลับตัวอยาง (cases) ท่ีอยูใน

รูปของแถว (rows) ไปเปนตัวแปร (variables) อยูในรูปของสดมภ (columns)  

ตัวแปรท่ีตองการไขวไปเปนตัวอยาง ตองเปนตัวแปรแบบตัวเลข (numeric variables) และตัว

แปรท่ีตองการไขวคาของตัวแปรไปเปนตัวแปรใหมควรเปนตัวแปรแบบตัวอักษร (string variables) 

เพราะคาตัวแปรท่ีเปนตัวเลข ตัวเลขแรกจะถูกเปนตัวอักษร V ท้ังหมด โดยมีวิธีการดังนี้ 

๏ เมนู Data -> Transpose… 

๏ Variables: เลือกตัวแปรคาตอเนื่อง 1 ตัวแปรหรือมากกวา (ตัวแปร -> ตัวอยาง) จาก

รายการตัวแปรดานซาย 

๏ Name Variables: เลือกตัวแปรคาจัดกลุมในชองดานซาย 1 ตัวแปร (ตัวอยาง -> ตัวแปร) 

๏ กดปุม OK 

ตัวอยาง: การไขวตัวแปร Age และ Edu เปนตัวอยาง และไขวคาใน Province เปนตัวแปร 
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1.3 การรวมกลุมตวัอยาง  

 การรวมกลุมตัวอยาง (Aggregate) คือ การรวมกลุม (summarizes groups) ของตัวอยาง 

(cases) ท่ีมีคาเหมือนกันจากหลายตัวแปร (break variables) เชน รวมรายได อายุ และประสบการณ

ทํางานของตัวอยางท่ีมีระบบการศึกษาเหมือนกันใหเปนกลุมการศึกษา โดยเลือกสรางเปนชุดขอมูลใหม 

(data set) หรือสรางเปนแฟมขอมูล (file) ใหมก็ได โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Data -> Aggregate… 

๏ Break variable(s): เลือกตัวแปรคาจัดกลุม 1 ตัวแปร จากรายการตัวแปรดานซาย 

๏ ในกลุมคําสั่ง Aggregated variables: กําหนดวิธีการรวมคาของกลุมตัวอยาง 

o Variable Name: พิมพชื่อตัวแปรท่ีเปนคารวมกลุมขอมูล  

o Variable Label: พิมพคําอธิบายตัวแปร 

o ในกลุมคําสั่ง Functions: เลือกวิธีการรวมกลุมขอมูล 

- Sum of values (คารวม) 

- Mean average (คาเฉลี่ย) 

- Median average (คาเฉลี่ยมัธยฐาน) 

- Standard deviation (คาเบี่ยงเบนมาตรฐาน) 

- Maximum value (คาสูงสุด) 

- Minimum value (คาต่ําสุด) 

- Percentage greater than (คารอยละท่ีมากกวา) 

- Percentage less than (คารอยละท่ีนอยกวา) 

- Percentage included in range (คารอยละท่ีอยูในชวง) 

- Percentage excluded from range (คารอยละท่ีไมอยูในชวง) 

- Fraction greater than (เศษสวนท่ีมากกวา) 

- Fraction less than (เศษสวนท่ีนอยกวา) 

- Fraction included in range (เศษสวนท่ีอยูในชวง) 

- Fraction excluded from range (เศษสวนท่ีไมอยูในชวง) 

- Number of cases (จํานวนของตัวอยาง) 

- Number of cases (unweighted) (จํานวนของตัวอยางท่ีไมถวงน้ําหนัก) 
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- Number of missing values (จํานวนของคาสูญหาย) 

- Number of missing values (unweighted) (จํานวนของคาสูญหายท่ีไมถวงน้ําหนัก) 

- First non-missing value (คาแรกของคาปกติ) 

- Last non-missing value (คาสุดทายของคาปกติ) 

o เลือกตัวแปรท่ีตองการรวมกลุมขอมูล 1 ตัวแปร จากรายการตัวแปรดานซายใสใน

ชองวางหลังปุมลูกศร 

o Argument 1: และ Argument 2: กําหนดเง่ือนไขการรวบกลุมขอมูล (บาง Functions 

เชน Percentage included in range -> Argument1: คาเริ่มตน และ Argument 2: 

คาสิ้นสุด)   

๏ กดปุม Add เพ่ือใสคําสั่งการรวมกลุมตัวอยางเขาโปรแกรม 

๏ ในกลุมคําสั่ง Save กําหนดวิธีการสรางผลลัพธ 

o Add aggregated variables to the active dataset (เพ่ิมตัวแปรการรวมกลุมตัวอยาง

ลงในชุดขอมูลท่ีเปดใชงาน) 

o Replace the current dataset with the aggregated variables (สร า ง ตัวแปรการ

รวมกลุมตัวอยางแทนท่ีชุดขอมูลท่ีเปดใชงาน) 

o Write a new data file containing only the aggregated variables (สรางแฟมขอมูล

ใหม มีเฉพาะตัวแปรการรวมกลุมตัวอยาง) 

๏ ในกลุมคําสั่ง Options for very large datasets กําหนดวิธีการจัดเรียงตัวอยาง (กรณี

เปนชุดขอมูลขนาดใหญมาก) 

o File is already sorted on break variables(s). (แฟมขอมูลทําการจัดเรียงตัวอยางแลว) 

o Sort file before aggregating. (จัดเรียงตัวอยางกอนทําการรวมกลุมตัวอยาง) 

๏ กดปุม OK 

ตัวอยาง: การรวมคาของตัวแปร Age เปนคาเฉลี่ยในแตละกลุมของตัวแปร Gender 
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1.4 การแบงกลุมตัวอยาง  

 การแบงกลุมตัวอยาง (Split File) คือ การแบงกลุมตัวอยางในแฟมขอมูลตามคาของตัวแปรแบบ

จัดประเภท (categorical variables) เพ่ือวิเคราะหตัวอยางเปนกลุมยอยแบบชั่วคราว (temporary) 

จนกวาจะยกเลิกการแบงกลุม โดยมีวิธีการดังนี้ 

๏ ทดลองวิเคราะหคาเฉลี่ยของอายุ 

o เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives…  

o Variables: เลือกตัวแปร Age ในรายการตัวแปรดานซาย 

๏ เลือกเมนู Data -> Split File… 

๏ ในกลุมคําสั่งดานขวามือ เลือกวิธีการแบงกลุมตัวอยาง 

o Analyze all cases. Do not create groups. (ไมแบงกลุม หรือ Split File Off) 

o Compare groups. (เปรียบเทียบคาเฉลี่ยแตละกลุม) 

o Organize output by groups. (แบงแสดงผลแตละกลุม) 

๏ Groups based on: เลือกตัวแปรคาจัดกลุม 1 ตัวแปรหรือมากกวา จากรายการตัวแปร

ดานซาย 

๏ เลือกวิธีการจัดเรียงกลุม 

o Sort the file by grouping variables. (เรียงกลุมตามตัวแปร) 

o File is already sorted. (แฟมขอมูลนี้จัดเรียงกลุมแลว) 

๏ กดปุม OK 

๏ ทดลองวิเคราะหคาเฉลี่ยของอายุอีกครั้งและดูเปรียบเทียบผลลัพธ 

 

ตัวอยาง: ผลการวิเคราะหคาเฉลี่ยของตัวแปร Age ดวยการแบงกลุมดวยตัวแปร Gender 
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1.5 การเลือกตัวอยาง  

 การเลือกตัวอยาง (Select Cases) คือ การกําหนดเง่ือนไขเพ่ือเลือกตัวอยางสําหรับใชวิเคราะห 

ขอมูลท่ีไมถูกเลือกตามเง่ือนไขจะถูกลบออกจากชุดขอมูลท่ีใชวิเคราะห (data stream) แบบชั่วคราว 

(temporary) จนกวาเง่ือนไขท่ีกําหนดไวจะถูกยกเลิก โดยมีวิธีการดังนี้ 

เง่ือนไขท่ีเปนคาปกติ (default) คือ เลือกท้ังหมด (all cases) และมีตัวเลือก คือ เลือกสุมเปน 

จํานวนรอยละ (random) เลือกเฉพาะชวงขอมูล (range) และเลือกเฉพาะตัวอยางท่ีไมมีคาขาดหาย 

(use filter variable) ขอมูลท่ีไมถูกเลือก โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Data -> Select Cases… 

๏ ในกลุมคําสั่ง Select เลือกวิธีการเลือกตัวอยาง 

o All Cases (เลือกท้ังหมด หรือ Filter off) 

o Random sample of cases (สุมขนาดตัวอยางเปนจํานวนรอยละ) 

- กําหนดจํานวนรอยละ 

- กดปุม Continue  

o Based on time or case range (เลือกตัวอยางตามชวงท่ีกําหนด) 

- กําหนดชวงตัวอยาง 

- กดปุม Continue 

o Use filter variable (ใชตัวแปรเลือกตัวอยางท่ีไมมีคาเปน 0 หรือคาสูญหาย) 

- เลือกตัวแปรจากชองดานซาย -> ใสในชองวาง 

- กดปุม Continue 

๏ ในกลุมคําสั่ง Unselected Cases Are กําหนดวิธีการเลือกตัวอยาง 

o Filtered (กรองออกดวยการทําสัญลักษณเปนเครื่องหมาย \ ท่ีหนาขอมูลของแตละ

ตัวอยาง) 

o Deleted (ลบออกจากชุดขอมูล) 

๏ กดปุม OK 
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ตัวอยาง: การเลือกตัวอยางดวยวิธีสุมขนาดตัวอยางเปนจํานวนรอยละและเลือกตัวอยางตามชวงท่ี

กําหนด 

 

 

 

 

 

1.6 การกําหนดน้ําหนักตวัอยาง  

 การกําหนดน้ําหนักตัวอยาง (Weight Cases) คือ การกําหนดจํานวนตัวอยางในการวิเคราะหให

มีจํานวนท่ีแตกตางไปจากเดิมแบบชั่วคราว (temporary) ตามสัดสวนของคาในตัวแปรดัชนีท่ีมีอยูใน

แฟมขอมูล จนกวาจะยกเลิกการกําหนดน้ําหนักตัวอยาง โดยมีวิธีการดังนี้ 

๏ ทดลองวิเคราะหเปรียบเทียบคาเฉลี่ยอายุระหวางกลุมเพศ 

๏ เลือกเมนู Analyze -> Compare Means -> Means…  

o Dependent List: เลือกตัวแปร Age จากรายการตัวแปรดานซาย 

o Independent List: เลือกตัวแปร Gender จากรายการตัวแปรดานซาย 

o กดปุม OK 

๏ ใชคําสั่ง Aggregate สรางตัวแปร Gender_freq เพ่ือรวมอายุของกลุมตัวอยาง 

๏ เลือกเมนู Data -> Weight Cases… 

๏ ในกลุมคําสั่งดานขวา เลือกวิธีการกําหนดน้ําหนักตัวอยาง 

o Do not weight cases (ไมกําหนดน้ําหนักตัวอยาง หรือ Weight Off) 

o Weight cases by (กําหนดน้ําหนักจากตัวแปรท่ีเลือก) 

- เลือกตัวแปรความถ่ีจากรายการตัวแปรในชองดานซาย -> Frequency Variable 

๏ กดปุม OK 
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๏ ทดลองวิเคราะหเปรียบเทียบคาเฉลี่ยอายุระหวางกลุมเพศอีกครั้งและดูเปรียบเทียบผลลัพธ 

ตัวอยาง: ผลการวิเคราะหคาเฉลี่ยตัวแปร Age กอนและหลังการกําหนดน้ําหนักตัวอยางดวยตัวแปร 

Gender 
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2. การแปลงขอมูล 

 การแปลงขอมูล คือ การเปลี่ยนแปลงขอมูลเฉพาะตัวแปรท่ีเลือก  เชน การเปลี่ยนคาของตัวแปร 

การสรางตัวแปรใหม  

2.1 การสรางตัวแปรแบบคาตอเนื่อง  

 การสรางตัวแปรแบบคาตอเนื่อง (Compute) คือ การสรางหรือเปลี่ยนคาตัวแปรท่ีมีคาเปน

ตัวเลขแบบตอเนื่อง (numeric) ใหเปนตัวแปรใหม โดยใชฟงกชั่น (function) ทางคณิตศาสตร เชน + 

(บวก) – (ลบ) * (คูณ) / (หาร) Sum (ผลรวม) Mean (คาเฉลี่ย) SD (คาเบี่ยงเบนมาตรฐาน) Median 

(คามัธยฐาน) Mod (ฐานนิยม)  เขียนเปนนิพจนเชิงตัวเลข (numerical expression) โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Compute… 

๏ Target Variable: พิมพชื่อตัวแปรใหม 

๏ กดปุม Type & Label… -> กําหนดรายละเอียดเก่ียวกับตัวแปร เชน คําอธิบายชื่อตัวแปร 

และประเภทตัวแปร (ไมกําหนดก็ได) 

๏ ในชอง Numeric Expression สรางนิพจนเชิงตัวเลข มี 2 วิธีการดังนี้ 

o สรางนิพจนเชิงตัวเลขเอง เชน Age+5 หรือ V1+V2+V3 หรือ (V1+V2+V3)/3  

o เลือกใชโปรแกรมฟงกชั่นในกลุมคําสั่ง Functions: เชน SUM(V1, V2, V3) หรือ MEAN 

(V1, V2, V3) 

ตัวอยาง: การสรางตัวแปร Age_new5 โดยเพ่ิมคา 5 ป ในตัวแปร Age และการสรางตัวแปรคะแนน

เฉลี่ยความพึงพอใจ Sat_avg จากตัวแปรคะแนนความพึงพอใจ 5 ตัวแปร (V1, V2, V3, V4, V5) 
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2.2 การนับจํานวนขอมูล  

 การนับจํานวนขอมูล (Count) คือ การสรางตัวแปรใหมจากการนับคาตามเง่ือนไข (criterion 

value) ท่ีเกิดข้ึน (occurrences) ภายในรายการตัวแปร (variable) ของแตละตัวอยาง (cases) โดยมี

วิธีการดังนี้ 

๏ เลือกเมนู Transform -> Count… 

๏ Target Variable: พิมพชื่อตัวแปรใหม 

๏ Numeric Variables: เลือกตัวแปรในชองรายการตัวแปรท่ีตองการนับคา 

๏ กดปุม Define Values…  

๏ เลือกวิธีการนับคา 

o Value: (คาใดคาหนึ่งของตัวแปร) 

o System Missing (คาสูญหายของระบบ) 

o System or User Missing (คาสูญหายของระบบหรือผูใช) 

o Range: (ชวงคาของตัวแปร) 

o Rang, LOWEST thru value (ชวงคาของตัวแปรท่ีกําหนดถึงคาต่ําสุด) 

o Rang, value thru HIGHEST (ชวงคาของตัวแปรท่ีกําหนดถึงคาสูงสุด) 
๏ ในกลุมคําสั่ง Values to Count: กดปุม Add 

๏ กดปุม Continue 

๏ กดปุม OK 
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ตัวอยาง: การนับจํานวนคา 2 และ 3 ในตัวแปร Gender และ Edu และสรางเปนตัวแปร 

GE_Count_23 

 

 

 

 

 

 

2.3 การจัดลําดับตัวอยาง  

 การจัดลําดับตัวอยาง (Rank Cases) คือ การสรางตัวแปรใหมจากการจัดลําดับกลุมตัวอยางดวย

การจัดเรียงคา (order) ของตัวแปรประเภทตัว เลข (numeric variables) ตามคําสั่ ง ท่ี กําหนด 

(mandatory) เชน คาท่ีเทากัน (tied) คาลําดับท่ี (rank) คาเปอรเซ็นตไทล (percentile) คาสัดสวน 

(proportion) ฯลฯ โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Rank Cases… 

๏ Variable(s): เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปรหรือมากกวา จากรายการตัวแปร

ดานซาย 

๏ By: เลือกหรือไมเลือกตัวแปรก็ได 

๏ ในกลุมคําสั่ง Assign rank 1 to: เลือกวิธีจัดลําดับ 

o Smallest Value (คานอยสุด) 

o Largest Value (คามากสุด) 

๏ กดปุม Rank Types เพ่ือเลือกประเภทการจัดลําดับ 

o Rank (จัดลําดับ) 
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o Fractional rank as % (คารอยละของลําดับคาเศษสวน) 

o Savage score (คะแนนดิบ) 

o Sum of case weights (คารวมของการกําหนดน้ําหนักของตัวอยาง) 

o Fractional rank (ลําดับของคาเศษสวน) 

o Ntiles (คาเปอรเซ็นไทล) 

o Proportion Estimates (การประมาณคาของสัดสวน) 

o Normal Scores (คะแนนมาตรฐาน) 

o ในกลุมคําสั่ง Proportion Estimation Formula เลือกสูตรการประมาณคาของสัดสวน 

- Blom (บลอม) 

- Tukey (ทูกีย) 

- Rankit (รันชิต) 

- Van der Waerden (แวน เดอ แวรเดน) 

๏ กดปุม Continues 

๏ กดปุม Ties… เพ่ือกําหนดวิธีจัดอันดับหากมีคาเทากัน 

o Mean (คาเฉลี่ย) 

o Low (คานอย) 

o Hight (คามาก) 

o Sequential ranks to unique value (เรียงอันดับตอไปจนถึงคาท่ีไมเทากัน) 

๏ กดปุม Continuous 

๏ กดปุม OK 

ตัวอยาง: การจัดลําดับตัวอยางดวยตัวแปร Age โดยใช Rank และ Ntiles 
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2.4 การสรางตัวแปรแบบอัตโนมัติ  

 การสรางตัวแปรแบบอัตโนมัติ (Automatic Recode) คือ การสรางตัวแปรใหมโดยใหโปรแกรม

เปลี่ยนคาตัวแปรท่ีเปนตัวอักษร (string) ใหเปนตัวเลข (numeric) แบบอัตโนมัติ คาใหมท่ีเปนตัวเลขเกิด

จากการใชตัวอักษรไปเทียบคากับรหัสอักขระ (character code) แลวแปลงเปนตัวเลขตามลําดับ เชน 

คาท่ีเปนตัวอักษรในตัวแปรเพศท่ีมีคาเปน “ชาย” ถูกเปลี่ยนเปน 1 และ “หญิง” ถูกเปลี่ยนเปน 2 แตถา

เปน “male” ถูกเปลี่ยนเปน 2 และ “female” ถูกเปลี่ยนเปน 1 

๏ เลือกเมนู Transform -> Automatic Recode… 

๏ Old: เลือกตัวแปรแบบตัวอักษรในชองรายการตัวแปร 1 ตัวแปรหรือมากกวา  

๏ New Name: คลิกเมาสท่ีชื่อตัวแปรเกา -> พิมพชื่อตัวแปรใหม 

๏ กดปุม Add New Name (ใสชื่อตัวแปรใหมในชอง New) 

๏ เลือกวิธีการสรางตัวแปรแบบอัตโนมัติ 

o Recode starting form (สรางคาตัวแปรจาก) 

- Lowest value (คานอยสุด) 

- Highest value (คามากสุด) 

o Use the same recode scheme for all variables (ใชวิธีการแปลงคาเหมือนกันทุกตัว

แปร) 

o Treat blank string values as missing (ตัวแปรท่ีมีคาวางใหทําเปนคาสูญหาย) 

๏ กดปุม OK 

ตัวอยาง: การสรางรหัสหรือคาตัวแปรใหมแบบอัตโนมัติจากตัวแปรท่ีมีคาเปนตัวอักษร 
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2.5 การเปลี่ยนคาตัวแปรในตัวแปรเดิม  

 การเปลี่ยนคาตัวแปรในตัวแปรเดิม (Recode into Same Variables) คือ การแทนคาหรือ

เปลี่ยนคาเกาใหเปนคาใหมในตัวแปรเดิม การเปลี่ยนคาตัวแปรแบบนี้ตองม่ันใจวาจะไมใชคาเดิมแลว โดย

มีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Recode into Same Variables… 

๏ Variables: เลือกตัวแปรแบบตัวเลข/ตัวอักษร 1 ตัวแปรหรือมากกวา จากรายการตัวแปร

ดานซาย -> คลิกเมาสท่ีชื่อตัวแปรในชอง Variables  

๏ กดปุม Old and New Values… 

o ในกลุมคําสั่งดานซาย กําหนดคาเกาของตัวแปร 

- Value: (คาใดคาหนึ่งของตัวแปร) 

- System Missing (คาสูญหายของระบบ) 

- System or User Missing (คาสูญหายของระบบหรือผูใช) 

- Rang:  through (ชวงจากคา…ถึงคา…) 

- Range, LOWEST thru value (ชวงจากคาต่ําสุดถึงคา…) 

- Range, value thru HIGHEST (ชวงจากคาสูงสุดถึงคา…) 

- All other values (คาอ่ืน ๆ ท้ังหมด) 

o ในกลุมคําสั่ง New Value กําหนดคาใหม 

- Value (คาใหม) 

- System Missing (กําหนดใหเปนคาสูญหายของระบบ) 

- กดปุม Add (เพ่ิมคา) หรือ Edit (แกไข) หรือ Remove (ลบท้ิง) 

o กดปุม Continue 

๏ กดปุม OK 
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ตัวอยาง: การแปลงตัวแปร Gender ใหเปนตัวแปรหุน (dummy variables) โดยการแทนคาเดิม 1 = 

Male และ 2 = Female ใหเปนคาใหม 1 = Female และ 0 = Non-femle 

 

 

 

 

2.6 การสรางตัวแปรแบบคาจัดกลุม  

 การสรางตัวแปรแบบคาจัดกลุม (Recode into Different Variables) คือ การสรางตัวแปรจาก

คาเกาท่ีเปนคาตอเนื่องหรือคาจัดกลุมใหเปนตัวแปรใหมมีคาเปนคาจัดกลุม โดยยังคงเก็บชื่อตัวแปรและ

คาของตัวแปรไวตามเดิม โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Recode into Different Variables… 

๏ Variables: เลือกตัวแปรแบบตัวเลข/ตัวอักษรในชองรายการตัวแปร 1 ตัวแปรหรือมากกวา 

๏ ใตคําวา Old ในชอง Variables: คลิกเมาสท่ีชื่อตัวแปรเกา 

๏ ในกลุมคําสั่ง Output Variable ชอง Name:  พิมพชื่อตัวแปรใหม และชอง Label: 

คําอธิบายของตัวแปรใหม -> กดปุม Change (หากมีหลายตัวแปรใหทําวิธีเดียวกัน) 

๏ กดปุม Old and New Values… 

o ในกลุมคําสั่งดานซาย กําหนดคาเกาของตัวแปร 

- Value: (คา) 

- System Missing (คาสูญหายของระบบ) 

- System or User Missing (คาสูญหายของระบบหรือผูใช) 

- Rang:  through (ชวงจากคา…ถึงคา…) 

- Range, LOWEST thru value (ชวงจากคาต่ําสุดถึงคา…) 

- Range, value thru HIGHEST (ชวงจากคาสูงสุดถึงคา…) 
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- All other values (คาอ่ืน ๆ ท้ังหมด) 

o กําหนดคาใหมในกลุมคําสั่ง New Value 

- Value (คาใหม) 

- System Missing (กําหนดใหเปนคาสูญหายของระบบ) 

- Copy old values (สําเนาหรือใชคาเกา) 

- กดปุม Add (เพ่ิมคา) หรือ Edit (แกไข) หรือ Remove (ลบท้ิง) 

o กําหนดคุณลักษณะของตัวแปรดังนี้ (หากตองการแปลงตัวแปรใหเปนตัวแปรแบบ

ตัวอักษรหรือตัวแปรแบบตัวเลข) 

- Output variables are stringsWidth: (กําหนดเปนตัวแปรแบบตัวอักษร) 

- Covert numeric strings to numbers (‘5’ -> 5) (เปลี่ยนตัวเลขแบบตัวอักษรเปนคา

แบบจํานวน) 

o กดปุม Continue 

๏ กดปุม OK 

ตัวอยาง: การจัดกลุมตัวอยางจากตัวแปร Age ท่ีเปนคาตอเนื่องใหเปนตัวแปรมีคาเปนกลุมอายุ (1 = 

ต่ํากวา 15 ป 2 = 15 ถึง 59 ป และ 3 = 60 ข้ึนไป)  
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2.7 การสั่งประมวลผลตอ  

 การสั่งประมวลผลตอ (Run Pending Transforms) คือ การสั่งใหโปรแกรมทํางานตอระหวาง

โปรแกรมหยุดการประมวลผลเพ่ือเตือนใหตรวจสอบและแกไข (ในแถบสถานการณทํางานดานลางจะ

แสดงขอความวา Transformation Pending) เม่ือตรวจสอบหรือแกไขแลวจึงสั่งใหประมวลผลตอ โดยมี

วิธีการดังนี้ 

๏ เลือกเมนู Transform -> Run Pending Transforms (เม่ือโปรแกรมเตือนใหตรวจสอบ

หรือแกไข ขอความ Run Pending Transforms จะเปลี่ยนเปนสีเขม) 

 

สรุป 

 การจัดการขอมูล คือ การปรับขอมูลหรือคาของตัวแปรในแฟมขอมูลเพ่ือเลือกขอมูลบางสวนมา

วิเคราะห หรือเปลี่ยนขอมูลใหเปนตัวแปรใหมหรือมีคาของตัวแปรเปนคาใหม 

 คําสั่งท่ีใชในการจัดการขอมูลมีท้ังคําสั่งแบบชั่วคราวท่ีมีผลตอคําสั่งตอไปท่ีใชเทานั้น และคําสั่ง

แบบถาวรท่ีมีผลตอการเปลี่ยนแปลงของชุดขอมูลตลอดไป คําสั่งท่ีใชในการจัดการขอมูลแบงไดเปน 2 

กลุม ดังนี้ 
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1. คําสั่งสําหรับการปรับขอมูล เปนคําสั่งท่ีใชในการเปลี่ยนแปลงรูปแบบของขอมูลท้ังหมดในชุด

ขอมูล เชน การจัดเรียงขอมูล การไขวตัวแปร การรวมขอมูล การแบงขอมูล การเลือกขอมูล และการ

กําหนดน้ําหนักขอมูล 

2. คําสั่งสําหรับการแปลงขอมูล เปนคําสั่งท่ีใชในการเปลี่ยนแปลงขอมูลเฉพาะตัวแปรท่ีเลือก 

เชน การเปลี่ยนคาของตัวแปร การสรางตัวแปรใหม 

แบบฝกหัดทายบท 

 ใหผูเรียนฝกจัดการขอมูลและแปลงขอมูลดังตอไปนี้ 

1. เปดแฟมขอมูล ASPSS_Data.sav และจัดการขอมูลดวยคําสั่งดังตอไปนี้ 

    - Transpose -> ไ ขว ข อ มู ล ในแฟ ม ข อ มู ล ท่ี บั น ทึ ก เ ก็ บ ไ ว ใ ห เ ห มื อน กับข อ มู ล ใน 

ASPSS_Data.sav  

    - Aggregate -> การรวมคาของตัวแปร Age เปนคาเฉลี่ยในแตละกลุมของตัวแปร Edu  

    - Split File -> วิเคราะหคาเฉลี่ยของตัวแปร Age ดวยการแบงกลุมดวยตัวแปร Edu  

    - Select Cases -> เลือกตัวอยางดวยวิธีสุมขนาดตัวอยางเปนจํานวนรอยละ 75 

    - Count -> นับคา 0 ในตัวแปร Gender  

    - Recode into Same Variables -> เปลี่ยนคาของตัวแปร Gender ใหเปนตามเดิม  

       - Recode into Difference Variables -> สรางตัวแปร Edu_level มี 2 กลุม คือ ระดับต่ํา

กวาอุดมศึกษา และระดับอุดมศึกษา 

2. เปดแฟมขอมูล hotel.sav และจัดการขอมูลดวยคําสั่งดังตอไปนี ้

    - Compute -> สรางตัวแปรใหมชื่อ Sat_sum รวมคะแนนความพึงพอใจจากตัวแปร V1 ถึง 

V5 



 

 

สวนท่ี 3 

การวิเคราะหเครื่องมือการวิจัย 

และตรวจสอบขอมูล 

  





 

 

บทที่ 8 

การวิเคราะหเครื่องมือการวิจัย 
ความมุงหมายของบทเรียน 

ผูเรียนสามารถวิเคราะหคุณภาพของเครื่องมือการวิจัยได  

เน้ือหา 

1. การวิเคราะหความถูกตอง 

2. การวิเคราะหความนาเชื่อถือ 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และ

ประเมินจากการทําแบบฝกหัดทายบท 
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เนื้อหา 

หัวใจท่ีสําคัญประการหนึ่งของการวัด (measurement) ในการวิจัยเชิงปริมาณดานสังคมศาสตร 

คือ การใชเครื่องมือวัดกําหนดตัวเลข (numbers) ใหกับปรากฎการณทางสังคมหรือพฤติกรรมของมนุษย

เพ่ือใหเปนปริมาณท่ีสามารถนับได (Drost, 2011, Kimberlin & Winterstein, 2008) และเปนเรื่องท่ี

ยอมรับไดในมุมมองของนักปฎิฐานนิยม (positivist) หรือวิธีการวิเคราะหแบบประจักษนิยม (empirical 

analytic approach) (Drost, 2011) 

แบบสอบถามเปนเครื่องมืออันหนึ่งท่ีไดรับความนิยมอยางแพรหลายในการสํารวจและรวบรวม

ขอมูลในการวิจัยเชิงปริมาณดานสังคมศาสตร แมวาเครื่องมือท่ีใชในการวิจัยดานสังคมศาสตรจะไม

สามารถวัดไดคาความถูกตอง (accurate) 100 เปอรเซ็นต แตสิ่งท่ีสําคัญ คือ ทําอยางไรใหผลการวิจัย

ไดรับการยอมรับวามีความถูกตอง (Kumar, 2014: 212-219)  

ในกระบวนการพัฒนาและการตรวจสอบเครื่องมือตองทําใหเครื่องมือมีคุณภาพ (quality) คือ มี

ท้ังความเท่ียงตรงและความนาเชื่อถือ เพ่ือใหไดขอมูลท่ีตรงกับความเปนจริงและลดความคลาดเคลื่อน

จากการวัด (Kimberlin & Winterstein, 2008; Taherdoost, 2016) และจากผลการวิจัยพบวา งานวิจัย

ท่ีมีการละเมิดขอตกลงดานเครื่องมือวัด (ไมมีการตรวจสอบเครื่องมือวัด) เม่ือเทียบกับไมละเมิดขอตกลง

ดานเครื่องมือวัด (มีการตรวจสอบเครื่องมือวัด) มีความเสี่ยงของการเกิดความคลาดเคลื่อนในงานวิจัย

มากกวาประมาณ 14 เทา (เรวัต แสงสุริยงค, 2565) 

1. การวิเคราะหความเท่ียงตรง 

ความเท่ียงตรง (Validity) คือ ความสัมพันธระหวางคําถามการวิจัยหรือคาท่ีไดจากการสังเกต 

(observed value) กับความจริง (objectives) หรือคาท่ีเปนจริง (true value) ท่ีทําการศึกษา หรือวัด

แลวไดสิ่งท่ีตองการจะวัด (measure what is intended to be measured) หรือวัดสิ่งใดก็วัดไดสิ่งนั้น

จริง 

การสรางเครื่องมือวิจัยในการวิจัยเชิงปริมาณมีความสําคัญเปนอยางมาก เพราะความจริง 

(objective) คําถามการวิจัย (research question) และสมมติฐาน (hypothesis) มีความเชื่อมโยงกัน 

ดังนั้นเครื่องมือท่ีใชวัดตองมีความเท่ียงตรงหรือความถูกตองดังตอไปนี้ 
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1. ความเท่ียงตรงดานขอเท็จจริง (Face validity) หมายถึง ความถูกตองท่ีตรงกับความเขาใจ

ท่ัวไปของแนวคิด (common understandings of the concept) 

2. ความเท่ียงตรงในเนื้อหา (Content validity) หมายถึง ความถูกตองท่ีขอความท้ังหมด

สามารถครอบคลุมขอบขายของความหมายของตัวแปรท่ีเราตองการจะวัด 

3. ความเท่ียงตรงท่ีสัมพันธกับขอบขาย (Criteria-related validity) หมายถึง ความถูกตองใน

การทํานาย และในการพิสูจนตามแนวคิด 

4. ความเท่ียงตรงในแนวความคิด (Construct validity) หมายถึง ความถูกตองเชิงทฤษฎีในการ

ใชเหตุผลแบบนิรนัย (deductive) และอุปนัย (inductive) 

1.1 การวิเคราะหความสอดคลองระหวางขอคําถาม-วัตถปุระสงคของการวิจัย 

วิธีการวิเคราะหความเท่ียงตรงเครื่องมือวิจัยเชิงปริมาณในการวิจัยดานสังคมศาสตรวิธีการหนึ่งท่ี

ไดรับความนิยมอยางแพรหลายโดยมีจุดกําเนิดมาจากสาขาวิชาดานการศึกษาท่ีพัฒนาโดยริชารด เจ. โร

วิเนลลี (Richard J. Rovinelli) และโรแนล เค. แฮเบิลตัน (Ronald K. Hambleton) คือ ดัชนีความ

สอดคลองระหวางขอคําถาม-วัตถุประสงคของการวิจัย (Index of Item-Objective Congruence: IOC)  

โรวิเนลลีและแฮเบิลตัน เชื่อวาวิธีการตัดสินโดยผูเชี่ยวชาญมีระดับความเชื่อม่ันสูง (high 

degree of confidence) เพราะเปนการทดสอบความตรงของดัชนตีามวัตถุประสงคของการวัดและการ

ออกแบบเครื่องมือของนักวิจัย และเปนการวัดแบบอางอิงตามเกณฑ (criterion-referenced test) โดย

ใหผูเชี่ยวชาญในเนื้อหาของแตละเรื่องเปนผูตัดสิน (judgements of content specialists) ประมาณ 3-

5 คน และประเมินตามวัตถุประสงคในการสรางเครื่องมือ (instructional objectives) อีกท้ังไมตองใช

วิธีการทางสถิติท่ีซับซอน (Rovinelli and Hambletion, 1967) 

วิธีการตัดสินจากผูเชี่ยวชาญ คือ ใหคะแนนขอคําถามท่ีสอดคลองกับวัตถุประสงค = 1 ไม

สอดคลอง = -1 และไมสามารตัดสินใจได = 0 นําคะแนนท่ีสอดคลองกับวัตถุประสงค (1) มาคํานวณแบง

ขอคําถามท่ี ดี (good) และไมดี (bad) ดวยคะแนนครึ่งหนึ่งหรือรอยละ 50 (.5) โดยมีสูตรดังนี้ 

𝐼𝐼𝐼𝐼𝐼𝐼 =
∑𝑅𝑅
𝑁𝑁
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IOC    แทน ดัชนีความสอดคลอง 

ΣR     แทน ผลรวมคะแนนผูเชี่ยวชาญท่ีมีความคิดเห็นวาวัดไดตรง 

N        แทน จํานวนผูเชี่ยวชาญ 

ตัวอยางแบบประเมินความคิดเห็นของผูเช่ียวชาญเกี่ยวกับความเท่ียงตรงของแบบสอบถาม 

ขอ ขอคําถาม 
ความเท่ียงตรง 

ขอเสนอแนะ 
1 0 -1 

1 เว็บไซตนี้ของหนวยงานนี้ใหบริการไดตรงกับความตองการ     

2 เว็บไซตนี้มีความรวดเร็วในการแกไขปญหาท่ีเกิดข้ึน     

3 เว็บไซตนี้ทํางานไดรวดเร็ว     

4 เว็บไซตนี้ใชงานไดงาย     

5 เว็บไซตนี้ออกแบบไดสวยงาม     

6 เว็บไซตนี้มีการบูรณาการขอมูลกับหนวยงานท่ีเก่ียวของไดดี     

7 เว็บไซตนี้สามารถใชงานไดแบบท่ีเดียวเบ็ดเสร็จ (One-stop-services)      

8 เว็บไซตนี้ใหขอมูลท่ีเชื่อถือได     

9 เว็บไซตนี้ใหบริการขอมูลท่ีเปนปจจุบัน (Up-to-date)     

10 เว็บไซตนี้เชื่อม่ันไดวามีการรักษาขอมูลสวนตัวของผูใชบริการไดดี     

 

เกณฑการใหคะแนน 

 +1  ขอคําถามตรงกับวัตถุประสงคการวิจัย 

   0 ขอคําถามไมแนใจวาตรงวัตถุประสงคการวิจัยหรือไม 

 - 1 ขอคําถามไมตรงกับวัตถุประสงคการวิจัย 

การวิเคราะห IOC อาจไมจําเปนตองใชโปรแกรมวิเคราะหขอมูลดานสถิติ เพราะยุงยากกวาการ

วิเคราะหดวยเครื่องคิดเลขหรือโปรแกรมตารางการคํานวณ (spreadsheet) แตในท่ีนี้จะแสดงเปน

ตัวอยางไวหากตองการใชงาน 
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การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดโปรแกรมและสรางแฟมขอมูล ASPSS_IOC.sav 

๏ สรางตัวแปร 10 ตัวแปร คือ ESQ1 ถึง ESQ10 โดยมีรายละเอียดดังนี้ 

o ใสหรือไมตองใส Label, Value Labels แตตองกําหนด Measure = Scale  

 

๏ ใสคาตัวแปรหรือขอมูลโดยมีรายละเอียดดังนี้ 
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives… 

๏ ในหนาตาง Descriptives 

o Variables: เลือกตัวแปร ESQ1 ถึง ESQ10 จากรายการตัวแปรดานซาย  

o Statistics: ใชคาท่ีโปรแกรมกําหนด (default) 

o กดปุม OK 

 

ผลการวิเคราะห 
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การแปลผลการวิเคราะหคา IOC จากคา Mean 

 จากการประเมินเครื่องมือวิจัยโดยใหผูเชี่ยวชาญตัดสินพบวา มีขอคําถามท่ีมีคา IOC นอยกวา .5 

จํานวน 1 ขอ คือ ขอ 1 (ESQ2) และมีขอคําถามท่ีมีคา IOC มากกวา .5 จํานวน 9 ขอ คือ ขอ 1, 3-10 

(ESQ1, ESQ3 ถึง ESQ10) 

 สรุป มีขอคําถามท่ีมีความเท่ียงตรงและสามารถนําไปใชเก็บรวบรวมขอมูล 9 ขอ และมีขอ

คําถามท่ีไมมีความเท่ียงตรงตองทําการปรับปรุงหรือตัดออกจากแบบสอบถามจํานวน 1 ขอ 

ขอ คา IOC การตัดสินใจ 

1 1.00 ใชได 

2 .40 ปรับปรุงหรือตัดท้ิง 

3 .80 ใชได 

4 1.00 ใชได 

5 .80 ใชได 

6 .60 ใชได 

7 .80 ใชได 

8 1.00 ใชได 

9 1.00 ใชได 

10 1.00 ใชได 
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1.2 การวิเคราะหความเห็นสอดคลองกัน  

ในการวิเคราะหความเท่ียงตรง อาจทําการประเมินแบบสอบถามดวยวิธีการวิเคราะหความ

เท่ียงตรงภายนอก (face validity) เพ่ือทดสอบความเปนไปได (feasibility) ความเขาใจจากการอาน 

(readability) การใชสํานวนและรูปแบบของภาษาท่ีมีความกลมกลืนกัน (consistency of style and 

formatting) และความชัดเจนของภาษา (clarity of the language) จากการใหคะแนนโดยผูประเมิน 

(inter-rater) ดวยมาตรวัดแบบสองคา (dichotomous scale) คือ ใช (Yes) = เหมาะสม และไม (No) 

= ไมเหมาะสม  

จากนั้นวิเคราะหหาความเท่ียงตรงระหวางคะแนนของผูประเมิน (inter-ratter) ดวยคาดัชนีแคป

ปาของโคเฮน (Cohen's Kappa Index: CKI) และใชคา Kappa ตั้งแต .60 ข้ึนไป เปนเกณฑในการ

ตัดสินใจยอมรับไดวา ผูประเมินมีความเห็นสอดคลองกัน (Taherdoost, 2016) และแปลระดับความ

สอดคลองจากคา Kappa ไดจากตารางตอไปนี้ (McHugh, 2012) 

ตารางท่ี 8.1 การแปลคาแคปปาของโคเฮน 

คาแคปปา  

(Value of Kappa) 

ระดับความสอดคลอง  

(Level of Agreement) 

จํานวนรอยละของขอมูลท่ีเช่ือถือได 

(% of Data that are Reliable) 

มากกวา .90 มากท่ีสุด 82–100% 

.90-.80 มาก 64–81% 

.79-.60 ปานกลาง 35–63% 

.59-.40 นอย 15–35% 

.39-.21 นอยท่ีสุด 4–15% 

.20-.00 ไมสอดคลอง 0–4% 
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ตัวอยางแบบประเมินความเห็นเก่ียวกับความเหมาะสมของแบบสอบถาม 

ขอ ขอคําถาม 
ความเหมาะสม 

ขอเสนอแนะ 
ใช ไม 

1 เว็บไซตนี้ของหนวยงานนี้ใหบริการไดตรงกับความตองการ    

2 เว็บไซตนี้มีความรวดเร็วในการแกไขปญหาท่ีเกิดข้ึน    

3 เว็บไซตนี้ทํางานไดรวดเร็ว    

4 เว็บไซตนี้ใชงานไดงาย    

5 เว็บไซตนี้ออกแบบไดสวยงาม    

6 เว็บไซตนี้มีการบูรณาการขอมูลกับหนวยงานท่ีเก่ียวของไดดี    

7 
เว็บไซตนี้สามารถใชงานไดแบบท่ีเดียวเบ็ดเสร็จ (One-stop-

services)  

  
 

8 เว็บไซตนี้ใหขอมูลท่ีเชื่อถือได    

9 เว็บไซตนี้ใหบริการขอมูลท่ีเปนปจจุบัน (Up-to-date)    

10 
เว็บไซตนี้เชื่อม่ันไดวามีการรักษาขอมูลสวนตัวของผูใชบริการได

ดี 

  
 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดโปรแกรมและสรางแฟมขอมูล ASPSS_Kappa.sav 

๏ สรางตัวแปร 3 ตัวแปร ItemNo, Rater1 และ Rater2 โดยมีรายละเอียดดังนี้ 

o ตัวแปร ItemNo (Label = Item Number และ Measure = Nominal)  

o ตัวแปร Rater1 (Label = First Rater, Value Labels 0 = No และ 1 = Yes และ 

Measure = Nominal) 

o ตัวแปร Rater2 (Label = Second Rater, Value Labels 0 = No และ 1 = Yes และ 

Measure = Nominal)  
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๏ ใสคาตัวแปรหรือขอมูลโดยมีรายละเอียดดังนี้ 

 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs… 

๏ ในหนาตาง Crosstabs 

o Rows: เลือกตัวแปร Ratter1 -> Columns: และเลือกตัวแปร Ratter2  

 

๏ กดปุม Statistics 
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o Statistics เลือกเฉพาะ Kappa  
o กดปุม Continue 

๏ กดปุม Cells 

o Cell Display เลือกเฉพาะ Count, Column และ Total 
o กดปุม Continue 

๏ กดปุม OK 

  

ตารางผลการวิเคราะห 

 

 

 

การแปลผลการวิเคราะห 

 ผลการวิเคราะหความเหมาะสมของแบบสอบถามจํานวน 10 ขอ ผูประเมินใหคะแนนเหมาะสม 

(1) สอดคลองกันนอยกวาไมสอดคลอง (Yes x Yes = 40.0%) และไดคา Kapp = .17 (Sig. = .53) แสดง

วาแบบสอบถามฉบับนี้มีความไมเหมาะสม  
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2. การวิเคราะหความนาเช่ือถือ 
ความนาเชื่อถือ (Reliability) คือ ความสามารถในการวัดอยางคงเสนคงวา (consistent) หรือ

ความแนนอน (stability) ในการวัดแตละครั้ง เม่ือนําเครื่องมือไปใชภายใตสถานการณท่ีเหมือนกัน หรือ

ประชากรท่ีเหมือนกัน ตองไดผลลัพธท่ีเหมือนกัน (Drost, 2011) 

 การวิเคราะหความนาเชื่อถือมีหลายวิธี แตละวิธีมีขอดีและขอเสียแตกตางกัน เชน ประหยัดเวลา

และคาใชจายในการเก็บขอมูลครั้งเดียว หรือตองใชเวลาและเสียเวลามากในการเก็บขอมูลหลายครั้ง แต

วิธีการท้ังหมดสามารถแบงไดเปน 2 กลุม ดังนี้ 

1. การทดสอบความนาเชื่อถือภายใน (Internal reliability) เปนการทดสอบความสอดคลอง

ภายในระหวางขอคําถามภายในแบบสอบถามแตละชุดท่ีเก็บขอมูลเพียงครั้งเดียว เชน การทดสอบแบบ

แบงครึ่ง (split-half) และการทดสอบความสอดคลองภายในดวยคาสัมประสิทธิ์แอลฟา (alpha 

coefficient)  

2. การทดสอบความนาเชื่อถือภายนอก (External reliability) เปนการทดสอบความสอดคลอง

เชิงเปรียบเทียบระหวางสองชวงเวลา ระหวางผูประเมิน และระหวางชุดแบบสอบถาม เชน การทดสอบ-

ทดสอบซํ้า (test-retest) การใหคะแนนระหวางผูประเมิน (inter-rater) และการทดสอบหลากรูปแบบ

หรือรูปแบบเผื่อเลือก (multiple/alternative forms)  

 วิธีการวิเคราะหความนาเชื่อถือท่ีนิยมใชกันท่ัวไป คือ การวัดความสอดคลองภายในดวยคา

สัมประสิทธิ์แอลฟาของครอนบัก (Cronbach Alpha Coefficient) ซ่ึงเหมาะกับเครื่องมือท่ีใชขอคําถาม

แบบใหคะแนน (scored items) แบบสองคา (dichotomous) เชน มาตรวัดแบบใหคะแนน 0 และ 1 

และแบบหลายคา (polychotomous) เชน มาตรวัดแบบลิเคิรต (Likert scale) (Ritter, 2010) ใชวิธีการ

เก็บขอมูลเพียงครั้งเดียว และขอคําถามไมจําเปนตองมีจํานวนเปนเลขคูเหมือนกับวิธีการทดสอบแบบ

แบงครึ่ง (split-half 

แมวาจะไมมีกฎท่ีแนนอน แตมีหลักท่ัวไป (rule of thumb) ท่ียอมรับกันอยางแพรหลาย คือ คา

ความสอดคลองภายในตองไมตํ่ากวา .70 (Taherdoost, 2016) และแปลระดับความนาเชื่อถือจากคา 

Cronbach ’s Alpha สําหรับคําถามแบบสองคา (dichotomous questions) หรือคําถามแบบลิเคิรต 

(Likert scale questions) ไดจากตารางตอไปนี้ (Glen, 2014) 
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ตารางท่ี 8.2 การแปลคาสัมประสิทธิ์แอลฟาของครอนบัก 

คาแอลฟาของครอนบัก  

(Value of Cronbach’ s Alpha) 

ความสอดคลองภายใน  

(Internal Consistency) 

α >= .9 ดีมาก (Excellent) 

.9 > α >= .9 ดี (Good) 

.8 > α >= .7 ยอมรับได (Acceptable) 

.7 > α >= .6 ไมแนนอน (Questionable) 

.6 > α >= .5 ต่ํา (Poor) 

.5 > .7 > α ไมยอมรับ (Unacceptable) 

 ตัวอยางท่ีนํามาใชในการวิเคราะหความนาเชื่อถือ คือ แฟมขอมูลตัวอยาง ASPSS_Alpha.sav 

โดยมีวิธีการดังตอไปนี้ 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดโปรแกรมและเปดแฟมขอมูล ASPSS_Alpha.sav 
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๏ เลือกเมนู Analyze -> Reliability… 

๏ ในหนาตาง Reliability Analysis 

o Items: เลือกตัวแปร ESQ1 ถึง ESQ10 จากรายการตัวแปรดานซายมาใส 

o Model: เลือก Alpha 

o เลือก Show descriptives for scale if item is deleted (แสดงคาสถิติเพ่ือปรับคา 

Cronbach ’s Alpha) 

o กดปุม OK 

 

ผลการวิเคราะห 
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การแปลผลการวิเคราะห 

 ผลการวิเคราะหความนาเชื่อถือขอคําถามจํานวน 10 ขอ จากกลุมตัวอยาง 10 คน ไดคา 

Cronbach’s Alpha = .67 โดยคาสถิติ Cronbach Alpha if Item Deleted ในตาราง Item-Total 

Statistics แนะนําใหลบคําถามขอ ESQ2 (The speed of solving problems) ออกจากการวิเคราะห

จะไดคา Alpha = .77  

ทําการวิเคราะหความนาเชื่อถือใหมดวยวิธีการเดิมโดยเอาตัวแปร ESQ2 ออกจากรายการ 

Items: เหลือขอคําถามท่ีใชในการวิเคราะหจํานวน 9 ขอ  

ผลการวิเคราะหหลังลบตัวแปร ESQ2 

 

 

 ผลการวิเคราะหความนาเชื่อถือจากการลบตัวแปร ESQ2 ออกจากการวิเคราะห ไดคา 

Cronbach’s Alpha = .77 มากกวาคาความสอดคลองภายใน .70 ตามท่ีกลาวมา และเปนเครื่องมือวัดมี

ความนาเชื่อถือหรือคงเสนคงวาในการวัดแตละครั้ง 

 สําหรับขอคําถาม ESQ2 หากมีความสําคัญและตองใชเปนดัชนีในการวัด ตองทําการปรับปรุง

และนําไปทดสอบกับกลุมตัวอยางใหม แลวจึงนํามาทําการวิเคราะหหาความนาเชื่อถือใหมอีกครั้ง 
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สรุป 

 การวิเคราะหเครื่องมือการวิจัย คือ การตรวจสอบความมีคุณภาพของเครื่องมือท้ังดานความ

เท่ียงตรงและความนาเชื่อถือเพ่ือลดความคลาดเคลื่อนจากการวัด และไดขอมูลท่ีตรงกับความเปนจริง

อยางคงเสนคงวา  

วิธีการวิเคราะหความเท่ียงตรงท่ีไดรับความนิยมอยางแพรหลาย คือ การทดสอบความตรงของ

ดัชนีตามวัตถุประสงคของการวัดและการออกแบบเครื่องมือของนักวิจัยดวยคาความสอดคลองระหวาง

ขอคําถาม-วัตถุประสงคของการวิจัย (Index of Item-Objective Congruence: IOC) และดัชนีความ

สอดคลองระหวางคะแนนของผูประเมินดวยคาแคปปาของโคเฮน (Cohen's Kappa Index: CKI) 

วิธีการวิเคราะหความนาเชื่อถือท่ีนิยมใชกันท่ัวไป คือ การวัดความสอดคลองภายในดวยคา

สัมประสิทธิ์แอลฟาของครอนบัก (Cronbach Alpha Coefficient) 

แบบฝกหัดทายบท 
 ใหผูเรียนฝกวิเคราะหความเท่ียงตรงและความนาเชื่อถือดังตอไปนี้ 

1. เปดแฟมขอมูล ASPSS_IOC.sav 

    - เพ่ิมคาตัวแปร Item4-Item10 และใสคาตัวแปรใหครบ 

    - วิเคราะหคา IOC และตัดสินใจวาขอคําถามใดใชไดหรือใชไมได  

2. เปดแฟมขอมูล ASPSS_Kappa.sav 

    - เพ่ิมคาตัวแปรใน ItemNo, First Rater และ Second Rater ตัวตอจากขอท่ี 3 ใหครบ 10 

รายการ  

    - วิเคราะหคา Kappa และประเมินวาแบบสอบถามมีความเหมาะสมหรือไม  

3. เปดแฟมขอมูล hotel.sav แลวดําเนินการดังนี้ 

   - เพ่ิมตัวแปร V6-V10 หรือขอคําถามอีก 5 ขอ ตอจากตัวแปร V5 และใสคาตัวแปรใหครบ  

   - วิเคราะหความนาชื่อถือ หากคา Cronbach’s Alpha ต่ํากวา .70 ใหตัดขอคําถามตามท่ี

โปรแกรมแนะนําเพ่ือปรบัคา Cronbach’s Alpha ใหอยูในระดับท่ียอมรับได    

  



 

 

บทที่ 9 

การวิเคราะหขอมูลเชิงสํารวจ 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถตรวจสอบความถูกตองและความสมบูรณของขอมูล รวมถึงตรวจสอบลักษณะ

ของขอมูลตามขอตกลงเบื้องตนของสถิติ 

เน้ือหา 

1. การตรวจสอบความถูกตองและความสมบูรณของขอมูล 

2. การตรวจสอบขอมูลตามขอตกลงเบื้องตน 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และ

ประเมินจากการทําแบบฝกหัดทายบท 
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เนื้อหา 

ความถูกตองและไมถูกตองของขอมูลเกิดข้ึนไดตั้งแตการออกแบบแฟมขอมูลและการนําขอมูล

เขาแฟมขอมูล กอนการวิเคราะหขอมูลควรทําความสะอาดขอมูล (data cleansing) เพ่ือตรวจสอบให

ม่ันใจวาขอมูลในแฟมขอมูลมีความถูกตองและตรงกับแบบสอบถาม แมวาขอมูลในแฟมขอมูลจะมี

ความถูกตองและตรงกับขอมูลท่ีไดจากการสํารวจแลว กอนการใชสถิติทดสอบตองตรวจสอบขอมูล 

(data screening) ใหม่ันใจวาลักษณะของขอมูลเปนไปตามขอตกลงเบื้องตนของสถิติแตละประเภท  

1. การตรวจสอบความถูกตองและความสมบูรณของขอมูล 

การตรวจสอบความถูกตองและความสมบูรณของขอมูล คือ การตรวจสอบการออกแบบขอมูล 

(data design) เพ่ือทบทวนการสรางตัวแปรใหถูกตองและตรงกับแบบสอบถาม การตรวจสอบการนําเขา

ขอมูล (data entry) เพ่ือตรวจสอบความถูกตองของขอมูลระหวางแบบสอบถามกับแฟมขอมูล และการ

ตรวจความสมบูรณของขอมูล เพ่ือตรวจสอบขอมูลมีคาสูญหายมากนอยเพียงใด   

1.1 การตรวจสอบการออกแบบขอมูล 

 การตรวจสอบการออกแบบขอมูล คือ การทบทวนการออกแบบแฟมขอมูลท่ีออกแบบไวกอน

การนําเขาขอมูลวามีความถูกตองตรงกับแบบสอบถามหรือไม โดยการเปดแฟมขอมูลและเขาไปท่ี

หนาตางแสดงตัวแปร (Variable View) แลวทําการตรวจสอบดังนี้ 

1. การกําหนดชื่อตัวแปร ควรใชคําหรือชื่อยอท่ีสื่อความหมาย หากเปนกลุมตัวแปรดัชนี ควรใช

ชื่อเดียวกันแลวตามดวยตัวเลข เพ่ือความสะดวกในการใชคําสั่งท่ีตองใชตัวแปรหลายตัวแปร 

2. การกําหนดความหมายตัวแปร ควรสั้นและเขาใจงาย เพ่ือใหการแสดงผลในผลการวิเคราะห 

(output) อยูภายในบรรทัดเดียวกัน   

3. การกําหนดคาตัวแปร ใหความหมายตรงกับคําตอบในแบบสอบถามหรือไม โดยเฉพาะตัวแปร

แบบสองคา (dichotomous variable) ควรใหคาแบบ 0 และ 1 หรือ 1 และ 2  

4. การกําหนดคาสูญหาย มีการกําหนดคาท่ีไมตองการนํามาใชในการคํานวณหรือไม เชน 

กําหนดใหเลข 8 = ไมตอบ หรือ 9 = ไมทราบ เพราะหากไมกําหนดเปนคาสูญหายจะทําใหคาสถิติ

เบี่ยงเบนไปจากคาท่ีเปนจริง 
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5. การกําหนดระดับการวัดตัวแปร กําหนดตรงกับลักษณะขอมูลในแบบสอบถามและระดับการ

วัดหรือไม 

การตรวจสอบความถูกตองในข้ันตอนนี้แมวาจะเปนการทํางานท่ีซํ้าซอน แตก็ชวยสรางความ

ม่ันใจของความถูกตองของขอมูล และอาจพบขอผิดพลาดท่ีควรทําการแกไขก็ได  

วิธีท่ี 1 การตรวจสอบพรอมกันทุกตัวแปร 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูลท่ีตองการตรวจสอบ (ตัวอยางแฟมขอมูล ASPSS_Data.sav) 

๏ เลือกเมนู File -> Display Data File Information -> Working File 

๏ ดูผลลัพธในหนาตาง Output Viewer 

ตัวอยาง: การตรวจสอบลักษณะตัวแปรท้ังแฟมขอมูล 
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วิธีท่ี 2 การตรวจสอบทีละตัวแปร 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูลท่ีตองการตรวจสอบ 

๏ เลือกเมนู Utilities -> Variables… 

๏ คลิกเมาสเลือกดุตัวแปรในเมนูดานซายตรวจสอบทีละตัวแปร 

ตัวอยาง: การตรวจสอบลักษณะตัวแปรทีละตัวแปร (ตัวแปร ID) 

 
ตัวอยาง: การตรวจสอบลักษณะตัวแปรทีละตัวแปร (ตัวแปร Gender) 
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1.2 การตรวจสอบความถูกตองของขอมูล 

การตรวจสอบความถูกตองของขอมูล คือ การตรวจสอบความผิดพลาดในการบันทึกขอมูล 

(coding error และความผิดพลาดจากความไมตั้งใจในการตอบแบบสํารวจหรือบันทึกขอมูลระหวางการ

สัมภาษณ (logical error) วิธีการตรวจสอบความถูกตองของขอมูลท่ีกลาวมามี 2 วิธี ดังนี้ (SPSS, 2005: 

3) 

1. การตรวจสอบแบบตัวแปรเดียว (Single-variable rule) เปนการคนหาความผิดพลาดในการ

บันทึกขอมูล และเปนการคนหาคาท่ีไมอยูในชวงของคาตัวแปร (out-of-range values) ในแฟมขอมูล 

ซ่ึงมีสาเหตุมาจากการพิมพคาตัวแปรผิดระหวางการบันทึกขอมูล หรือมีกลุมตัวอยางท่ีมีคุณลักษณะของ

ขอมูลอยูนอกชวงของคาตัวแปรท่ีกําหนดไวในการออกแบบสอบถาม  

 การใชโปรแกรมวิเคราะหขอมูล 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies…  

o Variable (s): ใสตัวแปร Gender และ Edu 

o Statistics: ยก เ ลิ ก ก า ร เ ลื อ ก ค า  Mean, Standard deviation, Minimum แ ล ะ 

Maximum 

 

ตัวอยาง: ผลลัพธการตรวจสอบขอมูลตัวแปรคาแบงกลุมแบบตัวแปรเดียว 

 

 

การตรวจสอบ: มีคาของตัวแปรอยูนอกเหนือจากคา (value) ท่ีกําหนดไวหรือไม 
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives… 

o Variable (s): ใสตัวแปร Age 

o Statistics: เลือกคา Mean, Standard deviation, Minimum และ Maximum 

 

ตัวอยาง: ผลลัพธการตรวจสอบขอมูลตัวแปรคาตอเนื่องแบบตัวแปรเดียว 

 

การตรวจสอบ: มีขอมูลอยูนอกขอบเขตหรือไม 

2. การตรวจสอบแบบไขวตัวแปร (Cross-variable rule) เปนการคนหาความผิดพลาดจาก

ความไมตั้งใจในการตอบแบบสํารวจหรือผูสัมภาษณบันทึกขอมูลในแบบสอบถามผิด กลาวคือ เปนการ

คนหาคาตัวแปรท่ีไมสอดคลองกับความเปนจริงหรือความขัดแยงของขอมูลระหวางตัวแปร เชน ครัวเรือน

ท่ีมีสมาชิก 1 คน เปนเพศชาย เปนโสด แตมีบุตรจํานวน 1 คนหรือมากกวา เปนตน 
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กรณีท่ี 1 ตัวแปรท่ีไมนาจะมีความสัมพันธกัน เชน สถานภาพการทํางาน กับ ตําแหนงงาน 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ สรางตัวแปร 2 ตัวแปร คือ Work และ Position โดยมีรายละเอียดดังนี้ 

o ตัวแปร Work (Label = Work Status, Value 1 = Employed 2 = 

Unemployed และ Measure = Nominal) 

o ตัวแปร Position (Label = Work Position, Value Labels 0 = Non 1 = 

Manager 2 = Employee 3 = Other และ Measure = Nominal) 

 

๏ ใสคาตัวแปรหรือขอมูลโดยมีรายละเอียดดังนี้ 

 

 



174 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstab… 

o Rows ใสตัวแปร Work  

o Columns ใสตัวแปร Position 

o กดปุม  Statistics… ในกลุ ม คําสั่ ง  Statistics ยกเ ลิกการเลือก Chisq -> กดปุม 

Continues 

o กดปุม Cells… ในกลุมคําสั่ง Cell Display เลือกเฉพาะ Count -> กดปุม Continues 

o กดปุม OK  

  

ตัวอยาง: ผลลัพธการตรวจสอบขอมูลแบบไขวระหวางตัวแปรคาแบงกลุม X ตัวแปรคาแบงกลุม 

 

 

การตรวจสอบ: คาตัวแปรท่ีไมสอดคลองกัน เชน Work Status = Unemployed แต Work 

Position ใน Employee = 1 
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กรณีท่ี 2 ตัวแปรท่ีไมนาจะมีความสัมพันธกัน เชน สถานภาพสมรส กับ จํานวนบุตร 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ สรางตัวแปร 2 ตัวแปร คือ Married และ Child โดยมีรายละเอียดดังนี้ 

o ตัวแปร Marital (Label = Marital Status, Value Labels 1 = Single 2 = 

Married 3 = Other และ Measure = Nominal) 

o ตัวแปร Child (Label = Child Numbers และ Measure = Scale) 

 

๏ ใสคาตัวแปรหรือขอมูลโดยมีรายละเอียดดังนี้ 
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๏ เลือกเมนู Analyze -> Compare Mean -> Means… 

เลือกตัวแปรท่ีคิดวาไมนาจะมีความสัมพันธกัน เชน สถานภาพสมรส กับ จํานวนบุตร 

o Dependent List: เลือกตัวแปร Child จากรายการตัวแปรดานซาย  

o Independent List:  เลือกตัวแปร Married จากรายการตัวแปรดานซาย 

o กดปุม OK 

 

ตัวอยาง: ผลลัพธการตรวจสอบขอมูลแบบไขวระหวางตัวแปคาแบงกลุม X ตัวแปรคาตอเนื่อง 

 

 

การตรวจสอบ: คาตัวแปรท่ีไมสอดคลองกัน เชน Mairtal Status = Single แตคาเฉลี่ย Child = 1  
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1.3 การตรวจสอบคาสูญหาย 

คาสูญหาย (Missing values) คือ คาตัวแปรท่ีไมทราบคาภายในแฟมขอมูลมีมากนอยเพียงใด 

และมีรูปแบบปกติหรือไมปกติ เชน คาวางเปลา (null) ท่ีโปรแกรมกําหนดใหเปนคาสูญหาย (system 

missing) และคาท่ีผูใชกําหนดใหเปนคาสูญหาย (user missing) เชน ไมทราบ ไมตอบ ผลกระทบของคา

สูญหายมีผลทําใหผลการวิเคราะหผิดพลาด (bias) และคาสถิติไมมีอํานาจในการทํานายท่ีดี (statistical 

power)  

การวิเคราะหหาขอมูลสูญหายภายในแฟมขอมูลวามีลักษณะดังตอไปนี้หรือไม (Hair and 

Others, 2006: 55-56) 

1. จํานวนคาสูญหาย มีจํานวนคาสูญหายของแตละชุดขอมูล (case) และแตละตัวแปร 

(variable) วามีคาสูญหายจํานวนมากนอยเพียงใด ถากําหนดไมใหนําเอาขอมูลท่ีมีคาสูญหายมาใชในการ

คํานวณ จํานวนตัวอยางท่ีถูกนําไปใชในการคํานวณก็จะมีขนาดลดลง หากมีขอมูลสูญหายจํานวนมาก 

อาจมีผลทําใหมีขอมูลไมเพียงพอในการวิเคราะหแบบหลายตัวแปร (multivariate analysis) ตามมา 

2. รูปแบบคาสูญหาย มีรูปแบบการสูญหายอยางมีระบบหรือสูญหายลักษณะคลายกัน 

(nonrandom) ท่ีเกิดจากผูตอบไมตองการเปดเผยขอมูลของตน เชน คนรวยไมตองการบอกรายไดของ

ตน เปนตน รูปแบบการสูญหายอยางมีระบบท่ีพบกันอยางแพรหลาย เชน การสูญหายของขอมูล

เนื่องจากผูตอบแบบสอบถามจํานวนหนึ่ งไมตอบคําถามขอใดขอหนึ่ง หรือสวนใดสวนหนึ่งใน

แบบสอบถาม หรือการสูญหายของขอมูลเนื่องจากการไมตอบท่ีเพ่ิมมากข้ึนในตอนทายของแบบสอบถาม 

เปนตน ถาคาสูญหายมีอยูในตัวแปรตาม คาสูญหายนั้นจะมีผลทําใหคาของตัวแปรตามเปลี่ยนตามไปดวย 

และอาจมีความสัมพันธกับคาของตัวแปรท่ีสังเกตได  

การไมใหความสนใจ (ignore) และการแกไข (remedy) การสูญหายของขอมูล มีผลกระทบตอ

ผลการวิเคราะหท้ังสองกรณี สิ่งสําคัญท่ีนักวิจัยควรทํากอนการวิเคราะหขอมูล คือ ทําความเขาใจการสูญ

หายของขอมูลวา การสูญหายของขอมูลมีสาเหตุมาจากอะไร และมีผลกระทบอยางไร เพราะจะทําใหการ

ตัดสินใจแกไขการสูญหายของขอมูลมีความถูกตองมากกวา และปองกันปญหาความผิดพลาดของผลการ

วิเคราะหไดเปนอยางดี โดยทําการตรวจสอบจํานวนคาสูญหายตอตัวแปร (missing per variable) และ

จํานวนคาสูญหายตอชุดขอมูล (missing per case) มีจํานวนมากนอยเพียงใด และเกิดการสูญหายอยาง
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มีระบบหรือสูญหายลักษณะคลายกัน (nonrandom) หรือไม ตามท่ีกลาวมาแลว แตสําหรับในท่ีนี้จะ

กลาวถึงเฉพาะการตรวจสอบจํานวนคาสูญหายเทานั้น โดยมีรายละเอียดดังนี้  

1. จํานวนคาสูญหายของแตละตัวอยาง (Missing values by case) ตัวอยางท่ีมีคาสูญหายต่ํา

กวารอยละ 10 ไมตองทําการปรับแก แตหากมากกวานั้นควรทําการแกไข และหากมีจํานวนมากรอยละ 

50 ควรตัดออกจากกระบวนการวิเคราะหขอมูล  

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ เลือกเมนู Transform -> Compute Variable 

o Target Variable: พิมพชื่อแปร VMissing 

o Function เลือก NMIS (นับเฉพาะคา System Missing หรือคาวางเปลา และ User 

Missing) 

o เลือกตัวแปรท้ังหมดท่ีตองการตรวจสอบใสในวงเล็บ (เฉพาะตัวแปรแบบตัวเลข) 

o กดปุม OK 

 

๏ เลือกเมนู Data -> Sort Cases… 

o Sort by: ใสตัวแปร VMissing 

o Sort Order เลือก 

Descending 

o กดปุม OK 
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ตัวอยาง: ผลลัพธการตรวจสอบจํานวนคาสูญหายของแตละชุดขอมูล 

 

การตรวจสอบ: ดูจํานวนคาสูญหายในตัวแปร VMissing ตัวอยางท่ี 5 มีคาสูญหายจํานวน 2 ตัวแปร 

(รอยละ 25) และตัวอยางท่ี 1 มีคาสูญจํานวน 1 ตัวแปร (รอยละ 12.5) 

2. จํานวนคาสูญหายของแตละตัวแปร (Missing values by variable) ตัวแปรท่ีมีคาสูญหาย

เล็กนอยประมาณรอยละ 15 ไมตองทําการปรับแก แตหากมากกวานั้นควรทําการแกไข และหากมี

จํานวนมากรอยละ 50 ควรตัดออกจากกระบวนการวิเคราะหขอมูล  

วิธีการตรวจสอบอาจใช Function MISSING(number) ในคําสั่ง Transform -> Compute 

Variable ก็ได แตวิธีดังกลาวสามารถนับไดทีละตัวแปรเทานั้น ดังนั้นในท่ีนี้จะประยุกตใช คําสั่ง 

Descriptive Statistics เปนเครื่องมือในการวิเคราะหแทน 

วิธีท่ี 1 การตรวจสอบตัวแปรคาแบงกลุม 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> 

ASPSS_Data.sav 

๏ เ ลื อ ก เ ม นู  Analyze -> Descriptive 

Statistics -> Frequencies 

o Variable (s): ใสตัวแปร Gender และ 

Edu 

o ในกลุมคําสั่ ง  Statistics: ยกเลิกการ

เลือกคา Mean, Standard deviation, 

Minimum และ Maximum 

o กดปุม OK 
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ตัวอยาง: ผลลัพธการตรวจสอบคาสูญหายของตัวแปรคาแบงกลุม 

 

 

การตรวจสอบ: ถามีคาสูญหายนอยกวา 5% เลือกใชการวิเคราะหแบบ Listwise และถามีคาสูญหาย

มากกวาหรือเทากับ 5% กําหนดคาสูญหายเปนกลุมใหม (new category) 

วิธีท่ี 2 การตรวจสอบตัวแปรคาตอเนื่อง 

การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Explore…  

o Dependent List: ใสตัวแปร Age และ Child 

 

 

o กดปุม Options… 

- Missing Values เลือก Report values 

- กดปุม Continue 

o กดปุม OK 
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ตัวอยาง: ผลลัพธการตรวจสอบคาสูญหายของตัวแปรคาตอเนื่อง 

 

การตรวจสอบ: ถามีคาสูญหายนอยกวา 5% เลือกใชการวิเคราะหแบบ Listwise ถามีคาสูญหาย

ระหวาง 5% ถึง 15% การแทนคานอยกวา 15% ของขอมูลมีผลกระทบตอผลลัพธเล็กนอย ให

คํานวณหาคาเฉลี่ยและแทนคาโดยใชคําสั่ง Recode into Difference Variables… แตถาตองแทน

คามากกวา 15% ใหพิจารณาตัดตัวแปรออกจากการวิเคราะห 

เนื่องจากโปรแกรมทางสถิติสวนใหญจะไมนําเอาขอมูล (exclude) ท่ีมีคาสูญหาย (missing 

value) มาทําการวิเคราะห ซ่ึงไมตรงกับความสนใจดานประชากรท่ีเปนเปาหมายในการศึกษา และมีผล

ทําใหผลการวิเคราะหมีความคลาดเคลื่อน ดังนั้นจึงวิธีการแกไขมีดังนี้ 

1. วิเคราะหเฉพาะชุดขอมูลท่ีทุกตัวแปรไมมีคาสูญหาย (Listwise)  

2. วิเคราะหเฉพาะชุดขอมูลท่ีคูตัวแปรไมมีคาสูญหาย (Pairwise)  

3. ประมาณคาท่ีสูญหายดวยวิธีความเปนไปไดสูงสุด (Maximum Likelihood Estimation: MLE)  

4. แทนคาท่ีสูญหาย (Imputation) ดังนี้ 

   - แทนคาดวยคาเฉลี่ยของท้ังชุดขอมูล (Series mean) 

   - แทนคาดวยคาเฉลี่ยของคาท่ีอยูขางบนและขางลางของคาสูญหาย (Mean of nearby   

     points) 

   - แทนคาดวยคามัธยฐานของคาท่ีอยูขางบนและขางลางของคาสูญหาย (Median of nearby  

     points) 

   - แทนคาดวยคาท่ีไดจากการลากเสนตรงจากคาสุดทายกอนคาสูญหายไปยังคาแรกหลังคาสูญ 

     หาย (Linear interpolation) 

   - แทนคาดวยคาทํานายท่ีไดจากสมการถดถอย (Linear trend at point) 
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1.4 การตรวจสอบคาผิดปกติและคาตางสุด 

คาผิดปกติและคาตางสุดอาจรวมอยูในตัวแปรเดียวกัน แตคาผิดปกติ (outliers) และคาตางสุด 

(extremes) ในแตละตํารามีนิยามและหลักเกณฑไมเหมือนกัน ดังนี้  

1. คาผิดปกติ บางตํารากลาววาเปนคาตัวแปรท่ีไมถูกตองท่ีปรากฏอยูในชุดขอมูล หรือเปนคาท่ี

ไมเปนจริงจากประชากรหรือกลุมตัวอยาง เชน เงินเดือน 15 บาท/เดือน แตอีกตําราหมายถึงคาตัวแปรท่ี

นอยกวา Q1-1.5(IQR) และคาตัวแปรท่ีมากกวา Q3+1.5(IQR)  

2. คาตางสุด บางตํารากลาววาเปนคาท่ีเปนจริงแตเบี่ยงเบน (deviates) ออกไปจากคาปกติท่ีได

จากประชากรหรือกลุมตัวอยาง อาจเปนคาท่ีมากกวาหรือนอยกวาคาปกติในชุดตัวแปรเดียวกัน เชน 

เงินเดือน 100,000 บาท/เดือน บางตํารากําหนดใหคาตางสุดอยูท่ีนอยกวา Q1-1.5(IQR) และคาตางสุด

อยูท่ีมากกวา Q3+1.5(IQR) แตบางตํารากําหนดใหคาตางสุดอยูท่ีนอยกวา Q1-3(IQR) และคาตางสุดอยูท่ี

มากกวา Q3+3(IQR)  

 

รูปท่ี 9.1 คาผิดปกติและคาตางสุด 

แมวาคาผิดปกติและคาตางสุดจะมีนิยามและเกณฑในการกําหนดคาผิดปกติและคาตางสุดไม

เหมือนกัน แตท้ังสองคาท่ีกลาวมามีสาเหตุการเกิดดังนี้ 
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1. การกรอกขอมูล คือ กรอกขอมูลผิดพลาด (wrong entry) เปนคาของตัวแปรท่ีไมอยูในชวง

ของขอมูลตามแบบสอบถาม 

2. ขอมูลจากกลุมตัวอยาง มีกลุมตัวอยางบางกลุมตัวอยางมีคุณลักษณะท่ีแตกตางไปจากกลุม

ตัวอยางท่ัวไป เชน สูงมาก มีบุตรมาก มีรายไดสูงมาก  

เนื่องจากในหัวขอการการตรวจสอบความถูกตองของขอมูลไดกลาวถึงการตรวจสอบคาตัวแปรท่ี

ไมปกติแลว ประกอบกับคําสั่งในโปรแกรมใชคําวา Extremes ดังนั้นเพ่ือไมใหเกิดความสับสนในท่ีนี้จะใช

คําวา คาตางสุด (extremes) ซ่ึงหมายถึง คาของตัวแปรท่ีมีคาต่ํากวาปกติหรือสูงกวาปกติเม่ือเทียบกับคา

ปกติท่ีไดมาจากกลุมตัวอยาง  

คาตางสุดมีผลทําใหเกิดความคาดเคลื่อนของคาสถิติ เชน คาเฉลี่ยต่ําหรือสูงเกินจริง คาเบี่ยงเบน

มาตรฐานสูงกวาปกติ การแจกแจงขอมูลไมปกติ คาความเบและความโดงไมปกติ คาสัมประสิทธิ์

สหสัมพันธ (correlation coefficient) เพ่ิมข้ึนหรือลดลง คาความชัน (slope) ในการพยากรณความ

ถดถอย (regression) เบี่ยงเบนไป เปนตน นําไปสูการ การตัดสินใจผิดพลาด โดยปฏิเสธและยอมรับ

สมมติฐานไมถูกตอง เชน ปฏิเสธสมมติฐาน H0 ท้ังท่ีเปนสมติฐานท่ีถูกตอง (Type I error) หรือยอมรับ

สมมติฐาน H0 ท้ังท่ีเปนสมติฐานท่ีไมถูกตอง (Type II error) (Struble, 2002; Verma, & Abdel-Salam, 

2019: p. 76-79) 

วิธีการตรวจสอบคาตางสุดในเบื้องตนมี 2 วิธี คือ การตรวจสอบเชิงขอเท็จจริงจากลักษณะทาง

ประชากร และการตรวจสอบเชิงสถิติจากคา Tukey’s Hinges คาตางสุด คือ คาท่ีอยูต่ํากวาคา Lower 

Hinge (HL) และสูงกวาคา Upper Hinge (HU) (Hoaglin, 2003) โดยมีวิธีการดังตอไปนี้ 
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  การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Explore…  

o Dependent List: ใสตัวแปร Age  

o กดปุ ม  Statistics… -> เ ลื อ ก คํ า สั่ ง  Extremes และ  Percentiles -> กดปุ ม 

Continue 

 
 

ตัวอยาง: ผลลัพธการตรวจสอบคาตางสุด 

 

 

การตรวจสอบ: 1. ตรวจสอบคาตางสุดในตาราง Extreme Value โดยดูคาสูงสุดและต่ําสุดวามีความ

เปนไปไดหรือสอดคลองกับลักษณะทางประชากรของตัวอยางหรือไม เชน กลุมตัวอยางเปนวัยผูใหญ มี

ความเปนไปไดหรือไมท่ีจะมีอายุสูงสุด = 60 ป หรือถากลุมตัวอยางเปนวัยหนุมสาว มีความเปนไปได

หรือไมท่ีจะมีอายุสูงสุด = 60 ป 2. ตรวจสอบจากคาตางสุดในตาราง Percentiles โดยพิจารณาจาก

คา Tukey’s Hinges คาตางสุด มีคาท่ีต่ํากวา HL = 25 และสูงกวา HU = 45 หรือไม จากตัวอยาง มี

เฉพาะอายุ 60 ป เทานั้นท่ีเปนคาตางสุด แมวาในแฟมขอมูลมีอายุ 14 ป แตถูกกําหนดใหเปนคาสูญ

หายแบบ user missing ไมใหเอามาคํานวณไวแลว  

 คาตางสุดอาจไมตองกําจัดท้ิง เพราะเปนคาท่ีแทจริงของกลุมตัวอยาง แตหากเกิดจากความ

ผิดพลาดในการนําเขาขอมูล หรือเกิดจากความผิดพลาดในการเก็บขอมูลท่ีไดขอมูลมาจากประชากรท่ีอยู

นอกกลุมตัวอยางตองกําจัดท้ิง 
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2. การตรวจสอบขอมลูตามขอตกลงเบ้ืองตน 

การตรวจสอบขอมูลตามขอตกลงเบื้องตน คือ การตรวจสอบหรือประเมินขอมูลตามเง่ือนไข

เบื้องตนของสถิติแตละประเภท (basic assumptions) โดยเฉพาะวิเคราะหขอมูล 1 ตัวแปร (univariate 

analysis) และ 2 ตัวแปร (bivariate analysis) ดวยสถิติเชิงอางอิง (inferential statistics) มีขอตกลง

ท่ัวไปท่ีตองตรวจสอบ คือ การแจกแจงปกติ (normality) ความเทากันของความแปรปรวน (equality of 

variance) และความสัมพันธเชิงเสนตรง (linearity)  

2.1 การแจกแจงแบบปกต ิ

การแจกแจงแบบปกติ (Normality/Normal distribution) หรืออาจเรียกวา การแจกแจงแบบ

เกาส (Gaussian distribution) คือ ลักษณะของขอมูลท่ีการแจกแจงแบบความนาจะเปน (probability 

distribution) หรือมีคาแบบสุม (random) ท่ีแสดงวา ขอมูลสวนใหญมีความถ่ีหรือปรากฏอยูใกล ๆ กับ

คาเฉลี่ย (mean)  

เง่ือนไขเบื้องตนของสถิติเชิงอางอิงในการทดสอบแบบอิงคาพารามิเตอร (parametric test) 

ตองทราบลักษณะขอมูลวา มีการแจกแจงปกติหรือไม ถาขอมูลมีการแจกแจงปกติมีโอกาสนอยท่ีจะเกิด

ความคลาดเคลื่อนเชิงสถิติ แตหากขอมูลมีการแจกแจงไมปกติการทดสอบสมมติฐานและการสรุปก็จะไม

ถูกตอง  (Verma, & Abdel-Salam, 2019: p. 66-67) ควรตัดสินใจเลื อกการทดสอบแบบไม อิ ง

คาพารามิเตอร (non-parametric test)  

ผลกระทบท่ีเกิดจากขอมูลท่ีมีความเบี่ยงเบนไปจากการแจกแจงปกติ คือ ถาเปนขอมูลของกลุม

ตัวอยางขนาดใหญ อาจทําใหเกิดความสัมพันธระหวางตัวแปรอันอยางมีนัยสําคัญทางสถิติ ท้ังท่ีในความ

เปนจริงแลวอาจไมความสัมพันธระหวางเหตุการณท่ีเกิดข้ึนหรือเปนประเด็นปญหาท่ีไมมีความสําคัญแต

อยางใด และถาขอมูลของกลุมตัวอยางมีขนาดเล็ก อาจไมแสดงความสัมพันธระหวางตัวแปร 

ขอมูลท่ีมีลักษณะแจกแจงปกติ (normal distribution) คือ ขอมูลท่ีมีรูปทรงแบบระฆังคว่ําท่ี

สมมาตร (symmetric bell-shaped curve) ขอมูลท่ีมีการแจกแจงปกติตามทฤษฎีมีคาความเบ  

(skewness) และความโดง (kurtosis) เทากับ 0  
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เบขวา (Right-Skewed) ปกติ (Normal or Symmetric) เบซาย (Left-Skewed) 

   
ขอมูลแจกแจงแบบเบขวา 

คา Skewness เปน + แสดงวา 

ขอมูลสวนใหญมีคาต่ํากวาคามัธย

ฐาน 

ขอมูลแจกแจงแบบปกติ 

คา Skewness เปน 0 แสดงวา ขอมูล

สวนใหญมีคาใกลเคียงกับคามัธยฐาน 

ขอมูลแจกแจงแบบเบซาย 

คา Skewness เปน – แสดงวา

ขอมูลสวนใหญมีคาสูงกวา

คามัธยฐาน 

ยอดแบน (Platykurtic) ยอดปานกลาง (Mesokurtic) ยอดสูง (Leptokurtic) 

   
ขอมูลแจกแจงแบบยอดแบน  

คา Kurtosis เปน – แสดงวา 

ขอมูลกระจายมากหรือแปรปรวน

มาก 

ขอมูลแจกแจงแบบยอดปานกลาง 

คา Kurtosis เปน 0 แสดงวา 

ขอมูลกระจายปานกลางหรือ

แปรปรวนปานกลาง 

ขอมูลแจกแจงแบบยอดสูง  

คา Kurtosis เปน + แสดงวา 

ขอมูลกระจายนอยหรืแปรปรวน

นอย 

รูปท่ี 9. 2 ความเบและความโดง  

ในความเปนจริงขอมูลท่ีไดจากการสังเกตและเก็บรวบรวมมาจากปรากฎการทางสังคมหรือคนใน

สังคมไมนาจะมีความเปนไปไดหรือเปนไปไดนอยมากท่ีจะมีการแจกแจงปกติ ขนาดของคาความเบและ

ความโดงท่ีใชในการตัดสินวา ขอมูลมีการแจกแจงใกลเคียงโคงปกติหรือไมนั้น มีการกําหนดขนาดของ

คาท่ีแตกตางกัน แตสวนใหญใช ± 1 หรือ ± 2 หรือ ± 3 (Garson, Online: 2008; Hair and Others, 

2006: 40; Hardy and Bryman, 2004: 44) 

การตรวจสอบการแจกแจงปกติอาจใชวิทัศนหรือกราฟ (visual/graphical methods) เชน 

กราฟแจกแจงความถ่ี (histogram) กราฟลําตนและใบ (stem-and-leaf diagram) กราฟกลองและ

หนวด (boxplot and whisker plot) กราฟการกระจาย (scatter plot) แตการใชสายตาตรวจสอบจาก

ภาพของกราฟอาจไมรับประกันไดวาขอมูลมีการกระจายปกติหรือไม ดังนั้น การใชวิธีการทางสถิติ นาจะ
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ไดรับการยอมรับและมีความนาเชื่อถือมากกวา โดยมีวิธีการทดสอบท่ีสําคัญ ๆ เชน คาความเบ 

(skewness) และคาความโดง (kurtosis) การทดสอบดวยวิธีการทางสถิติ เชน กลุมตัวอยางขนาดใหญใช

การทดสอบแบบคอลมอโกรอฟ-สเมอรนอฟ  (Kolmogorov-Smirnov test: K-S test) และกลุมตัวอยาง

ขนาดเล็กถึงขนาดกลางใชการทดสอบแบบแชพิโล-วิลค (Shapiro-Wilk test: S-W test) สําหรับในท่ีนี้

จะทําเสนอวิธีการตรวจสอบโดยใชคาความเบและความโดงประกอบการใชกราฟแจกแจงความถ่ี และการ

ทดสอบดวยวิธีการทางสถิติแบบแบบคอลมอโกรอฟ-สเมอรนอฟเทานั้น โดยมีรายละเอียดดังนี้ 

2.1.2 การตรวจสอบความเบและความโดง 

2.1.2.1 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies… 

o Frequencies ใสตัวแปร (คาตอเนื่อง) Child 

o กดปุม Chart 

               - Histograms เลือก Draw histograms และ Superimpose normal curve 

               - กดปุม Continue 

o กดปุม Chart 

    - Display frequency tables เลือก Never 
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ตัวอยาง: ผลลัพธการตรวจสอบคาความเบและความโดง 

 

 

การตรวจสอบ: ขอมูลตัวแปร Child (จํานวนบุตร) มีลักษณะเบขวาและยอดแบน แสดงวา ขอมูลสวน

ใหญมมีคาต่ํากวาคามัธยฐาน และมีการกระจายหรือแปรปรวนมาก แตคาความเบและความโดงไมเกิน 

± 2 ยอมรับไดวา ขอมูลมีการแจกแจงใกลเคียงโคงปกติ  

2. การทดสอบดวยวิธีการทางสถิติ 

   2.1 กําหนดสมมติฐาน 

H0: ขอมูลมีการแจกแจงปกติ 

   : ตัวแปรอายุมีการแจกแจงปกติ 

H1: ขอมูลมีการแจกแจงไมปกติ 

       : ตัวแปรอายุมีการแจกแจงไมปกติ 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบการแจกแจงของขอมูลแบบคอลมอโกรอฟ-

สเมอรนอฟ  (Kolmogorov-Smirnov test: K-S test) ไดคาความนาจะเปน (p-value) มากกวาคา

นัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) เทากับ

หรือนอยกวาคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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   2.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ เลือกเมน ูAnalyze -> Non-Parametric Statistics -> 1-Sample K-S… 

o Test Variable List: ใสตัวแปร (ตัวแปรคาตอเนื่อง) Age 

o Test Distribution เลือกคําสั่งสถิติ Normal   
o กดปุม OK 

 

   2.3 ผลการวิเคราะห 

 

    2.4 สรุป 

จากผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .960 มีคามากกวาคานัยสําคัญ

ทางสถิติท่ีกําหนดไว (α = .05) จึงยอมรับสมมติฐาน H0: ตัวแปรอายุมีการแจกแจงปกติ 
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2.2 ความเทากันของความแปรปรวน  

ความเทากันของความแปรปรวน (Equality of variance) หรือเรียกวา ความเปนแบบเดียวกัน

ของความแปรปรวน (Homogeneity of variance) คือ ลักษณะของขอมูลท่ีอยูรอบคาเฉลี่ยของ 2 กลุม

ตัวอยาง หรือมากกวา 2 กลุมตัวอยาง มีลักษณะการแจกแจงหรือการกระจายเทากัน 

ความไมเทากันของแปรปรวนมีผลทําใหบางคาหรือบางระดับของตัวแปรอิสระมีความสามารถใน

การทํานายไดดีกวาคาอ่ืนของตัวแปรอิสระ รวมถึงมีผลตอความคาดเคลื่อนมาตรฐาน และการยอมรับ/ไม

ยอมรับผลของการทดสอบสมมติฐาน ดังนั้นจึงตองทําการทดสอบความแปรปรวนหรือการกระจายของ

ขอมูลระหวางกลุมในแตละตัวแปรตามมีความแปรปรวนเทากันหรือไม เชน การตรวจสอบความเทากัน

ของความแปรปรวนระหวางกลุมของแตละตัวแปร (homogeneity of variance) การตรวจสอบความ

เทา กันของความแปรปรวน -ความแปรปรวนรวมพหุ  (homogeneity of variance-covariance 

matrices) และการตรวจสอบความ เท า กันขอ งคว ามแปรปรวนของคว ามคล าด เ คลื่ อ น 

(homoscedasticity) 

ความแปรปรวนเทากัน (Equal Variance/homoskedasticity) 

   
ความแปรปรวนไมเทากัน (Unequal Variance/heteroskedasticity) 

   

รูปท่ี 9.3 ความแปรปรวน 

การทดสอบความเทากันของความแปรปรวนมีท้ังการทดสอบจากขอมูลระหวางกลุมของตัวแปร

ตามแตละตัวหรือตัวแปรเดียว และการทดสอบรวมของตัวแปรตหลายตัวแปรรวมกัน สําหรับในท่ีนี้จะ

กลาวถึงเฉพาะการตรวจสอบความเทากันของความแปรปรวนระหวางกลุมของแตละตัวแปรตาม 

(homogeneity of variance) เทานั้น โดยมีวิธีการดังนี้ 
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1. กําหนดสมมติฐาน 

H0: ขอมูลระหวางกลุมตัวอยางมีความแปรปรวนหรือการกระจายเทากัน 

   : คาเฉลี่ยจํานวนบุตรระหวางกลุมเพศมีความแปรปรวนเทากัน 

H1: ขอมูลระหวางกลุมตัวอยางอยางนอย 2 กลุมประชากรมีความแปรปรวนไมเทากัน 

   : คาเฉลี่ยจํานวนบุตรระหวางกลุมเพศมีความแปรปรวนไมเทากัน 

เกณฑในการทดสอบสมมุติฐาน คือ หากทดสอบความเทากันของแปรปรวนระหวางกลุมตัวอยาง 

(Test of Homogeneity of Variances) ดวยวิธีการทางสถิติของเลวีน (Levene Statistic) ดวยคา

ทดสอบ .05 ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับ

สมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) เทากับหรือนอยกวาคานัยสําคัญทางสถิติ (α 

= .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

 2. การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล ASPSS_Data.sav 

๏ Analyze -> Compare Means -> One Way ANOVA…  

o Test Variables(s): ใสตัวแปร (ตัวแปรคาตอเนื่อง) Age 

o Grouping Variable: ใสตัวแปร (ตัวแปรคาแบงกลุม) Gender 

o Statistics เลือก Homomeneity 

 

 3. ผลการวิเคราะห 

 
 4. สรุป  
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จากผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .495 มีคามากกวาคานัยสําคัญ

ทางสถิติท่ีกําหนดไว (α = .05) จึงยอมรับสมมติฐาน H0: คาเฉลี่ยจํานวนบุตรระหวางกลุมเพศมีความ

แปรปรวนเทากัน  

2.3 ความเปนเสนตรง 

ความเปนเสนตรง (Linearity) คือ ลักษณะความสัมพันธของขอมูลระหวาง 2 ตัวแปรท่ีมีการ

เปลี่ยนแปลงไปในทิศทางเดียวกันในเชิงเสนตรง เม่ือคาของตัวแปรหนึ่งมีการเปลี่ยนแปลงเพ่ิมข้ึนคาของ

อีกตัวแปรหนึ่งมีการเปลี่ยนแปลงเพ่ิมข้ึนดวย และเม่ือตัวแปรหนึ่งมีคาเปลี่ยนแปลงลดลงคาของอีกตัว

แปรหนึ่งก็มีการเปลี่ยนแปลงลดลงดวยเชนกัน 

การวิเคราะหขอมูลแบบสองตัวแปร (bivariate analysis) เชน การวิเคราะหการถดถอยแบบ

งาย (simple regression) และการวิเคราะหขอมูลแบบหลายตัวแปร (multivariate analysis)  เชน 

การวิเคราะหการถดถอยแบบพหุหรือหลายตัวแปร (multiple regression) การวิเคราะหการถดถอย

แบบโลจิสติกส (logistic regression) การวิเคราะหปจจัย (factor analysis) และการวิเคราะหตัวแบบ

สมการเชิงโครงสราง (structural equation model) ขอมูลท่ีใชในการวิเคราะหตองมีความสัมพันธ

ระหวางกันเชิงเสนตรง ไมเปนความสัมพันธเชิงเสนโคง 

ความสัมพันธเชิงเสนตรง  

(Linear relationships) 

ความสัมพันธเชิงเสนโคง  

(Curvilinear relationships) 

  

  

รูปท่ี 9.4 ความสัมพันธเชิงเสนตรงและเสนโคง 

การตรวจสอบความเปนเสนตรงระหวางตัวแปรมีหลายวิธีข้ึนอยูกับจํานวนตัวแปร แตโดยท่ัวไปมี 

2 วิธี ดังนี้ 
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1. การตรวจสอบดวยกราฟหรือแผนภาพ เชน แผนภาพการกระจาย (scatterplot) โดย

กําหนดใหตัวแปรอิสระ (X) อยูในแกนนอน (X Axis) และตัวแปรตาม (Y) อยูในแกนตั้ง (Y Axis) ถาตัว

แปรมีความสัมพันธเชิงเสนตรง การกระจายของจุดขอมูลจะมีเปนรูปทรงรี (oval shape) หรือคลาย

ซิการ (cigar shape) 

2. การตรวจสอบดวยคาสถิติ เชน การตรวจสอบดวยคาสัมประสิทธิ์สหสัมพันธ (Correlation 

coefficient) ตัวแปรท่ีมีความสัมพันธระหวางกัน แสดงวาเปนตัวแปรท่ีมีความสัมพันธเชิงเสน (Hair and 

Others, 2006: 205) โดยคาสัมประสิทธิ์สหสัมพันธ (r) เปนดัชนีบอกระดับความสัมพันธ (degree of 

association) หากมีคาใกล 0 แสดงวา มีความสัมพันธเชิงเสนระหวางกันนอย แตหากมีคาใกล 1 แสดง

วา มีความสัมพันธเชิงเสนระหวางกันมาก  

สําหรับในท่ีนี้จะนําเสนอเฉพาะการตรวจสอบความสัมพันธเชิงตรงระหวาง 2 ตัวแปรดวยคา

สัมประสิทธิ์สหสัมพันธเทานั้น โดยมีวิธีการดังนี้ 

๏ เปดแฟมขอมูล File -> Open -> ASPSS_Data.sav 

๏ สรางตัวแปร 1 ตัวแปร คือ Income ตอจากตัวแปร Child โดยมีรายละเอียดดังนี้ 

o คลิกเมาสปุมขวาท่ีเลข 9 หนาตัวแปร Child -> เลือกคําสั่ง Insert Variable 

 

 

o เพ่ิมตัวแปร Income (Label = Income of Responder และ Measure = Scale) 
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๏ ใสคาตัวแปรหรือขอมูลโดยมีรายละเอียดดังนี้ 

 

1. กําหนดสมมติฐาน 

   H0: ไมมีความสัมพันธเชิงเสนตรงระหวางตัวแปร 

      : ไมมีความสัมพันธเชิงเสนตรงระหวางตัวแปรอายุและรายได 

   H1: มีความสัมพันธเชิงเสนตรงระหวางตัวแปร 

      : มีความสัมพันธเชิงเสนตรงระหวางตัวแปรอายุและรายได 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบสัมประสิทธิ์ความสัมพันธเพียรสันไดคา

ความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แตหากได
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คาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน 

H0 และยอมรับสมมติฐาน H1 

2. การใชโปรแกรมวิเคราะหขอมูล 

๏ เลือกเมนู Analyze -> Bivariate Correlation…   

o เลือกตัวแปร Age และ Income (ตัวแปรคาตอเนื่อง) จากรายการตัวแปรดานซาย -> ใส

ชองวางดานขวา 

o Flag Significance Correlations เลือก / 

o กดปุม OK 

 

3. ผลการวิเคราะห 

 

4. สรุป  

จากผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .263 มีคามากกวาคานัยสําคัญ

ทางสถิติท่ีกําหนดไว (α = .05) จึงยอมรับสมมติฐาน H0: ไมมีความสัมพันธเชิงเสนตรงระหวางตัวแปร

อายุและรายได 
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สรุป 

 การวิเคราะหขอมูลเชิงสํารวจ คือ กระบวนการทําใหขอมูลมีความสมบูรณ (data cleansing) 

โดยการตรวจสอบขอมูลใหมีความถูกตองและตรงกับความเปนจริง รวมถึงการตรวจหาคาตางสุด และ

การตรวจสอบคาสูญหาย หากขอมูลมีความไมถูกตองและไมสมบูรณจะมีผลทําใหการวิเคราะหเบี่ยงเบน

ไปจากความเปนจริง แมวาขอมูลจะมีความถูกตองและสมบูรณแลว กอนการทดสอบแบบอิง

คาพารามิเตอรยังตองมีการตรวจสอบ (data screening) ขอตกลงเบื้องตนเก่ียวกับลักษณะของขอมูล 

เชน การแจกแจงปกติ ความเทากันของความแปรปรวน และความสัมพันธเชิงเสนตรง เพราะการละเมิด

ขอตกลงเบื้องตนในการวิเคราะหขอมูลดวยสถิติแตละประเภทมีความเสี่ยงท่ีจะทําใหผลวิเคราะหเกิด

ความคลาดเคลื่อนและไดขอสรุปท่ีไมถูกตอง 

แบบฝกหัดทายบท 

1. ใหผูเรียนตรวจสอบความถูกตองของขอมูลแบบไขวระหวางตัวแปรอายุ (age) และระดับ

การศึกษา (edu)  

2. ใหผูเรียนวิเคราะหจํานวนคาสูญหายของแตละตัวอยางจากตัวแปรเพศ (gender) 

สถานการณทํางาน (work) และตําแหนงงาน (position) 

3. ใหผูเรียนวิเคราะหหาคาตางสุดของตัวแปรจํานวนบุตร (child) 

4. ใหผูเรียนตรวจสอบการแจกแจงปกติแบบคอลมอโกรอฟ-สเมอรนอฟ  (Kolmogorov-

Smirnov: K-S Test) ของตัวแปรจํานวนบุตร (child) 

5. ใหผูเรียนตรวจสอบความเทากันของความแปรปรวนของตัวแปรอายุ (age) ระหวางกลุมเพศ 

(gender) 

6. ใหผูเรียนตรวจสอบความสัมพันธเชิงเสนตรงระหวางตัวแปรอายุ (age) กับจํานวนบุตร 

(child) 

  



 

 

สวนท่ี 4 

การวิเคราะหขอมูลดวยสถิติเชิงพรรณนา 
  





 

 

บทที่ 10 

การวิเคราะหขอมูลเชิงพรรณนา 1 ตัวแปร 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถใชโปรแกรมประมวลผลการแจกแจงขอมูลของตัวแปร 1 ตัวแปร ดวยสถิติเชิง

พรรณนา และเขียนบรรยายผลการวิเคราะหได 

เน้ือหา 

1. การวิเคราะหตัวแปรแบบคาแบงกลุม 

2. การวิเคราะหตัวแปรแบบคาตอเนื่อง 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และ

ประเมินจากการทําแบบฝกหัดทายบท 
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เนื้อหา 

การนําเสนอขอมูลท่ัวไปเก่ียวของประชากรและกลุมตัวอยางสวนใหญใชการวิเคราะหขอมูล 1 

ตัวแปร (univariate analysis) เพ่ือนําเสนอลักษณะของขอมูลและบรรยายลักษณะของขอมูลของแตละ

ตัวแปร และสถิติท่ีนิยมใชคือสถิติเชิงพรรณนา ไดแก คาความถ่ี (frequency) คารอยละ (percentage)  

คาฐานนิยม (mode) คาเฉลี่ย (mean) คาเบี่ยงเบนมาตรฐาน (standard deviation) และคาสัมประสิทธิ์

การกระจาย (coefficient of variation)  

1. การวิเคราะหตัวแปรแบบคาจัดประเภท 

การวิเคราะหตัวแปรแบบคาจัดประเภท 1 ตัวแปร เปนการวิเคราะหและอธิบายขอมูลจากตัว

แปรท่ีมีระดับการวัดเปนคาจัดประเภท (categorical variables) เชน ตัวแปรแบบมาตราจัดกลุม 

(nominal scale) และ ตัวแปรแบบมาตราจัด อันดับ  ( scale: ordinal) ด ว ยส ถิติ เ ชิ งพรรณนา 

(descriptive statistics) ดังนี ้

1. การแจกแจงความถ่ี (frequency distribution) ไดแก จํานวนนับ ความถ่ี และคารอยละ)  

2. การวิเคราะหตําแหนง (location) หรือแนวโนมเขาศูนยกลาง (central tendency) ไดแก คา

ฐานนิยม (mode) 

1.1 การวิเคราะหขอมูลดวยคารอยละ 

 คารอยละ (Percentage) คือ สวนหนึ่ง (a portion) ของผลรวมเม่ือเทียบกับสวนรอยท่ีแสดง

เปนตัวเลขระหวาง 0 ถึง 100  

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานแตละตําแหนงมี

จํานวนมากนอยเพียงใด 

 

 

 



ก า ร วิ เ ค ร า ะ ห ข อ มู ล เ ชิ ง พ ร ร ณ น า  1  ตั ว แ ป ร | 201 

1.1.1 ตัวแปร 

ช่ือตัวแปร มาตรการวัด 

ตําแหนงงาน (jobcat) จัดกลุม 

1.1.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee Data.sav 

๏ เมนู Analyze -> Descriptive Statistics -> Frequencies… 

o Variable (s): เลือกตัวแปรแบบคาแบงกลุม 1 ตัวแปร หรือมากกวา จากรายการตัวแปร

ดานซาย  
o ในกลุมคําสั่ง Statistic: ไมเลือกสถิติ Mean, Standard deviation, Minimum และ 

Maximum   
o กดปุม OK 

 

1.1.3 ผลการวิเคราะห 
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1.1.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงจํานวนและคารอยละของกลุมตัวอยางพนักงาน จําแนกตามตําแหนงงาน 

ตําแหนงงาน จํานวน รอยละ 

เจาหนาท่ีปฏิบัติงาน 363 76.6 

หัวหนางาน 27 5.7 

ผูจัดการ 84 17.7 

รวม 474 100.0 

1.1.5 การแปลผลและสรุป 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางสวนใหญเปนเจาหนาท่ีปฏิบัติงาน รองลงมา คือ 

ผูจัดการ และนอยท่ีสุดคือ หัวหนางาน 

ตัวอยางเพ่ิมเติม: การแปลผลและสรุป 

#1 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางจํานวน 474 คน เปนเจาหนาท่ีปฏิบัติงาน จํานวน 

363 คน คิดเปนรอยละ 76.6 เปนหัวหนางาน จํานวน 27 คน คิดเปนรอยละ 5.7 และเปนผูจัดการ 

จํานวน 84 คน คิดเปนรอยละ 17.7    

#2 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางจํานวน 474 คน เปนเจาหนาท่ีปฏิบัติงาน รอยละ 

76.6 (363 คน) เปนหัวหนางาน รอยละ 5.7 (27 คน) และเปนผูจัดการ รอยละ 17.7 (84 คน) 

#3 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางจํานวน 474 คน สวนใหญเปนเจาหนาท่ี

ปฏิบัติงาน รอยละ 76.6 (363 คน) รองลงมา คือ ผูจัดการ รอยละ 17.7 (84 คน) และนอยท่ีสุดเปน

หัวหนางาน รอยละ 5.7 (27 คน)  
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1.2 การวิเคราะหขอมูลดวยคาฐานนิยม 

 คาฐานนิยม (Mode) คือ คาท่ีแสดงความถ่ีมากท่ีสุด (most frequency) ของขอมูล 1 ชุด หรือ 

1 ตัวแปร ขอมูลแตละชุดอาจมีคาฐานนิยม 1 คา หรือมากกวา 1 คา หรืออาจไมมีคาฐานนิยมเลยก็

เปนได 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจผูมาใชบริการตองการทราบวา ผูใชบริการใหคะแนนการใหบริการแตละ

ดานอยูในระดับมากท่ีสุด 

1.2.1 ตัวแปร 

ช่ือตัวแปร มาตรการวัด 

ความพึงพอใจกับการใหบริการ (V1) จัดอันดับ 

ความคุมคาของเงินกับการใหบริการ (V2) จัดอันดับ 

ความลาชาของพนักงานในการใหบริการ (V3) จัดอันดับ 

ความมีประสิทธิภาพในการใหบริการ (V4) จัดอันดับ 

ความดังของเสียงรบกวนภายในหองพัก (V5) จัดอันดับ 

1.2.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> hotel.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies… 

o Variable (s): เลือกตัวแปรแบบคาแบงกลุม 1 ตัวแปร หรือหลายตัวแปร จากรายการตัว

แปรดานซาย  

o ในกลุมคําสั่ง Statistic: ไมเลือกสถิติ Mean, Standard deviation, Minimum, 

Maximum และเลือกสถิติ Mode  

o กดปุม Frequency Tables… -> Display frequency tables เลือก Never -> กด

ปุม Continue 

o กดปุม OK   
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1.2.3 ผลการวิเคราะห 

 

1.2.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงคาฐานนิยมของการประเมินการใหบริการของโรงแรม 

ขอ การบริการ จํานวน ฐานนิยม 

1. ความพึงพอใจกับการใหบริการ 17 ไมเห็นดวยอยางยิ่ง 

2. ความคุมคาของเงินกับการใหบริการ 17 ไมเห็นดวย 

3. ความลาชาของพนักงานในการใหบริการ 17 เห็นดวยอยางยิ่ง 

4. ความมีประสิทธิภาพในการใหบริการ 17 ไมมีความเห็น 

5. ความดังของเสียงรบกวนภายในหองพัก 17 ไมเห็นดวยอยางยิ่ง 

1.2.5 การแปลผลและสรุป 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางสวนใหญประเมินการใหบริการของโรงแรมเกือบ

ทุกขออยูในระดับไมพึงพอใจกับการใหบริการ ยกเวนดานเสียงภายในหองพักท่ีประเมินใหอยูในระดับพึง

พอใจมาก 
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2. การวิเคราะหตัวแปรแบบคาตอเน่ือง 

การวิเคราะหตัวแปรแบบคาตอเนื่อง 1 ตัวแปร เปนการวิเคราะหและอธิบายขอมูลจากตัวแปรท่ี

มีระดับการวัดเปนคาตอเนื่อง (continuous variables) ดวยสถิติเชิงพรรณนา เชน การวิเคราะห

ตําแหนง (location) หรือแนวโนมเขาศูนยกลาง (central tendency)  ไดแก คาเฉลี่ย (mean) การ

วิเคราะหการกระจาย (dispersion/variation) ไดแก สวนเบี่ยงเบนมาตรฐาน (standard deviation) 

และการวิเคราะหรูปรางของการแจกแจงขอมูล (shape of the distributions) ไดแก ความเบ  

(skewness) และความโดง (kurtosis) ของขอมูล  

สถิติเชิงพรรณนาท่ีนิยมใชวิเคราะหตัวแปรแบบคาตอเนื่อง คือ คาเฉลี่ย (Mean) ท่ีเปนคาการ

เฉลี่ย (average) หรือคากลาง (middle) ของขอมูลประเภทหนึ่ง โดยการบวก (add) รวมคาท้ังหมด 

(total) ในชุดขอมูล และทําการหาร (divided) ดวยจํานวนคาของขอมูลท้ังหมดในชุดขอมูล 

2.1 การวิเคราะหขอมูลคาเฉลี่ย (รายตัวแปร) 

 การวิเคราะหรายตัวแปร คือ การวิเคราะหตัวแปรวัดท่ีไดจากการวัดมิติเดียว เชน อายุ เงินเดือน 

ระยะเวลาทํางาน น้ําหนัก สวนสูง 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานมีคาเฉลี่ยของ

เงินเดือนปจจุบัน เงินเดือนเริ่มตน ระยะเวลาทํางาน และประสบการณ เปนอยางไร 

2.1.1 ตัวแปร 

ช่ือตัวแปร มาตราการวัด 

เงินเดือนปจจุบัน (salary) คาตอเนื่อง/สเกล 

เงินเดือนเริ่มตน (salbegin) คาตอเนื่อง/สเกล 

ระยะเวลาทํางาน (jobtime) คาตอเนื่อง/สเกล 

ประสบการณ (prevexp) คาตอเนื่อง/สเกล 
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2.1.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee Data.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives… 

o Variable (s): เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปร หรือมากกวา จากรายการตัวแปร

ดานซาย 

o ในกลุมคําสั่ง Statistics:  เลือกสถิติ Mean, Standard deviation, Minimum และ 

Maximum  
o กดปุม OK 

 

2.1.3 ผลการวิเคราะห 
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2.1.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงคาเฉลี่ย คาเบี่ยงเบนมาตรฐาน และคาสัมประสิทธิ์การกระจายขอมูลพ้ืนฐานของ

พนักงาน 

ขอมูลพ้ืนฐาน จํานวน คาต่ําสุด คาสูงสุด คาเฉล่ีย S.D. CV16 (%) 

เงินเดือนปจจุบัน (ดอลลาร) 474 15,750 135,000 34,419.57 17,075.661 49.61 

เงินเดือนเริ่มตน (ดอลลาร) 474 9,000 79,980 17,016.09 7,870.638 46.25 

ระยะเวลาทํางาน (เดือน) 474 63 98 81.11 10.061 12.40 

ประสบการณกอนทํางาน (เดือน) 474 0 476 95.86 104.586 100.10 

2.1.5 การแปลผลและสรุป 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางจํานวน 474 คน มีเงินเดือนปจจุบันเฉลี่ย 

34,419.57 ดอลลาร มีเงินเดือนเริ่มตนเฉลี่ย 17,016.09 ดอลลาร มีระยะเวลาทํางานเฉลี่ย 81.11 เดือน 

และมีประสบการณกอนทํางาน เฉลี่ย 95.86 เดือน  

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย (coefficient of variation: CV) แสดงใหเห็น กลุม

ตัวอยางมีเงินเดือนปจจุบันแตกตางกันอยูในระดับนอย มีเงินเดือนเริ่มตนแตกตางกันอยูในระดับนอย มี

ระยะเวลาทํางานแตกตางกันอยูในระดับนอยมาก และมีประสบการณกอนทํางานแตกตางกันอยูในระดับ

มาก 

  

                                                           
16 สัมประสิทธิ์การกระจาย (Coefficient of Variation: C.V.) คือ คาวัดการกระจายของขอมูลรอบคาเฉล่ียจากอัตราสวน (ratio) ของคา

เบี่ยงเบนมาตรฐาน (standard deviation) ตอคาเฉล่ีย (mean) หรือคํานวณจากคา Standard deviation หารดวยคา Mean และคูณดวย 

100 หากคา C.V. นอยกวา 1 หรือ 100 แสดงวาขอมูลมีการกระจายนอย แตหากมากกวา 1 หรือ 100 แสดงวาขอมูลมีการกระจายมาก 

สามารถนําไปใชเปรียบเทียบการกระจายของขอมูลระหวางกลุมไดงายกวาคาเบี่ยงเบนมาตรฐาน  
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ตัวอยางเพ่ิมเติม: การแปลผลและสรุป 

#1 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางจํานวน 474 คน มีเงินเดือนปจจุบันเฉลี่ย 

34,419.57 ดอลลาร โดยมีเงินเดือนปจจุบันต่ําสุด 15,750 ดอลลาร และสูงสุด 135,000 ดอลลาร มี

เงินเดือนเริ่มตน เฉลี่ย 17,016.09 ดอลลาร โดยมีเงินเดือนเริ่มตนต่ําสุด 9,000 ดอลลาร และสูงสุด 

79,980 ดอลลาร มีระยะเวลาทํางาน เฉลี่ย 81.11 เดือน โดยมีระยะเวลาทํางานต่ําสุด 63 เดือน และ

สูงสุด 98 เดือน และมีประสบการณกอนทํางาน เฉลี่ย 95.86 เดือน โดยมีประสบการณกอนทํางานต่ําสุด 

0 เดือน และสูงสุด 476 เดือน 

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย (coefficient of variation: CV) แสดงใหเห็น กลุมตัวอยาง

มีเงินเดือนปจจุบันแตกตางกันนอย (C.V. = 49.61) มีเงินเดือนเริ่มตนแตกตางกันนอย (C.V. = 46.25) มี

ระยะเวลาทํางานแตกตางกันนอยมาก (C.V. = 12.40) และมีประสบการณกอนทํางานแตกตางกันมาก 

(C.V. = 100.10)  

#2 

 จากตารางท่ี (#) แสดงใหเห็นวา พนักงานของหนวยงานนี้มีเงินเดือนเริ่มตน เงินเดือนปจจุบัน 

และระยะเวลาทํางานแตกตางกันอยูในระดับนอย แตมีประสบการณกอนทํางานแตกตางกันอยูในระดับ

มาก 
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2.2 การวิเคราะหขอมูลดวยคาเฉลี่ย (ตัวแปรดัชนี) 

 การวิเคราะหตัวแปรดัชนี คือ การวิเคราะหขอคําตอบหรือดัชนีของตัวแปรเชิงโครงสราง 

(construct variables) หรือตัวแปรแฝง (latent variables) เชน คุณภาพการใหบริการ ความสุขในการ

ทํางาน ความผูกพันตอองคการ   

ตัวอยางคําถามการวิจัย 

จากการสํารวจการใหบริการผูมาใชบริการตองการทราบวา ผูใชบริการใหคะแนนการใหบริการ

รายขออยูในระดับใด 

2.2.1 ตัวแปร 

ตัวแปรเชิงโครงสรางหรือตัวแปรแฝง (คุณภาพการใหบริการ) 

ดัชน ี ประเภทคําถาม การใหคะแนน 

ความพึงพอใจกับการใหบริการ (V1) + ปกติ (5= มาก <--> 1 = นอย) 

ความคุมคาของเงินกับการใหบริการ (V2) + ปกติ (5= มาก <--> 1 = นอย) 

ความลาชาของพนักงานในการใหบริการ (V3) - กลับคา (5= นอย <--> 1 = มาก) 

ความมีประสิทธิภาพในการใหบริการ (V4) + ปกติ (5= มาก <--> 1 = นอย) 

ความดังของเสียงรบกวนภายในหองพัก (V5) - กลับคา (5= นอย <--> 1 = มาก) 

ผลการวิเคราะหกอนกลับคาของตัวแปร 
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2.2.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> hotel.sav 

๏ กลับคาของตัวแปร V3 และ V5 

o เมนู Transform -> Recode in Same Variables 

o Variables: เลือกตัวแปร V3 และ V5 จากรายการตัวแปรดานซาย 

o กดปุม Old and New Values… -> เปลี่ยนคา 5->1, 4 -> 2, 2 -> 4 และ 1 -> 5 

o กดปุม Continue 

o กดปุม OK  

 

 

๏ สรางตัวแปร SumService (รวมคะแนนประเมินการใหบริการดวยคาเฉลี่ย) 
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives… 

o Variable (s): เลือกตัวแปร V1, V2, V3, V4, V5 และ SumService จากรายการตัวแปร

ดานซาย 

o ในกลุมคําสั่ง Statistics: เลือกสถิติ Mean และ Standard deviation 
o กดปุม OK 

 

2.2.3 ผลการวิเคราะห 

 

2.2.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงคาเฉลี่ย คาเบี่ยงเบนมาตรฐาน และคาสัมประสิทธิ์การกระจายคะแนนการใหบริการ 

การประเมินของผูใชบริการ จํานวน คาเฉล่ีย S.D. C.V. (%) 

ความพึงพอใจในการใหบริการ 17 2.53 1.33 58.08 

ความคุมคาของเงินกับการใหบริการ 17 2.29 1.31 57.21 

ความรวดเร็วของพนักงานในการใหบริการ 17 2.53 1.37 54.15 

ความมีประสิทธิภาพในการใหบริการ 17 2.41 1.12 46.47 

ความเงียบของเสียงภายในหองพัก 17 4.00 1.17 29.25 

รวม 17 2.75 .59 21.45 



212 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

2.2.5 การแปลผลและสรุป 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางใหคะแนนเฉลี่ยรวมการใหบริการอยูท่ี 2.75 จาก

คะแนนเต็ม 5 คะแนน โดยใหคะแนนดานความเงียบของเสียงภายในหองพักมากท่ีสุด รองลงมา คือ 

ความพึงพอใจในการใหบริการและความรวดเร็วของพนักงาในการใหบริการ ความมีประสิทธิภาพในการ

ใหบริการ และนอยท่ีสุด คือ ความคุมคาของเงินกับการใหบริการ 

 เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย (C.V.) แสดงใหเห็นวา กลุมตัวอยางใหคะแนนการ

ประเมินโดยรวมและรายขอทุกขอแตกตางกันอยูในระดับนอย  

สรุป 

 การวิเคราะหขอมูล 1 ตัวแปร เปนการแจกแจงใหเห็นลักษณะของขอมูลของแตละตัวแปร ใน

การวิเคราะหตองเลือกใชสถิติใหสอดคลองกับลักษณะของขอมูลของแตละตัวแปร คือ  ตัวแปรแบบคา

แบงกลุม ใชคาความถ่ี คารอยละ และคาฐานนิยม สวนตัวแปรแบบคาตอเนื่อง ใชคาเฉลี่ย คาเบี่ยงเบน

มาตรฐาน และคาสัมประสิทธิ์การกระจาย   

แบบฝกหัดทายบท 

ใหผูเรียนเปดแฟมขอมูล 1991 US. General Social Survey.sav แลวประมวลผลขอมูล เพ่ือ

วิเคราะหและอธิบายผล ดังนี้ 

1. วิเคราะหและอธิบายผลตัวแปรภูมิภาค (region) อายุ (age) และการศึกษา (educ) ดวย

คําสั่ง Frequencies หรือ Descriptive  

ตารางท่ี (#) จํานวนและคารอยละของ…………. จําแนกตาม…………… 

………………… จํานวน รอยละ 

   

รวม   
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ตารางท่ี (#) แสดงคาเฉลี่ย คาเบี่ยงเบนมาตรฐาน และคาสัมประสิทธิ์การกระจายของ…………… 

ตัวแปร จํานวน คาตํ่าสุด คาสูงสุด คาเฉลี่ย S.D. CV17 (%) 

       

2. วิเคราะหและอธิบายผลตัวแปรพ่ีนอง (sibs) และบุตร (childs) ดวยคําสั่ง Explore แลว

อธิบายลักษณะขอมูลดวยคาเฉลี่ย (mean) คามัธยฐาน (median) คาต่ําสุด (minimum) 

คาสูงสุด (maximum) คาพิสัย (range) คาความเบ (skewness) คาความโดง (kurtosis) 

และคาผิดปกติ (outlier) 

ตารางท่ี (#) แสดง………………………….. 

ตัวแปร จํานวน คาตํ่าสุด คาสูงสุด คาเฉลี่ย คามัธยฐาน คาพิสัย คาความเบ คาความโดง คาผิดปกติ 

          

                                                           
17 สัมประสิทธิ์การกระจาย (Coefficient of Variation) 





 

 

บทที่ 11 

การวิเคราะหขอมูลเชิงพรรณนา 2 ตัวแปร  
ความมุงหมายของบทเรียน 

ผูเรียนสามารถใชโปรแกรมประมวลผลการเปรียบเทียบขอมูลของตัวแปร 2 ตัวแปร ดวยสถิติ

เชิงพรรณนา และเขียนบรรยายผลการวิเคราะหได 

เน้ือหา 

1. การวิเคราะหขอมูลระหวางตัวแปรแบบคาแบงประเภท 

2. การวิเคราะหขอมูลระหวางตัวแปรแบบคาแบงประเภทกับตัวแปรแบบคาตอเนื่อง 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และ

ประเมินจากการทําแบบฝกหัดทายบท 
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เนื้อหา 

การวิเคราะหขอมูล 2 ตัวแปร (bivariate analysis) คือ วิธีการนําเอาตัวแปร 2 ตัวแปร มาไขว

หรือเปรียบเทียบกันเพ่ือหารูปแบบของความสัมพันธระหวางตัวแปรดวยสถิติเชิงพรรณนา เชน คาความถ่ี 

(frequency) คารอยละ (percentage) คาเฉลี่ย (mean) คาเบี่ยงเบนมาตรฐาน (standard deviation) 

และคาสัมประสิทธิ์การกระจาย (coefficient of variation)  

1. การวิเคราะหขอมูลระหวางตัวแปรแบบคาจัดประเภท 

การวิเคราะหขอมูลระหวางตัวแปรแบบคาจัดประเภท เปนการการนําเสนอขอมูลในรูปของ

ตารางเพ่ือสรุปขอมูลท่ีเกิดจากความสัมพันธของตัวแปร 2 ตัวแปร (2x2) หรือมากกวา (NxN)  

1.1 การวิเคราะหแบบตารางไขว 2 ตัวแปร 

การวิเคราะหแบบตารางไขว 2 ตัวแปร เปนการวิเคราะหขอมูลระหวางตัวแปรแบบคาจัด

ประเภท 2 ตัวแปร  เพ่ือสรุปขอมูลและเปรียบเทียบความสัมพันธระหวาง 2 ตัวแปร โดยใชสถิติเชิง

พรรณนา ไดแก คาความถ่ีและคารอยละ 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานแตละเพศมีตําแหนง

งานแตกตางกันมากนอยเพียงใด 

1.1.1 ตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดกลุม คาจัดกลุม 

เพศ (gender) 

- ชาย 

- หญิง 

ตําแหนงงาน (jobcat) 

- เจาหนาท่ีปฏิบัติงาน 

- หัวหนางาน 

- ผูจัดการ 
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1.1.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล Employee Data.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs … 

o Rows: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรท่ีตองการให

เปนตัวแปรอิสระ) จากรายการตัวแปรดานซาย  

o Column: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรท่ี

ตองการใหเปนตัวแปรตาม) จากรายการตัวแปรดานซาย  

o กดปุม Statistics… ในกลุมคําสั่ง Statistics ไมเลือกสถิติ Chisq -> กดปุม Continue 

o กดปุม Cells… ในกลุมคําสั่ง Cell Display เลือกคารอยละเฉพาะ Count และ Row -

> กดปุม Continue 

o กดปุม OK  

 

 

 

1.1.3 ผลการวิเคราะห 
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1.1.4 การสรางตารางแสดงผลการวิเคราะห 

ตารางท่ี (#) แสดงคารอยละของพนักงาน จําแนกตามเพศและตําแหนงงาน 

เพศ 
ตําแหนงงาน 

รวม 
เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

หญิง 95.4 0.0 4.6 100.0 (216) 

ชาย 60.9 10.5 28.7 100.0 (258) 

รวม 76.6 5.7 17.7 100.0 (474) 

1.15 การแปลผลและสรุป 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท้ังเพศหญิงและเพศชายสวนใหญเปนเจาหนาท่ี

ปฏิบัติงาน เพศหญิงเปนผูจัดการนอยท่ีสุด สวนเพศชายเปนหัวหนางานนอยท่ีสุด  

เม่ือเปรียบเทียบการดํารงตําแหนงงานของเพศหญิงและเพศชาย แสดงใหเห็นวา เพศหญิงเปน

เจาหนาท่ีปฏิบัติงานมากกวาเพศชาย เพศชายเปนหัวหนางานและผูจัดการมากกวาเพศหญิง  

สรุป เพศชายมีตําแหนงงานสูงกวาเพศหญิง 
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ตัวอยางเพ่ิมเติม: การสรางตารางแสดงผลการวิเคราะห 

#1 

เพศ 
ตําแหนงงาน 

รวม 
เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

หญิง 205 (95.4) 0 (0.0) 10 (4.6) 216 (100.0) 

ชาย 157 (60.9) 27 (10.5) 74 (28.7) 258 (100.0) 

รวม 363 (76.6) 27 (5.7) 84 (17.7) 474 (100.0) 

#2 

เพศ 
ตําแหนงงาน 

รวม 
เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

หญิง 95.4 (205) 0.0 (0) 4.6 (10) 100.0 (216) 

ชาย 60.9 (157) 10.5 (27) 28.7 (74) 100.0 (258) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

ตัวอยางเพ่ิมเติม: การแปลผลและสรุป 

#1 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานท้ังหมดจํานวน 474 คน แบงเปน

เพศหญิง จํานวน 216 คน คิดเปนจํานวนรอยละ 100.0 เปนเจาหนาท่ีปฏิบัติงาน จํานวน 205 คน คิด

เปนจํานวนรอยละ 95.4 เปนหัวหนางาน จํานวน 0 คน คิดเปนจํานวนรอยละ 0.0 และเปนผูจัดการ 

จํานวน 10 คน คิดเปนจํานวนรอยละ 4.6 และแบงเปนเพศชาย จํานวน 258 คน คิดเปนจํานวนรอยละ 

100.0 เปนเจาหนาท่ีปฏิบัติงาน จํานวน 157 คน คิดเปนจํานวนรอยละ 60.9 เปนหัวหนางาน จํานวน 27 

คน คิดเปนจํานวนรอยละ 10.5 และเปนผูจัดการ จํานวน 74 คน คิดเปนจํานวนรอยละ 28.7 

#2 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานท้ังหมด จํานวน 474 คน แบงเปน

เพศหญิง  จํานวน 216 คน และเพศชาย จํานวน 258 คน เพศหญิงสวนใหญเปนเจาหนาท่ีปฏิบัติงาน 

จํานวนรอยละ 95.4 รองลงมา คือ ผูจัดการ จํานวนรอยละ 4.6 และไมมีเพศหญิงในตําแหนงหัวหนางาน 



220 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

สวนกลุมตัวอยางเพศชายสวนใหญเปนเจาหนาท่ีปฏิบัติงาน จํานวนรอยละ 60.9 รองลงมา คือ ผูจัดการ 

จํานวนรอยละ 28.7 และนอยท่ีสุด คือ หัวหนางาน จํานวนรอยละ 10.5   

เม่ือเปรียบเทียบการดํารงตําแหนงงานระหวางเพศหญิงและเพศชาย แสดงใหเห็นวา เพศหญิง

เปนเจาหนาท่ีปฏิบัติงานมากกวาเพศชาย เพศชายเปนหัวหนางานและผูจัดการมากกวาเพศหญิง  

โดยสรุปแสดงใหเห็นวา เพศชายมีตําแหนงงานสูงกวาเพศหญิง   

#3 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท่ีเปนเพศหญิงสวนใหญเปนเจาหนาท่ีปฏิบัติงาน 

รองลงมา คือ ผูจัดการ และไมมีเพศหญิงในตําแหนงหัวหนางาน สวนกลุมตัวอยางท่ีเปนเพศชายสวนใหญ

เปนเจาหนาท่ีปฏิบัติงาน รองลงมา คือ ผูจัดการ และนอยท่ีสุด คือ หัวหนางาน  

เม่ือเปรียบเทียบการดํารงตําแหนงงานระหวางเพศหญิงและเพศชาย แสดงใหเห็นวา เพศหญิง

เปนเจาหนาท่ีปฏิบัติงานมากกวาเพศชาย เพศชายเปนหัวหนางานและผูจัดการมากกวาเพศหญิง  

สรุป เพศชายมีตําแหนงงานสูงกวาเพศหญิง   
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1.2 การวิเคราะหแบบตารางไขว 2 ตัวแปร โดยมีตัวแปรคุม 

การวิเคราะหแบบตารางไขว 2 ตัวแปร โดยมีตัวแปรคุม เปนการวิเคราะหขอมูลระหวางตัวแปร

แบบคาจัดกลุม 2 ตัวแปรเหมือนกันแตมีตัวแปรคุมเปนตัวแปรคาจัดกลุม เพ่ือสรุปขอมูลและเปรียบเทียบ

ความสัมพันธระหวางตัวแปรมากกวา 2 ตัวแปร ในรูปของตาราง 2x3 หรือ 3x2 หรือมากกวา (NxN) ดวย

สถิติเชิงพรรณนา ไดแก คาความถ่ีและคารอยละ 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานแตละเพศในแตละ

กลุมชนมีตําแหนงงานแตกตางกันมากนอยเพียงใด 

1.2.1 ตัวแปร 

ตัวแปรอิสระ 

ตัวแปรคุม 

คาจัดกลุม 

กลุมชน (minority) 

-> 

ตัวแปรตาม 

คาจัดกลุม คาจัดกลุม 

เพศ (gender)  

- ชาย 

- หญิง 

ตําแหนงงาน (jobcat) 

- เจาหนาท่ีปฏิบัติงาน 

- หัวหนางาน 

- ผูจัดการ 
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1.2.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล Employee Data.sav 

๏ เลือกเมนู Data -> Split File… 

o เลือกคําสั่ง Compare groups. 

o ใน Group base on เลือกตัวแปรแบบคาจัดประเภทจากรายการเมนูดานซาย 1 ตัวแปร 

หรือมากกวา 

o กดปุม OK 

 

๏ เมนู Analyze -> Descriptive Statistics -> Crosstabs … 

o Rows: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรท่ีตองการให

เปนตัวแปรอิสระ) จากรายการตัวแปรดานซาย 

o Column: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรท่ี

ตองการใหเปนตัวแปรตาม) จากรายการตัวแปรดานซาย 

o กดปุม Statistics… ในกลุมคําสั่ง Statistics ไมเลือกสถิติ Chisq -> กดปุม Continue 

o กดปุม Cells… ในกลุมคําสั่ง Cell Display เลือกคารอยละเฉพาะ Count และ Row -

> กดปุม Continue 

o กดปุม OK  
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1.2.3 ผลการวิเคราะห 
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1.1.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงคารอยละของตําแหนงงาน จําแนกตามกลุมชนและเพศ 

กลุมชน เพศ 
ตําแหนงงาน 

รวม 
เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

ชนกลุมหลัก หญิง 94.3 0.0 5.7 100.0 (176) 

 ชาย 56.7 7.2 36.1 100.0 (194) 

 รวม 74.6 3.8 21.6 100.0 (370) 

ชนกลุมนอย หญิง 100.0 0.0 0.0 100.0 (40) 

 ชาย 73.4 20.3 6.3 100.0 (64) 

 รวม 83.7 12.5 3.8 100.0 (104) 

1.1.5 การแปลผลและสรุป 

จากตารางท่ี (#) สามารถอธิบายตําแหนงงานของกลุมตัวอยางจําแนกตามกลุมชนและเพศ ได

ดังนี ้

1. เปรียบเทียบการดํารงตําแหนงของชนกลุมหลักกับชนกลุมนอย แสดงใหเห็นวา ชนกลุมหลักท่ี

เปนเพศหญิง ดํารงตําแหนงงานเปนเจาหนาท่ีปฏิบัติงานนอยกวาชนกลุมนอยท่ีเปนเพศหญิง แตชนกลุม

หลักท่ีเปนเพศหญิง ดํารงตําแหนงงานเปนผูจัดการมากกวาชนกลุมนอยท่ีเปนเพศหญิง 

2. เปรียบเทียบการดํารงตําแหนงของชนกลุมหลักกับชนกลุมนอย แสดงใหเห็นวา ชนกลุมหลักท่ี

เปนเพศชาย ดํารงตําแหนงงานเปนเจาหนาท่ีปฏิบัติงานและหัวหนางานนอยกวาชนกลุมนอยท่ีเปนเพศ

ชาย แตชนกลุมหลักท่ีเปนเพศชาย ดํารงตําแหนงงานเปนผูจัดการมากกวาชนกลุมนอยท่ีเปนเพศชาย 

สรุป ชนกลุมหลักท้ังเพศชายและหญิงมีตําแหนงงานสูงกวาชนกลุมนอยท้ังเพศชายและหญิง 
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ตัวอยางเพ่ิมเติม: การแปลผลและสรุป 

#1 

จากตารางท่ี (#) สามารถอธิบายตําแหนงงานของกลุมตัวอยางจําแนกตามกลุมชนและเพศ ได

ดังนี้ 

1. กลุมตัวอยางท่ีเปนชนกลุมหลักจํานวน 370 คน เปนพนักงานเพศหญิง จํานวน 179 คน คิด

เปนรอยละ 100.0 ดํารงตําแหนงเปนเจาหนาท่ีปฏิบัติงาน รอยละ 94.3 เปนหัวหนางาน รอยละ 0.0 และ

เปนผูจัดการรอยละ 5.7 สวนพนักงานเพศชาย จํานวน 194 คน คิดเปนรอยละ 100.0 ดํารงตําแหนงเปน

เจาหนาท่ีปฏิบัติงาน รอยละ 56.7 เปนหัวหนางานรอยละ 7.2 และเปนผูจัดการรอยละ 36.1 

2. กลุมตัวอยางท่ีเปนชนกลุมนอยจํานวน 104 คน เปนพนักงานเพศหญิง จํานวน 40 คน คิด

เปนจํานวนรอยละ 100.0 ดํารงตําแหนงเปนเจาหนาท่ีปฏิบัติงานรอยละ 100.0 ดํารงตําแหนงหัวหนา

งานรอยละ 0.0 และดํารงตําแหนงเปนผูจัดการรอยละ 0.0 สวนพนักงานเพศชาย จํานวน 64 คน คิดเปน

จํานวนรอยละ 100.0 ดํารงตําแหนงเปนเจาหนาท่ีปฏิบัติงาน รอยละ 73.4 เปนหัวหนางานรอยละ 20.3 

และเปนผูจัดการรอยละ 6.3 

สรุป กลุมตัวอยางเพศหญิงท้ังชนกลุมหลักและชนกลุมนอยสวนใหญมีตําแหนงงานตํ่ากวา

พนักงานท่ีเปนเพศชายท้ังชนกลุมหลักและชนกลุมนอย 

#2 

จากตารางท่ี (#) สามารถอธิบายตําแหนงงานของกลุมตัวอยางจําแนกตามกลุมชนและเพศ ได

ดังนี้ 

1. กลุมตัวอยางท่ีเปนชนกลุมหลักและเปนเพศหญิง จํานวน 176 คน คิดเปนจํานวนรอยละ 

100.0 ดํารงตําแหนงเปนเจาหนาท่ีปฏิบัติงาน รอยละ 94.3 เปนหัวหนางาน รอยละ 0.0 และเปน

ผูจัดการ รอยละ 5.7 สวนพนักงานท่ีเปนชนกลุมนอยและเปนเพศหญิง จํานวน 40 คน คิดเปนรอยละ 

100.0 ดํารงตําแหนงเปนเจาหนาท่ีปฏิบัติงาน รอยละ 100.0 เปนหัวหนางาน รอยละ 0.0 และเปน

ผูจัดการ รอยละ 0.0 

2. กลุมตัวอยางท่ีเปนชนกลุมหลักและเปนเพศชาย จํานวน 194 คน คิดเปนรอยละ 100.0 ดํารง

ตําแหนงเปนเจาหนาท่ีปฏิบัติงาน รอยละ 56.7 เปนหัวหนางาน รอยละ 7.2 และเปนผูจัดการ รอยละ 
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36.1 สวนพนักงานท่ีเปนชนกลุมนอยและเปนเพศชาย 64 คน คิดเปนรอยละ 100.0 ดํารงตําแหนงเปน

เจาหนาท่ีปฏิบัติงาน รอยละ 73.4 เปนหัวหนางาน รอยละ 20.3 และเปนผูจัดการรอยละ 6.3 

สรุป กลุมชนมีอิทธิพลตอการดํารงตําแหนงของพนักงาน กลาวคือ พนักงานท่ีเปนชนกลุมหลักมี

แนวโนมท่ีจะดํารงตําแหนงงานในระดับบังคับบัญชามากกวาพนักงานท่ีเปนชนกลุมนอยท้ังเพศชายและ

เพศหญิง  

#3 

จากตารางท่ี (#) เปรียบเทียบการดํารงตําแหนงของกลุมตัวอยางท่ีเปนชนกลุมหลักและชนกลุม

นอยท้ังเพศชายและเพศหญิง แสดงใหเห็นวา ชนกลุมหลักท้ังเพศชายและเพศหญิงดํารงตําแหนงเปน

เจาหนาท่ีปฏิบัติงานนอยกวาชนกลุมนอยท้ังเพศชายและเพศหญิง ชนกลุมหลักและชนกลุมนอยท่ีเปน

เพศหญิงไมมีตําแหนงเปนหัวหนางานเลย สวนชนกลุมหลักท่ีเปนเพศชายดํารงตําแหนงหัวหนางานนอย

กวาชนกลุมนอยท่ีเปนเพศชาย แตชนกลุมหลักท่ีเปนเพศชายดํารงตําแหนงเปนผูจัดการมากกวาชนกลุม

นอยท่ีเปนเพศชาย 

สรุป ชนกลุมหลักท้ังเพศชายและเพศหญิงดํารงตําแหนงงานเปนผูบริหารระดับสูงมากกวาชน

กลุมนอยท้ังเพศชายและเพศหญิง สวนชนกลุมนอยท้ังเพศชายและเพศหญิงดํารงตําแหนงเปนเจาหนาท่ี

ปฏิบัติงานและหัวหนางานมากกวาชนกลุมนอยท้ังเพศชายและเพศหญิง  
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2. การวิเคราะหขอมูลระหวางตัวแปรแบบคาแบงประเภทกับตัวแปรแบบคา

ตอเน่ือง 

การวิเคราะหขอมูลระหวางตัวแปรแบบคาแบงประเภท (ตัวแปรเชิงคุณภาพ) กับตัวแปรแบบคา

ตอเนื่อง (ตัวแปรเชิงปริมาณ) เปนการเปรียบเทียบขอมูลของตัวแปรแบบคาแบงประเภทดวยคาเฉลี่ย 

(compare means) การวิเคราะหแบบนี้มีขอมูลมีตั้งแต 2 กลุม และมากกวา 2 กลุม อาจเรียกวา การ

วิเคราะหเปรียบเทียบคาเฉลี่ย 2 กลุม และ การวิเคราะหเปรียบเทียบคาเฉลี่ยมากกวา 2 กลุม โดยมี

รายละเอียดดังตอไปนี้  

2.1 การเปรียบเทียบคาเฉลี่ย 2 กลุม 

 การเปรียบเทียบคาเฉลี่ย 2 กลุม เปนวิธีการวิเคราะหแบบไขวตัวแปรแบบหนึ่ง แตตัวแปรอิสระ

เปนตัวแปรแบบคาจัดกลุมสวนตัวแปรตามเปนตัวแปรแบบคาตอเนื่อง โดยใชสถิติเชิงพรรณนา ไดแก 

คาเฉลี่ย คาเบี่ยงเบนมาตรฐาน และคาสัมประสิทธิ์การกระจาย 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานแตละกลุมชนมี

ประสบการณกอนทํางานแตกตางกันมากนอยเพียงใด 

2.1.1 ตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดกลุม คาตอเนื่อง 

กลุมชน (minority) 

- ชนกลุมหลัก 

- ชนกลุมนอย 

ประสบการณกอนทํางาน (prevexp) 
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2.1.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Compare Means -> Means… 

o Dependent List: เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปร (ตัวแปรท่ีตองการใหเปนตัว

แปรตาม) จากรายการตัวแปรดานซาย 

o Independent List: เลือกตัวแปรแบบคาจัดประเภท (2 กลุม) 1 ตัวแปร หรือหลายตัว

แปร (ตัวแปรท่ีตองการใหเปนตัวแปรอิสระ) จากรายการตัวแปรดานซาย 

o กดปุม OK 

 

2.1.3 ผลการวิเคราะห 

 

 

2.1.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงคาเฉลี่ยประสบการณกอนทํางานของพนักงาน ระหวางกลุมชน 

ประสบการณกอนทํางาน (เดือน) จํานวน คาเฉล่ีย S.D. C.V. (%) 

ชนกลุมหลัก 370 88 105 119 

ชนกลุมนอย 104 124 100 81 

รวม 474 96 105 109 
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2.1.5 การแปลผลและสรุป 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท่ีเปนชนกลุมนอยมีประสบการณกอนทํางานโดย

เฉลี่ยมากกวาชนกลุมหลัก 

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย แสดงใหเห็นวา ประสบการณกอนการทํางานของ

ชนกลุมหลักมีความแตกตางกันอยูในระดับมาก สวนชนกลุมนอยมีความแตกตางกันอยูในระดับนอย 
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ตัวอยางเพ่ิมเติม: การแปลผลและสรุป 

#1 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท้ังหมด จํานวน 474 คน มีประสบการณกอน

ทํางานตํ่าสุด 0 เดือน สูงสุด 476 เดือน เฉลี่ย 96 เดือน และมีคาสัมประสิทธิ์การกระจาย รอยละ 119 

โดยชนกลุมหลัก จํานวน 370 คน มีประสบการณกอนทํางานต่ําสุด 0 เดือน สูงสุด 476 เดือน เฉลี่ย 88 

เดือน และมีคาสัมประสิทธิ์การกระจาย รอยละ 119 สวนชนกลุมนอย จํานวน 104 คน มีประสบการณ

กอนทํางานต่ําสุด 0 เดือน สูงสุด 432 เดือน เฉลี่ย 124 เดือน และมีคาสัมประสิทธิ์การกระจาย รอยละ 

81  

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย แสดงใหเห็นวา กลุมตัวอยางท้ังหมดมีประสบการณ

กอนทํางานแตกตางตางกันมาก (C.V. = 109) โดยชนกลุมหลักมีประสบการณกอนการทํางานแตกตาง

กันมาก (C.V. = 119) สวนชนกลุมนอยมีประสบการณกอนการทํางานแตกตางกันนอย (C.V. = 81) 

#2 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท้ังหมด จํานวน 474 คน มีประสบการณกอน

ทํางาน เฉลี่ย 96 เดือน โดยชนกลุมนอยมีประสบการณกอนทํางานมากกวาคาเฉลี่ยรวม คือ 124 เดือน 

และชนกลุมหลักท่ีมีประสบการณกอนทํางานนอยกวาคาเฉลี่ยรวม คือ 88 เดือน 

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย แสดงใหเห็นวา กลุมตัวอยางท้ังหมดมีประสบการณ

กอนการทํางานแตกตางกันมาก (C.V. = 109) โดยชนกลุมหลักมีประสบการณกอนทํางานแตกตางกัน

มากกวา (C.V. = 119) ชนกลุมนอย (C.V. = 109) 

#3 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท้ังหมด จํานวน 474 คน มีประสบการณกอน

ทํางาน เฉลี่ย 96 เดือน โดยชนกลุมนอยมีประสบการณกอนทํางาน เฉลี่ย 124 เดือน มากกวาชนกลุม

หลักท่ีมีประสบการณกอนทํางาน เฉลี่ย 88 เดือน 

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย แสดงใหเห็นวา ประสบการณกอนการทํางานของ

กลุมตัวอยางท้ังหมดมีความแตกตางกันอยูในระดับมาก (C.V. = 109) และชนกลุมหลักมีความแตกตาง

กันอยูในระดับมากเชนกัน (C.V. = 119) สวนชนกลุมนอยมีแตกตางกันอยูในระดับนอย (C.V. = 109) 
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2.2 การเปรียบเทียบคาเฉลี่ยมากกวา 2 กลุม 

 การเปรียบเทียบคาเฉลี่ยมากกวา 2 กลุม เปนวิธีการวิเคราะหแบบเดียวกับการเปรียบเทียบคา

เฉ่ีย 2 กลุม แตตัวแปรอิสระเปนคาจัดกลุมมากกวา 2 กลุมข้ึนไป และตัวแปรตามเปนคาตอเนื่อง โดยใช

สถิติเชิงพรรณนา ไดแก คาเฉลี่ย คาเบี่ยงเบนมาตรฐาน และคาสัมประสิทธิ์การกระจาย 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานแตละตําแหนงงานมี

ประสบการณกอนทํางานแตกตางกันมากนอยเพียงใด 

2.2.1 ตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดกลุม คาตอเนื่อง 

ตําแหนงงาน (jobcat) 

- เจาหนาท่ีปฏิบัติงาน 

- หัวหนางาน 

- ผูจัดการ 

ประสบการณกอนทํางาน (prevexp) 
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2.2.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล Employee data.sav 

๏ เลือกเมนู Analyze -> Compare Means -> Means… 

o Dependent List: เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปร (ตัวแปรท่ีตองการใหเปนตัว

แปรตาม) จากรายการตัวแปรดานซาย  

o Independent List: เลือกตัวแปรแบบคาจัดประเภท (มากกวา 2 กลุม) 1 ตัวแปร หรือ

หลายตัวแปร (ตัวแปรท่ีตองการใหเปนตัวแปรอิสระ) จากรายการตัวแปรดานซาย 

o กดปุม OK 

 

2.2.3 ผลการวิเคราะห 

 

 

2.2.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงคาเฉลี่ยประสบการณกอนทํางานของพนักงาน 

ตําแหนงงาน จํานวน คาเฉล่ีย S.D. C.V. (%) 

เจาหนาท่ีปฏิบัติงาน 363 85 95 112 

หัวหนางาน 27 298 101 34 

ผูจัดการ 84 78 73 94 

รวม 474 96 105 109 
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2.2.5 การแปลผลและสรุป 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท่ีมีประสบการณกอนทํางานโดยเฉลี่ยมากท่ีสุด คือ 

หัวหนางาน รองลงมา คือ เจาหนาท่ีปฏิบัติงาน และนอยท่ีสุด คือ ผูจัดการ  

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจายแสดงใหเห็นวา ประสบการณกอนทํางานของ

เจาหนาท่ีปฏิบัติงานมีความแตกตางกันอยูในระดับมาก สวนหัวหนางานและผูจัดการมีความแตกตางกัน

อยูในระดับนอย 

  



234 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

ตัวอยางเพ่ิมเติม: การแปลผลและสรุป 

#1 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท้ังหมด 474 คน มีประสบการณกอนทํางาน เฉลี่ย 

96 เดือน โดยตําแหนงงานมีประสบการณกอนทํางานเฉลี่ยมากท่ีสุด คือ หัวหนางาน เฉลี่ย 298 เดือน 

รองลงมา คือ เจาหนาท่ีปฏิบัติงาน เฉลี่ย 85 เดือน และนอยท่ีสุด คือ ผูจัดการ เฉลี่ย 78 เดือน  

เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจาย แสดงใหเห็นวา ประสบการณกอนทํางานของกลุม

ตัวอยางท้ังหมดมีความแตกตางกันอยูในระดับมาก (C.V. = 109) และเจาหนาท่ีปฏิบัติงานมีความ

แตกตางกันอยูในระดับมากเชนกัน (C.V. = 112) สวนหัวหนางานและผูจัดการมีความแตกตางกันอยูใน

ระดับนอย (C.V. = 34 และ C.V. = 94) 
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2.3 การเปรียบเทียบคาเฉลี่ยโดยมตีัวแปรคุม 

 การเปรียบเทียบคาเฉลี่ยโดยมีตัวแปรคุม เปนการวิเคราะหเหมือนกับการเปรียบเทียบคาเฉลี่ย 2 

กลุม และมากกวา 2 กลุม แตมีตัวแปรคุมเปนคาจัดกลุม 2 กลุมหรือมากกวา แตเพ่ือไมใหซับซอนควร

เลือกตัวแปรแบบคาจัดกลุมไมเกิน 2 กลุม โดยใชสถิติเชิงพรรณนา ไดแก คาเฉลี่ย คาเบี่ยงเบนมาตรฐาน 

และคาสัมประสิทธิ์การกระจาย 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานแตกลุมชนท่ีมีเพศ

แตกตางกันมีประสบการณกอนทํางานแตกตางกันมากนอยเพียงใด 

2.3.1 ตัวแปร 

ตัวแปรอิสระ 
ตัวแปรคุม 

เพศ (gender) 

ตัวแปรตาม 

คาจัดกลุม คาตอเนื่อง 

กลุมชน (minority) 

- ชนกลุมหลัก 

- ชนกลุมนอย 

ประสบการณกอนทํางาน (prevexp) 
-> 
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2.3.2 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล Employee Data.sav 

๏ เมนู Data -> Split File… 

o เลือกคําสั่ง Compare groups. 

o ใน Group base on เลือกตัวแปรแบบคาจัดประเภทจากรายการเมนูดานซาย 1 ตัวแปร 

หรือมากกวา 

o กดปุม OK 

 

๏ เลือกเมนู Analyze -> Compare Means -> Means… 

o Dependent List: เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปร (ตัวแปรท่ีตองการใหเปนตัว

แปรตาม) จากรายการตัวแปรดานซาย 

o Independent List: เลือกตัวแปรแบบคาจัดประเภท (มากกวา 2 กลุม) 1 ตัวแปร หรือ

หลายตัวแปร (ตัวแปรท่ีตองการใหเปนตัวแปรอิสระ) จากรายการตัวแปรดานซาย  

o กดปุม OK 
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2.3.3 ผลการวิเคราะห 

  

2.3.4 การสรางตารางผลการวิเคราะห 

ตารางท่ี (#) แสดงคาเฉลี่ยประสบการณกอนทํางานของพนักงาน ระหวางเพศและกลุมชน 

เพศ กลุมชน จํานวน คาเฉล่ีย S.D. C.V. (%) 

หญิง ชนกลุมหลัก 176 72 98 136 

 ชนกลุมนอย 40 99 78 79 

รวม 216 77 95 123 

ชาย ชนกลุมหลัก 194 102 109 107 

 ชนกลุมนอย 64 140 109 78 

รวม 258 112 110 98 

2.3.5 การแปลผลและสรุป 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางเพศหญิงท่ีเปนชนกลุมหลักมีประสบการณกอน

ทํางานโดยเฉลี่ย 72 เดือน นอยกวาเพศหญิงท่ีเปนชนกลุมนอยท่ีมีประสบการณกอนทํางานโดยเฉลี่ย 99 

เดือน สวนกลุมตัวอยางเพศชายท่ีเปนชนกลุมหลักมีประสบการณกอนทํางานโดยเฉลี่ย 102 เดือน นอย

กวาเพศชายท่ีเปนชนกลุมนอยท่ีมีประสบการณกอนทํางานโดยเฉลี่ย 140 เดือน  

อาจกลาวไดวา เพศหญิงและเพศชายท่ีเปนชนกลุมหลักมีประสบการณกอนทํางานโดยเฉลี่ยนอย

กวาเพศหญิงและเพศชายท่ีเปนชนกลุมนอย หรือชนกลุมหลักมีประสบการณกอนทํางานโดยเฉลี่ยนอย

กวาชนกลุมนอย  
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เม่ือพิจารณาจากคาสัมประสิทธิ์การกระจายแสดงใหเห็นวา ประสบการณกอนการทํางานของชนกลุม

หลักท้ังเพศชายและเพศหญิงมีความแตกตางกันอยูในระดับมาก สวนชนกลุมนอยท้ังเพศชายและเพศ

หญิงมีความแตกตางกันอยูในระดับนอย 

สรุป 

 การวิเคราะหขอมูล 2 ตัวแปร หากเปนตัวแปรแบบคาแบงประเภทตั้งแต 2 กลุม และมากกวา 

ใชการเปรียบเทียบความสัมพันธระหวางกลุมดวยคาความถ่ี และคารอยละ แตถาตัวแปรหนึ่งเปนตัวแปร

แบบคาจัดประเภทและอีกตัวแปรหนึ่งเปนตัวแปรแบบคาตอเนื่อง ใชการเปรียบเทียบขอมูลระหวางกลุม

ดวยคาเฉลี่ย คาเบี่ยงเบนมาตรฐาน และคาสัมประสิทธิ์การกระจาย   

แบบฝกหัดทายบท 

ใหผูเรียนเปดแฟมขอมูล 1991 US. General Social Survey.sav แลวประมวลผลขอมูล เพ่ือ

วิเคราะหและอธิบายผล ดังนี้ 

1. วิเคราะหและอธิบายผลตัวแปรอิสระคือ ภูมิภาค (region) กับตัวแปรตามคือ ประเภทของ

อาชีพ (occcat80) ดวยคําสั่ง Crosstabs  

2. วิเคราะหและอธิบายผลตัวแปรอิสระคือ ภูมิภาค (region) กับตัวแปรตามคือ ความคิดเห็น

เก่ียวกับภาษี (tax) และคุมดวยตัวแปรกลุมสีผิว (race) ดวยคําสั่ง Crosstabs  

3. วิเคราะหและอธิบายผลตัวแปรภูมิภาค (region) กับจํานวนพ่ีนอง (sibs) ดวยคําสั่ง Means  

4. วิเคราะหและอธิบายผลตัวแปรภูมิภาค (region) กับจํานวนพ่ีนอง (sibs) และคุมดวยตัวแปร

กลุมสีผิว (race) ดวยคําสั่ง Means  

 

  



 

 

สวนท่ี 5 

การวิเคราะหขอมูลดวยสถิติเชิงอางอิง 

  





 

 

บทที่ 12 

การทดสอบขอมูลแบบอิงคาพารามิเตอร 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถใชโปรแกรมประมวลผลทดสอบขอมูลของตัวแปรดวยสถิติเชิงอางอิงแบบอิง

คาพารามิเตอรและเขียนบรรยายผลการทดสอบได 

เน้ือหา 

1. การทดสอบคาเฉลี่ยของกลุมตัวอยาง 1 กลุม  

2. การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีไมเปนอิสระจากกัน 2 กลุม 

3. การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม 

4. การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม 

5. การทดสอบความสัมพันธรายคูแบบเพียรสัน 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และ

ประเมินจากการทําแบบฝกหัดทายบท  
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เนื้อหา 

เม่ือขอมูลเปนไปตามขอตกลงเบื้องตน (meet basic assumptions) และใชการทดสอบแบบอิง

คาพารามิเตอร (parametric test) ผลการทดสอบใหอํานาจจําแนกทางสถิติ (statistical power) สูง

กวาการทดสอบแบบไมอิงคาพารามิเตอร  

แมวาการทดสอบแบบอิงคาพารามิเตอรสวนใหญวางอยูบนฐานของขอมูลท่ีมีระดับการวัดตั้งแต

มาตราแบบชวงข้ึนไปหรือเปนคาตอเนื่อง และขอมูลตองมีการแจกแจงแบบปกติ (normal distribution) 

แลว แตการทดสอบแตละประเภทยังมีขอตกลงเฉพาะเพ่ิมเติมอีก เชน การทดสอบคาเฉลี่ยระหวางกลุม

ตัวอยาง ขอมูลแตละกลุมตัวอยางตองมาจากประชากรท่ีมีความแปรปรวนเทากัน (homogeneity of 

variance) การทดสอบคาเฉลี่ยแบบทดสอบซํ้า ขอมูลของแตละตัวอยางตองมีความเปนอิสระจากกัน 

(independence) 

1. การทดสอบคาเฉลี่ยของกลุมตัวอยาง 1 กลุม  

การทดสอบคาเฉลี่ยของกลุมตัวอยาง 1 กลุม (One Sample t Test) คือ การเปรียบเทียบขอมูล

ของตัวอยาง 1 กลุม ท่ีสุมมาจากประชากร กับคาทดสอบ (value test) ของประชากรท่ีทราบจํานวน 

(know populations) หรือเปนคาของสมมติฐาน (hypothesized) เพ่ือตัดสินใจวา คาเฉลี่ยของขอมูลมี

ความแตกตางกันหรือไมแตกตางกัน 

การทดสอบแบบนี้อาจมีชื่อเรียกอีกชื่อหนึ่งวา Single Sample t Test 

ตัวอยางคําถามการวิจัย 

จากรายงานผลการสํารวจของสํานักงานสถิติดานสังคมและเศรษฐกิจของประเทศพบวา ผูจบ

การศึกษาในทุกระดับการศึกษา มีการยายหรือเปลี่ยนงานหลังจากไดงานครั้งแรกแลวโดยเฉลี่ย

ประมาณ 5 ป (60 เดือน) ดังนั้นจากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา พนักงาน

มีคาเฉลี่ยของประสบการณกอนทํางานแตกตางไปจากคาเฉลี่ยตามรายงานผลการสํารวจของสํานักงาน

สถิติหรือไม 
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1.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. กลุมตัวอยางไดมาจากประชากรท่ีทราบจํานวน (know population) โดย

การสุมตัวอยางแบบสุม (independence random sampling)  

 2. มีกลุมตัวอยางมากกวาหรือนอยกวา 30 ตัวอยาง 

 3. ตัวแปรทดสอบเปนตัวแปรแบบคาตอเนื่อง (continuous variable) หรือ

คะแนน (scores) 

การวิเคราะหขอมูล 1. ขอมูลมีการแจกแจงแบบปกติ (normal distribution) 

 2. ขอมูลไมมีคาผิดปกติ (outliers) หรือคาตางสุด (extremes) 

1.2 รูปแบบการทดสอบตัวแปร 

ตัวแปร 

-> 

คาทดสอบ 

คาตอเนื่อง คาเฉลี่ย 

ประสบการณกอนทํางาน (prevexp) 60 เดือน 

1.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงคาเฉลี่ยประสบการณกอนทํางานของพนักงาน 

ประสบการณทํางาน จํานวน คาต่ําสุด คาสูงสุด คาเฉล่ีย S.D. C.V. (%) 

กอนทํางาน (เดือน) 474 0 476 95.86 104.59 109.11 

จากตารางท่ี (#) แสดงใหเห็นวา พนักงานจํานวน 474 คน มีประสบการณกอนทํางานเฉลี่ย 

95.86 เดือน มีประสบการณกอนทํางานต่ําสุด 0 เดือน และมีประสบการณสูงสุด 476 เดือน เม่ือ

พิจารณาจากคาสัมประสิทธิ์การกระจายแสดงใหเห็นวา พนักงานมีประสบการณกอนทํางานแตกตางกัน

มาก    

จากขอมูลคาเฉลี่ยประสบการณกอนทํางานของพนักงาน ตองการทดสอบวา พนักงานของ

หนวยงานมีคาเฉลี่ยของประการณกอนทํางานเทากับหรือไมเทากับคาเฉลี่ยจากผลการสํารวจ จึงทําการ

ทดสอบดวยวิธีการทางสถิติ โดยมีสมมติฐานดังนี้ 



244 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

H0: กลุมตัวอยางท่ีเปนพนักงานของหนวยงานมีประสบการณกอนทํางานเทากับ 60 เดือน 

H1: กลุมตัวอยางท่ีเปนพนักงานของหนวยงานมีประสบการณกอนทํางานไมเทากับ 60 เดือน 

เกณฑในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกตางระหวางคาเฉลี่ยของกลุม

ตัวอยางกับคาทดสอบ (one-sample t-test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทาง

สถิติ (α = .05) จะยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคา

นัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

1.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Compare Means -> One Sample T Test… 

o Test Variable(s): เลือกตัวแปรทดสอบ (ตัวแปรแบบคาตอเนื่อง) 1 ตัวแปร หรือ

มากกวา 1 ตัวแปร จากรายการตัวแปรดานซาย  

o Test Value: ใสคาทดสอบในชอง (คาทดสอบมาจากขอมูลในอดีต ความรูท่ีมีอยู  ทฤษฎี 

หรืองานวิจัย) 

o กดปุม Options 

- Confidence Interval Percentage: กําหนดชวงความเชื่อม่ันในชอง (คาปกติ .95)  

- ในชุดคําสั่ง Missing Values เลือกวิธีการคํานวณคาสูญหาย 

 Exclude cases analysis by analysis (วิเคราะหตัวอยางท่ีไมมีขอมูลสูญหายในแต

ละตัวแปรทดสอบ) 

 Exclude cases listwise (วิเคราะหตัวอยางท่ีไมมีขอมูลสูญหายในทุกตัวแปร

ทดสอบ) 

o กดปุม Continue 

o กดปุม OK 
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1.5 ผลการวิเคราะห 

 

1.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงการทดสอบการเปรียบเทียบคาเฉลี่ยประสบการณกอนทํางานของพนักงาน 

คาทดสอบ = 60 เดือน 

ประสบการณ

ทํางาน 

จํานวน 

(คน) 
คาเฉล่ีย t df Sig. 

Mean 

Difference 

95% Confidence Level 

Lower Upper 

กอนทํางาน 474 95.86 7.47 473 .00 35.86 26.42 45.30 

1.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .00 มีคานอยกวาคา

นัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป พนักงานของหนวยงานมีประสบการณกอนทํางานโดยเฉลี่ยไมเทากับ 60 เดือน (มีคาเฉลี่ย

แตกตางจากคาทดสอบประมาณ 35.86 เดือน โดยมีความเชื่อม่ันวาความแตกตางของคาเฉลี่ยมีคาต่ําสุด

ไมเกิน 26.42 เดือน และสูงสุดไมเกิน 45.30 เดือน) 
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2. การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีไมเปนอิสระจากกัน 2 กลุม  

 การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีไมเปนอิสระจากกัน 2 กลุม (Paired Samples t Test) 

คือ การเปรียบเทียบขอมูลของกลุมตัวอยางท่ีสัมพันธกันหรือเก่ียวของกัน (ไดมาจากสถานการณ/บุคคล/

สิ่งของเดียวกันแตเปนเรื่องท่ีมีความเก่ียวของกันอาจเกิดข้ึนในชวงเวลาหรือสถานท่ีท่ีแตกตางกันท่ี) เพ่ือ

ตัดสินใจวา คาเฉลี่ยของขอมูลมีความแตกตางกันหรือไมแตกตางกัน เชน รายไดเฉลี่ยของครัวเรือนในแต

ละชุมชนระหวางป พ.ศ. 2555 กับ ป พ.ศ. 2560 จํานวนประชากรในแตละจังหวัดระหวางป พ.ศ. 2553 

กับ ป พ.ศ. 2563 เงินเดือนของพนักงานในหนวยงานระหวางปปจจุบันกับเม่ือ 5 ปท่ีแลว   

การทดสอบแบบนี้อาจมีชื่อเรียกเปนอยางอ่ืน ไดแก Dependent t Test, Related t Test และ 

Repeated Measures t Test 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานมีคาเฉลี่ยของ

เงินเดือนเริ่มตนแตกตางกับเงินเดือนปจจุบันหรือไม 

2.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวิจัย 1. กลุมตัวอยางไดมาจากประชากรท่ีทราบจํานวน (know population) โดย

การสุมตัวอยางแบบสุมท่ีเปนอิสระจากกัน (independence random 

sampling) 

 2. กลุมตัวอยางอาจมีขนาดมากกวาหรือนอยกวา 30 ตัวอยาง 

 3. ขอมูลไดมาจากกลุมตัวอยางมีความสัมพันธหรือเก่ียวของกัน 

(dependent/paired sample) 

 4. ขอมูลของตัวแปรทดสอบท้ังคูเปนมีระดับการวัดแบบคาตอเนื่อง 

(continuous level)  

การวิเคราะหขอมูล 1. ขอมูลของตัวแปรทดสอบท้ังคูมีการแจกแจงปกติ (normal distribution)   

 2. ขอมูลของตัวแปรทดสอบท้ังคูไมมีคาผิดปกติ (outliers) หรอืคาตางสุด 

(extremes) 
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2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรทดสอบ (การวัดครั้งท่ี 1) วัดซํ้า ตัวแปรทดสอบ (การวัดครั้งท่ี 2) 

คาตอเนื่อง -> คาตอเนื่อง 

เงินเดือนเริ่มตน (salbegin)   เงินเดือนปจจุบัน (salary) 

2.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงการเปรียบเทียบคาเฉลี่ยเงินเดือนปจจุบันกับเงินเดือนเริ่มตน 

เงินเดือน จํานวน คาเฉล่ีย S.D. C.V. (%) 

เงินเดือนปจจุบัน 474 34,419.57 17,075.66 49.61 

เงินเดือนเริ่มตน 474 17,016.09 7,870.64 46.25 

จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานจํานวน 474 คน มีเงินเดือนปจจุบัน

เฉลี่ย 34,419.57 ดอลลารสหรัฐ สวนเงินเดือนเริ่มตนเฉลี่ย 17,016.09 ดอลลารสหรัฐ กลาวคือ คาเฉลี่ย

ของเงินเดือนปจจุบันมากกวาคาเฉลี่ยของเงินเดือนเริ่มตน  

ดังนั้น เพ่ือเปนการยืนยันวา คาเฉลี่ยของเงินเดือนปจจุบันแตกตางจากคาเฉลี่ยของเงินเดือน

เริ่มตน จึงทําการทดสอบดวยวิธีการทางสถิติ โดยมีสมมติฐาน ดังนี้ 

H0: คาเฉลี่ยของเงินเดือนปจจุบันกับคาเฉลี่ยของเงินเดือนเริ่มตนของพนักงานไมแตกตางกัน 

H1: คาเฉลี่ยของเงินเดือนปจจุบันกับคาเฉลี่ยของเงินเดือนเริ่มตนของพนักงานแตกตางกัน 

เกณฑในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกตางระหวางคาเฉลี่ยของกลุม

ตัวอยางท่ีมีความสัมพันธกันหรือไมเปนอิสระจากกัน (paired sample t-test) ไดคาความนาจะเปน (p-

value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน 

(p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับ

สมมติฐาน H1 
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2.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Compare Means -> Paired Samples T Test… 

o เลือกตัวแปรทดสอบตัวท่ี 1 (ตัวแปรแบบคาตอเนื่อง/เหตุการณกอน) จากชองรายการตัว

แปร -> ใสในชอง Var1 ของ Test Pair(s): 

o เลือกตัวแปรทดสอบตัวท่ี 2 (ตัวแปรแบบคาตอเนื่อง/เหตุการณหลัง) จากชองรายการตัว

แปร -> ใสในชอง Var2 ของ Test Pair(s): 

o กดปุม Options 

- กําหนดชวงความเชื่อม่ันในชอง Confidence Interval Percentage: (คาปกติ .95) 

- เลือกวิธีการคํานวณคาสูญหายในชุดคําสั่ง Missing Values 

 Exclude cases analysis by analysis (วิเคราะหตัวอยางท่ีไมมีขอมูลสูญหายในแต

ละตัวแปรทดสอบ) 

 Exclude cases listwise (วิเคราะหตัวอยางท่ีไมมีขอมูลสูญหายในทุกตัวแปร

ทดสอบ) 

o กดปุม Continue 

o กดปุม OK 

 

 

2.5 ผลการวิเคราะห 
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2.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงการทดสอบเปรียบเทียบคาเฉลี่ยเงินเดือนปจจุบันกับเงินเดือนเริ่มตน 

เงินเดือน 
Mean 

Difference 

Std. Error 

Difference 

S.E. 

Mean 

95% Confidence Level 
t df Sig. 

Lower Upper 

ปจจุบัน-เริ่มตน 1,7403.48 10,814.62 496.73 16,427.4 18,379.6 35.04 473 .000 

2.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .000 มีคานอยกวา

คานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

สรุป คาเฉลี่ยของเงินเดือนปจจุบันกับคาเฉลี่ยของเงินเดือนเริ่มตนของพนักงานแตกตางกัน 

(คาเฉลี่ยของเงินเดือนปจจุบันแตกตางจากคาเฉลี่ยของเงินเดือนเริ่มตนประมาณ 1,7403.48 ดอลลาร

สหรัฐ โดยมีความเชื่อม่ันวาความแตกตางของคาเฉลี่ยมีคาต่ําสุดไมเกิน 16427.41 ดอลลารสหรัฐ และ

สูงสุดไมเกิน 18,379.59 ดอลลารสหรัฐ) 
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ตัวอยางเพ่ิมเติม: การแปลผลและสรุป 

#1 

จากการทดสอบความแตกตางระหวางคาเฉลี่ยของกลุมตัวอยางท่ีมีความสัมพันธกัน (paired 

sample t-test) ไดคานัยสําคัญทางสถิติ (Sig.) = .000 ซ่ึงนอยกวาเกณฑท่ีกําหนดไว จึงปฏิเสธ

สมมติฐาน H0 และยอมรับสมมติฐาน H1 คือ คาเฉลี่ยของเงินเดือนปจจุบันกับคาเฉลี่ยของเงินเดือน

เริ่มตนของพนักงานแตกตางกันประมาณ 1,7403.48 ดอลลารสหรัฐ โดยมีความเชื่อม่ันวาความ

แตกตางของคาเฉลี่ยมีคาต่ําสุดไมเกิน 16427.41 ดอลลารสหรัฐ และสูงสุดไมเกิน 18,379.59 ดอลลาร

สหรัฐ 

#2 

จากการทดสอบความแตกตางระหวางคาเฉลี่ยของเงินเดือนปจจุบันกับคาเฉลี่ยของเงินเดือน

เริ่มตนของพนักงานแสดงใหเห็นวา มีแตกตางกันอยางมีนัยสําคัญทางสถิติ 
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3. การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม  

 การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม (2 Samples t Tests) คือ การ

เปรียบเทียบขอมูลของกลุมตัวอยางท่ีไมมีความสัมพันธกัน 2 กลุม เพ่ือตัดสินใจวา คาเฉลี่ยของขอมูลมี

ความแตกตางกันหรือไมแตกตางกัน  

การทดสอบแบบนี้อาจมีชื่อเรียกเปนอยางอ่ืน ไดแก Independent t Test, Independent 

Measures t Test, Independent Two-sample t Test, Student t Test, Uncorrelated Scores t 

Test, Unpaired t Test และ Unrelated t Test 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา พนักงานระหวางชนกลุมหลักกับ

ชนกลุมนอยมีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกันหรือไม 

3.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. กลุมตัวอยางไดมาจากประชากรท่ีทราบจํานวน (know population) โดย

การสุมตัวอยางแบบสุมท่ีเปนอิสระจากกัน (independence random 

sampling) 

 2. กลุมตัวอยางมีขนาดใหญ (มากกวา 30) 

 3. ตัวแปรอิสระเปนตัวแปรแบบคาจัดประเภท (categorical variable) มีอยาง

นอย 2 กลุม  

 4. ตัวแปรตามเปนตัวแปรแบบคาตอเนื่อง (continuous variable) 

การวิเคราะหขอมูล 1. ขอมูลท้ังสองกลุมมีการแจกแจงแบบปกติ (normal distribution) 

 2. ขอมูลระหวางกลุมมีความแปรปรวนเทากัน (homogeneity of Variance)  

3. ขอมูลท้ังสองกลุมไมมีคาผิดปกติ (outliers) หรือคาตางสุด (extremes) 
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3.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดประเภท คาตอเนื่อง 

กลุมชน (minority) 

- ชนกลุมหลัก 

- ชนกลุมนอย 

ประสบการณกอนทํางาน (prevexp) 

3.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงการเปรียบเทียบคาเฉลี่ยประสบการณกอนทํางานของพนักงานระหวางกลุมชน 

กลุมชน จํานวน คาเฉล่ีย S.D. C.V. 

ชนกลุมหลัก 370 87.84 104.56 119.04 

ชนกลุมนอย 104 124.38 100.07 80.46 

รวม 474 95.86 104.59 109.11 

จากตารางท่ี (#) แสดงใหเห็นวา พนักงานท่ีเปนกลุมตัวอยางจํานวน 474 คน เปนชนกลุมหลัก 

จํานวน 370 คน มีประสบการณกอนทํางานเฉลี่ย 87.84 เดือน สวนกลุมตัวอยางท่ีเปนชนกลุมนอย 

จํานวน 104 คน มีประสบการณกอนทํางานเฉลี่ย 124.38 เดือน  

จากการเปรียบเทียบพนักงานท่ีเปนชนกลุมหลักมีประสบการณกอนการทํางานนอยกวาพนักงาน

ท่ีเปนชนกลุมนอย 

ดังนั้น เพ่ือเปนการยืนขอสรุปท่ีวา กลุมตัวอยางท่ีเปนพนักงานชนกลุมหลักมีประสบการณกอน

การทํางานแตกตางกับกลุมตัวอยางท่ีเปนพนักงานชนกลุมนอย จึงทําการทดสอบความแตกตางระหวาง

กลุมตัวอยาง โดยกําหนดสมมติฐาน ดังนี้ 

H0: พนักงานท่ีเปนชนกลุมหลักและชนกลุมนอยมีคาเฉลี่ยของประสบการณกอนทํางานเทากัน 

H1: พนักงานท่ีเปนชนกลุมหลักมีคาเฉลี่ยของประสบการณกอนทํางานนอยกวาพนักงานท่ีเปน

ชนกลุมนอย 
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เกณฑในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกตางของคาเฉลี่ยระหวางกลุม

ตัวอยางท่ีเปนอิสระจากกัน (Independent sample t-test) ไดคาความนาจะเปน (p-value) มากกวา

คานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอย

กวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

3.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Compare Means -> Independent Samples T Test… 

o Test Variable (s): เลือกตัวแปรคาตอเนื่อง 1 ตัวแปร หรือมากกวา 1 ตัวแปร จากรายการตัว

แปรดานซาย  

o Grouping Variable: เลือกตัวแปรคาแบงกลุม 1 ตัวแปร   

o กดปุม Define Groups…  

- Use specified values: กําหนดคาของตัวแปรคาแบงกลุมใน Group 1: และ Group2: หรือ 

- Cut point: กําหนดจุดแบงกลุมใน (กรณีตองการรวมกลุมท่ีมีลักษณะเปนคาตอเนื่องเปน 2 กลุม)  

o กดปุม Continue 

o กดปุม Options 

- Confidence Interval Percentage: กําหนดชวงความเชื่อม่ันในชอง (คาปกติ .95) 

- Missing Values เลือกวิธีการคํานวณคาสูญหายในชุดคําสั่ง  

 Exclude cases analysis by analysis (วิเคราะหตัวอยางท่ีไมมีขอมูลสูญหายในแตละตัวแปร

ทดสอบ) 

 Exclude cases listwise (วิเคราะหตัวอยางท่ีไมมีขอมูลสูญหายในทุกตัวแปรทดสอบ) 

o กดปุม Continue 

o กดปุม OK 
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3.5 ผลการวิเคราะห 

 

 

3.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบการเปรียบเทียบคาเฉลี่ยประสบการณกอนทํางานของพนักงานระหวาง

กลุมชน 

กลุมชน 
Leven’s Test 

t df Sig. 
Mean 

Difference 

95% Confidence Level 

F Sig. Lower Upper 

ประสบการณกอนทํางาน .11 .74 -3.18 472 .002 -36.54 -59.13 -13.95 

หรือ 

กลุมชน จํานวน คาเฉล่ีย S.D. t df Sig. 

ชนกลุมหลัก 370 87.84 104.56 

-3.18 472 .002 ชนกลุมนอย 104 124.38 100.07 

รวม 474 95.86 104.59 

3.7 การแปลผลและสรุป 

 จากตารางท่ี (#) แสดงใหเห็นวา คาความนาจะเปน (Sig.) = .002 มีคานอยกวาคานัยสําคัญทาง

สถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป พนักงานท่ีเปนชนกลุมหลักมีคาเฉลี่ยของประสบการณกอนทํางานนอยกวาพนักงานท่ีเปน

ชนกลุมนอย (มีคาเฉลี่ยแตกตางกันประมาณ 36.54 เดือน โดยมีความเชื่อม่ันวาความแตกตางของ

คาเฉลี่ยมีคาต่ําสุดไมเกิน 59.13 เดือน และสูงสุดไมเกิน 13.95 เดือน) 
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Tips: การแปลผลและสรุป 

#1 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา พนักงานท่ีเปนชนกลุมหลักมีประสบการณ

กอนทํางานนอยกวาพนักงานท่ีเปนชนกลุมนอยโดยเฉลี่ย 36.54 เดือน อยางมีนัยสําคัญทางสถิติ 

#2 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา พนักงานท่ีเปนชนกลุมหลักคาเฉลี่ยของ

ประสบการณกอนทํางานนอยกวาพนักงานท่ีเปนชนกลุมนอย อยางมีนัยสําคัญทางสถิติ 

#3 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานชนกลุมหลักมี

ประสบการณกอนทํางานแตกตางกับกลุมตัวอยางท่ีเปนพนักงานชนกลุมนอย อยางมีนัยสําคัญทาง

สถิติ 
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4. การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม  

การทดสอบคาเฉลี่ยของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม (One Way Analysis 

of Variance of Analysis: One-way ANOVA) คือ การเปรียบเทียบขอมูลของกลุมตัวอยางท่ีเปนอิสระ

จากกันมากกวา 2 กลุม เพ่ือตัดสินใจวา คาเฉลี่ยของขอมูลมีความแตกตางกันหรือไมแตกตางกัน 

การทดสอบแบบนี้อาจมีชื่อเรียกเปนอยางอ่ืน ไดแก One-Factor ANOVA, One-Way Analysis 

of Variance และ Between Subjects ANOVA 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา พนักงานท่ีมีตําแหนงงานแตกตาง

กันมีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกันหรือไม 

4.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวิจัย 1. กลุมตัวอยางไดมาจากประชากรท่ีทราบจํานวน (know population) โดย

การสุมตัวอยางแบบสุมท่ีเปนอิสระจากกัน (independence random 

sampling) 

 2. กลุมตัวอยางมีขนาดใหญ (มากกวา 30) 

 3. ตัวแปรอิสระเปนตัวแปรแบบคาจัดประเภท (categorical variable) มีการ

แบงประเภทอยางนอย 3 กลุม 

 4. ตัวแปรตามเปนตัวแปรแบบคาตอเนื่อง (continuous variable) 

การวิเคราะหขอมูล 1. ขอมูลของแตละกลุมมีการแจกแจงแบบปกติ (normal distribution) 

 2. ขอมูลของแตกลุมมีความแปรปรวนเทากัน (homogeneity of variance) 

 3. ขอมูลของแตละกลุมไมมีคาผิดปกติ (outliers) หรือคาตางสุด (extremes) 
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4.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดประเภท  

(3 กลุมหรือมากกวา) 
คาตอเนื่อง 

ตําแหนงงาน (jobcat) 

- เจาหนาท่ีปฏิบัติงาน 

- หัวหนางาน 

- ผูจัดการ 

คาเฉลี่ยของประสบการณกอนทํางาน (prevexp) 

4.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงการเปรียบเทียบคาเฉลี่ยประสบการณกอนทํางานของพนักงานระหวางตําแหนงงาน 

ตําแหนงงาน จํานวน ต่ําสุด สูงสด คาเฉล่ีย S.D. 

เจาหนาท่ีปฏิบัติงาน 363 0 476 85.04 95.27 

หัวหนางาน 27 144 460 298.11 101.43 

ผูจัดการ 84 3 285 77.62 73.26 

รวม 474 0 476 95.86 104.59 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางพนักงานท่ีเปนหัวหนางานมีประสบการณกอน

ทํางานมากท่ีสุด คือ 298.11 เดือน รองลงมาเปนเจาหนาท่ีปฏิบัติงาน คือ 85.04 เดือน และผูจัดการมี

ประสบการณกอนทํางานนอยท่ีสุด คือ 77.62 เดือน หรือสรุปไดวา พนักงานท่ีมีตําแหนงงานแตกตางกัน

มีประสบการณการกอนทํางานแตกตางกัน 

 ดังนั้น เพ่ือเปนการยืนยันวา พนักงานท่ีมีตําแหนงงานแตกตางกันมีประสบการณการกอนทํางาน

แตกตางกัน จึงทําการทดสอบดวยวิธีการทางสถิติ โดยมีสมมติฐาน ดังนี้ 

 H0: กลุมตัวอยางท่ีมีตําแหนงงานแตกตางกันมีคาเฉลี่ยของประสบการณกอนทํางานไมแตกตางกัน 

 H1: กลุมตัวอยางท่ีมีตําแหนงงานแตกตางกันมีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกัน 

เกณฑในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกตางของคาเฉลี่ยระหวางกลุม

ตัวอยางมากกวา 2 กลุม (One-way ANOVA) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทาง
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สถิติ (α = .05) จะยอมรบัสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคา

นัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมน ูAnalyze -> Compare Means -> One-Way ANOVA… 

o Dependent List: เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปร หรือมากกวา 1 ตัวแปร 

จากรายการตัวแปรดานซาย  

o Factor: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร จากรายการตัวแปรดานซาย  

o ในกลุมคําสั่ง Statistics เลือกคาสถิติ Descriptives  

o กดปุม OK 

 

4.5 ผลการวิเคราะห 
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4.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบการเปรียบเทียบคาเฉลี่ยประสบการณกอนทํางานของพนักงานระหวาง

ตําแหนงงาน 

ตําแหนงงาน  Sum of Squares df Mean Square F Sig. 

ประสบการณ

กอนทํางาน 

ระหวางกลุม 1174907 2 587453.4 69.19 .00 

ภายในกลุม 3998900 471 8490.23   

รวม 5173807 473    

หรือ 

ตําแหนงงาน จํานวน คาเฉล่ีย S.D. F df Sig. 

เจาหนาท่ีปฏิบัติงาน 363 85.04 95.27 

69.19 2 .00 
หัวหนางาน 27 298.11 101.43 

ผูจัดการ  84 77.62 73.26 

รวม 474 95.86 104.59 

4.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .000 มีคานอยกวา

คานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป กลุมตัวอยางท่ีมีตําแหนงงานแตกตางกันมีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกัน 

โดยหัวหนางานมีคาเฉลี่ยของประสบการกอนทํางานมากท่ีสุด รองลงมา คือ เจาหนาท่ีปฏิบัติงาน และ

ผูจัดการ ตามลําดับ 

จากการทดสอบสมมติฐานพบวา กลุมตัวอยางท่ีมีตําแหนงงานแตกตางกันมีคาเฉลี่ยของ

ประสบการณกอนทํางานแตกตางกัน นั่นแสดงวา มีกลุมตัวอยางท่ีมีตําแหนงงานแตกตางกันอยางนอย 1 

คู ท่ีมีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกัน  

เนื่องจากกลุมตัวอยางพนักงานท่ีมีตําแหนงงานแตกตางกันแตละกลุมมีจํานวนไมเทากัน จึงทํา

การทดสอบความแปรปรวนระหวางกลุมดวยสถิติของเลวีน (Levene Statistic) เพ่ือตัดสินใจเลือกการ



260 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

วิเคราะหเปรียบเทียบความแตกตางของคาเฉลี่ย (Post Hoc Tests) ของประสบการณกอนการทํางาน

ของพนักงานท่ีมีตําแหนงงานแตกตางกัน โดยมีสมมติฐานดังนี้ 

 H0: ความแปรปรวนของคาเฉลี่ยประสบการณกอนการทํางานของพนักงานท่ีมีตําแหนงงาน

แตกตางกันเทากัน 

H1: ความแปรปรวนของคาเฉลี่ยประสบการณกอนการทํางานของพนักงานท่ีมีตําแหนงงาน

แตกตางกันไมเทากัน 

 เกณฑในการทดสอบสมมติฐาน คือ หากการทดสอบความแปรปรวนดวยวิธีของเลวีน 

(Levene’s Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับ

สมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α 

= .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.7.1 การทดสอบความแปรปรวน 

๏ เลือกเมน ูAnalyze -> Compare Means -> One-Way ANOVA… 

o Dependent List: เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปร หรือมากกวา 1 ตัวแปร จาก

รายการตัวแปรดานซาย  

o Factor: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร จากรายการตัวแปรดานซาย  

o ในกลุมคําสั่ง Statistics เลือกคาสถิติ Homogeneity  

o กดปุม OK 

 

4.7.1.1 ผลการทดสอบความแปรปรวน 
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4.7.1.2 การสรางตารางแสดงผลการทดสอบความแปรปรวน 

ตารางท่ี (#) แสดงผลการทดสอบความแปรปรวนของคาเฉลี่ยประสบการณกอนการทํางานของพนักงาน

ท่ีมีตําแหนงงานแตกตางกัน 

Levene Statistic df1 df2 Sig. 

2.54 2 471 .080 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .080 มีคามากกวา

คานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงยอมรับสมมติฐาน H0  

สรุป ความแปรปรวนของคาเฉลี่ยประสบการณกอนการทํางานของพนักงานท่ีมีตําแหนงงาน

แตกตางกันเทากัน 
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4.7.2 การทดสอบเปรียบเทียบคาเฉล่ียรายคูหลังการทดสอบรวม 

๏ เลือกเมนู Analyze -> Compare Means -> One-Way ANOVA… 

o Dependent List: เลือกตัวแปรแบบคาตอเนื่อง 1 ตัวแปร หรือมากกวา 1 ตัวแปร 

จากรายการตัวแปรดานซาย  

o Factor: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร จากรายการตัวแปรดานซาย  

o กดปุม Post-Hoc… (ทดสอบคาเฉลี่ยรายคู) 

- เลือกคาสถิติ Bonferroni หรือ Fisher’s LSD หรือ Scheffé, Šídák หรือ Turkey 

HSD (คาความแปรปรวนของท้ังสองกลุมเทากัน)17

18 

- เลือกคาสถิติ Games Howell (คาความแปรปรวนของท้ังสองกลุมไมเทากัน) 

o กดปุม Continue 

o กดปุม OK 

  

 จากการทดสอบความแปรปรวนของคาเฉลี่ยประสบการณกอนทํางานระหวางกลุมพนักงานท่ีมี

ตําแหนงแตกตางกัน พบวามีความแปรวนเทากัน จึงทําการทดสอบความแตกตางของคาเฉลี่ยรายคู (Post 

Hoc Tests) ดวยวิธีของทูก้ี (Tukey HSD: Tukey Honestly Significant Difference) โดยมีสมมติฐาน

ดังนี้ 

 H0: คาเฉลี่ยของประสบการณกอนทํางานไมแตกตางกัน 

 H1: มีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกันอยางนอย 1 คู  

                                                           
18 คาสถิติท่ีนิยมใชกันอยางแพรหลาย คือ Scheffé เพราะเปนการทดสอบเชิงอนุรักษ (คานัยสําคัญทางสถิติของอัตราความคลาดเคล่ือน

นอยกวา .05) มีโอกาสทําใหเกิดความผิดพลาดชนิดที่ 1 (Type I Error) นอยกวาสถิติเชิงกาวหนา (คานัยสําคัญทางสถิติของอัตราความ

คลาดเคล่ือนมากกวา .05) เหมาะกับขอมูลที่มีขนาดตัวอยางเทากันและไมเทากัน และมีการเปรียบเทียบรายคูมากกวา 3 กลุม แตหากทํา

การเปรียบเทียบรายคู 2-3 กลุม มีขนาดกลุมตัวอยางเทากันและไมเทากัน นิยมใช Tukey HSD เพราะจะใชการทดสอบเชิงอนุรักษ  
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 เกณฑในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกตางของคาเฉลี่ย (Mean 

difference) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับ

สมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α 

= .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.7.2.1 ผลการทดสอบเปรียบเทียบคาเฉล่ียรายคู 

 

4.7.2.2 การสรางตารางแสดงผลการทดสอบคาเฉล่ียรายคู 

ตารางท่ี (#) แสดงผลการทดสอบการเปรียบเทียบคาเฉลี่ยของประสบการณกอนทํางานระหวางตําแหนงงาน 

ประสบการณกอน

ทํางาน(คาเฉลี่ย) 

เจาหนาท่ีปฏิบัติงาน 

(85.04) 

หัวหนางาน 

(298.11) 

ผูจัดการ 

(77.62) 

เจาหนาท่ีปฏิบัติงาน

(85.04) 

- -213.073* 7.420 

หัวหนางาน 

(298.11) 

 - 220.492* 

ผูจัดการ 

(77.62) 

  - 

* มีคาความนาจะเปน (Sig.) = .000 

 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา การเปรียบเทียบคาเฉลี่ยประสบการณกอน

ทํางานรายคูระหวางเจาหนาท่ีปฏิบัติงานกับหัวหนางาน และหัวหนางานกับผูจัดการ มีคาความนาจะเปน 

(Sig.) = .000 นอยกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับ

สมมติฐาน H1 
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 สรุป มีกลุมตัวอยางท่ีมีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกันอยางนอย 1 คู ตําแหนง

งานท่ีมีคาเฉลี่ยของประสบการณกอนทํางานแตกตางกัน คือ เจาหนาท่ีปฏิบัติงานกับหัวหนางาน และ

หัวหนางานกับผูจัดการ สวนเจาหนาท่ีปฏิบัติงานกับผูจัดการ มีคาเฉลี่ยของประสบการณกอนทํางานไม

แตกตางกัน 
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ตัวอยางเพ่ิมเติม: การทดสอบ การแปลผลและสรุป 

#1 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบคาเฉลี่ยประสบการณกอนทํางานของพนักงาน 

ตําแหนงงาน จํานวน คาเฉล่ีย S.D. F Df Sig. 

เจาหนาท่ีปฏิบัติงาน 363 85.04 95.27 

69.19 2 .000 
หัวหนางาน 27 298.11 101.43 

ผูจัดการ  84 77.62 73.26 

รวม 474 95.86 104.59 

Levene Statistic = 2.54, df1 = 2, df2 = 471, Sig. = .08 

 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานตําแหนงหัวหนางาน

มีประสบการณกอนทํางานมากท่ีสุด รองลงมา คือ เจาหนาท่ีปฏิบัติงาน และผูจัดการ ตามลําดับ  

สรุป พนักงานท่ีมีตําแหนงงานแตกตางกันมีประสบการณการกอนทํางานแตกตางกันอยางมี

นัยสําคัญทางสถิติ โดยมีความแปรปรวนของคาเฉลี่ยของประสบการณกอนทํางานไมแตกตางกัน ดังนั้น

จึงทําการทดสอบความแตกตางของคาเฉลี่ยรายคู (Post Hoc Tests) ดวยวิธีของเชฟเฟ (Scheffe's 

Method) 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบคาเฉลี่ยประสบการณกอนทํางานของพนักงานท่ีมีตําแหนง

แตกตางกัน 

ประสบการณกอนทํางาน 

(คาเฉลี่ย) 

เจาหนาท่ีปฏิบัติงาน 

(85.04) 

หัวหนางาน 

(298.11) 

ผูจัดการ 

(77.62) 

เจาหนาท่ีปฏิบัติงาน 

(85.04) 
- -213.073* 7.420 

หัวหนางาน 

(298.11) 
 - 220.492* 

ผูจัดการ 

(77.62) 
  - 

* มีคาความนาจะเปน (Sig.) = .000 
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 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานตําแหนงเจาหนาท่ี

ปฏิบัติงานมีประสบการณกอนทํางานโดยเฉลี่ยแตกตาง (นอยกวา) กับตําแหนงหัวหนางาน และพนักงาน

ตําแหนงหัวหนางานมีประสบการณกอนทํางานโดยเฉลี่ยแตกตาง (มากกวา) กับตําแหนงผูจัดการ อยางมี

นัยสําคัญทางสถิติ สวนกลุมตัวอยางพนังงานตําแหนงเจาหนาท่ีปฏิบัติงานมีประสบการณกอนทํางานไม

แตกตางกับตําแหนงผูจัดการ หรือกลาวไดวา กลุมตัวอยางพนักงานตําแหนงหัวหนางานมีประสบการณ

กอนทํางานโดยเฉลี่ยมากกวาตําแหนงเจาหนาท่ีปฏิบัติงานและผูจัดการ 

#2 

ตารางคาเฉลี่ยเงินเดือนปจจุบันของพนักงาน 

ตําแหนงงาน จํานวน คาเฉล่ียของเงินเดือนปจจุบัน (ดอลลารสหรัฐ) S.D. 

เจาหนาท่ีปฏิบัติงาน 363 27,838.54 7,567.995 

หัวหนางาน 27 30,938.89 2,114.616 

ผูจัดการ 84 63,977.80 18,244.776 

รวม 474 34,419.57 17,075.661 

F = 434.481, df = 2, Sig. = .000, Levene Statistic = 59.733, df1=2, df2=471, Sig. = .000 

 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานจํานวน 474 คน 

ตําแหนงงานท่ีมีเงินเดือนปจจุบันเฉลี่ยสูงสุดคือ ตําแหนงผูจัดการ รองลงมาเปน หัวหนางาน และ

ตําแหนงท่ีมีเงินเดือนปจจุบันเฉลี่ยต่ําท่ีสุด คือ ตําแหนงเจาหนาท่ีปฏิบัติงาน จากการทดสอบเปรียบ

คาเฉลี่ยของเงินเดือนปจจุบันดวยวิธีการทางสถิติ พบวา พนักงานท่ีมีตําแหนงงานแตกตางกันอยางนอย 1 

คู จะมีเงินเดือนปจจุบันเฉลี่ยแตกตางกัน อยางมีนัยสําคัญทางสถิติ และจากการทดสอบความแปรปรวน

ระหวางกลุมพบวา คาเฉลี่ยของเงินเดือนปจจุบันมีความแปรปรวนแตกตางกัน จึงทําการทดสอบความ

แตกตางของคาเฉลี่ยรายคู (Post Hoc Tests) ดวยวิธีของทามเฮน (Tamhane's Method)  

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบคาเฉลี่ยเงินเดือนปจจุบันของพนักงานท่ีมีตําแหนงแตกตางกัน 

เงินเดือนปจจุบัน 

(คาเฉลี่ย) 

เจาหนาท่ีปฏิบัติงาน 

($27,838.54) 

หัวหนางาน 

($30,938.89) 

ผูจัดการ 

($63,977.80) 

เจาหนาท่ีปฏิบัติงาน 

($27,838.54) 
- -$3,100.349* -$36,139.258* 
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เงินเดือนปจจุบัน 

(คาเฉลี่ย) 

เจาหนาท่ีปฏิบัติงาน 

($27,838.54) 

หัวหนางาน 

($30,938.89) 

ผูจัดการ 

($63,977.80) 

หัวหนางาน 

($30,938.89) 
 - -$33,038.909* 

ผูจัดการ 

($63,977.80) 
  - 

* มีคาความนาจะเปน (Sig.) = .000 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา กลุมตัวอยางท่ีเปนพนักงานตําแหนงงานเปน

เจาหนาท่ีปฏิบัติงาน มีเงินเดือนปจจุบันเฉลี่ยนอยกวา กลุมตัวอยางพนักงานท่ีมีตําแหนงงานเปนหัวหนา

งานและผูจัดการ และกลุมตัวอยางพนักงานท่ีมีตําแหนงงานเปนหัวหนางานมีเงินเดือนปจจุบันเฉลี่ยนอย

กวา กลุมตัวอยางพนักงานท่ีมีตําแหนงงานเปนผูจัดการ อยางมีนัยสําคัญทางสถิติ ดังนั้นจึงสรุปไดวา กลุม

ตัวอยางพนักงานท่ีมีตําแหนงงานแตกตางกัน มีเงินเดือนปจจุบันเฉลี่ยแตกตางกันทุกตําแหนง 
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5. การทดสอบความสมัพันธรายคูแบบเพียรสัน  

การทดสอบความสัมพันธรายคูแบบเพียรสัน (Pearson’s Correlation) คือ การวัดความสัมพันธ

เชิงเสนตรง (linear relationship) จากคาสัมประสิทธิ์สหสัมพันธ (correlation coefficient) ระหวางคู

ตัวแปร (2 ตัวแปร) ท่ีเปนตัวแปรแบบคาตอเนื่อง (continuous variables) จะมีความสัมพันธกันอยางมี

นัยสําคัญทางสถิติหรือไม เพ่ืออธิบายความเขม/ขนาด (strength) และทิศทาง (direction)  

ความสัมพันธเชิงเสนตรง คือ ลักษณะของความสัมพันธระหวางตัวแปรเม่ือตัวแปรหนึ่งมีการ

เปลี่ยนแปลงจะมีความเก่ียวของกับสัดสวนการเปลี่ยนแปลงในอีกตัวแปรหนึ่ง 

การทดสอบแบบนี้อาจมีชื่อเรียกในชื่ออ่ืน เชน Pearson correlation coefficient, Pearson’s 

correlation และ Pearson product-moment correlation (PPMC) 

การแปรผลคาความสัมพันธ ข้ึนอยู กับบริบท (context) และจุดประสงค/ความตองการ 

(purposes) คา  r = .90 อาจสูงมากในสาขาวิชาดานสังคมศาสตร แตอาจมีคาต่ํามากในสาขาวิชาฟสิกส

ท่ีมีการใชเครื่องมือวัดท่ีมีคุณภาพสูง (Araújo Jr, A.H.A. et al., 2011) คาท่ีคํานวณไดอาจมีคาเปน + 

หรือ – แสดงถึงความสัมพันธท่ีแตกตางกันดังนี้  

คา r เปน + แสดงวา ตัวแปรท้ังสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) มีความสัมพันธใน

ทิศทางเดียวกัน 

คา r เปน – แสดงวา ตัวแปรท้ังสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) มีความสัมพันธใน

ทิศทางตรงกันขาม 

คา r เปน 0 แสดงวา ตัวแปรท้ังสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) ไมมีความสัมพันธกัน

เลย 

คา r มีคาเขาใกล 1 แสดงวา ตัวแปรท้ังสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) มี

ความสัมพันธกันมาก 

คา r มีคาเขาใกล 0 แสดงวา ตัวแปรท้ังสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) มี

ความสัมพันธกันนอย 
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ตารางท่ี 12.1 การแปลคาสัมประสิทธิ์สหสัมพันธแบบเพียรสัน 

คาสัมประสิทธิ์สหสัมพันธ (Correlation Coefficient) 

คาของความสัมพันธ ความเขมและทิศทางของความสัมพันธ 

1.00 ถึง .80 มีความสัมพันธเชิงบวกระดับมากอยางยิ่ง 

.79 ถึง .60 มีความสัมพันธเชิงบวกระดับมาก 

.59 ถึง .40 มีความสัมพันธเชิงบวกระดับปานกลาง 

.39 ถึง .20 มีความสัมพันธเชิงบวกระดับนอย 

.19 ถึง .01 มีความสัมพันธเชิงบวกระดับนอยมาก 

.00 ไมมีความสัมพันธ 

-.01 ถึง -.19 มีความสัมพันธเชิงลบระดับนอยมาก 

-.39 ถึง -.20 มีความสัมพันธเชิงลบระดับนอย 

-.59 ถึง -.40 มีความสัมพันธเชิงลบระดับปานกลาง 

-.79 ถึง -.60 มีความสัมพันธเชิงลบระดับมาก 

-1.00 ถึง .-80 มีความสัมพันธเชิงลบระดับมากอยางยิ่ง 

ปรับปรุงมาจาก: Evans, J. D. (1996). Straightforward statistics for the behavioral sciences. 

Pacific Grove, CA: Brooks/Cole Publishing. 
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5.1 การทดสอบความสมัพันธแบบงาย  

 การทดสอบความสัมพันธแบบงาย (Simple correlation) คือ การทดสอบความสัมพันธของ

ขอมูล 1 คู เชน การวิเคราะหหาความสัมพันธระหวางประสบการณกอนทํางานกับเงินเดือนเริ่มตน 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา ประสบการณกอนการทํางานกับ

เงินเดือนเริ่มตนของพนักงานมีความสัมพันธกันหรือไม 

5.1.2 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวิจัย 1. กลุมตัวอยางไดมาจากประชากรท่ีทราบจํานวน (know population) โดย

การสุมตัวอยางแบบสุมท่ีเปนอิสระจากกัน (independence random 

sampling) 

 2. มีตัวแปรอิสระ (independent variable) 1 ตัว และตัวแปรตาม 

(dependent variable) 1 ตัว 

 3. ตัวแปรอิสระและตัวแปรตามเปนตัวแปรแบบคาตอเนื่อง (continuous 

variable) 

การวิเคราะหขอมูล 1. ขอมูลมีการแจกแจงแบบปกติท้ังสองตัวแปร (bivariate normal 

distribution) 

 2. ขอมูลมีความคงท่ีของความแปรปรวนของคาความคาดเคลื่อน 

(homoscedasticity) ถา n = 30 หรือมากกวา ไมตองทดสอบ 

 3. ขอมูลท้ัง 2 ตัวแปร ไมมีคาสูญหาย (missing values) 

 4. ขอมูลมีความสัมพันธเชิงเสนตรง (linear relationship) 

5.1.3 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

<-> 

ตัวแปรตาม 

คาตอเนื่อง  คาตอเนื่อง 

ประสบการณกอนทํางาน (prevexp) เงินเดือนเริ่มตน (salbegin) 
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5.1.4 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงคาเฉลี่ยของประสบการณกอนทํางาน และเงินเดือนเริ่มตน 

ตัวแปร จํานวน คาเฉล่ีย S.D. 

ประสบการณกอนทํางาน (เดือน) 474 95.86 104.586 

เงินเดือนเริ่มตน (ดอลลารสหรัฐ ) 474 17,016.09 7,870.638 

 จากตารางท่ี (#) แสดงใหเห็นวา พนักงาน 474 คน มีประสบการณกอนทํางานเฉลี่ย 95.86 

เดือน และมีเงินเดือนเริ่มตนเฉลี่ย 17,016.09 ดอลลารสหรัฐ  

 จากขอมูลท่ีกลาวมานาจะมีความสัมพันธระหวางตัวแปรประสบการณกอนทํางานและเงินเดือน

เริ่มตน ดังนั้นจึงทําการทดสอบความสัมพันธรายคูโดยมีสมมติฐานดังนี้ 

 H0: ไมมีความสัมพันธระหวางประสบการณกอนทํางานกับเงินเดือนเริ่มตนของพนักงาน 

 H1: มีความสัมพันธระหวางประสบการณกอนทํางานกับเงินเดือนเริ่มตนของพนักงาน 

 เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธดวยวิธีของเพียรสันไดคาความ

นาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แตหากไดคา

ความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 

และยอมรับสมมติฐาน H1 

 

 

 

 

 

 



272 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

5.1.5 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Bivariate Correlation… 

o เลือกตัวแปรคาตอเนื่อง (continuous variables) 2 ตัวแปร จากรายการตัวแปรในชอง

ดานซาย -> ชองดานขวา  

o ในกลุมคําสั่ง Test of Significance เลือกประเภทการทดสอบนัยสําคัญ  

- Two-tailed (สมมติฐานแบบสองหาง r = 0) 

- One-tailed (สมมติฐานแบบหางเดียว r > 0 หรือ r < 0) 

o Flag significant correlations (แสดงเครื่องหมาย * หากมีความสัมพันธอยาง

นัยสําคัญทางสถิติ) เลือก /   

o คลิกปุม OK 

 

5.1.6 ผลการวิเคราะห 
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5.1.7 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบความสัมพันธระหวางประสบการณกอนทํางานกับเงินเดือนเริ่มตน 

ตัวแปร จํานวน เงินเดือนเริ่มตน (r) Sig. (2-tailed) 

ประสบการณกอนทํางาน (เดือน) 474 .05 .327 

5.1.8 การแปลผลและสรุป 

จากการทดสอบสมมติฐานดวยการวิเคราะหคาสัมประสิทธิ์สหสัมพันธเพียรสัน พบวา 

ประสบการณกอนทํางานกับเงินเดือนเริ่มตนของพนักงาน มีคาความนาจะเปน (Sig.) = .327 มากกวาคา

นัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงยอมรับสมมติฐาน H0  

สรุป ไมมีความสัมพันธระหวางประสบการณกอนทํางานกับเงินเดือนเริ่มตนของพนักงาน  

5.2 การทดสอบความสมัพันธแบบหพุ  

 การทดสอบความสัมพันธแบบพหุ (Multiple correlation) คือ การทดสอบความสัมพันธของ

ขอมูลรายคูมากกวา 1 คู เชน การวิเคราะหหาความสัมพันธระหวางระดับการศึกษากับเงินเดือนเริ่มตน 

ประสบการณกอนทํางานกับเงินเดือนเริ่มตน   

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา ระดับการศึกษาและประสบการณ

กอนทํางานของพนักงานมีความสัมพันธกับเงินเดือนเริ่มตนหรือไม และเงินเดือนเริ่มตนและระยะเวลา

ทํางานของพนักงานมีความสัมพันธกับเงินเดือนปจจุบันหรือไม 
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5.2.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวิจัย 1. กลุมตัวอยางไดมาจากประชากรท่ีทราบจํานวน (know population) โดย

การสุมตัวอยางแบบสุมท่ีเปนอิสระจากกัน (independence random 

sampling) 

 2. มีตัวแปรอิสระ (independent variable) อยางนอย 1 ตัว และตัวแปร

ตาม (dependent variable) อยางนอย 1 ตัว 

 3. ตัวแปรอิสระและตัวแปรตามเปนตัวแปรแบบคาตอเนื่อง (continuous 

variable) 

การวิเคราะหขอมูล 1. ขอมูลมีการแจกแจงแบบปกติท้ังสองตัวแปร (bivariate normal 

distribution) 

 2. ขอมูลมีความคงท่ีของความแปรปรวนของคาความคาดเคลื่อน 

(homoscedasticity) ถา n = 30 หรือมากกวา ไมตองทดสอบ 

 3. ขอมูลมีความสัมพันธเชิงเสนตรง (linear relationship) 

5.2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

<-> 

ตัวแปรตาม 

คาตอเนื่อง  คาตอเนื่อง 

ระดับการศึกษา: ป (educ) เงินเดือนเริ่มตน: ดอลลารสหรัฐ (salbegin) 

ประสบการณกอนทํางาน: เดือน (prevexp) เงินเดือนเริ่มตน: ดอลลารสหรัฐ (salbegin) 

เงินเดือนเริ่มตน: ดอลลารสหรัฐ (salbegin) เงินเดือนปจจุบัน: ดอลลารสหรัฐ (salary) 

ระยะเวลาทํางาน: เดือน (jobtime) เงินเดือนปจจุบัน: ดอลลารสหรัฐ (salary) 
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5.2.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงคาเฉลี่ยระดับการศึกษา เงินเดือนเริ่มตน เงินเดือนปจจุบัน ระยะเวลาทํางาน และ

ประสบการณกอนทํางาน 

ตัวแปร จํานวน (คน) คาเฉล่ีย S.D. 

ระดับการศึกษา (ป) 474 13.49 2.89 

เงินเดือนเริ่มตน (ดอลลารสหรัฐ) 474 17,016.09 7,870.64 

เงินเดือนปจจุบัน (ดอลลารสหรัฐ) 474 34,419.57 17,075.66 

ระยะเวลาทํางาน (เดือน) 474 81.11 10.06 

ประสบการณกอนทํางาน (เดือน) 474 95.86 104.59 

 จากตารางท่ี (#) แสดงใหเห็นวา พนักงาน 474 คน มีการศึกษาเฉลี่ย 13.49 ป มีเงินเดือนเริ่มตน

เฉลี่ย 17,016.09 ดอลลารสหรัฐ  มีเงินเดือนปจจุบันเฉลี่ย 34,419.57 ดอลลารสหรัฐ  มีระยะเวลา

ทํางานเฉลี่ย 81.11 เดือน และมีประสบการณกอนทํางานเฉลี่ย 65.86 เดือน   

 จากขอมูลท่ีกลาวมานาจะมีความสัมพันธระหวางตัวแปรบางคู ดังนั้นจึงทําการทดสอบ

ความสัมพันธรายคูโดยมีสมมติฐานดังนี้ 

 H1: มีความสัมพันธระหวางระดับการศึกษากับเงินเดือนเริ่มตนของพนักงาน 

 H2: มีความสัมพันธระหวางประสบการณกอนทํางานกับเงินเดือนเริ่มตนของพนักงาน 

 H3: มีความสัมพันธระหวางเงินเดือนเริ่มตนกับเงินเดือนปจจุบันของพนักงาน 

 H4: มีความสัมพันธระหวางระยะเวลาทํางานกับเงินเดือนปจจุบันของพนักงาน 

 เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธดวยวิธีของเพียรสัน ไดคา

ความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H1 , H2 , H3 

และ H4 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะ

ยอมรับสมมติฐาน H1 , H2 , H3 และ H4 
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5.2.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เมนู Analyze -> Bivariate Correlation… 

o เลือกตัวแปรคาตอเนื่อง (continuous variables) 3 ตัวแปร หรือมากกวา จาก

รายการตัวแปรในชองดานซายใสในชองดานขวา  

o ในกลุมคําสั่ง Test of Significance เลือกประเภทการทดสอบนัยสําคัญ  

- Two-tailed (สมมติฐานแบบสองหาง) 

- One-tailed (สมมติฐานแบบหางเดียว) 

o Flag significant correlations (แสดงเครื่องหมาย * หากมีความสัมพันธอยาง

นัยสําคัญทางสถิติ) เลือก /  

o คลิกปุม OK 

 

5.2.5 ผลการวิเคราะห 
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5.2.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบความสัมพันธระหวางระดับการศึกษา ประสบการณกอนทํางาน 

เงินเดือนเริ่มตน ระยะเวลาทํางาน และเงินเดือนปจจุบัน 

ความสัมพันธระหวางตัวแปร จํานวน r Sig. (2-tailed) 

ระดับการศึกษา เงินเดือนเริ่มตน 474 .63 .000 

ประสบการณกอนทํางาน เงินเดือนเริ่มตน 474 .05 .327 

เงินเดือนเริ่มตน เงินเดือนปจจุบัน 474 .88 .000 

ระยะเวลาทํางาน เงินเดือนปจจุบัน 474 .08 .067 

5.2.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา ระดับการศึกษากับเงินเดือนเริ่มตนของพนักงาน 

และเงินเดือนเริ่มตนและเงินเดือนปจจุบัน มีคาความนาจะเปน (Sig.) = .000 นอยกวาคานัยสําคัญทาง

สถิติท่ีกําหนดไว (α = .05) สวนประสบการณกอนทํางานและเงินเดือนเริ่มตน มีคานัยสําคัญทางสถิติ 

(Sig.) = .327 มากกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) และระยะเวลาทํางานกับเงินเดือน

ปจจุบัน มีคานัยสําคัญทางสถิติ (Sig.) = .067 มากกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึง

ยอมรับสมมติฐาน H1 และ H3 แตปฏิเสธสมมติฐาน H2 และ H4  

สรุป การศึกษาของพนักงานมีความสัมพันธเชิงบวกระดับปานกลางกับเงินเดือนเริ่มตน เงินเดือน

เริ่มตนของพนักงานมีความสัมพันธเชิงบวกระดับปานกลางกับเงินเดือนปจจุบันของพนักงาน (พนักงานท่ี

มีระดับการศึกษาสูงจะไดรับเงินเดือนเริ่มตนสูงกวาพนักงานท่ีมีการศึกษาต่ํากวา และพนักงานท่ีไดรับ

เงินเดือนเริ่มตนสูงจะไดรับเงินเดือนปจจุบันสูงกวาพนักงานท่ีไดรับเงินเดือนเริ่มตนต่ํากวา) 

สรุป 

   การทดสอบแบบอิงคาพารามิเตอรมีคาตัวเลขทางประชากรท่ีใชในการอางอิงไปสูคุณลักษณะ 

(characteristics) ของประชากร กอนใชการทดสอบแบบอิงคาพารามิเตอรตองทําการตรวจสอบขอตกลง

เบื้องตนของการทดสอบแตละวิธี การละเมิดขอตกลงบางครั้งอาจไมมีผลตอขอสรุปหรือผลการวิเคราะห

แตอยางไร แตบางครั้งอาจมีผลตอการแปลความหมายเปนอยางมากและอาจทําใหไดขอสรุปท่ีไมถูกตอง 



278 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

แบบฝกหัดทายบท 

ใหผูเรียนเปดแฟมขอมูล 1991 US. General Social Survey.sav แลวประมวลผลขอมูล เพ่ือ

ทดสอบและแปลผล ดังนี้ 

1. การทดสอบคาเฉลี่ย 1 กลุม และ 2 กลุม 

   1.1 วิเคราะหและอธิบายผล โดยการทดสอบเปรียบเทียบวา กลุมตัวอยางมีพ่ีนอง (sib) 

มากกวาหรือนอยกวา 4 คน  

   1.2 วิเคราะหและอธิบายผล โดยการทดสอบเปรียบเทียบวา กลุมตัวอยางท่ีอยูภาค (region) 

ตะวันออกกับตะวันตก (สรางตัวแปรใหมเปนตัวแปร region_group) มีพ่ีนอง (sibs) แตกตางกันหรือไม  

   1.3 วิเคราะหและอธิบายผล โดยการทดสอบเปรียบเทียบวา การศึกษาของบิดา (paeduc) 

และมารดา (maeduc) แตกตางกันหรือไม  

2. การทดสอบคาเฉลี่ยของกลุมตัวอยางมากกวา 2 กลุม 

วิเคราะหเปรียบคาเฉลี่ย ทดสอบสมมติฐาน และทดสอบเปรียบเทียบคาเฉลี่ยรายคูคะแนน

ความมีเกียรติในอาชีพ (prestg80) ของคนในแตละภูมิภาค (region) 

3. สหสัมพันธแบบเพียรสัน 

   3.1 วิเคราะหและอธิบายผลความสัมพันธแบบงายระหวางการศึกษาของผูตอบ (edu) และ

จํานวนพ่ีนอง (sibs)  

   3.2 วิเคราะหและอธิบายผลความสัมพันธแบบพหุระหวางการศึกษาของผูตอบ (edu) กับ

จํานวนพ่ีนอง (sibs) และจํานวนบุตร (childs) 

  



 

 

บทที่ 13 

การทดสอบขอมูลแบบไมอิงคาพารามิเตอร (1 ตัวแปร) 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถใชโปรแกรมประมวลผลทดสอบขอมูลของตัวแปร 1 ตัวแปร ดวยสถิติเชิงอางอิง

แบบไมอิงคาพารามิเตอร และเขียนบรรยายผลการทดสอบได 

เน้ือหา 

1. การทดสอบการแจกแจงของตัวอยาง 

2. การทดสอบสัดสวนของตัวอยาง 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และ

ประเมินจากการทําแบบฝกหัดทายบท  
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เนื้อหา 

การทดสอบขอมูลดวยสถิติเชิงอางอิงหากขอมูลมีลักษณะหนึ่งดังตอไปนี้ คือ มีจํานวนตัวอยาง

นอยกวา 30 ตัวอยาง หรือเปนกลุมตัวอยางขนาดเล็ก (small sample size) ขอมูลมีการแจกแจงไมปกติ 

ขอมูลเปนมาตราแบบจัดกลุมหรือจัดอันดับ ขอมูลมีคาผิดปกติ (outlier) ท่ีไมสามารถกําจัดออกไปได 

ควรตัดสินใจเลือกการทดสอบแบบไมอิงคาพารามิเตอร (non-parametric test) หรือการทดสอบแบบ

แจกแจงอิสระ (distribution-free test) การฝนใชการทดสอบแบบอิงคาพารามิเตอรโดยละเมิดขอตกลง

เบื้องตนมีความเสี่ยงทําใหผลลัพธและขอสรุปท่ีไมถูกตองตามมา 

การทดสอบขอมูลแบบไมอิงพารามิเตอร สมมติฐานไมมีความเก่ียวของกับคาพารามิเตอรของ

ประชากร (population parameters) เชน สมมติฐานหลัก μ=50 เปนการเปรียบเทียบขอมูลของ

ตัวอยางท่ีไดมาจากประชากรกับคาอางอิงท่ีใชในการทดสอบวาเทากันหรือไมเทากัน หรือ μ1=μ2 เปน

การเปรียบเทียบตําแหนงของขอมูลระหวาง 2 กลุมตัวอยางมีแนวโนมเขาสูสวนกลาง (central 

tendency) เหมือนกันหรือแตกตางกัน 

แมวาการทดสอบดวยสถิติแบบไมอิงคาพารามิเตอรจะเปนอิสระจากขอตกลง (assumption-

free test) แตมีขอตกลงท่ัวไป (common assumptions) ดังนี้ (Verma, & Abdel-Salam, 2019: 141-

142) 

1. ความเปนสุมหรือความไมเปนแบบแผน (Randomness) คือ กลุมตัวอยางไดมาจากประชากร

แบบสุม (random sampling) หรือเลือกแบบปราศจากความลําเอียง (bias)   

2. ความเปนอิสระ ( Independence) คือ คาสั ง เกตแตละคา มีความเปนอิสระจากกัน 

(independence of observations) หรือคาสังเกตไดมาจากแตละตัวอยางท่ีมีความเปนอิสระจากกัน ไม

ไดมาจากบุคคลท่ีเปนคนเดียวกัน (independent sample) 

การทดสอบแบบอิงคาพารามิเตอรมีวิธีการทดสอบขอมูล 1 ตัวแปร คือ การทดสอบคาเฉลี่ยของ

กลุมตัวอยาง 1 กลุม (One-sample t-test) ใชสําหรับทดสอบกับคาทดสอบ (value test) ท่ีเปนคาเฉลี่ย

จากประชากรท่ีทราบจํานวน (know populations) สวนการทดสอบแบบไมอิงคาพารามิเตอรมีการ

ทดสอบขอมูล 1 ตัวแปรเชนกัน แตเปนการทดสอบการแจกแจงของขอมูล (มีการแจกแจงปกติหรือไม มี
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การแจกแจงเปนไปอยางสุมหรือไม) และการทดสอบสัดสวน (เปรียบเทียบสัดสวนระหวางกลุมตัวอยาง 

เชน กลุมตัวอยางมีสัดสวนระหวางเพศชายกับเพศหญิงเชนเดียวกับสัดสวนประชากรของประเทศหรือไม)  

1. การทดสอบการแจกแจงของขอมูล 

 การทดสอบการแจกแจงขอมูล (Distribution Tests)  คือ การทดสอบลักษณะขอมูลของกลุม

ตัวอยางท่ีไดมาจากประชากรมีการแจกแจงปกติ (normal distributions) หรือไม และมีการแจกเปนไป

อยางสุม (randomness) หรือไม  

1.1 การทดสอบการแจกแจงของขอมูลแบบรันส  

 การทดสอบการแจกแจงขอมูลแบบรันส (Runs test/ Wald–Wolfowitz runs test) คือ การ

ทดสอบขอมูลภายในกลุม (one group) และระหวางกลุม (two group) ของกลุมตัวอยางท่ีมีลักษณะ

การจัดเรียง (sequence) มีการแจกแจงเปนไปอยางสุมหรือไม (randomness) โดยใชคามัธยฐาน 

(median) คาฐานนิยม (mode) คาเฉลี่ย (mean) และคาท่ีผูทดสอบกําหนดเอง (custom) 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา ระดับการศึกษาของพนักงาน

มีการแจกแจงแบบสุมหรือไม 

1.1.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ขอมูลไดมาจากการสุมตัวอยางแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample) 

 2. ขอมูลเปนตัวแปรแบบสองประเภท (dichotomous variables)  

การวิเคราะหขอมูล ขอมูลประเภทตัวอักษร (string data) ตองแปลงคา (recode) ใหเปนขอมูล

ประเภทตัวเลข (numeric data) 
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1.1.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

คาตอเนื่อง การแจกแจงขอมูล 

การศึกษา: ป (educ) แจกแจงแบบสุม 

1.1.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

จากขอมูลท่ีทําการสํารวจจากพนักงานในหนวยงาน ผูวิจัยตองการทราบวา ขอมูลการศึกษาของ

พนักงานมีการแจกแจงแบบสุมหรือไม โดยมีสมมติฐานดังนี้ 

 H0: ขอมูลการศึกษาของพนักงานมีการแจกแจงแบบสุม 

H1: ขอมูลการศึกษาของพนักงานมีการแจกแจงแบบไมสุม 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบการแจกแจงขอมูลแบบรันส (Runs Test) 

ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แต

หากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธ

สมมติฐาน H0 และยอมรับสมมติฐาน H1 

1.1.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดเมนู File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> Runs … 

o Test Variable List: เลือกตัวแปรทดสอบท่ีเปนตัวแปรแบบคาจัดประเภทหรือตัวแปร

แบบคาตอเนื่อง 1 ตัวแปร จากรายการตัวแปรดานซาย  

o Cut Point: กําหนดกลุมวิธีการแบงกลุมในกลุมคําสั่ง  

o กดปุม OK 
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1.1.5 ผลการวิเคราะห 

 

1.1.6 การสรางตารางแสดงผลการทดสอบ 

ตารางผลการทดสอบรันสแบบฐานนิยม (Mode) 

 ระดับการศึกษา (ป) 

คาทดสอบ (Test Value) 12 

จํานวนตัวอยางท่ีมีคานอยกวาคาทดสอบ (Cases < Test Value) 53 

จํานวนตัวอยางท่ีมีคามากกวาหรือเทากับคาทดสอบ (Cases >= Test Value) 421 

จํานวนตัวอยางท้ังหมด (Total Cases) 474 

จํานวนของรันส (Number of Runs) 97 

Z .430 

Asymp. Sig. (2-tailed) .667 

1.1.7 การแปลผลและสรุป 

 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Asymp. Sig.) = .667 มีคา

มากกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงยอมรับสมมติฐาน H0  

สรุป ขอมูลการศึกษาของพนักงานมีการแจกแจงเปนไปอยางสุม การทดสอบการแจกแจงขอมูล

ความเปนสุมของขอมูลตัวแปรการศึกษาของพนักงานมีคาทดสอบ (ระดับการศึกษา) ท่ี 12 ป แสดงวา 

จํานวนตัวอยางท่ีมีคานอยกวาคาทดสอบมีจํานวน 53 คน จํานวนตัวอยางท่ีมีคามากกวาหรือเทากับคา

ทดสอบมีจํานวน 421 คน ระดับการศึกษาท่ีอยูตรงกลางของผูตอบแบบสอบถามหรือมีคาฐานนิยม 

(mode) 12 ป และจากคาการทดสอบแสดงใหเห็นวา ผูตอบแบบสอบถามมีการศึกษาต่ํากวา 12 ป 

จํานวน 53 คน และมีการศึกษาเทากับและมากกวา 12 ป มีจํานวน 421 คน  
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1.2 การทดสอบการแจกแจงของขอมูลแบบคอลมอโกรอฟ-สเมอรนอฟ  

 การทดสอบการแจกแจงขอมูลแบบคอลมอโกรอฟ-สเมอรนอฟ (Kolmogorov-Smirnov: K-S 

Test) คือ การทดสอบการแจกแจงขอมูลแบบสะสม (cumulative distributions) ระหวางขอมูลท่ีได

จากการสังเกต (observed) กับการแจกแจงเชิงทฤษฎี (theoretical) ซ่ึงอาจเปนการแจกแจงแบบปกติ 

(normal/gaussian distribution) 18

19 การแจกแจงแบบเอกรูปหรือส มํ่าเสมอหรือสี่ เหลี่ยมผืนผา 

(uniform/rectangular distribution) 19

20 การแจกแจงแบบปวซอง (poisson distribution)21 การแจก

แจงแบบเอ็กโปเนนเชียลหรือแบบเลขชี้กําลัง (exponential distribution)21

22 

  
 

 

การแจกแจงแบบปกติ การแจกแจงแบบเอกรูป การแจกแจงแบบปวซอง การแจกแจงแบบเลขยกกําลัง 

รูปท่ี 13.1 การแจกแจงความถ่ี 

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา เงินเดือนเริ่มตนของพนักงาน

ในหนวยงานมีการแจกแจงแบบปกติหรือไม 

                                                           
19 การแจกแจงของขอมูลจากเหตุการณที่เกิดซ้ํา ๆ กัน 
20 การแจกแจงของขอมูลจากเหตุการณที่เกิดข้ึนเหมือน ๆ กัน หรือแตละเหตุการณมีชวงเทากัน เชน จํานวนสมาชกิเฉลี่ยของแตละ
ครอบครัว หรือจํานวนน้ําหนักเฉลี่ยที่เพ่ิมข้ึนของแตละคนในฤดูหนาว (ประมาณ 0-30 ปอนด) 
21 การแจกแจงของขอมูลจากหลายเหตุการณและไมตอเนื่องกันหรือเปนอิสระจากกัน เชน จํานวนรถยนตที่ผานดานแตละนาท ี
22 การแจกแจงของขอมูลจากเหตุการณที่เกิดข้ึนแบบสะสมตั้งแตเร่ิมตนจนถึงเกิดเหตุการณ เชน จํานวนเงินที่เก็บสะสม ระยะเวลาการ
เกิดแผนดินไหม 
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1.2.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ขอมูลไดมาจากการสุมตัวอยางแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample) 

 2. ขอมูลเปนตัวแปรแบบคาตอเนื่อง (continuous variable) หรือตัวแปรแบบ

มาตราจัดอันดับ (ordinal variable) บางตําราบอกวา ตัวแปรมาตราแบบจัด

กลุม (nominal variable) 

การวิเคราะหขอมูล - 

1.2.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

คาตอเนื่อง การแจกแจงของขอมูล 

เงินเดือนเริ่มตน: ดอลลาร (salbegin) แจกแจงแบบปกติ 

1.2.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

จากขอมูลท่ีทําการสํารวจจากพนักงานในหนวยงาน ผูวิจัยตองการทราบวา ขอมูลเงินเดือน

เริ่มตนของพนักงานมีการแจกแจงปกติหรือไม โดยมีสมมติฐานดังนี้ 

 H0: ขอมูลเงินเดือนเริ่มตนของพนักงานมีการแจกแจงปกติ 

 H1: ขอมูลเงินเดือนเริ่มตนของพนักงานมีการแจกแจงไมปกติ 

 เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบการแจกแจงของขอมูลแบบคอลมอโกรอฟ-

สเมอรนอฟ  (Kolmogorov-Smirnov Test: K-S Test) ไดคาความนาจะเปน (p-value) มากกวาคา

นัยสําคัญทางสถิติ (α = .05) จะยอมรบัสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวา

หรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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1.2.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> 1-Sample K-S… 

o Test Variable List: เลือกตัวแปรทดสอบท่ีเปนตัวแปรแบบคาตอเนื่อง 1 ตัวแปร หรือ

หลายตัวแปร จากรายการตัวแปรดานซาย  

o ในกลุมคําสั่ง Test Distribution เลือกสถิติ Normal 

o กดปุม OK 

 

1.2.5 ผลการวิเคราะห 
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1.2.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบขอมูล 1 กลุม แบบคอลมอโกรอฟ-สเมอรนอฟ 

  เงินเดือนเริ่มตน (ดอลลาร) 

จํานวน (N)  474 

คาพารามิเตอรการทดสอบการแจกแจง

ปกติ (Normal Parameters) 

คาเฉลี่ย (Mean) 

คาเบี่ยงเบนมาตรฐาน  

(Std. Deviation) 

17,016.09 

7,870.64 

 

ความแตกตางของคาโตงมากท่ีสุด  

(Most Extreme Differences) 

คาสัมบูรณ (Absolute) 

คาบวก (Positive) 

คาลบ (Negative) 

.25 

.25 

-.170 

Kolmogorov-Smirnov Z  5.48 

Asymp. Sig. (2-tailed)  .000 

1.2.7 การแปลผลและสรุป 

 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Asymp. Sig.) = .000 มีคา

นอยกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป ขอมูลเงินเดือนเริ่มตนของพนักงานมีการแจกแจงไมปกติ 
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2. การทดสอบสดัสวนของกลุมตัวอยาง 

 การทดสอบสัดสวนของกลุมตัวอยาง  (Sample Proportion Test) คือ การทดสอบสัดสวนของ

ขอมูลจากตัวอยางกับสัดสวนท่ีแทจริงของประชากรท้ังหมดหรือคาอางอิง สมมติฐานในการทดสอบอาจ

ระบุเปนสัดสวน (proportions) แตกตาง (difference) อัตราสวน (ratio) หรืออัตราสวนท่ีจะเกิด (odds 

ratio) 

2.1 การทดสอบความแนบสนิทแบบไค-สแควร 

 การทดสอบความแนบสนิทแบบไค-สแควร (X2 goodness of fit) คือ การทดสอบสัดสวนของ

กลุมตัวอยาง 2 กลุม หรือมากกวา 2 กลุม ท่ีไดจากการสังเกต (observed value) กับคาท่ีคาดหวัง 

(expected value) หรือคาตามทฤษฎี  

ตัวอยางของขอมูล เชน ตําแหนงงาน มีคําตอบคือ เจาหนาท่ีปฏิบัติงาน หัวหนางาน และ

ผูจัดการ ตัวแปรการศึกษา มีคําตอบคือ ประถมศึกษา มัธยมศึกษา และอุดมศึกษา ตัวแปรศาสนา มี

คําตอบคือ พุทธ คริสต และอิสลาม เปนตน 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา พนักงานของหนวยงานมีสัดสวน

ของตําแหนงงานเทากันหรือไม 

2.1.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ขอมูลไดมาจากการสุมตัวอยางแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample) 

 2. มีคาสังเกตอยางนอย 5 ตัวอยาง ในแตละระดับของตัวแปร (level of the 

variable) 

 3. ตัวแปรเปนตัวแปรแบบคาจัดประเภท (categorical variables) 1 ตัวแปร  

การวิเคราะหขอมูล - 
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2.1.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

คาจัดประเภท สัดสวน 

ตําแหนงงงาน (Jobcat) 

- เจาหนาท่ีปฏิบัติงาน 

- หัวหนางาน 

- ผูจัดการ 

เทากัน (Equal) หรือ 

ไมเทากัน (Unequal) 

2.1.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

จากตารางท่ี (#) ผลการศึกษาพบวา กลุมตัวอยางมีตําแหนงงานเปนเจาหนาท่ีปฏิบัติงานมาก

ท่ีสุด คือ รอยละ 76.6 รองลงมามีตําแหนงงานเปนผูจัดการ คือ รอยละ 17.7 และมีตําแหนงงานเปน

หัวหนางานนอยท่ีสุด คือ รอยละ 5.7 ดังตารางท่ี (#) 

ตารางท่ี (#) แสดงจํานวนและคารอยละของกลุมตัวอยาง จําแนกตามตําแหนงงาน 

ตําแหนงงาน จํานวน รอยละ 

เจาหนาท่ีปฏิบัติงาน 363 76.6 

หัวหนางาน 27 5.7 

ผูจัดการ 84 17.7 

รวม 474 100.0 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางมีตําแหนงเปนเจาหนาท่ีปฏิบัติงานมากท่ีสุด 

รองลงมาเปนผูจัดการ และเปนหัวหนางานนอยท่ีสุด ดังนั้นจึงทําการทดสอบวา พนักงานแตละตําแหนงมี

สัดสวนเทากันหรือไม โดยมีสมมติฐานดังนี้ 

 H0: สัดสวนของตําแหนงงานเทากัน  หรือ Σ(O - E)2 = 0 

 H1: สัดสวนของตําแหนงงานไมเทากัน หรือ Σ(O - E)2 ≠ 0 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบสัดสวนของขอมูลดวยวิธีไค-สแควร (X2 

Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 
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แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธ

สมมติฐาน H0 และยอมรับสมมติฐาน H1 

2.1.4 การใชโปรแกรมวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee Data.sav 

๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> Chi-square… 

o Test Variable: เลือกตัวแปรทดสอบท่ีเปนตัวแปรแบบจัดประเภท 1 ตัวแปร หรือหลาย

ตัวแปร จากรายการตัวแปรดานซาย  

o ในกลุมคําสั่ง Expected Range กําหนดคาตัวแปรหรือกลุมขอมูล  

- Get from data (ท้ังหมดจากขอมูล) 

- Use specified range (กําหนดชวงขอมูลกรณีเปนตัวแปรแบบคาตอเนื่อง) 

o ในกลุมคําสั่ง Expected Values กําหนดสัดสวน  

- All categories equal (ทุกกลุมเทากัน) 

- Values: (กําหนดสัดสวนในชองวางและเพ่ิมจํานวนใหสัมพันธกับกลุมของตัวแปร เชน มี 

2 กลุม กําหนดเปน 2 คา มี 3 กลุม กําหนดเปน 3 คา) 

o กดปุม OK 

หมายเหตุ คาคาดหวัง (Expected frequencies) มาจากขอมูลในอดีต ความรูท่ีมีอยู  ทฤษฎี หรืองานวิจัย  
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2.1.5 ผลการวิเคราะห 

 

2.1.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบสัดสวนระหวางคาสังเกตและคาคาดหวังของตําแหนงงาน 

ตําแหนงงาน 
คาสังเกต 

(Observed N) 

คาคาดหวัง 

(Expected N) 

สวนเหลือ 

(Residual) 

สถิติทดสอบ 

(Test Statistics) 

เจาหนาท่ีปฏิบัติงาน 363 158.0 205.0 X2 = 409.25 

หัวหนางาน 27 158.0 -131.0 df = 2 

ผูจัดการ 84 158.0 -74.0 Asymp. Sig. = .000 

รวม 474    

2.1.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Asymp. Sig.) = .000 นอย

กวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรปุ ตําแหนงงานของพนักงานมีสัดสวนไมเทากัน 
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2.2 การทดสอบสดัสวนของกลุมตวัอยางแบบทวินาม  

 การทดสอบสัดสวนของกลุมตัวอยาง (Sample Proportion Test) แบบทวินาม (Binomial 

Test) คือ การทดสอบสัดสวนของขอมูลท่ีไดจากการสังเกต (observed value) ของตัวแปรแบบคาจัด

ประเภท 2 ประเภท (dichotomous variables) หรือตัวแปรแบบคาทวิลักษณะ (binary variables) กับ

คาพารามิเตอร ท่ีเปนคาสัดสวนท่ีคาดหวัง (expected value) หรือคาสัดสวนท่ีใชทดสอบ (test 

proportion)   

ตัวอยางคําถามการวิจัย 

จากการสํารวจขอมูลของพนักงานในหนวยงานตองการทราบวา พนักงานมีสัดสวนระหวาง

เพศชายกับเพศหญิงคลองกับสัดสวนประชากรของประเทศหรือไม (ชาย:หญิง = 49:51) 

2.2.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ขอมูลไดมาจากการสุมตัวอยางแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample) 

 2. ตัวแปรเปนตัวแปรแบบคาสองประเภท (dichotomous variables) 

การวิเคราะหขอมูล - 

2.2.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

คาจัดประเภท สัดสวน 

เพศ (gender) 

- ชาย 

- หญิง 

ชาย:หญิง = 49:51 
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2.2.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

จากการสํารวจพนักงานในหนวยงานจํานวน 474 คน ตองการทดสอบวา พนักงานเพศชายกับ

เพศหญิงมีสัดสวนเทากับ 49:51 หรือไม โดยมีสมมติฐานดังนี้ 

 H0: สัดสวนของพนักงานเพศชายกับเพศหญิงเทากับ 49:51 (P1=.49) 

H1: สัดสวนของพนักงานเพศชายกับเพศหญิงไมเทากับ 49:51 (P≠.49) 

เกณฑในการทดสอบสมมุติฐาน คือ หากทดสอบสัดสวนของขอมูลแบบทวินาม (Binomial Test)

ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แต

หากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธ

สมมติฐาน H0 และยอมรับสมมติฐาน H1 

2.2.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav  

 

หมายเหตุ: คําสั่ง Binomial ใชขอมูลท่ีเปนตัวเลข (numeric) แตขอมูลของตัวแปร gender 

เปนขอมูลตัวอักษร (string) 

o สรางตัวแปร gender_n โดยใชคําสั่ง Recode into Different Variables จากตัวแปร 

gender กําหนดใหคา m = 1 และ f = 2  

o กําหนดคาตัวแปร 1 = Male และ 2 = Female 
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๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> Binomial … 

o Test Variable List: เลือกตัวแปรทดสอบท่ีเปนตัวแปรแบบคาจัดประเภทหรือตัวแปร

แบบคาตอเนื่อง 1 ตัวแปร จากรายการตัวแปรดานซาย  

o ในกลุมคําสั่ง Define Dichotomy กําหนดกลุมขอมูล 

- Get from data (เฉพาะตัวแปรท่ีมีคา 2 กลุม) 

- Cut point (ใสคาแบงขอมูลของตัวแปรใหเปน 2 กลุม)  

o Test Proportion: กําหนดสัดสวนในการทดสอบ  

o กดปุม OK 

 

2.2.5 ผลการวิเคราะห 
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2.2.6 การสรางตารางแสดงผลการทดสอบ 

ตาราง (#) แสดงการทดสอบสัดสวนเพศของพนักงาน 

เพศ 
จํานวน  

(N) 

สัดสวนคาสังเกต 

(Observed Prop.) 

สัดสวนการทดสอบ 

(Test Prop.) 
Exact Sig. 

ชาย 258 .54 

.49 .010 หญิง 216 .46 

รวม 474 1.00 

2.2.7 การแปลผลและสรุป 

 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Exact Sig.) = .01 นอยกวา

คานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธรับสมมติฐาน H0 และยอมรับสมมติฐาน H1 

 สรุป สัดสวนของพนักงานเพศชายกับพนักงานเพศหญิงไมเทากับ 49:51 

สรุป 
 การทดสอบขอมูล 1 ตัวแปร คือ การใชคาของตัวแปรหรือขอมูลภายในตัวแปรเดียวท่ีเปนขอมูล

จริงท่ีไดจากการสํารวจหรือเปนขอมูลท่ีมีอยู (observed value) แลวมาทําการทดสอบคาท่ีคาดหวัง 

(expected value) ซ่ึงอาจเปนขอมูลในอดีต ความรูท่ีมีอยู ทฤษฎี หรืองานวิจัย  

แบบฝกหัดทายบท 

ใหผูเรียนเปดแฟมขอมูล 1991 US. General Social Survey.sav แลวประมวลผลขอมูล เพ่ือ

ทดสอบและแปลผล ดังนี้ 

1. เปรียบเทียบกลุมตัวยางแตละภูมิภาค (region) มีสัดสวนท่ีเทากันหรือไม 

2. ใชตัวแปรกลุมชน (race) สรางเปนตัวแปรใหมชื่อ กลุมชนใหม (newrace) มี 2 กลุม คือ ผิวขาว 

และไมใชผิวขาว และเปรียบเทียบวากลุมชนผิวขาวมีสัดสวนเทากับ .72 ของกลุมตัวอยางท้ังหมดหรือไม 

3. ทดสอบขอมูลการศึกษาของผูตอบ (educ) มีการแจกแจงเปนไปอยางสุมหรือไม 

4. ทดสอบขอมูลการศึกษาของผูตอบ (educ) มีการแจกแจงปกติหรือไม 





 

 

บทที่ 14 

การทดสอบขอมูลแบบไมอิงคาพารามิเตอร (2 ตัวแปร) 

ความมุงหมายของบทเรียน 

ผูเรียนสามารถใชโปรแกรมประมวลผลทดสอบขอมูลของตัวแปร 2 ตัวแปร ดวยสถิติเชิงอางอิง

แบบไมอิงคาพารามิเตอร และเขียนบรรยายผลการทดสอบได 

เน้ือหา 

1. การทดสอบความเปนอิสระของกลุมตัวอยาง 

2. การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม 

3. การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม 

4. การทดสอบคากลางของกลุมตัวอยางท่ีไมเปนอิสระจากกัน 2 กลุม 

5. การทดสอบคากลางของกลุมตัวอยางท่ีไมเปนอิสระจากกันมากกวา 2 กลุม 

6. การทดสอบความสัมพันธรายคูแบบสเปยรแมน 

วิธีการสอนและกิจกรรมการเรียนการสอน 

บรรยาย อธิบาย แสดงตัวอยาง ฝกปฏิบัติ ทําแบบฝกหัด แลกเปลี่ยนความคิดเห็น สรุป และ

ทบทวนจากคลิปวีดีโอ 

สื่อและอุปกรณการสอน 

เอกสารคําสอน ภาพเลื่อน คอมพิวเตอร โปรแกรม PSPP โปรแกรมสอนออนไลน (สอนแบบ

ออนไลน) เครื่องฉาย (สอนในชั้นเรียน) หองเรียนเสมือนจริง และคลิปวีดีโอ 

งานท่ีมอบหมาย 

 ทําแบบฝกหัดทายบท 

การวัดผลและประเมินผล 

การเขาชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเขาใจจากการบรรยาย และ

ประเมินจากการทําแบบฝกหัดทายบท  
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เนื้อหา 

การวิเคราะหความสัมพันธระหวางตัวแปรอิสระกับตัวแปรตามหากมีตัวแปรใดตัวแปรหนึ่งเปน

ตัวแปรแบบคาแบงกลุมตองเลือกใชการทดสอบแบบไมอิงคาพารามิเตอรตามลักษณะของตัวแปร

ดังตอไปนี้   

1. การทดสอบความเปนอิสระของกลุมตัวอยาง  

 การทดสอบความเปนอิสระของกลุมตัวอยาง (Test of Independence) คือ การทดสอบความ

แนบสนิท (goodness-of-fit test) โดยใชตารางไขว (contingency table) ทําการทดสอบคาท่ีไดจาก

การสังเกต (observed values) กับคาท่ีคาดหวัง (expected values) หรือคาท่ีควรจะเปนตามทฤษฎี 

เพ่ือตัดสินใจวา คาสังเกตแตละคามีความเปนอิสระจากกันหรือไมเปนอิสระจากกัน 

 การทดสอบความเปนอิสระของกลุมตัวอยางเปนการทดสอบความสัมพันธ (related) ระหวางตัว

แปรท่ีมีระดับการวัดแบบจัดประเภท 2 ตัวแปร เพ่ือดูวาตัวแปร 2 ตัว มีความสัมพันธกันหรือมีความเปน

อิสระจากกันหรือไม มีหลายวิธีดังนี ้

1. ไค-สแควร (Chi-square หรือ X2) ใชวิเคราะหตารางขอมูลท่ีตัวแปรอิสระมีคาเปนขอมูล 2 

กลุม และตัวแปรตามมีคาเปนขอมูล 2 กลุม หรือท่ีเรียกวา ตาราง 2x2 มีสถิติทดสอบดังนี้  

   1.1 ไค-สแควรแบบเพียรสัน (Pearson chi-square) 

   1.2 ไค-สแควรแบบความเปนไปไดหรือความนาจะเปนของอัตราสวน (The likelihood-ratio 

chi-square)     

   1.3 ความเท่ียง/แมนยําของฟชเชอร (Fisher's exact test) 

   1.4 ไค-สแควรแบบแกไขของเยตส (Yates' corrected chi-square) 

2. สหสัมพันธ (Correlations) ใชวิเคราะหตารางขอมูลท่ีตัวแปรอิสระมีคาเปนขอมูลจัดอันดับ 

(อันดับมาตรา) และตัวแปรอิสระมีคาเปนขอมูลแบบจัดอันดับ (มาตราแบบจัดอันดับ) มีสถิติทดสอบดังนี้ 

   2.1 สัมประสิทธิ์สหสัมพันธของสเปยรแมน (Spearman's correlation coefficient)  

   2.2 โร (rho) เฉพาะขอมูลท่ีเปนตัวเลข (numeric data only) 

3. ขอมูลแบบจัดกลุม (Nominal) ใชวิเคราะหขอมูลจัดกลุม (nominal data) มีสถิติทดสอบ

ดังนี ้
   3.1 สัมประสิทธิ์ของสถานการณท่ีสอดคลองกัน (Contingency coefficient) 

   3.2 ฟและแครมเมอร วี (Phi and Cramer’s V) 
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   3.3 แลมดา (Lambda) 

   3.4 สัมประสิทธิ์ความไมแนนอน (Uncertainty coefficient) 
4. ขอมูลแบบจัดอันดับ (Ordinal) ใชวิเคราะหขอมูลท่ีตัวแปรอิสระและตัวแปรตามเปนมีคาจัด

อันดับ (ordinal value) มีสถิติทดสอบดังนี้ 
   4.1 แกรมมา (Gamma) ลบคูท่ีไมสอดคลองกันออกและนับเฉพาะคูท่ีสอดคลองกันในตารางไขว 

   4.2 เดลตาของโสเมอรส (Somers’ d) 

   4.3 สัมประสิทธิ์สหสัมพันธของเคนดอลล (Kendall's coefficient) คํานวณเหมือนแกรมมา 

แตมีการแบงสวน (denominator) ท่ีซับซอนกวา และใหคาสถิติท่ีต่ํากวาคาแกรมมา 

        - แบบทาว-บี (Kendall’s tau-b) ตารางแบบ 2x2 (square table) 
        - แบบทาว-ซี (Kendall’s tau-c) ตารางแบบ NxN (rectangular tables) 
5. ขอมูลแบบจัดกลุมกับขอมูลแบบชวง (Nominal by Interval) ใชวิเคราะหขอมูลเม่ือตัวแปร

หนึ่ งเปนตัวแปรแบบคาแบบจัดประเภท (categorical) สวนอีกตัวแปรเปนตัวแปรเชิงปริมาณ 

(quantitative) มีสถิติทดสอบดังนี้ 
   5.1 อีตา (Eta) วัดความสัมพันธระหวาง 0-1 โดย 0 แสดงวาไมมีความสัมพันธระหวางตัวแปร

แถว (row) และสดมภ (column) 1 แสดงวามีความสัมพันธมาก เหมาะกับการวัดตัวแปรตามท่ีมีการวัด

เปนมาตราแบบชวง และตัวแปรอิสระท่ีมีการวัดเปนมาตราแบบจัดกลุม 

6. แคปปา (Kappa) หรือสัมประสิทธิ์แคปปาของโคเฮน (Cohen's kappa coefficient) ใช

วิเคราะหความคิดเห็น (agreement) จากผูใหคะแนน 2 ฝาย (two raters) ในเรื่องเดียวกัน โดย

กําหนดใหคา 1 หมายถึง เห็นดวยท้ังหมด (perfect agreement) และใหคา 0 หมายถึง ไมเห็นดวย

ท้ังหมด ตัวแปรท่ีนํามาวิเคราะหท้ังสองตัวแปรตองเปนตัวแปรแบบคาจัดประเภทเหมือนกันและมีการ

แบงจํานวนกลุมของคาตัวแปรเทากันดวย 
7. ความเสี่ยง (Risk) ใชวิเคราะหความเขมของความสัมพันธในรูปของตารางแบบ 2x2 ในการ

นําเสนอปจจัยหนึ่งกับเหตุการณท่ีเกิด หากคาสถิติท่ีไดมีชวงของความเชื่อม่ันเปน 1 แสดงวา ปจจัยนั้นไม

มีความสัมพันธกับเหตุการณท่ีเกิด อัตราสวนของโอกาสท่ีจะเกิด (odds ratio) สามารถใชในการ

ประมาณคา (estimate) ความเสี่ยงท่ีเหตุการณนั้นยากท่ีจะเกิดข้ึนมาจากปจจัยนั้น ๆ 

8. แมคนีมาร (McNemar) ใชวิเคราะหความสัมพันธของตัวแปรสองคา (dichotomous) เพ่ือ

ทดสอบการตอบสนองตอการเปลี่ยนแปลงจากปจจัยแทรกในการทดลอง (experimental intervention) 

ท่ีออกแบบเปนกอนการทดลองและหลังการทดลอง 

9. คอครานและแมนเทล-แฮนสเซล (Cochran's and Mantel-Haenszel) ใชในการวิเคราะห

ความเปนอิสระระหวางตัวแปรปจจัยแบบสองคา (dichotomous factor variable) และตัวแปร
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ตอบสนองแบบสองคา (dichotomous response variable) บนเง่ือนไขท่ีกําหนดใหเปนรูปแบบของ

การใชตัวแปรรวม (covariate patterns) โดยมีตัวแปรควบคุม 1 ตัวแปรหรือมากกวา 1 ตัวแปร 

วิธีการทดสอบความเปนอิสระของกลุมตัวอยางระหวางตัวแปรแบบจัดประเภท 2 ตัวแปรท่ีนิยม

กันอยางแพรหลาย คือ การทดสอบความเปนอิสระของกลุมตัวอยางแบบไค-สแควร (X2 Test for 

Independence) 

 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา พนักงานท่ีมีเพศแตกตางกันมี

ตําแหนงงานแตกตางกันหรือไม หรือเพศมีความสัมพันธกับตําแหนงงานหรือไม 

1.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ตัวอยางไดมาจากการสุมแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample)  

 2. คาสังเกตแตละคามีความเปนอิสระจากกัน (independence of 

observations) หรือคาของตัวแปรแบงเปนกลุมและไมมีความสัมพันธ

ระหวางกัน 

 3. มีกลุมตัวอยางไมนอยกวา 10 ตัวอยาง หรือมีขนาดใหญพอใหแตละเซลล

มีอยางนอย 1 ตัวอยาง และเซลลสวนใหญมีอยางนอย 5 ตัวอยาง 

 4. ตัวแปรเปนแบบคาจัดประเภท (categorical) 

การวิเคราะหขอมูล 1. ขอมูลมีการแจกแจงไมปกต ิ(asymmetrical distribution) 

 2. ตัวแปรแบบคาจัดประเภท 2 กลุม แตละเซลลตองมีความถ่ีอยางนอย 5 

ตัวอยาง และตัวแปรแบบคาจัดประเภทท่ีมีจํานวนมากกวา 2 กลุม แตละ

เซลลตองมีความถ่ีไมนอยกวา 1 ตัวอยาง และความถ่ีท่ีนอยกวา 5 

ตัวอยาง ตองไมเกินรอยละ 20 
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1.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดประเภท คาจัดประเภท 

เพศ (gender) 

- ชาย 

- หญิง 

ตําแหนงงาน (jobcat) 

- เจาหนาท่ีปฏิบัติงาน 

- หัวหนางาน 

- ผูจัดการ 

1.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงจํานวนและคารอยละของพนักงาน จําแนกตามเพศและตําแหนงงาน 

เพศ 
ตําแหนงงาน 

รวม 
เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

หญิง 205 (95.4) 0 (0.0) 10 (4.6) 216 (100.0) 

ชาย 157 (60.9) 27 (10.5) 74 (28.7) 258 (100.00) 

รวม 363 (76.6) 27 (5.7) 84 (17.7) 474 (100.0) 

 จากตารางท่ี (#) แสดงใหเห็นวา เพศหญิงสวนใหญเปนเจาหนาท่ีปฏิบัติงาน รองลงมา คือ 

ผูจัดการ และไมมีผูดํารงตําแหนงหัวหนางานเลย สวนเพศชายสวนใหญเปนเจาหนาท่ีปฏิบัติงาน 

รองลงมา คือ ผูจัดการ และหัวหนางาน ตามลําดับ  

เม่ือเปรียบเทียบตําแหนงระหวางเพศชายกับเพศหญิงแสดงใหเห็นวา เพศหญิงชายมีตําแหนง

งานเปนเจาหนาท่ีปฏิบัติงานมากกวาเพศชาย สวนเพศชายมีตําแหนงงานเปนหัวหนางานและผูจัดการ

มากกวาเพศหญิง หรืออาจกลาวไดวา เพศชายมีตําแหนงงานแตกตางกับเพศหญิง (เพศชายมีตําแหนง

งานและสูงกวาเพศหญิง)  

ดังนั้น เพ่ือเปนการยืนยันขอสรุปดังกลาว จึงนําขอสรุปมาทําการทดสอบความเปนอิสระของ

ขอมูลดวยวิธีการทางสถิติแบบไค-สแควร (Chi-square หรือ X2) โดยกําหนดสมมติฐาน ดังนี้  

H0: เพศชายกับเพศหญิงมีตําแหนงงานไมแตกตางกัน 

H1: เพศชายกับเพศหญิงมีตําแหนงงานแตกตางกัน 
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เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ (เปรียบเทียบความแตกตาง)

ดวยวิธีไค-สแควร (Chi-square Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α 

= .05) จะยอมรับสมมตฐิาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญ

ทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

1.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs…  

o Rows: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ท่ีตองการใหเปนตัว

แปรอิสระ) จากรายการตัวแปรดานซาย 

o Column: เลือกตัวแปรแบบคาจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ท่ีตองการให

เปนตัวแปรตาม) จากรายการตัวแปรดานซาย 

o กดปุม Statistics เลือกสถิติ Chisq -> กดปุม Continue 

o กดปุม Cells… ในกลุมคําสั่ง Percentages (เลือก Row) -> กดปุม Continue 

o กดปุม OK 
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1.5 ผลการวิเคราะห 

 

 

1.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบตําแหนงงานจําแนกตามเพศ 

เพศ 
ตําแหนงงาน 

รวม 
เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

หญิง 206 (95.4) 0 (0.0) 10 (4.6) 216 (100.0) 

ชาย 157 (60.9) 27 (10.5) 74 (28.7) 258 (100.00) 

รวม 363 (76.6) 27 (5.7) 84 (17.7) 474 (100.0) 

X2 =79.28 df = 2 Sig = .000 

1.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .000 มีคานอยกวา

คานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธ H0 ยอมรับสมมติฐาน H1  

สรุป เพศชายกับเพศหญิงมีตําแหนงงานแตกตางกัน 
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ตัวอยางเพ่ิมเติม: การทดสอบ การแปลผลและสรุป 

#1 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบตําแหนงานจําแนกตามระดับการศึกษา 

ระดับ

การศึกษา 

ตําแหนงงาน 
รวม 

เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

ต่ํากวาปริญญา 88.9 (216) 10.7 (26) 0.4 (1) 100.0 (243) 

ปริญญา 63.6 (147) 0.4 (1) 35.9 (83) 100.0 (231) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

X2 =116.08 df = 2 Sig = .000 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางพนักงานท่ีมีการศึกษาตํ่ากวาปริญญา สวนใหญ

ดํารงตําแหนงงานเปนเจาหนาท่ีปฏิบัติงาน รองลงมา เปนหัวหนางาน และผูจัดการ สวนกลุมตัวอยาง

พนักงานท่ีมีการศึกษาระดับปริญญา สวนใหญดํารงตําแหนงงานเปนเจาหนาท่ีปฏิบัติงาน รองลงมา เปน

ผูจัดการ และหัวหนางาน และเม่ือเปรียบเทียบตําแหนงงานระหวางพนักงานท่ีมีการศึกษาแตกตางกัน 

แสดงใหเห็นวา พนักงานท่ีมีการศึกษาระดับปริญญา มีตําแหนงงานแตกตางกับพนักงานท่ีมีการศึกษาตํ่า

กวาปริญญา ดังนั้นเพ่ือเปนการยืนยันขอสรุปท่ีวา พนักงานท่ีมีการศึกษาระดับปริญญา มีตําแหนงงาน

แตกตางกับพนักงานท่ีมีการศึกษาตํ่ากวาปริญญา จึงทําการทดสอบดวยวิธีการทางสถิติ โดยกําหนด

สมมติฐาน ดังนี้ 

H0: พนักงานท่ีมีการศึกษาระดับปริญญากับพนักงานท่ีมีการศึกษาต่ํากวาปริญญามีตําแหนงงาน

ไมแตกตางกัน 

H1: พนักงานท่ีมีการศึกษาระดับปริญญากับพนักงานท่ีมีการศึกษาต่ํากวาปริญญามีตําแหนงงาน

แตกตางกัน 

 เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ (เปรียบเทียบความแตกตาง)

ดวยวิธีไค-สแควร (Chi-square Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α 

= .05) จะยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญ

ทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .000 มีคานอยกวา

คานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธ H0 ยอมรับสมมติฐาน H1 กลาวคือ พนักงานท่ีมี

การศึกษาระดับปริญญากับพนักงานท่ีมีการศึกษาต่ํากวาระดับปริญญามีตําแหนงงานแตกตางกัน 

#2 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบตําแหนงานจําแนกตามระดับการศึกษา 

ระดับ

การศึกษา 

ตําแหนงงาน 
รวม 

เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

ต่ํากวาปริญญา 88.9 (216) 10.7 (26) 0.4 (1) 100.0 (243) 

ปริญญา 63.6 (147) 0.4 (1) 35.9 (83) 100.0 (231) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

X2 =116.08 df = 2 Sig = .000 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางพนักงานท่ีมีการศึกษาต่ํากวาปริญญา สวนใหญ

ดํารงตําแหนงงานเปนพนักงาน รองลงมา เปนหัวหนางาน และผูจัดการ สวนกลุมตัวอยางพนักงานท่ีมี

การศึกษาระดับปริญญา สวนใหญดํารงตําแหนงงานเปนเจาหนาท่ีปฏิบัติงาน รองลงมา เปนผูจัดการ และ

หัวหนางาน และเม่ือเปรียบเทียบตําแหนงงานระหวางพนักงานท่ีมีการศึกษาแตกตางกัน แสดงใหเห็นวา 

พนักงานท่ีมีการศึกษาระดับปริญญา มีตําแหนงงานสูงกวาพนักงานท่ีมีการศึกษาตํ่ากวาปริญญา อยางมี

นัยสําคัญทางสถิต ิ

#3 

ตารางท่ี (#) แสดงผลการเปรียบเทียบตําแหนงงานจําแนกตามระดับการศึกษา 

ระดับ

การศึกษา 

ตําแหนงงาน 
รวม 

เจาหนาท่ีปฏิบัติงาน หัวหนางาน ผูจัดการ 

ต่ํากวาปริญญา 88.9 (216) 10.7 (26) 0.4 (1) 100.0 (243) 

ปริญญา 63.6 (147) 0.4 (1) 35.9 (83) 100.0 (231) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

X2 =116.08 df = 2 Sig = .000 

 จากตารางท่ี (#) แสดงใหเห็นวา กลุมตัวอยางพนักงานท่ีมีการศึกษาต่ํากวาปริญญา สวนใหญ

ดํารงตําแหนงงานเปนเจาหนาท่ีปฏิบัติงาน รองลงมา เปนหัวหนางาน และผูจัดการ สวนกลุมตัวอยาง
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พนักงานท่ีมีการศึกษาระดับปริญญา สวนใหญดํารงตําแหนงงานเปนเจาหนาท่ีปฏิบัติงาน รองลงมา เปน

ผูจัดการ และหัวหนางาน  

ผลการศึกษาดังกลาว เม่ือพิจารณาจากสมมติฐานการศึกษาตามทฤษฎีท่ีกําหนดไววา พนักงานท่ี

มีการศึกษาแตกตางกันมีตําแหนงงานท่ีแตกตางกัน แสดงใหเห็นวา พนักงานท่ีมีการศึกษาระดับปริญญา 

มีตําแหนงงานแตกตางกับพนักงานท่ีมีการศึกษาต่ํากวาปริญญา อยางมีนัยสําคัญทางสถิติ ดังนั้นจึง

ยอมรับสมมติฐานดังกลาว 
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2. การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม  

การทดสอบแบบไมอิงคาพารามิเตอรมีขอสมมติพ้ืนฐาน (assumption) คือ ขอมูลมีการแจกแจง

ไมปกติ (non-normal distribution) ทําใหไมสามารถใชวิธีการเปรียบเทียบความแตกตางระหวางกลุม

ตัวอยางดวยคาเฉลี่ย (mean) เหมือนกับวิธีการทดสอบแบบอิงคาพารามิเตอร ดังนั้นในการทดสอบขอมูล

ระหวางกลุมตัวอยางจึงใชวิธีการเปรียบเทียบจากคากลาง (median) 

 การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม (2 Independent Samples 

Test) คือ การเปรียบเทียบตําแหนงขอมูล (location) โดยใชคากลาง (median) ของกลุมตัวอยางท่ีไมมี

ความสัมพันธกันหรือเปนอิสระจากกัน 2 กลุม เพ่ือตัดสินใจวาขอมูลระหวาง 2 กลุมตัวอยางมีความ

เหมือนกันหรือแตกตางกัน  

วิธีการทดสอบแบบนี้ใชแทนกรณีท่ีขอมูลไมเปนไปตามขอตกลงเบื้องตนของการทดสอบคาเฉลี่ย

แบบ Independent t-Test โดยมีวิธีดังนี้ 

1. การทดสอบของแมน-วิทนี ยู (Mann-Whitney U Test) อาจเรียกอีกอยางวา การทดสอบ

ของแมน-วิทนี-วิลคอกซัน (Mann-Whitney-Wilcoxon Test) หรือการทดสอบแบบผลรวมของอันดับท่ี

ของวิลคอกซัน (Wilcoxon rank-sum Test) เปนการทดสอบความเทากันของการกระจายของขอมูล

จากตําแหนงหรือแนวโนมเขาสูสวนกลางของขอมูลจากกลุมตัวอยาง 2 กลุมท่ีเปนอิสระจากกัน 

2. การทดสอบของคอลมอโกรอฟ-สเมอรนอฟ (Kolmogorov-Smirnov Z) เปนการทดสอบ

ความแตกตางกันของการกระจายท้ังจากตําแหนงและรูปรางของขอมูลจากกลุมตัวอยาง 2 กลุมท่ีเปน

อิสระจากกัน จากคาสูงสุดสัมบูรณ (absolute maximum) ของขอมูลการกระจายสะสม (cumulative 

distribution) 

3. การทดสอบคาตางสุดของโมเซส  (Moses extreme reactions) เปนการทดสอบความ

แตกตางกันของการกระจาย (distribution) ของตัวแปรแบบสองทิศในทางตรงขาม (opposite 

direction) ท่ีไดจากการทดลอง 2 กลุม โดยนําเอาขอมูลท่ีไดจากการสังเกตมารวมกัน (combined) และ

ทําการจัดตําแหนง (ranked) เพ่ือวัดชวง (span) ของตําแหนงสูงสุดและต่ําสุด แลวทําการเปรียบเทียบ

คาตางสุดกับกลุมทดลอง 
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4. การทดสอบของวอรค–วูลฟอวิทซ (Wald-Wolfowitz runs) เปนการทดสอบความแตกตาง

กันของการกระจายท้ังจากตําแหนงและรูปรางของขอมูลจากกลุมตัวอยาง 2 กลุมท่ีเปนอิสระจากกัน จาก

การนําเอาขอมูลจากกลุมตัวอยาง 2 กลุมมารวมกัน (combines) และจัดตําแหนง (ranks) แลวนับ

จํานวนความตอเนื่อง (runs)  

วิธีการทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกัน 2 กลุม ท่ีนิยมกันอยางแพรหลาย คือ 

การทดสอบแบบแมน-วิทนี ยู (Mann-Whitney U Test) 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวาพนักงานท่ีเปนกลุมชนแตกตางกันมี

ประสบการณกอนการทํางานแตกตางกันหรือไม 

2.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ตัวอยางไดมาจากการสุมแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample) 

 2. คาสังเกตแตละคามีความเปนอิสระจากกัน (independence of 

observations) หรือคาของตัวแปรแบงเปน 2 กลุมและไมมี

ความสัมพันธระหวางกัน 

 3. ตัวแปรอิสระมีการวัดแบบมาตราจัดอันดับ (ordinal level) หรือเปนคา

ตอเนื่อง (continuous level) 

การวิเคราะหขอมูล 1. ขอมูลของแตละกลุมมีการแจกแจงไมปกต ิ(asymmetrical 

distribution) 

 2. ขอมูลของแตละกลุมมีรูปแบบการแจกแจงหรือรูปรางเหมือนกัน (same 

distribution/shape) 
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2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดประเภท (มาตราแบบจัดกลุม 2 กลุม) คาตอเนื่อง 

กลุมชน (minority) 

- ชนกลุมหลัก 

- ชนกลุมนอย 

ประสบการณกอนทํางาน (prevexp) 

2.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

H0: พนักงานชนกลุมหลักกับพนักงานชนกลุมนอยมีประสบการณกอนทํางานไมแตกตางกัน 

 H1: พนักงานชนกลุมหลักกับพนักงานชนกลุมนอยมีประสบการณกอนทํางานแตกตางกัน 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความแตกตางของการกระจายของขอมูล

โดยใชวิธีของแมน-วิทนี ยู (Mann-Whitney U Test) ไดคาความนาจะเปน (p-value) มากกวาคา

นัยสําคัญทางสถิติ (α = .05) จะยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวา

หรือเทากับคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

2.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ วิเคราะหผาน Syntax Editor ดวยคําสั่งดังนี้ 

NPAR TESTS 

[ /MANN-WHITNEY = var_list BY var (group1, group2) ] 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู File -> New -> Syntax  

o NPAR TESTS 

/MANN-WHITNEY = var list (พิมพชื่อตัวแปรทดสอบหรือตัวแปรตามท่ีเปนตัวแปร

แบบคาตอเนื่องแทนคําวา var list) BY var (พิมพชื่อตัวแปรอิสระท่ีเปนตัวแปรแบบคา

จัดประเภทแทนคําวา var) และ (group1 เชน 1 หรือ 4, group2 เชน 2 หรือ 5). 

o เมนู Run -> All 
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2.5 ผลการวิเคราะห 

 

2.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบลําดับท่ีคาเฉลี่ยของประสบการณกอนทํางานของพนักงาน

ระหวางกลุมชน 

กลุมชน จํานวน 
ลําดับท่ีคาเฉล่ีย 

(Mean Rank) 

ผลรวมของลําดับท่ี 

(Sum of Ranks) 

Mann-Whitney 

U Test 
Z Sig. 

กลุมหลัก 370 222.70 82399.50 
13764.50 -4.44 .000 

กลุมนอย 104 290.15 30175.50 

รวม 474      

 

2.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบการเปรียบเทียบลําดับท่ีคาเฉลี่ยของประสบการณกอนทํางาน

ของพนักงานระหวางกลุมชน แสดงใหเห็นวา พนักงานท่ีเปนชนกลุมหลักมีลําดับท่ีคาเฉลี่ยของ

ประสบการณกอนทํางานนอยกวาพนักงานท่ีเปนชนกลุมนอย และจากผลการทดสอบความแตกตางของ

การกระจายของขอมูลโดยวิธีของแมน-วิทนี ยู (Mann-Whitney U Test) ไดคาความนาจะเปน (Sig.) 
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= .000 ซ่ึงมีคานอยกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับ

สมมติฐาน H1  

สรุป พนักงานชนกลุมหลักกับพนักงานชนกลุมนอยมีประสบการณกอนทํางานแตกตางกัน  
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3. การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม  

 การทดสอบคากลางของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม (K Independent 

Samples Test) คือ การเปรียบเทียบตําแหนงของขอมูล (location) โดยใชคากลาง (median) ของกลุม

ตัวอยางท่ีไมมีความสัมพันธกันหรือเปนอิสระจากกันมากกวา 2 กลุม เพ่ือตัดสินใจวาขอมูลระหวางกลุม

ตัวอยางมีความเหมือนกันหรือแตกตางกัน 

วิธีการทดสอบแบบนี้ใชแทนกรณีท่ีขอมูลไมเปนไปตามขอตกลงเบื้องตนของการทดสอบคาเฉลี่ย

ดวยวิธีการวิเคราะหความแปรปรวนแบบทางเดียว (One-way Analysis of Variance: One-way 

ANOVA) โดยมีวิธีดังนี้ 

1. การทดสอบของครัสคาลและวัลลิส (Kruskal Wallis Test) เปนการทดสอบความเหมือนกัน

ของรูปรางของขอมูลท่ีไมมีการจัดเรียง (no a priori ordering) จากกลุมตัวอยางมากกวา 2 กลุมท่ีเปน

อิสระจากกัน (multiple/several independent)  

2. การทดสอบของจองฮีรี (Jonckheere Test) หรืออาจเรียกวา การทดสอบแนวโนมของจองฮี

รี (Jonckheere’s Trend Test) หรือการทดสอบของจองฮีรี-เทิรพสตรา (Jonckheere-Terpstra Test) 

เปนการทดสอบความเหมือนกันของรูปรางของขอมูลท่ีมีการจัดเรียง (priori ordered) จากกลุมตัวอยาง

มากกวา 2 กลุมท่ีเปนอิสระจากกัน ขอมูลท่ีมีการจัดเรียงจากกลุมตัวอยางอาจเปนการจัดเรียงแบบจาก

นอยไปมาก (ascending) หรือจากมากไปนอย (descending) ก็ได เชน การเพ่ิมข้ึนของอุณหภูมิ การลด

ของอุณหภูมิ เปนตน 

3. การทดสอบคามัธยฐาน (Median Test) เปนการทดสอบความเหมือนกันของคามัธยฐาน 

(median) ของขอมูลจากกลุมตัวอยางมากกวา 2 กลุมท่ีเปนอิสระจากกัน 

วิธีการทดสอบขอมูลเชิงคุณภาพของกลุมตัวอยางท่ีเปนอิสระจากกันมากกวา 2 กลุม ท่ีนิยมกัน

อยางแพรหลาย คือ การทดสอบแบบครัสคาลและวัลลิส (Kruskal Wallis Test) 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา พนักงานท่ีมีตําแหนงงานแตกตาง

กันมีประสบการณกอนการทํางานแตกตางกันหรือไม 
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3.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ตัวอยางไดมาจากการสุมแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample) 

 2. คาสังเกตแตละคามีความเปนอิสระจากกัน (independence of 

observations) หรือคาของตัวแปรแบงเปน 3 กลุม หรือมากกวา และไม

มีความสัมพันธระหวางกัน 

 3. ตัวแปรตามมีการวัดแบบมาตราจัดอันดับ (ordinal level) หรือเปนคา

ตอเนื่อง (continuous level) 

การวิเคราะหขอมูล 1. ขอมูลของแตละกลุมมีการแจกแจงไมปกติ (asymmetrical 

distribution) 

 2. ขอมูลของแตละกลุมมีการแจกแจงหรือรูปรางเหมือนกัน (same 

distribution/shape) 

3.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดประเภท  

(มาตราแบบจัดกลุมมากกวา 2 กลุม) 
คาจัดอันดับหรือคาตอเนื่อง 

ตําแหนงงาน (jobcat) 

- เจาหนาท่ีปฏิบัติงาน 

- หัวหนางาน 

- ผูจัดการ 

คาเฉลี่ยของประสบการณกอนทํางาน (prevexp) 

3.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

H0: พนักงานท่ีมีตําแหนงงานแตกตางกันมีประสบการณกอนทํางานไมแตกตางกัน 

 H1: พนักงานท่ีมีตําแหนงงานแตกตางกันมีประสบการณกอนทํางานแตกตางกัน 

เกณฑในการทดสอบสมมุติฐาน คือ หากการเปรียบเทียบรูปรางของขอมูลโดยใชวิธีของครัสคาล

และวัลลิส (Kruskal Wallis Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α 
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= .05) จะยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญ

ทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

3.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> K Independent Samples… 

o Test Variable List: เลือกตัวแปรทดสอบ (ตัวแปรตาม) ท่ีเปนตัวแปรแบบคาจัดอันดับ

หรือคาตอเนื่อง 1 ตัวแปร หรือมากกวา 1 ตัวแปร จากรายการตัวแปรดานซาย  

o Grouping Variable: เลือกตัวแปรอิสระท่ีเปนตัวแปรแบบคาจัดประเภท 1 ตัวแปร จาก

รายการตัวแปรดานซาย 

o กดปุม Define Range… 

o กําหนดคาของตัวแปรแบบคาจัดประเภทในชอง Lower limit: (คาต่ําสุดของกลุม) และ 

Upper limit: (คาสูงสุดของกลุม) -> กดปุม Continue 

o ในกลุมคําสั่ง Test Type เลือกสถิติ Kruskal-Wallis H  

o กดปุม OK 

 

 

3.5 ผลการวิเคราะห 
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3.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบลําดับท่ีคาเฉลี่ยของประสบการณกอนทํางานของพนักงาน

ระหวางตําแหนงงาน 

ตําแหนงงาน จํานวน ลําดับท่ีคาเฉล่ีย (Mean Rank) Kruskal Wallis Test 

เจาหนาท่ีปฏิบัติงาน 363 224.53 X2 = 57.47  

df = 2  

Asymp. Sig = .000 

หัวหนางาน 27 431.26 

ผูจัดการ  84 231.27 

รวม 474   

3.7 การแปลผลและสรุป 

จากการเปรียบเทียบลําดับท่ีคาเฉลี่ยของประสบการณกอนทํางานของพนักงานระหวางตําแหนง

งาน แสดงใหเห็นวา พนักงานท่ีเปนหัวหนางานมีลําดับท่ีคาเฉลี่ยของประสบการณกอนทํางานมากท่ีสุด 

รองลงมา คือ เจาหนาท่ีปฏิบัติงาน และนอยท่ีสุด คือ ผูจัดการ และจากการทดสอบการเปรียบเทียบ

รูปรางของขอมูลโดยใชวิธีของครัสคาลและวัลลิส (Kruskal Wallis Test) ไดคาความนาจะเปน (Sig.) 

= .000 ซ่ึงมีคานอยกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับ

สมมติฐาน H1  

สรุป พนักงานท่ีมีตําแหนงงานแตกตางกันมีประสบการณกอนทํางานแตกตางกัน 
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4. การทดสอบคากลางของกลุมตัวอยางท่ีมีความสัมพันธกัน 2 กลุม 

 การทดสอบคากลางของกลุมตัวอยางท่ีมีความสัมพันธกัน 2 กลุม (2 Related Samples Test) 

คือ การทดสอบเปรียบเทียบตําแหนงขอมูล (location) โดยใชคากลาง (median) ของกลุมตัวอยางท่ีมี

ความสัมพันธกันหรือไมเปนอิสระจากกัน 2 กลุม เพ่ือตัดสินใจวาขอมูลระหวางกลุมตัวอยางมีความ

เหมือนกันหรือแตกตางกัน 

การทดสอบแบบนี้อาจมีชื่อเรียกในชื่ออ่ืน เชน Paired Samples Test, Matched Samples 

Test และ Dependent Samples Test  

วิธีการทดสอบแบบนี้ใชแทนกรณีท่ีขอมูลไมเปนไปตามขอตกลงเบื้องตน (not meet  basic 

assumptions) ของการทดสอบคาเฉลี่ย 2 กลุมท่ีสัมพันธกัน (Pair Sample t-test) โดยมีวิธีการดังนี้ 

1. การทดสอบแบบเครื่องหมาย (Sign Test) เปนการทดสอบความแตกตางกันของคามัธยฐาน 

(median) ของขอมูลตอเนื่อง (continuous data) จากเครื่องหมาย + และเครื่องหมาย – ท่ีไดจาก

ขอมูลท่ีนํามาจับคูกัน (Xi > Yi ไดเครื่องหมาย + แตถา Xi < Yi จะไดเครื่องหมาย -) 

2. การทดสอบแบบวิลคอกชัน (Wilcoxon Test หรือ Wilcoxon Singed Ranks Test) เปน

การทดสอบความเหมือนกันของคามัธยฐาน (median) ของขอมูลตอเนื่อง (continuous data) ท่ีมี

ความสัมพันธกัน (related) จากกลุมตัวอยางเดียวกันหรือคูเดียวกัน (same/matched sample) ท่ี

พัฒนามาจากการทดสอบเครื่องหมาย โดยการนําคาของความแตกตางมาจัดอันดับในการทดสอบ 

3. การทดสอบแบบแมคนีมาร (McNemar Test) เปนการทดสอบความไมเปลี่ยนแปลง 

(unchanged) ของขอมูลแบบ 2 คา (binary response) หรือตัวแปรท่ีมีคา 2 คา (data: binary) เปน

การทดสอบท่ีสามารถใชไดท้ังตัวแปรแบบมาตราจัดกลุม (nominal) และจัดอันดับ (ordinal) 

4. การทดสอบความเปนเอกพันธของสวนเพ่ิม (Marginal Homogeneity Test) เปนการ

ทดสอบความเหมือนกันของการกระจายของสวนเพ่ิมของตัวแปรพหุวิภาคหรือตัวแปรหลายคา 

(polytomous variables) จากกลุมตัวอยาง 2 กลุมท่ีมีความสัมพันธกัน 

วิธีการทดสอบกลุมตัวอยาง 2 กลุมท่ีมีความสัมพันธกันท่ีนิยมกันอยางแพรหลาย คือ การ

ทดสอบแบบวิลคอกชัน (Wilcoxon Test หรือ Wilcoxon Singed Ranks Test)  
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ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา พนักงานท่ีทํางานอยูขณะนี้ไดรับ

เงินเดือนแตกตางไปจากเงินเดือนเริ่มตนหรือไม 

4.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ตัวอยางไดมาจากการสุมแบบสุม (random sampling) และเปนอิสระจาก

กัน (independent sample) 

 2. ขอมูลไดมาจากกลุมตัวอยางเดียวกันหรือคูเดียวกัน (same/matched 

sample) และเปนสถานการณท่ีมีความเก่ียวของกันหรือสัมพันธกัน 2 

สถานการณ (2 related samples or dependent/paired sample) หรือ

เปนการวัดซํ้า (repeated measures data) 

 3. ตัวแปรตองมีระดับการแบบคาจัดอันดับหรือคาตอเนื่อง (ordinal or 

continuous level)  

 4. ตัวแปรท้ังคูตองมีระดับการวัดอยูในระดับเดียวกัน (มาตราแบบจัดอันดับ

กับมาตราแบบจัดอันดับ หรือคาตอเนื่องกับคาตอเนื่อง) 

การวิเคราะหขอมูล 1. ขอมูลของ 2 ตัวแปร มีการแจกแจงไมปกติ (asymmetrical distribution) 

 2. ขอมูลของ 2 ตัวแปร มีการแจกแจงหรือรูปรางเหมือนกัน (same 

distribution/shape) 

4.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรทดสอบ (การวัดครั้งท่ี 1) วัดซํ้า ตัวแปรทดสอบ (การวัดครั้งท่ี 2) 

คาตอเนื่อง -> คาตอเนื่อง 

เงินเดือนเริ่มตน (salbegin)  เงินเดือนปจจุบัน (salary) 

4.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

H0: พนักงานมีเงินเดือนปจจุบันเทากับเงินเดือนเริ่มตน 

 H1: พนักงานมีเงินเดือนปจจุบันไมเทากับเงินเดือนเริ่มตน 
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เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบเปรียบเทียบคามัธยฐานโดยใชวิธีของวิลค

อกชัน (Wilcoxon Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะ

ยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ 

(α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> 2 Related Samples… 

o Test Pair(s): เลือกตัวแปรทดสอบตัวท่ี 1 (ตัวแปรแบบคาตอเนื่องหรือคาจัดอันดับ/

เหตุการณกอน) จากชองรายการตัวแปรใสในชอง Var1   

o Test Pair(s): เลือกตัวแปรทดสอบตัวท่ี 2 (ตัวแปรแบบคาตอเนื่องหรือคาจัดอันดับ/

เหตุการณหลัง) จากชองรายการตัวแปรใสในชอง Var2  

o ในกลุมคําสั่ง Test Type เลือกสถิติ Wilcoxon  

o กดปุม OK 

 

4.5 ผลการวิเคราะห 
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4.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบลําดับท่ีคาเฉลี่ยระหวางเงินเดือนเริ่มตนกับ

เงินเดือนปจจุบัน 

เงินเดือน จํานวน 
ลําดับท่ีคาเฉล่ีย 

(Mean Rank) 

ผลรวมของลําดับท่ี 

(Sum of Ranks) 

Wilcoxon 

Test 

เงินเดือนปจจุบัน-

เงินเดือนเริ่มตน 

อันดับคาท่ีมีคานอยกวา  

(Negative Ranks) 
474 237.50 112575.00 

Z = -18.86 

Sig = .000  อันดับคาท่ีมีคามากกวา  

(Positive Ranks) 
0 0 .00 

 อันดับคาท่ีมีคาเทากัน 

(Ties) 
0   

 

รวม  474    

4.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบการเปรียบเทียบคามัธยฐานโดยใชวิธีของวิลคอกชัน (Wilcoxon 

Test) ไดคาความนาจะเปน (Sig.) = .000 มีคานอยกวาคานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึง

ปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป พนักงานมีเงินเดือนปจจุบันไมเทากับเงินเดือนเริ่มตน (พนักงานมีเงินเดือนปจจุบันมากกวา

เงินเดือนเริ่มตนจํานวน 474 คน ไมมีพนักงานท่ีมีเงินเดือนปจจุบันนอยกวาเงินเดือนเริ่มตน และไมมี

พนักงานท่ีมีเงินเดือนปจจุบันเทากับเงินเดือนเริ่มตน) 
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5. การทดสอบคากลางของกลุมตัวอยางท่ีมีความสัมพันธกันมากกวา 2 กลุม 

 การทดสอบคากลางของกลุมตัวอยางท่ีมีความสัมพันธกันมากกวา 2 กลุม (K Related Samples 

Tests) คือ การเปรียบเทียบตําแหนง (location) โดยใชคากลาง (median) ของกลุมตัวอยางท่ีมี

ความสัมพันธกันมากกวา 2 กลุม เพ่ือตัดสินใจวาขอมูลระหวางกลุมตัวอยางมีความเหมือนกันหรือ

แตกตางกัน 

วิธีการทดสอบแบบนี้ใชแทนกรณีท่ีขอมูลไมเปนไปตามขอตกลงเบื้องตน (not meet  basic 

assumptions) ของการทดสอบคาเฉลี่ยมากกวา 2 กลุมท่ีสัมพันธกัน (One-Way repeated-measures 

ANOVA) โดยมีวิธีดังนี้ 

1. การทดสอบแบบฟรีดแมน (Friedman Test) เปนการทดสอบความเหมือนของขอมูลจากตัว

แปรแบบมาตราจัดอันดับแบบพหุ (multiple ordinal responses) ท่ีไดจากการวัดซํ้าแบบเดียวกัน 

(same measure) จากกลุมตัวอยางเดียวกันแบบพหุ (multiple matched samples) 

2. การทดสอบแบบเคนดอลล (Kendall’s W Test) เปนวิธีการทดสอบสัมประสิทธิ์ของความ

สอดคลองในการจัดลําดับท่ี (coefficient of concordance for ranks: W) จากคําตอบความคิดเห็น 

(agreement) ของผูตอบท่ีมีคาแบบมาตราจัดอันดับชวง 0 ถึง n-1 โดยคา 0 = ไมเห็นดวย (no 

agreement) และ 1 = เห็นดวยท้ังหมด (complete agreement) เชน คา 1=0 คา 2=1 และคา 9=8 

เปนตน  

3. การทดสอบแบบคอคราน (Cochran’s Q Test) เปนการทดสอบความเหมือนกันของสัดสวน

ของขอมูลจากตัวแปรแบบสองคา (dichotomous) ท่ีมีความสัมพันธกันแบบพหุ (multiple related) ท่ี

พัฒนามาจากการทดสอบแบบแมคนีมาร (McNemar) ท่ีใชในการทดสอบขอมูล 2 คา 

วิธีการทดสอบความสัมพันธของกลุมตัวอยางมากกวา 2 กลุมท่ีใชเปนตัวอยางการทดสอบ คือ 

การทดสอบแบบฟรีดแมน (Friedman Test)  

ตัวอยางคําถามการวิจัย 

จากคะแนนการตัดสินของคณะกรรมการท้ังหมดการทราบวา คณะกรรมการของประเทศอิตาลี 

ประเทศเกาหลีใต และประเทศโรมาเนีย ใหคะแนนแตกตางกันหรือไม 
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5.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ตัวอยางไดมาจากการสุมแบบสุม (random sampling) และเปนอิสระ

จากกัน (independent sample) 

 2. ขอมูลของตัวแปรทดสอบมีความเก่ียวของหรือสัมพันธกันมากกวา 2 

สถานการณ (K related sample)  

 3. ขอมูลของตัวแปรทดสอบมีระดับการวัดดวยมาตราแบบจัดอันดับหรือคา

ตอเนื่อง (ordinal or continuous level)  

 4. ขอมูลของตัวแปรทดสอบทุกตัวตองมีระดับการวัดอยูในระดับเดียวกัน 

(มาตราแบบจัดอันดับทุกตัวแปร หรือคาตอเนื่องทุกตัวแปร) 

การวิเคราะหขอมูล ขอมูลมีการแจกแจงไมปกต ิ(asymmetrical distribution) 

5.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรทดสอบ (การวัดครั้งท่ี 1) ตัวแปรทดสอบ (การวัดครั้งท่ี 2) ตัวแปรทดสอบ (การวัดครั้งท่ี n) 

คาตอเนื่อง คาตอเนื่อง คาตอเนื่อง 

คะแนนของกรรมการคนท่ี 1 

อิตาลี่ (judge1) 

คะแนนของกรรมการคนท่ี 2 

เกาหลีใต (judge2) 

คะแนนของกรรมการคนท่ี n 

โรมาเนีย (judge3) 

5.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

 จากการแขงขันยิมนาสติก ตองการทดสอบความเหมือนกันของคะแนนการตัดสินนักยิมนาสติก

ของกรรมการจากประเทศอิตาลี เกาหลีใต และโรมาเนีย 

 H0: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต และโรมาเนียเหมือนกัน 

 H1: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต และโรมาเนียไมเหมือนกัน 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความเหมือนกันของลําดับท่ีคะแนนโดยใช

วิธีของฟรีดแมน (Friedman Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α 

= .05) จะยอมรบัสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญ

ทางสถิติ (α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 



322 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

5.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> judges.sav 

๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> K Related Samples… 

o Test Variables: เลือกตัวแปรทดสอบ 3 ตัวแปรหรือมากกวา (ตัวแปรแบบคาตอเนื่อง/

เหตุการณเหมือนกันหรือเปนการวัดซํ้า 3 เหตุการณหรือมากกวา เชน การใหคะแนนของ

กรรมการ 3 คนหรือมากกวา) จากรายการตัวแปรดานซาย  

o ในกลุมคําสั่ง Test Type เลือกสถิติ Friedman  

o กดปุม OK 

 

5.5 ผลการวิเคราะห 
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5.7 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบลําดับท่ีคาเฉลี่ยของคะแนนจากกรรมการ 3 ประเทศ 

กรรมการ ลําดับท่ีคาเฉล่ีย (Mean Rank) Friedman Test 

อิตาลี 1.99 
N = 300 

X2 = 497.803 df = 2 Sig = .000 
เกาหลีใต 2.90 

โรมาเนีย 1.11 

5.8 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .000 มีคานอยคา

นัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต และโรมาเนียไมเหมือนกัน 

(กรรมการจากประเทศเกาหลีใตใหคะแนนมากท่ีสุดเปนอันดับ 1 กรรมการจากประเทศอิตาลีใหคะแนน

นอยรองลงมาเปนอันดับท่ี 2 และกรรมการจากประเทศโรมาเนียใหคะแนนนอยท่ีสุดเปนอันดับท่ี 3) 
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ตัวอยางเพ่ิมเติม: การทดสอบ การแปลผลและสรุป 

#1 

 H0: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต และโรมาเนียไมแตกตางกัน 

 H1: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต และโรมาเนียแตกตางกัน 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความสอดคลองดวยโดยใชวิธีของเคนดอลล 

(Kendall’s W Test)ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะ

ยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ 

(α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

ตารางท่ี (#) แสดงผลการทดสอบเปรียบเทียบลําดับท่ีคาเฉลี่ยของคะแนนจากกรรมการ 3 ประเทศ 

กรรมการ  ลําดับท่ีคาเฉลี่ย Kendall’s W Test 

อิตาลี  1.99 N = 300 Kendall’s W = .830 

X2 = 497.803 df = 2  

Asymp. Sig = .000 

เกาหลีใต  2.90 

โรมาเนีย  1.11 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .000 มีคานอยกวา

คานัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต และโรมาเนียแตกตางกัน โดย

มีคา Kendall’s W = .830 หรือมีความสอดคลองของคะแนนอยูระดับมาก กรรมการจากประเทศเกาหลี

ใตใหคะแนนมีลําดับท่ีคาเฉลี่ยมากท่ีสุด รองลงมาคือ กรรมการจากประเทศอิตาลี และนอยท่ีสุดคือ 

กรรมการจากประเทศโรมาเนีย 
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6. การทดสอบความสมัพันธรายคูแบบสเปยรแมน 

 การทดสอบความสัมพันธกรณีขอมูลของตัวแปรไมเปนคาตอเนื่อง มีวิธีการทดสอบความสัมพันธ

ระหวางตัวแปร 2 ตัว ท่ีเปนตัวแปรแบบคาไมตอเนื่อง (discontinuous  variable) กับตัวแปรแบบคาไม

ตอเนื่อง (discontinuous  variable) ดวยการจัดอันดับของขอมูล (ranks of the data) โดยมีวิธีดังนี้ 

1. การทดสอบความสัมพันธดวยสัมประสิทธิ์สหสัมพันธอันดับท่ีของสเปยรแมนหรือสเปยรแมน

โร  (Spearman's Rank Correlation Coefficient or Spearman's rho (ρ) Test) หรือ เปนการวัด

ระดับความสัมพันธ (association) โดยตัวแปรมีการเรียงลําดับไปในทิศทางเดียวกัน (monotonicity) 

เหมาะกับตัวแปรแบบคาตอเนื่อง (continuous variable) ตัวแปรแบบคาไมตอเนื่อง (discrete 

variable) และตัวแปรแบบมาตราจัดอันดับ (order variable) 

2. การทดสอบความสัมพันธดวยสัมประสิทธิ์สหสัมพันธอันดับของเคนดอลล (Kendall rank 

correlation coefficient)  หรือ  สัมประสิทธิ์ แบบเทาว ของ เคนดอลล  ทาว  (Kendall Tau (τ) 
coefficient) เปนการวัดระดับความสอดคลอง (correspondence) ท่ีเกิดจากความแตกตางระหวาง

จํานวนคูท่ีเปนสัดสวน (concordant) หรือคูของลําดับท่ีมีลักษณะตรงกันกับจํานวนคูท่ีไมเปนสัดสวน 

(discordant) ประกอบดวย 

   2.1 ทาว-เอ (Tau-a) เปนสถิติทดสอบความเขมของความสัมพันธ (strength of association) 

ของตารางไขว (cross tabulations) ตัวแปรท้ังสองเปนตัวแปรแบบมาตราจัดอันดับ โดยการทดสอบ

แบบทาว-บี จะไมทําการปรับคามีคาเทากัน (ties) 

   2.2 ทาว-บี (Tau-b) เปนสถิติทดสอบท่ีแตกตางจากสถิติทดสอบแบบทาว-เอ เพราะทําการ

ปรับคาท่ีมีคาเทากัน (ties) ท่ีไดจากการทดสอบความสัมพันธของขอมูลท่ีอยูในรูปของตารางสี่เหลี่ยม

จตุรัส (square tables) คาของทาว-บี อยูในชวง -1 (มีความสัมพันธเชิงลบ 100% หรือตรงขามอยาง

สมบูรณ) ถึง +1 (มีความสัมพันธเชิงบวก 100% หรือเห็นดวยอยางสมบูรณ) และคา 0 เปนดัชนีของการ

ไมมีความสัมพันธ  

   2.3 ทาว-ซี (Tau-c) แตกตางจากทาว-บี คือ เหมาะกับการทดสอบขอมูลท่ีอยูในรูปของตาราง

แบบสี่เหลี่ยมผืนผา (rectangular table) มากกวาตารางแบบสี่เหลี่ยมจตุรัส (square tables) 
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การวิเคราะหความสัมพันธระหวางตัวแปรหากขอมูลไมเปนไปตามขอตกลงของการวิเคราะห

ความสัมพันธแบบเพียรสันสามารถใชวิธีการทดสอบความสัมพันธแบบสเปยรแมนแทน ผลการวิเคราะห

ใหคาความเขมของความสัมพันธมากหรือนอย และบอกทิศทางของความสัมพันธเชิงบวกหรือเชิงลบดังนี ้

ตารางท่ี 14.1 การแปลคาสัมประสิทธิ์สหสัมพันธแบบสเปยรแมน 

คาสัมประสิทธิ์สหสัมพันธ (Correlation Coefficient) 

คาของความสัมพันธ ความเขมและทิศทางของความสัมพันธ 

1.00 ถึง .80 มีความสัมพันธเชิงบวกระดับมากอยางยิ่ง 

.79 ถึง .60 มีความสัมพันธเชิงบวกระดับมาก 

.59 ถึง .40 มีความสัมพันธเชิงบวกระดับปานกลาง 

.39 ถึง .20 มีความสัมพันธเชิงบวกระดับนอย 

.19 ถึง .01 มีความสัมพันธเชิงบวกระดับนอยมาก 

.00 ไมมีความสัมพันธ 

-.01 ถึง -.19 มีความสัมพันธเชิงลบระดับนอยมาก 

-.39 ถึง -.20 มีความสัมพันธเชิงลบระดับนอย 

-.59 ถึง -.40 มีความสัมพันธเชิงลบระดับปานกลาง 

-.79 ถึง -.60 มีความสัมพันธเชิงลบระดับมาก 

-1.00 ถึง .-80 มีความสัมพันธเชิงลบระดับมากอยางยิ่ง 

ปรับปรุงมาจาก: Evans, J. D. (1996). Straightforward statistics for the behavioral sciences. 

Pacific Grove, CA: Brooks/Cole Publishing. 
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6.1 การทดสอบความสมัพันธอันดับที่แบบงาย 

การทดสอบความสัมพันธอันดับท่ีแบบงาย (Simple correlation) คือ การวิเคราะหหา

ความสัมพันธตัวแปร 1 คู โดยตัวแปรอิสระหรือตัวแปรตามท่ีใชในการวิเคราะหความสัมพันธมีระดับการ

วัดแบบมาตราจัดอันดับหรือเปนตัวแปรท่ีมีระดับการวัดแบบคาตอเนื่องแตขอมูลไมเปนไปตามขอตกลง

เบื้องตนของการวิเคราะหความสัมพันธแบบเพียรสัน  

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา ระดับการศึกษาของพนักงานมี

ความสัมพันธกับเงินเดือนเริ่มตนหรือไม 

6.1.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ตัวอยางไดมาจากการสุมแบบสุม (random sampling) และเปนอิสระจาก

กัน (independent sample) 

 2. ตัวแปรอิสระเปนตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบคาตอเนื่อง 

รวมถึงตัวแปรแบบคาไมตอเนื่อง (discrete variables) 1 ตัว 

 3. ตัวแปรตามเปนตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบคาตอเนื่อง 

รวมถึงตัวแปรแบบคาไมตอเนื่อง (discrete variables) 1 ตัว 

การวิเคราะหขอมูล ขอมูลมีการแจกแจงไมปกต ิ(asymmetrical distribution) 

6.1.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

คาจัดประเภท (จัดอันดับ) คาตอเนื่อง 

การศึกษา (educ) 

- ประถมศึกษา 

- มัธยมศึกษา 

- อุดมศึกษา 

เงินเดือนเริ่มตน (salbegin) 

 



328 | ก า ร ใ ช โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร ท า ง ส ถิ ติ ใ น ด า น สั ง ค ม ศ า ส ต ร  

6.1.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงคาเฉลี่ยของเงินเดือนเริ่มตน จําแนกตามระดับการศึกษา 

ระดับการศึกษา จํานวน คาเฉล่ียเงินเดือนเริ่มตน S.D. 

มัธยมศึกษาตอนตน 53 13,064.15 2,408.147 

มัธยมศึกษาตอนปลาย 190 13,241.87 2,653.896 

อุดมศึกษา 231 21,027.14 9,421.873 

รวม 474 17,061.09 7870.638 

 จากตารางท่ี (#) แสดงใหเห็นวา พนักงานมีเงินเดือนเฉลี่ย 17,061.09 ดอลลารสหรัฐ โดย

พนักงานท่ีมีการศึกษาระดับอุดมศึกษามีเงินเดือนเฉลี่ยมากท่ีสุด รองลงมา คือ มัธยมศึกษาตอนปลาย 

และมัธยมศึกษาตอนตน ตามลําดับ 

 จากขอมูลท่ีกลาวมานาจะมีความสัมพันธระหวางระดับการศึกษากับเงินเดือนเริ่มตน ดังนั้นจึงทํา

การทดสอบความสัมพันธดวยสัมประสิทธิ์สหสัมพันธอันดับท่ีของสเปยรแมน (Spearman's Rank 

Correlation Coefficient Test) โดยมีสมมติฐานดังนี้ 

 H0: ระดับการศึกษากับเงินเดือนเริ่มตนไมมีความสัมพันธกัน 

 H1: ระดับการศึกษากับเงินเดือนเริ่มตนมีความสัมพันธกัน 

เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธดวยวิธีของสเปยรแมน 

(Spearman's Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะ

ยอมรับสมมติฐาน H0 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ 

(α = .05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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6.1.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ สรางตัวแปรกลุมประสบการณกอนทํางาน 

o เลือกเมนู Transform -> Recode in Different Variables 

o เลือกตัวแปร educ ใสในชอง Variables: 

o ใตคําวา Old ในชอง Variables: คลิกเมาสท่ีชื่อตัวแปรเกา 

o ในกลุมคําสั่ง Output Variable ชอง Name:  พิมพ educ_group -> กดปุม Change  

o กดปุม Old and New Values… 

เปลี่ยนคา LOWEST-9 ->1, 10-12 -> 2 และ 13-Highest -> 3 

o กดปุม Continue 

o กดปุม OK  

 
 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs…  

o Rows: เลือกตัวแปรแบบคาจัดประเภท (จัดอันดับ) หรือตัวแปรแบบคาตอเนื่อง/ตัวแปร

แบบคาไมตอเนื่อง (discrete variables) 1 ตัวแปร หรือมากกวา 1 ตัวแปร (ท่ีตองการให

เปนตัวแปรตาม) ชองรายการตัวแปรดานซาย  

o Column: เลือกตัวแปรแบบคาจัดประเภท (จัดอันดับ) หรือตัวแปรแบบคาตอเนื่อง 1 ตัว

แปร หรือมากกวา 1 ตัวแปร (ท่ีตองการใหเปนตัวแปรตาม) จากรายการตัวแปรดานซาย  

o กดปุม Statistics… ไมเลือกสถิติ Chisq และเลือกสถิติ Corr แทน -> กดปุม Continue 

o กดปุม Cells… ไมเลือก Count, Row, Column, Total และเลือก None -> กดปุม 

Continue  

o กดปุม OK  
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6.1.5 ผลการวิเคราะห 

 

6.1.6 การสรางตารางแสดงผลการทดสอบ 

ตาราง (#) แสดงการทดสอบความสัมพันธระหวางระดับการศึกษากับเงินเดือนเริ่มตน 

6.1.7 การแปลผลและสรุป 

จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา คาความนาจะเปน (Sig.) = .03 มีคานอยกวาคา

นัยสําคัญทางสถิติท่ีกําหนดไว (α = .05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 คือ ระดับ

การศึกษากับเงินเดือนเริ่มตนมีความสัมพันธกัน  

 สรุป ระดับการศึกษากับเงินเดือนเริ่มตนมีความสัมพันธกัน (ระดับการศึกษาของพนักงานมี

ความสัมพันธเชิงบวกระดับมากกับเงินเดือนเริ่มตน) 

ตัวแปร จํานวน เงินเดือนเริ่มตนของผูตอบ (ρ) Sig. (2-tailed) 

ระดับการศึกษา 474 .60 .03 
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6.2 การทดสอบความสมัพันธอันดับที่แบบพห ุ

 การทดสอบความสัมพันธอันดับท่ีแบบพหุ (Multiple correlation) คือ การวิเคราะหหา

ความสัมพันธระหวางตัวแปรมากกวา 1 คู โดยตัวแปรอิสระหรือตัวแปรตามท่ีใชในการวิเคราะห

ความสัมพันธมีระดับการวัดแบบมาตราจัดอันดับหรือเปนตัวแปรท่ีมีระดับการวัดแบบคาตอเนื่องแต

ขอมูลไมเปนไปตามขอตกลงเบื้องตนของการวิเคราะหความสัมพันธแบบเพียรสัน 

ตัวอยางคําถามการวิจัย 

จากขอมูลการสํารวจพนักงานในหนวยงานตองการทราบวา ระดับการศึกษาและประสบการณ

กอนการทํางานของพนักงานมีความสัมพันธกับเงินเดือนเริ่มตนหรือไม 

6.2.1 ขอตกลงเบ้ืองตน 

ข้ันตอน ขอตกลง 

การออกแบบการวจิัย 1. ตัวแปรอิสระเปนตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบคาตอเนื่อง 

รวมถึงตัวแปรแบบคาไมตอเนื่อง (discrete variables) 1 ตัวแปร หรือ

หลายตัวแปร  

 2. ตัวแปรตามเปนตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบคาตอเนื่อง 

รวมถึงตัวแปรแบบคาไมตอเนื่อง (discrete variables) มากกวา 1 ตัวแปร 

การวิเคราะหขอมูล ขอมูลมีการแจกแจงไมปกต ิ(asymmetrical distribution) 
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6.2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

<-> 

ตัวแปรตาม 

คาจัดประเภท (จัดอันดับ) คาตอเนื่อง 

การศึกษา (educ) 

- ประถมศึกษา 

- มัธยมศึกษา 

- อุดมศึกษา 

ประสบการณกอนทํางาน (prevexp_group) 

- ไมมีประสบการณ 

- มีประสบการณนอย 

- มีประสบการณปานกลาง 

- มีประสบการณมาก 

เงินเดือนเริ่มตน (salbegin) 

6.1.3 การกําหนดสมมติฐานและเกณฑการทดสอบ 

ตารางท่ี (#) แสดงคาเฉลี่ยของเงินเดือนเริ่มตน จําแนกตามระดับการศึกษาและตําแหนงงาน 

ตัวแปร จํานวน คาเฉล่ียเงินเดือนเริ่มตน S.D. 

ระดับการศึกษา    

- มัธยมศึกษาตอนตน 53 13,064.15 2,408.147 

- มัธยมศึกษาตอนปลาย 190 13,241.87 2,653.896 

- อุดมศึกษา 231 21,027.14 9,421.873 

รวม 474 17,061.09 7870.638 

ประสบการณกอนทํางาน    

- ไมมีประสบการณ 24 11,331.25 1,308.402 

- มีประสบการณนอย (1-36 เดือน) 153 16,504.93 6,287.574 

- มีประสบการณปานกลาง (37-60 เดือน) 75 16,691.60 6,218.312 

- มีประสบการณมาก (61 เดือนข้ึนไป) 222 18,092.57 9,347.561 

รวม 474 17,016.09 7,870.638 
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 จากตาราแสดงใหเห็นวา พนักงานมีเงินเดือนเฉลี่ย 17,061.09 ดอลลารสหรัฐ โดยพนักงานท่ีมี

การศึกษาระดับอุดมศึกษามีเงินเดือนเฉลี่ยมากท่ีสุด รองลงมาคือ มัธยมศึกษาตอนปลาย และมีเงินเดือน

เฉลี่ยนอยท่ีสุดคือ มัธยมศึกษาตอนตน และเม่ือพิจารณาจากประสบการณกอนทํางานของพนักงานแสดง

ใหเห็นวา พนักงานท่ีมีประสบการณมากมีเงินเดือนเฉลี่ยมากท่ีสุด รองลงมาคือ มีประสบการณปานกลาง 

มีประสบการณนอย และมีเงินเดือนเฉลี่ยนอยท่ีสุดคือ ไมมีประสบการณ 

 จากขอมูลท่ีกลาวมานาจะมีความสัมพันธระหวางระดับการศึกษาและประสบการณการทํางาน

กับเงินเดือนเริ่มตน ดังนั้นจึงทําการทดสอบความสัมพันธดวยสัมประสิทธิ์สหสัมพันธอันดับท่ีของสเปยร

แมน (Spearman's Rank Correlation Coefficient Test) โดยมีสมมติฐานดังนี้ 

 H1: ระดับการศึกษากับเงินเดือนเริ่มตนมีความสัมพันธกัน 

 H2: ประสบการณการกอนทํางานกับเงินเดือนเริ่มตนมีความสัมพันธกัน 

 เกณฑในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธดวยวิธีของสเปยรแมน 

(Spearman's Test) ไดคาความนาจะเปน (p-value) มากกวาคานัยสําคัญทางสถิติ (α = .05) จะปฏิเสธ

สมมติฐาน H1 และ H2 แตหากไดคาความนาจะเปน (p-value) นอยกวาหรือเทากับคานัยสําคัญทางสถิติ 

(α = .05) จะยอมรบัสมมติฐาน H1 และ H2 
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6.2.4 การใชโปรแกรมคอมพิวเตอรวิเคราะหขอมูล 

๏ เปดแฟมขอมูล File -> Open -> Employee data.sav 

๏ สรางตัวแปรกลุมประสบการณกอนทํางาน 

o เลือกเมนู Transform -> Recode in Different Variables 

o เลือกตัวแปร prevexp ใสในชอง Variables: 

o ใตคําวา Old ในชอง Variables: คลิกเมาสท่ีชื่อตัวแปรเกา 

o ในกลุมคําสั่ง Output Variable ชอง Name:  พิมพ prevexp_group -> กดปุม 

Change  

o กดปุม Old and New Values… 

เปลี่ยนคา 0->1, 1-36 -> 2, 37-60 -> 3 และ 61-Highest  -> 4 

o กดปุม Continue 

o กดปุม OK  
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs…  

o Rows: เลือกตัวแปรแบบคาจัดประเภท (จัดอันดับ) หรือตัวแปรแบบคาตอเนื่อง/ตัวแปร

แบบคาไมตอเนื่อง (discrete variables) 1 ตัวแปร หรือมากกวา 1 ตัวแปร (ท่ีตองการให

เปนตัวแปรตาม) จากรายการตัวแปรดานซาย 

o Column: เลือกตัวแปรแบบคาจัดประเภท (จัดอันดับ) หรือตัวแปรแบบคาตอเนื่อง 1 ตัว

แปร หรือมากกวา 1 ตัวแปร (ท่ีตองการใหเปนตัวแปรตาม) จากรายการตัวแปรดานซาย 

o กดปุม Statistics… ไมเลือกสถิติ Chisq และเลือกสถิติ Corr แทน -> กดปุม Continue 

o กดปุม Cells… ไมเลือก Count, Row, Column, Total และเลือก None -> กดปุม 

Continue  

o กดปุม OK 

 

 

 

6.2.5 ผลการวิเคราะห 
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6.2.6 การสรางตารางแสดงผลการทดสอบ 

ตารางท่ี (#) แสดงผลการทดสอบความสัมพันธระหวางระดับการศึกษากับเงินเดือนเริ่มตนและ

ประสบการณกอนทํางาน 

6.2.7 การแปลผลและสรุป 

 จากตารางท่ี (#) ผลการทดสอบแสดงใหเห็นวา ความสัมพันธระหวางระดับการศึกษากับ

เงินเดือนเริ่มตน และความสัมพันธระหวางประสบการณกอนทํางานกับเงินเดือนเริ่มตน ไดคาความนาจะ

เปน (Sig.) = .03 และ .05 ตามลําดับ มีคานอยกวาและเทากับคานัยสําคัญทางสถิติท่ีกําหนดไว (α 

= .05) จึงยอมรับสมมติฐาน H1 และ H2  

 สรปุ ระดับการศึกษากับเงินเดือนเริ่มตนมีความสัมพันธกัน และประสบการณการกอนทํางานกับ

เงินเดือนเริ่มตนมีความสัมพันธกัน (ระดับการศึกษาของพนักงานมีความสัมพันธเชิงบวกระดับมากกับ

เงินเดือนเริ่มตน และประสบการณกอนทํางานมีความสัมพันธเชิงบวกระดับนอยมากกับเงินเดือน) 

สรุป 

การวิเคราะหขอมูลเพ่ือทดสอบสมมติฐานหากขอมูลไมเปนไปตามขอตกลงเบื้องตน (not meet 

basic assumption) ของการทดสอบแบบอิงคาพารามิเตอร (parametric tests) เชน ขอมูลมีการแจก

แจงแบบไมปกติ ขอมูลเปนมาตราแบบจัดกลุม (nominal scale) หรือจัดอันดับ (ordinal scale) หรือ

ตัวอยางท่ีสุมมีขนาดเล็กเกินไป (นอยกวา 30) ควรเลือกใชการทดสอบแบบไมอิงคาพารามิเตอร (non-

parametric statistics) เพราะเปนวิธีการทดสอบท่ีมีขอตกลงเพียงเล็กนอยหรือไม มีขอตกลง 

(assumption-free test) เชน ขอมูลมีการวัดระดับใดก็ได ไมจําเปนตองมีการแจกแจงเปนโคงปกติ 

ขอมูลแตละกลุมไมจําเปนตองมีการกระจายเทากัน และ/หรือไมมีความเปนเสนตรงในการวิเคราะหการ

ถดถอยไมใชเชิงเสนตรง (nonlinear regression analysis) 

ตัวแปร จํานวน เงินเดือนเริ่มตน (rs) Sig. (2-tailed) 

ระดับการศึกษา 474 .60 .03 

ประสบการณกอนทํางาน 474 .20 .05 



ก า ร ท ด ส อ บ ข อ มู ล แ บ บ ไ ม อิ ง ค า พ า ร า มิ เ ต อ ร  ( 2  ตั ว แ ป ร ) | 337 

แบบฝกหัดทายบท 

ใหผูเรียนเปดแฟมขอมูล 1991 US. General Social Survey.sav แลวประมวลผลขอมูล เพ่ือ

ทดสอบและแปลผล ดังนี้ 

1. ทดสอบความเปนอิสระของขอมูลระหวางตัวแปรกลุมชนใหม (newrace) กับภูมิภาค 

(region) โดยใชตัวแปรกลุมชน (race) สรางเปนตัวแปรใหมชื่อ กลุมชนใหม (newrace) มี 2 กลุม คือ ผิว

ขาว และไมใชผิวขาว เพ่ือหาคําตอบวา แตละภูมิภาคมีกลุมชนท่ีมีผิวขาวและไมใชผิวขาวแตกตางกัน

หรือไม 

2. ทดสอบลําดับท่ีคาเฉลี่ยของตัวแปรระดับความสุข (happy) ดวยตัวแปรเพศ (sex) โดยใช

วิธีการทดสอบของแมน-วิทนี ยู (Mann-Whitney U Test) 

3. ทดสอบลําดับท่ีคาเฉลี่ยของตัวแปรระดับความสุข (happy) ดวยตัวแปรภูมิภาค (region) โดย

ใชวิธีการทดสอบของครสัคาลและวัลลิส (Kruskal Wallis Test) 

4. ทดสอบความเหมือนกันของระดับการศึกษาสูงสุดของผูตอบแบบสํารวจ (edu) และบิดา 

(paeduc) ของผูตอบแบบสอบสํารวจ โดยใชวิธีเครื่องหมาย (Sign Test) 

5. ทดสอบความเหมือนกันของระดับการศึกษาสูงสุดของผูตอบแบบสํารวจ (edu) บิดา 

(paeduc) และมารดา (maeduc) ของผูตอบแบบสํารวจ โดยใชวิธีฟรีดแมน (Friedman Test) 

6. ทดสอบความสัมพันธระหวางจํานวนบุตร (childs) กับจํานวนพ่ีนอง (sibs) กับระดับความสุข 

(happy) 

7. ทดสอบความสัมพันธระหวางจํานวนบุตร (childs) กับจํานวนพ่ีนอง (sibs) และระดับ

ความสุข (happy) 
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